
USER MANUAL
Rev. 4 (ENG)70003482



Copyright and License
Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under 
the copyright laws.

The information contained herein is subject to change without notice.

The only warranties for ALPINION products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. ALPINION shall not be liable for technical or editorial errors or omissions contained here in.

Prepared by: 
ALPINION MEDICAL SYSTEMS Co., LTD. 
5FL, I Dong, 77, Heungan-daero 81beon-gil,  
Dongan-gu, Anyang-si, Gyeonggi-do, Republic of Korea

T: +82 2 3282 0903  F: +82 2 851 5593   www.alpinion.com 
Copyright © ALPINION MEDICAL SYSTEMS Co., LTD, All rights reserved.

Revision Log
The following is a list of major changes and additions that have been made to this manual since it was first 
released.

Rev Date (YYYY/MM/DD) Description

Rev. 0 2019/01/22 User manual first released

Rev. 1 2019/03/15 Updated for Rev. 1 release

Rev. 2 2019/08/27 Updated for Rev. 2 release

Rev. 3 2020/01/10 Updated for Rev. 3 release

Rev. 4 2021/12/15 Updated for Rev. 4 release



Table of Contents

1.	 System Basics................................................................................ 1-1

Introduction.......................................................................................................... 1-2

System Components............................................................................................. 1-6

Peripherals and Accessories............................................................................... 1-11

Image Display..................................................................................................... 1-17

Control Panel...................................................................................................... 1-19

QWERTY Keyboard.............................................................................................. 1-22

Touch Screen....................................................................................................... 1-23

Transducers......................................................................................................... 1-24

2.	 Getting Started............................................................................. 2-1

Operating Requirements...................................................................................... 2-2

Moving and transporting the system.................................................................... 2-3

Powering On/Off................................................................................................... 2-6

Adjusting the Monitor and Touch Screen............................................................. 2-8

Connecting/Disconnecting the Transducer........................................................ 2-10

Activating/Deactivating the Transducer............................................................. 2-11

3.	 Starting a Study............................................................................ 3-1

Patient Registration.............................................................................................. 3-2

4.	 Imaging Modes............................................................................. 4-1

2D Mode............................................................................................................... 4-2

M Mode.............................................................................................................. 4-18

Color Flow (CF) Mode......................................................................................... 4-23

Power Doppler (PD) Mode.................................................................................. 4-32

Pulsed Wave Doppler (PWD) Mode.................................................................... 4-38

Continuous Wave Doppler (CWD) Mode............................................................ 4-47

Tissue Doppler Imaging (TDI) Mode................................................................... 4-52

3D and 4D Modes............................................................................................... 4-54



5.	 Imaging Functions......................................................................... 5-1

Freezing Images.................................................................................................... 5-2

Zooming Images................................................................................................... 5-3

Full Screen............................................................................................................ 5-4

Screen Split........................................................................................................... 5-5

CINE Images.......................................................................................................... 5-6

Annotating Images................................................................................................ 5-7

Panoramic Imaging............................................................................................. 5-13

Needle Vision™ Plus........................................................................................... 5-17

Contrast Enhanced Imaging................................................................................ 5-19

Elastography....................................................................................................... 5-22

Stress Echo.......................................................................................................... 5-30

Cube Strain™...................................................................................................... 5-44

6.	 Managing Patient Information and Image..................................... 6-1

Clipboard.............................................................................................................. 6-2

Touch Clip............................................................................................................. 6-4

E-view................................................................................................................... 6-5

DICOM Spooler................................................................................................... 6-18

Printer................................................................................................................. 6-20

DVR..................................................................................................................... 6-21

7.	 Measurements and Reports.......................................................... 7-1

Basics.................................................................................................................... 7-2

Abdomen............................................................................................................ 7-34

Obstetrics........................................................................................................... 7-43

Gynecology......................................................................................................... 7-82

Cardiology........................................................................................................... 7-92

Vascular............................................................................................................ 7-129

Urology............................................................................................................. 7-142

Pediatrics.......................................................................................................... 7-149

Small Parts........................................................................................................ 7-158

Breast................................................................................................................ 7-166

Musculoskeletal (MSK)..................................................................................... 7-173



Emergency Medicine (EM)................................................................................ 7-178

8.	 Transducer and Biopsy.................................................................. 8-1

Transducer............................................................................................................ 8-2

Biopsy................................................................................................................... 8-7

Transducer Accessories....................................................................................... 8-18

9.	 Preset........................................................................................... 9-1

System Preset....................................................................................................... 9-2

Image Preset....................................................................................................... 9-47

10.	Care and Maintenance................................................................ 10-1

System Care and Maintenance........................................................................... 10-2

Battery Care and Maintenance........................................................................... 10-6

Transducer Care and Maintenance..................................................................... 10-7

11.	Safety and Regulatory Information............................................. 11-1

Safety Summary.................................................................................................. 11-2

Equipment Safety Information........................................................................... 11-3

Patient Safety Information.................................................................................. 11-4

Anti-Virus Program............................................................................................. 11-5

Electrical Safety Information.............................................................................. 11-6

Transducer Safety Information........................................................................... 11-7

Biopsy Safety Information................................................................................... 11-9

System Symbols and Labels.............................................................................. 11-10

Regulatory Information.................................................................................... 11-14

Electromagnetic Compatibility (EMC)............................................................... 11-17

Diagnostic Ultrasound Indications for Use Format........................................... 11-22

Acoustic Output................................................................................................ 11-43

12.	Appendix.................................................................................... 12-1

Appendix A. Biopsy Guide................................................................................... 12-2



1
Introduction............................................................................................................ 1-2

System Components............................................................................................... 1-6

Peripherals and Accessories................................................................................. 1-11

Image Display....................................................................................................... 1-17

Control Panel........................................................................................................ 1-19

QWERTY Keyboard............................................................................................... 1-22

Touch Screen........................................................................................................ 1-23

Transducers.......................................................................................................... 1-24

This chapter describes the system overview and operator controls.

System Basics
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Introduction

System overview
The E-CUBE 8 ultrasound system provides excellent quality and reliability as well as these specific 
features:

Table 1-1 System feature

Physical Dimensions

	• Height: 1470/1560 mm
	• Width: 532 mm
	• Depth: 787 mm
	• Weight: 55 kg (not including options)

Clinical Applications

	• Abdomen
	• OB
	• GYN
	• Cardiology
	• Small Parts
	• MSK
	• Vascular
	• Urology
	• EM
	• TCD
	• Breast
	• Appendix

Available Imaging Modes

	• 2D mode
	• Harmonic mode (HAR)
	• M mode
	• Color M mode
	• Anatomical M mode (AMM)
	• Color Flow Doppler (CF) mode
	• Power Doppler (PD) mode
	• Directional PD mode
	• Pulsed Wave Doppler (PWD) mode
	• Continuous Wave Doppler (CWD) mode
	• High PRF Doppler mode
	• Tissue Doppler Imaging (TDI) mode
	• 3D/4D mode

Image Processing Technology

	• Xpeed™
	• Full SRI™
	• Spatial Compounding Image (SCI)
	• Panoramic
	• Live HQ™
	• Needle Vision™/Needle Vision™ Plus
	• Contrast Enhanced Ultrasound (CEUS)
	• ECG
	• Elastography
	• Filter Method Tissue Harmonic Image (FTHI)
	• Pulse Inversion Tissue Harmonic Image (PTHI)
	• Raw Data Processing
	• Post Processing
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Operable Transducers

Pencil Doppler 	• CW2.0
	• CW5.0

Linear Array 	• L3-12T
	• L3-12H
	• L3-12HWD

	• L8-17H
	• IO3-12
	• IO8-17T

Sector Phased Array 	• SP3-8T
	• P1-5CT

Convex Array 	• C1-6CT
	• C5-8NT
	• SC1-4H
	• SC1-4HS
	• SC1-6H

Endocavity 	• EV3-10T
	• EC3-10T
	• E3-10

Volume Convex 	• VC1-6T
Volume Endocavity 	• VE3-10H

Measurement Package

Including reports for:
	• Abdomen
	• OB
	• GYN
	• Cardiology
	• Vascular
	• Urology
	• Pediatrics
	• Small Parts
	• Breast
	• MSK
	• EM

Basic Measurements

2D Mode 	• Distance, Ellipse, Trace
	• Area, Circumference
	• %Stenosis
	• Volume
	• Angle
	• A/B Ratio
	• Volume Flow Area

Doppler Mode 	• Velocity
	• Time
	• PI
	• Trace
	• Acceleration
	• S/D Ratio
	• RI
	• Auto Trace
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Basic Measurements (cont.)

M Mode 	• A/B Ratio
	• Distance
	• Time
	• Slope
	• %Stenosis
	• HR

Connectivity

	• Verification
	• DICOM storage
	• DICOM print
	• DICOM storage commitment
	• DICOM media
	• DICOM worklist
	• DICOM MPPS
	• DICOM Structured Report (OB-GYN)
	• DICOM Structured Report (Echocardiography)
	• DICOM Structured Report (Vascular)
	• Cube View™
	• Network Storage
	• Wireless LAN (Option)

User Interface

	• English
	• German
	• French
	• Spanish
	• Italian
	• Russian
	• Portuguese
	• Chinese
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Documentation

CAUTION
Safety instructions must be reviewed before operating the unit.

E-CUBE 8 documentation consists of following manuals:

	• The User Manual and Quick Guide (TRANSLATED) provides information needed by the user to operate 
the system safely. It describes the basic functions of the system, safety features, operating modes, 
measurements/calculations, transducers, and user care and maintenance.

	• The Reference Manual (ENGLISH ONLY) contains data tables, such as Obstetric and Cardiology 
references.

	• The Service Manual (ENGLISH ONLY) supplies block diagrams, lists of spare parts, descriptions, 
adjustment instructions or similar information which helps qualified technical personnel in repairing 
those parts of the system which have been defined as repairable.

The E-CUBE 8 manuals are written for users who are familiar with basic ultrasound principles and 
techniques. They do not include sonographic training or detailed clinical procedures.

NOTE
	• The manuals are only provided in electronic format on the CD.
	• The CD includes English and all translations.
	• The screen images in this manual are only for illustrational purposes. Actual screen display may differ 

slightly from that shown in this manual.

Contraindication
Using the system for certain purposes such as gender determination is severely restricted by law. 

Do not operate the system for an ophthalmic purpose or any use affecting the patient’s eye by the 
acoustic beam.

Prescription device
United States law restricts this device to sale or use by, or on the order of a physician.

Intended operator profile
The E-CUBE 8 is intended for use by a qualified and trained physician or sonographer with at least basic 
ultrasound knowledge for ultrasound evaluation. 

The operator must have read and understood the user manual.
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System Components

Front view 
There are the main components of your system:
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Figure 1-1 Front view

No. Component No. Component 

1 Monitor (21.5-inch wide display) 6 Control panel

2 LED lamp 7 Up/Down lever

3 Gel warmer 8 Handle

4 Transducer holder 9 Transducer cable holder

5 Transducer holder 10 CW port
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Rear view
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Figure 1-2 Rear view

No. Component No. Component 

1 I/O panel 4 ECG port

2 AC outlet 5 System on/off switch

3 AC inlet

NOTE
When connecting an external monitor to your system, use the monitor with 1366 x 768 or higher resolution.
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Side view

1

2

34

Figure 1-3 Side view

No. Component No. Component 

1 Monitor arm 3 Caster lock

2 Transducer port 4 Caster

Peripheral area
In the middle of the system, you can place optional peripherals such as black and white printer and color 
printer.

CAUTION
The peripheral area is only for peripheral devices. Do not place transducers or the footswitch in the 
peripheral area to prevent damaging them from accidentally falling off.
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I/O panel
I/O panel located on the rear side of a system includes video input and output, audio input and output, 
Ethernet, power and control connections for a printer. See Figure 1-4 below for more details.

CAUTION
	• Each outer (case) ground line of peripheral/accessory connectors are earth grounded. Signal ground lines 

are not isolated.
	• For compatibility reasons, use only ALPINION approved transducers, peripherals or accessories.
	• Be sure to plug the power supply cable of the peripherals to the connector panel of the system to avoid 

unexpected electrical shock.
	• Do not connect any transducer or accessories without approval from ALPINION.

12119
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7

Figure 1-4 I/O panel

No. Component No. Component 

1 B/W printer port 7 VGA port

2 Color printer port 8 Audio in port (Reserved)

3 S-Video input port (Rerserved) 9 HDMI port

4 Remote control port for a B/W printer 10 Audio out port

5 Remote control port for a color printer 11 USB ports (4 ports)

6 S-Video output port 12 Ethernet port

NOTE
The external storage media such as USB HDD or DVD-RW should be connected with the system referring to 
the following instructions.

	• If power consumption of the external storage media corresponds to more than 0.5 A and less than 1 A, you 
should use 3 or 4 port to get it activated properly.

	• If power consumption of the external storage media exceeds 1A, you should use a Y-cable that makes the 
external storage media receive power from two USB ports at the same time. 
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CAUTION
	• The connection of equipment or transmission network other than as specified in these instructions can 

result in electric shock hazard.
	• Connected peripherals must meet IEC standard (An equipment that processes data: IEC 60950/EN 60950, 

a medical equipment: IEC 60601-1/EN 60601-1). For product configuration, it must meet the safety 
requirements of product standard IEC/EN 60601-1 or system standard IEC 60601-1-1/EN 60601-1-1.

	• The operator shall not contact the parts (SIP/SOP) and the patient simultaneously.
	• When connecting a cable to the ethernet (LAN) port, always use the optional LAN isolator (EN-20G by 

EMO system or any similar isolator complying with IEC/EN 60601-1) to protect your system from electrical 
damage.
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Peripherals and Accessories
Before using the peripherals or accessories, you should consider the following requirements.

WARNING
Observe all warnings and cautions given in the operation manual of peripheral device. 

CAUTION
For compatibility reasons, use only ALPINION approved peripherals or accessories. DO NOT connect any 
peripherals or accessories without approval by ALPINION.

Peripheral update for EU countries
The following is intended to provide the users in EU countries with updated information concerning the 
connection of the E-CUBE 8 to image recording and other devices or communication networks.

The E-CUBE 8 has been verified for overall safety, compatibility and compliance with the following on-
board image recording devices:

	• Color Printer  
Manufacturer: Sony Corporation 
Model: UP-D25MD, UP-25MD

	• B/W Printer 
Manufacturer: Sony Corporation, Mitsubishi Electric Corporation 
Model: UP-D898MD, UP-X898MD, P95DE(P95DW)

	• DVD-RW 
Manufacturer: Hitachi-LG Data Storage, Inc 
Model: GP50NW40

The E-CUBE 8 has also been verified for compatibility, and compliance for connection to a local area 
network (LAN) via the rear panel Ethernet connection, provided the LAN components are IEC/EN 60950 
compliant.

The E-CUBE 8 may also be used safely while connected to devices other than those recommended above 
if the devices and their specifications, installation, and interconnection with the system conform to the 
requirements of IEC/EN 60601-1-1.
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Basic accessories 
The E-CUBE 8 has the following basic accessories:

	• E-CUBE 8 console 	• User Manual, Reference Manual (Soft copy)

	• Sonic gel 	• Quick Guide (Soft copy)

Optional supplies and accessories
The following tables show optional supplies and accessories that have been verified to be compatible 
with the system.

Biopsy kit

	• L3-12 Biopsy Starter Kit (for L3-12T, L3-12H)

	• SC1-6 Biopsy Starter Kit (for C1-6CT, SC1-4H, SC1-6H)

	• SC1-4HS Biopsy Starter Kit (for SC1-4HS)

	• VE3-10H Disposable Needle Guide (for VE3-10H)

	• VE3-10H Reusable Needle Guide (for VE3-10H)

	• E3-10 Disposable Needle Guide (for E3-10)

	• E3-10 Reusable Needle Guide (for E3-10)

	• EN3-10 Disposable Needle Guide (for EV3-10T, EC3-10T)

	• EN3-10 Reusable Needle Guide (for EV3-10T, EC3-10T)

Optional function

	• Full SRI 	• SRI 	• Elastography

	• FTHI (Filtered Tissue Harmonic) 	• Auto IMT 	• Cube ViewTM

	• Xpeed 	• CW 	• Needle Vision™

	• Spatial compounding 	• Anatomical-M 	• Needle Vision™ Plus

	• Value 3D/4D 	• Frequency Compounding 	• Auto NT

	• CV M&R 	• Panoramic 	• Volume Advance

	• DICOM 3.0 Connectivity 	• Tissue Doppler Image 	• Cube Note

	• DICOM SR (OB) 	• Stress Echo 	• AutoEF

	• DICOM SR (Adult Echo) 	• Cube StrainTM

	• DICOM SR (Vascular) 	• Live HQTM

Console accessory

	• Tri-pedal footswitch
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Footswitch (Option)
The optional tri-pedal footswitch that is connected with the rear panel of your system performs specific 
functions easily instead of pressing function keys on the control panel.

The each pedal of the footswitch may have different functions depending on the assigned settings such 
as Freeze, P1, P2, P3, and Rec/Pause.

To assign the footswitch functions, press the [System Preset] key and go to User Setting > Print/Foot 
Switch.

Figure 1-5 Footswitch

CAUTION
Do not place or store the footswitch in the peripheral area on the system to prevent damaging the footswitch 
from accidently falling off.

Wireless LAN (Option)
A Wireless Network is available on the E-CUBE 8. For adjusting a wireless LAN connection, see "Network" 
on page 9-34.

Using unrecommended wireless LAN adapter may cause system malfunction. To prevent system 
malfunction, only use wireless LAN adapters approved or recommended by ALPINION.

NOTE
Please contact your local agent to get the latest information on compatible wireless LAN adapters.
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Battery (Option)
This system uses lithium ion batteries. The lithium ion battery provides power if AC power is not 
available.

NOTE
The battery is designed to work with E-CUBE 8 systems only. Use only the batteries authorized by Alpinion 
Medical Systems.

The length of the time the system can run on the battery will vary, depending on the diagnostic mode 
and the peripherals connected.

If the battery level runs low while using the system, connect it to an AC power source to recharge the 
battery.

WARNING
	• The battery has a safety device. Do not disassemble or alter the battery.
	• Do not heat the battery or discard it in a fire.
	• Do not leave the battery in direct sunlight.
	• Do not short-circuit the battery by directly connecting the negative terminals with metal objects.
	• Do not subject batteries to mechanical shock.
	• Do not use a damaged battery. If the battery emits an unusual odor or heat during use or recharging, 

immediately stop using it and contact an authorized agent or an ALPINION MEDICAL service engineer. 

CAUTION
	• This system has an embedded battery. The battery used in the system must be replaced by an authorized 

agent or an ALPINION MEDICAL service engineer.
	• Ensure that water or liquids do not drip into the battery connection area.
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Battery icons and status

The following battery icons describes the status of the battery and shown on the bottom right of the 
screen. With the battery icons, you can easily check the remaining battery level.

Table 1-2 Battery Icons and status

Icon Status Note

Battery level is between 95 and 100%.

AC power cable is plugged.

Battery level is between 40 and 94%.

Battery level is between 20 and 39%.

Battery level is between 1 and 19%.

Battery level is 0 %.

Icon Status Note

Battery level is between 95 and 100%.

AC power cable is unplugged.

Battery level is between 40 and 94%.

Battery level is between 20 and 39%.

Battery level is between 1 and 19%.

Battery level is 0 %.
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Monitor and touch screen

1
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Figure 1-6 Monitor buttons

No. Component No. Component 

1 Up ( ) button 4 USB port (2 ports)

2 Mode/Select ( ) button 5 LED lamp button

3 Down ( ) button 6 Brightness dial

CAUTION
The LED lamp may overheat. Be careful not to directly touch it to avoid injury.
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Image Display
The image display consists of an ultrasound image, application information, patient information, and 
indicators.
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Figure 1-7 Image display

1
Hospital logo & name 10 Transducer orientation marker

Current date & time 11 Image area

2 Patient ID, Patient name 12 Image parameter

3 Operator ID, Transducer name 13 Clipboard indicator

4 Mechanical index, Thermal index 14 Image clipboard

5 Zoom reference window

15

Status bar: Symbol lock, Caps lock, USB 
connection, Network connection, Wireless 
network connection, User defined key, 
Data backup status, Cube View connection, 
Battery status icon

6 Labeled measurement menu

7 Gray/Color scale bar

8 Focal zone marker
16

Clipboard icons: Touch Clip, Thumbnail 
Preview, Recycle bin, Single & Dual layout 
format, Scroll Up/Down/Home/End9 Depth scale marker
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Screen saver 
Screen saver mode automatically activates to save the system power when you do not operate the 
system and the system stays in idle for a specified time. To deactivate this mode and return to normal 
operating mode, press any key on the control panel.

NOTE
To configure the screen saver settings, press the [System Preset] key and go to System > General > Monitor.
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Control Panel

Update
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Figure 1-8 Control panel layout

Table 1-3 Key description

No Controls Description

1 TGC slides Use these controls to adjust TGC values on images.

2 Soft keys 

Use these controls to select or adjust the functions in the soft menu at the 
bottom of the display. 

	• Press to select the corresponding soft menu.
	• Rotate to adjust the function of the corresponding soft menu.

3 Power on/off Use this control to turn on and off the system. 

4 U1, U2, U3 Use these controls to access user-defined functions.

5 Imaging modes Use these controls to activate M, PW, CF, or 2D mode.

6

CW Use this control to activate Continuous Wave (CW) Doppler mode. This control is 
optional.

PD Use this control to activate Power Doppler mode.

3D4D Use this control to activate 3D and 4D modes.
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No Controls Description

7

Patient Use this control to display the Patient Registration screen. You can enter patient 
data.

Transducer Use this control to select the desired transducer, application, and preset.

Report Use this control to create a report based on the exam result and edit it.

E-view Use this control to activate image management with end of study options.

End Exam Use this control to end the current study.

8 QWERTY keyboard Use this control to type numeric values and texts.

9 Select Use this control to select the desired function from the context menu on the 
screen.

10 Angle

Use this control to change an angle.
	• In 2D or Color mode, rotate to adjust the angle steer.
	• In CW or PW mode, rotate to adjust the Doppler angle correct.
	• In Body pattern mode, rotate to adjust the transducer angle.
	• In Arrow mode, rotate to adjust the arrow angle.
	• In CW or PW mode, press to adjust the auto angle.

11

Clear Use this control to delete the arrow, comment, and measurement.

Exit Use this control to exit current screen (mode) and return to the previous screen 
(mode).

12

Depth Use this control to adjust the scanning depth of an image.

Focus Use this control to focus on the area of interest..

Zoom
Use this control to turn Zoom mode on.

	• Rotate to activate Read zoom.
	• Press to activate Write zoom in Read zoom mode.

13 Image layout keys Use these controls to view an image in dual or quad screen.

14
Xpeed Use this control to automatically optimize image parameters on the live screen.

P2, P3 Use these controls to print out images.

15

Set/Cur Use this control to show the cursor on the screen and set the current function. 
You can select a menu on the screen using this cursor.

Body Pattern Use this control to display the body pattern images.

Text Use this control to annotate images.

Update Use this control to update a 2D image in real time based on the specified time or 
freeze a 2D image.

Measure Use this control to perform measurement.

Priority

Use this control to adjust the priority of Trackball.
	• In 2D mode, press to select the priority between the width and tilt functions.
	• In Duplex or Triplex mode, press to select the priority between ROIs of the 

activated imaging modes.
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No Controls Description

16 Trackball Use this control to scroll through menus or options on the screen by moving the 
cursor.

17 Freeze Use this control to start and stop scanning.

18 P1 Use this control to print out images.
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QWERTY Keyboard
The QWERTY keyboard is available which you can enter text or perform special functions.

Figure 1-9 Keyboard layout

Using the special keys 
Table 1-4 Special key description

No Controls Description

1 Quick ID Access the Quick ID screen.

2 Patient Browse Access the E-View menu.

3 Image Preset Access the Image Preset menu.

4 System Preset Access the System Preset menu.

5 DICOM Spool Access the DICOM Spooler menu.

6 F7 Create your own user preset.

7 DVR Access the DVR menu.

8 Help Access the electronic manual.

9 Eject Eject a media (CD, DVD, or USB).

10 Hide Hide the current menu screen.

11 Clear All Clear your input or cancel your selection.

12 Biopsy Show the biopsy guideline.

13 Flip the image 180 degrees left/right.

14 Initial Restore the default settings of the current function.

15 End Exam End the current study.

16 Show the arrow pointer on the screen.
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Touch Screen
Your ultrasound system has the touch screen that enables you to easily access menus or adjust options 
on the current monitor display. With the touch screen, you can also enter text instead of using the 
QEWRTY keyboard. Simply touch the menu or option you want. 

8

5
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3

4

7

6

1

Figure 1-10 Touch screen

No Controls Description

1 Touch Clip Select the tab to activate the Touch Clip.

2 Power Preset Access user-defined preset customized to best suit the user's needs.

3 E-Tool Access system configuration.

4 Virtual Keyboard Access the virtual keyboard on the touch screen.

5 Scanning Modes Tab Select the tab to activate scanning mode.

6 Touch Menus Touch buttons with mode/function specific controls.

7 Soft Menus Rotary/Push buttons with mode/function specific controls.

8 Page Indicator Switch to the previous/next page of the touch menu screen.
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Transducers
The E-CUBE 8 ultrasound system provides various types of transducers. Most of them have a state of 
art in transducer technology: single crystal transducers, composite transducers, and extreme fine pitch 
transducer, and real-time mechanical 4D transducers

Moving and storing transducers
Transducers should be placed inside their holders for moving short distances. For shipping or moving 
considerably a long distance, storing transducers in their carrying cases are strongly recommended. 
Storing them in carrying cases is not only to protect the transducers from physical damage such as 
shock or vibration, but also it will protect them from environmental damages such as humidity and 
temperature.

NOTE
For more information about transducer, see "Transducer" on page 8-2.



2
Operating Requirements........................................................................................ 2-2

Moving and transporting the system..................................................................... 2-3

Powering On/Off.................................................................................................... 2-6

Adjusting the Monitor and Touch Screen............................................................... 2-8

Connecting/Disconnecting the Transducer.......................................................... 2-10

Activating/Deactivating the Transducer............................................................... 2-11

This chapter describes how to get started using your system.

Getting Started
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Operating Requirements
Before using your system, you should consider the following requirements.

NOTE
Only qualified sonographers or physicians should perform scanning with the system.

WARNING
Do not install the system by yourself. Only ALPINION MEDICAL SYSTEMS service engineer should install the 
system. 

Electrical requirements
You should use a system with the specified power outlet as follows:

	• 100-120 / 200-240 VAC, 450 VA, 50-60 Hz

WARNING
Using the system in a wrong voltage range causes damages on the system.

Environmental requirements
You should use this system in proper environment to prevent it from radio wave interference, dust and 
gas.

WARNING
Using the system in an inappropriate environment might cause unexpected problems.

Make sure the area, which your system is installed, is well-ventilated, with a temperature, humidity, and 
pressure requirements. If the system is exposed to inappropriate temperature, humidity, or pressure, 
adapt your system to normal range of environment for a few hours.

Table 2-1 Environmental requirements

Temperature Humidity Pressure

Operation 10 °C–35 °C 30 %–75 % 700–1060 hPa

Storage -25 °C–60 °C 20 %–90 % 700–1060 hPa

Transportation -25 °C–60 °C 20 %–90 % 700–1060 hPa

CAUTION
Before powering the system on, make sure that the system meets the operational conditions in temperature 
and humidity.
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Moving and transporting the system

Before moving the system

CAUTION
	• For your safety, you must follow the precautions carefully before moving or transporting the system.
	• Before moving the system, make sure that the peripherals in the storage area are installed securely.

Before you move the system, use the following steps.

1	1	 Power off the system using the [Power On/Off] key on the control panel.

2	2	 Unplug the power cord from the power outlet.

3	3	 Disconnect all peripheral devices (e.g. printers or DVD) and the footswitch from the system.

4	4	 Secure all cables.

5	5	 Store all transducers or accessories in the proper spaces carefully.

6	6	 Push down the locking switch to lock the monitor arm.

Unlock Lock

Figure 2-1 Locking the monitor arm

7	7	 If necessary, push the Up/Down lever and adjust the height.

CAUTION
To avoid injury or damage, make sure nothing is within the range of motion before adjusting the height. 
This includes both objects and people.

8	8	 Fold up the monitor.

9	9	 Unlock the front and rear casters by stepping on the lock levers.
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When moving the system

CAUTION
	• For your safety, follow the precautions carefully when moving the system.
	• Do not use the system cables to move the system.
	• When you move the system with another person, take extra precaution not to injure feet.

When moving the system, use the following procedure.

1	1	 Move the system by using the front or rear handle grip.

2	2	 Take extra care when moving the system for long distances and on inclines.  
Ask for help, if necessary.

3	3	 Use extra care to move the system when crossing door or elevator thresholds.

4	4	 When you reach the destination, lock the front and rear casters.
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When transporting the system
When transporting the system with vehicles, use the following procedure.

1	1	 Only use vehicles that are capable of transporting your E-CUBE 8 system.

2	2	 Load and unload the system to a vehicle parked on a level surface.

3	3	 Ensure that the transporting vehicle can handle the weight of the system plus the passengers.

4	4	 Ensure that the load capacity of the lift is capable of handling the weight of the system.

5	5	 Ensure that the lift is in good working order.

6	6	 Secure the system while it is on the lift so that it cannot roll. Use wood chocks, restraining straps, or 
other similar types of constraints. Do not attempt to hold it in place by hand.

7	7	 Employ two to three persons to load and unload safely from a vehicle.

8	8	 Load the unit aboard the vehicle carefully and keep its center of gravity. Keep the unit still and 
upright. (Do not lay the unit down on its side.)

9	9	 Ensure that the system is firmly secured while inside the vehicle. Any movement, coupled with the 
weight of the system, could cause it to break loose.

10	10	 Secure the system with straps or as directed otherwise to prevent motion during the transport.

11	11	 Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds, and erratic 
stops or starts.
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Powering On/Off

Power on
1	1	 Make sure that the power cord is plugged into the power outlet.

CAUTION
Make sure that the system power is supplied from a separate and properly rated power outlet.

2	2	 Push the System On/Off switch to turn on the system power on the bottom rear of the system.

3	3	 Press the [Power On/Off] key on the control panel.

4	4	 The system boots up and the progress bar appears on the monitor.

5	5	 After initialization is complete, the scan screen appears.

6	6	 If the access control has been set by the system administrator, the System Log In window appears.

7	7	 Enter the operator's ID and password, and then click OK.

Power off

CAUTION
Do not unplug the power cord during the system operation. Do not turn off the System On/Off switch before 
pressing the [Power On/Off] key. This may lead to data loss or system software damage.

NOTE
Depending on the power-off setting, you can activate Sleep mode or turn the system off immediately. To 
change the power-off setting, press the [System Preset] key and go to System > General > Power Off.

1	1	 Press the [Power On/Off] key on the control panel. 

2	2	 When the Power off dialog box appears, click Shutdown by using [Trackball].

NOTE
If the system has not fully shut down in 60 seconds, press and hold down the [Power On/Off] key until 
the system shuts down.
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System Protection
If the system access control has been set by the administrator, you can access the patient data in the 
system only after you log on the system.

Figure 2-2 System Log In window

NOTE
To set the system to log on automatically, press the [System Preset] key and go to Administration > Users and 
select the System Auto Login check box.
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Adjusting the Monitor and Touch Screen

Rotate, tilt, pan, and fold the monitor
The position of monitor can be easily adjusted to fit your viewing by help of the professional arm. This 
monitor can be adjusted in following positions:

	• Rotating: the monitor with the professional arm provides three pivot points for rotation (covers 
considerably wide rotation area).

	• Tilting: the monitor can be tilted around its pivot point to both forward and backward. 

	• Panning: the monitor can be panned forward and backward by the rotation on the rear rotation pivot 
point on the professional arm. The distance of monitor from user can be easily adjusted. 

	• Folding: the monitor can be folded down close to the control panel to provide a stability when 
moving the system. 

	• Adjusting height (up/down): the height of monitor can be adjusted without handling the control 
panel height.

Move up (Height adjust)Folded

Tilt forward

Default posture

Panning

Tilt backward

Figure 2-3 Adjusting the monitor
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Contrast, brightness, and dim brightness
To adjust the contrast, 

1	1	 Press the Mode/Select ( ) button on the monitor once.

2	2	 To increase the contrast, press the Up ( ) button. Press the Down ( ) button to decrease the 
contrast. Repeat step 2 until desired value reached.

NOTE
Current contrast value is shown on the display.

To adjust the brightness of the monitor, 

1	1	 Press the Mode/Select ( ) button on the monitor twice.

2	2	 To increase the brightness, press the Up ( ) button. Press the Down ( ) button to decrease the 
brightness. Repeat step 2 until the desired value is reached.

NOTE
Current brightness value is shown on the display.

To adjust the brightness of the touch screen,

1	1	 Push up Brightness dial to increase the brightness.

2	2	 To decrease the brightness, push down Brightness dial.

To adjust the dim brightness, 

1	1	 Press the Mode/Select ( ) button on the monitor three times.

2	2	 To increase the dim brightness, press the Up ( ) button. Press the Down ( ) button to decrease the 
dim brightness. Repeat step 2 until the desired value is reached.

LED lamp
The LED lamp is adapted to offer proper light at a dark room to see the chart or readings. To turn the 
light on, press the LED Lamp button. Press this button once again to turn this lamp off.
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Connecting/Disconnecting the Transducer

Connecting the transducer
You can connect the transducer to the transducer port when the system is powered off or on. Make sure 
that you press the [Freeze] key on the control panel before connecting the transducer.

CAUTION
Do not touch the patient when connecting or disconnecting a transducer.

1	1	 Check if you press the [Freeze] key on the control panel.

2	2	 Insert the transducer connector into the transducer port.

CAUTION
Do not forcibly insert the transducer connector to the system. Improper connection may cause 
damages to the system and transducer.

3	3	 Push the connector locking lever to the left to secure the transducer connector.

NOTE
After connecting the transducer to the system, you need to activate the desired transducer by selecting 
it from the screen. 

Disconnecting the transducer
You can disconnect the transducer from the transducer port when the system is powered off or on. Make 
sure that you press the [Freeze] key on the control panel before disconnecting the transducer.

CAUTION
Do not touch the exposed surface of the transducer connector when the transducer is removed. 

1	1	 Check if you press the [Freeze] key on the control panel.

2	2	 Push the connector locking lever to the right to release the transducer connector.

3	3	 Pull out the transducer connector from the transducer port.
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Activating/Deactivating the Transducer

Activating the transducer
Use the following procedure to activate the transducer and application.

1	1	 On the control panel, press the [Transducer] key. 
The dialog box for transducer and application selection appears.

2	2	 Select the desired transducer, application and preset using [Trackball] on the control panel, and 
then press the [Set] key on the control panel.

NOTE
Default transducer for the selected preset or default preset for the selected transducer is selected 
automatically.

3	3	 Click Exit to complete the transducer selection.

NOTE
Selecting the Automatic Preset selection when changes the Transducer check box shows the default 
application and preset for the selected transducer.

Deactivating the transducer

NOTE
Before deactivating the transducer, press the [Freeze] key on the control panel. An error may occur when you 
deactivate the transducer while the system is running.

Use the following procedure to deactivate the transducer.

1	1	 Press the [Freeze] key on the control panel. 

2	2	 Gently wipe the excess gel on the transducer surface.

3	3	 Place the transducer in its holder.
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This chapter describes how to begin a study.

Starting a Study
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Patient Registration
You can enter the patient information on the Patient Registration screen. When the patient information 
is entered, you can perform measurement and calculation, save images to the image archive, and send 
the images to a DICOM device. You can also identify the patient information on the patient banner and 
report screen.

To enter the Patient Registration screen, 

–	 Press the [Patient] key on the control panel. 

Patient Registration display
The following components are shown on the screen:

3

6

1

2

4

5

Figure 3-1 Patient display

1 Function selection 4 Exam information

2 Patient information 5 Patient list/Study list

3 Application selection 6 Save & Exit, Exit
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Patient Registration menu

Figure 3-2 Patient menu

Starting a new patient
1	1	 On the Patient Registration screen, enter the patient information using the QWERTY keyboard. You 

can also select  and use the virtual keyboard on the touch screen.

2	2	 The cursor positions on the Patient ID field. Enter the patient information using the alphanumeric 
keyboard. The Patient Registration screen includes the following patient information fields.

Table 3-1 Patient information

Field Description Remarks

Patient ID Identification code for a patient Maximum 64 characters are supported. Use a 
unique ID for each patient.

Name Patient's last, first, and middle 
name

Each of last name, middle name, and first name 
supports maximum 62 characters and the total 
name supports maximum 62 characters.

Birth Date Patient's birth date
Click the calendar icon and select a date on the 
calendar. You can also manually enter a date.

Age Patient's age Automatically calculated when birth date is 
entered. You can also manually enter an age.

Sex Female, Male, Other
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NOTE
	• Using the [TAB] or [Enter] key on the QWERTY keyboard allows you to navigate through each field 

on the Patient Registration screen. You can use [Trackball] and the [Set] key on the control panel to 
move and fix the cursor.

	• To automatically generate a patient ID with current date and time, 
–	 Press the [System Preset] key and go to Patient Info. Select the Auto ID Generation check box. 
–	 Press the [Quick ID] key on the QWERTY keyboard and select the Auto ID Generation check box 

on the Quick ID screen.
–	 Select Quick Register on the touch screen. 

3	3	 Select the desired application from exam application categories: ABD, OB, GYN, CARD, VAS, URO, 
SMP, BREAST, MSK, TCD, or EM. When a category is selected, the measurement and category 
presets are displayed.

4	4	 Enter the required application information for the selected application. 

	❚ ABD application

No specific application data

	❚ OB and EM application

Table 3-2 OB and EM application

Field Description

LMP/IVF Select LMP or IVF first to calculate EDD and enter the date of the last 
menstrual period (or In Vitro Fertilization).

EDD

Estimated Date of Delivery. The system automatically calculates and 
displays EDD after entering LMP or IVF. When you enter or change EDD, 
the system calculates and displays values for LMP/IVF and GA.
EDD = LMP + 280 days

GA GA is automatically calculated when you enter LMP, IVF or EDD.
GA = Current date - LMP

Fetus # Select the fetus number (up to 4 fetuses).

Gravida Enter the number of pregnancy.

Para Enter the number of childbirth.

Ectopic Enter the number of ectopic pregnancy.

Aborta Enter the number of abortion.
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	❚ GYN application

Table 3-3 GYN application

Field Description

LMP
Enter the date of the last menstrual period using the selected date 
format (ex – MM/DD/YYYY).

Expected Ovulation Date Enter an expected ovulation date.

Day of Cycle Enter a menstrual cycle.

Gravida Enter the number of pregnancy.

Para Enter the number of childbirth.

Ectopic Enter the number of ectopic pregnancy.

Aborta Enter the number of abortion.

	❚ Cardio application

Table 3-4 Cardio application

Field Description

BSA Body Surface Area (Calculated, No input data)

	❚ Vascular application

Table 3-5 Vascular application

Field Description

Left BP Blood pressure of left arm, using the systole over diastole measurement 
in mmHg

Right BP Blood pressure of right arm, using the systole over diastole measurement 
in mmHg

ABI Ankle Brachial Index

	❚ Urology application

Table 3-6 Urology application

Field Description

PSA Enter the value of the Prostate-specific antigen.

PPSA coef.(1) Enter the first value of the predicted PSA coefficient.

PPSA coef.(2) Enter the second value of the predicted PSA coefficient.



3-6 Starting a Study

	❚ Pediatrics application

No specific application data

	❚ Small Part application

No specific application data

5	5	 Enter the general application information.

Table 3-7 General application information

Field Description

Height Enter the patient’s height using selected dimension (cm, ft, inch).

Weight Enter the patient’s weight using selected dimension (kg, lb, oz).

BP Blood pressure in mmHg

Accession #
Maximum 16 characters
Identification code indicating the sequence of the current study as related to 
other studies for this patient. Usually generated by a HIS or RIS server.

Exam Comments Maximum 144 characters

Indication Maximum 72 characters

Performing MD The name of performing MD

Referring MD The name of referring MD

Operator The name of operator

Description Maximum 64 characters

NOTE
	• To configure the measurement unit, press the [System Preset] key and go to System > General > 

Location > Unit.
	• When you change the operator ID on the Patient Registration screen, the Log in dialog box appears 

on the screen. Select the desired operator ID from the Operator ID field and enter a valid password 
into the Password field, and then click OK.

6	6	 Click Save & Exit or select Start Exam on the touch screen to save the patient and application 
information. The scan screen appears. 
If you click Exit, return to the scan screen without saving the patient and application information.

CAUTION
Always verify the identification with the patient to avoid patient identification errors. Make sure that 
the correct patient identification appears on all screens before printing out the patient information.
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Quick ID
With the Quick ID feature, you can quickly register a patient by entering the basic patient information. 
This feature is useful when you do not have enough time to register all patient information.

1	1	 Press the [Quick ID] key on the QWERTY keyboard. Or select Quick Register on the touch screen. 
The Quick ID screen appears.

Figure 3-4 Quick ID screen 

2	2	 Enter Patient ID, Name, Birth Date, Age and Sex. Only OB application shows the LMP and EDD fields.

NOTE
Using the [TAB] or [Enter] key on the QWERTY keyboard allows you to navigate through each field on 
the Quick ID screen. You can use [Trackball] and the [Set] key on the control panel to move and fix the 
cursor.

To enter more information including the application information, go to the Patient Registration 
screen by pressing the [Patient] key on the control panel. 

3	3	 Click OK to save the patient information.
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Searching for an existing patient
1	1	 Press the [Patient] key on the control panel. The Patient Registration screen appears.

2	2	 Select a search criteria (Patient ID, Patient Name, Birth Date, Sex, Exam Date, and Locked) from the 
Search drop-down list and enter a search keyword. 
If you select Exam Date, you can select a desired period (Today, Last Week, Last Month, and Last 3 
Months) and a specific date from the drop-down list.

NOTE
To view all registered patients while entering a search keyword, click Clear.

3	3	 The list of patients who match the criteria is displayed in the patient list.

Sorting the list
Sort the patient or study information by clicking the column names (e.g. Lock, Patient ID, Name, Birth 
Date, Sex, Image Size, Exam Type, Exam Date, and Exam #) of the patient or study list in ascending or 
descending order.

Starting a new exam on an existing patient

NOTE
When you register a patient, the study list appears on the display. If the patient is not registered, the patient 
list appears instead.

1	1	 Press the [Patient] key on the control panel. The Patient Registration screen appears.

2	2	 Select a desired patient from the patient list.

3	3	 If necessary, enter or edit the patient information.

4	4	 Select Start Exam on the touch screen to create a new study and return to the scan screen.
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Retrieving patient information via worklist
1	1	 Press the [Patient] key on the control panel. The Patient Registration screen appears.

2	2	 Select Worklist on the function selection to view patient data from the default worklist server.

3	3	 To change the worklist server, select a source from the Source drop-down list.

NOTE
Before connecting to the worklist server, you need to configure worklist settings. To configure worklist 
settings, press the [System Preset] and go to Connectivity > Worklist.

4	4	 Select Worklist to retrieve patient data from the worklist server.  
The search results appear on the list.

5	5	 Select the patient you want to start a study.

6	6	 Select Transfer on the touch screen to transfer the selected study to the patient archive.

NOTE
Destination for transfer is always Local Archive HDD.

Locking a patient or study
To prevent deleting or moving patient data, use Lock functionality.

Locking the existing patient

1	1	 Search and select a patient from the patient list.

2	2	 Select Lock on the touch screen.

3	3	 You can see the locked patient with the lock icon in the patient list.

NOTE
When you select a locked patient, you can see all of the studies are locked.

Locking the existing study

1	1	 Select a study from the study list.

2	2	 Select Lock on the touch screen.

3	3	 You can see the locked study with the lock icon in the study list.

NOTE
To unlock the locked patient or study, select Unlock on the touch screen. 
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Deleting a patient or study

CAUTION
Before deleting a patient or study, make sure you have already backed up the patient data using Backup 
Patient Archive or export function. After deleting the patient or study, you CANNOT recover it. 

NOTE
To select multiple patients from the patient list, press the [Set] key while the [Ctrl] or [Shift] key is pressed.

Deleting a patient

NOTE
To switch between the patient list and the study list, use Patient List or Study List. 

1	1	 Search and select a patient from the patient list.

2	2	 Select Delete on the touch screen.

3	3	 When the Message dialog box appears, click Yes to delete the selected patient.

NOTE
When the patient you want to delete is locked, you cannot delete the patient by using Delete. You have 
to unlock the locked patient before deleting it.

Deleting a study

1	1	 Select a study from the study list.

2	2	 Touch Delete on the touch screen.

3	3	 When the Message dialog box appears, click Yes to delete the selected study.

NOTE
When the study you want to delete is locked, you cannot delete the study by using Delete. You have to 
unlock the locked study before deleting it.

Ending a study
When you end a study, all images of the current study are saved in the local hard disk.

–	 Press the [End Exam] key on the control panel to save the current study.

–	 Press the [End Exam] key on the QWERTY keyboard to save the current study. 

–	 You can also end a study by selecting New Patient on the Patient Registration screen.

NOTE
You can return to the Patient Registration screen after ending the current study. To configure, press the 
[System Preset] key and go to System > General > After End Exam. 
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This chapter describes the general functions of the imaging modes.

Imaging Modes
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2D Mode
In 2D mode ultrasound, your transducer simultaneously scans a plane through the body that can be 
viewed as a two-dimensional image on the screen. Two-dimensional images and measurements of the 
anatomical structures of soft tissues such as internal organs and vascularities can be determined.

2D mode display

Figure 4-1 2D mode display

General workflow
To start a scan in 2D mode, 

1	1	 Press the [2D] key on the control panel to start 2D mode.

2	2	 Use the following controls for image optimization:

	– [2D] key (rotate to adjust 2D mode gain)

	– [Depth] and [Focus] keys

	– [TGC] slide controls

NOTE
To reset the current image settings, press the [Initial] key on the QWERTY keyboard.

3	3	 Use additional soft keys, if necessary.

4	4	 To enter another imaging mode, press the corresponding mode key.

5	5	 Press the [2D] key to return to 2D mode from another imaging mode.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-2 2D mode touch screen
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Gain

Increase or decrease in the amount of echo information displayed in an image. It may have the effect of 
brightening or darkening the image if sufficient echo information is generated.

	❚ Adjusting the gain

Increase or decrease the sensitivity of the instrument. You can use two controls to adjust gain: The 
overall gain control and TGC. To increase or decrease overall gain, rotate the [2D] key on the control 
panel.

	❚ Gain values

Gain is shown as Gn on the display. Gain values may vary depending on the transducer, application, 
and frequency setting.

Gain values are returned to the factory or user preset value when you change one of the followings: 
Transducer, application, or new patient.

	❚ Remarks

Commonly, you need to decrease the gain when you increase the Power Output; to increase the gain, 
decrease the power output. Gain and TGC interact by adding together.
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Depth

Increasing the depth enables the deeper structures to be visualized. You can decrease the depth if you 
do not need the bottom portion of the display.

	❚ Adjusting Depth

To increase or decrease the depth, rotate the [Depth] key clockwise or counter- clockwise on the 
control panel. You can see the display and image parameters are automatically changed. 

	❚ Depth values

Maximum and minimum depth selections are dependent on the frequency of the transducer you are 
currently using. 

NOTE
	• You might adjust TGC and focus with depth adjustment. Adjusting depth erases real-time calculations 

of the graphic on the screen (but not the completed results on the worksheet page).
	• Incrementing depth depends on what transducer and application you use. When you change the 

transducer, application, preset, or click New Patient on the Patient Registration screen, depth 
parameters are set to the factory or user preset settings. 

Xpeed™

Xpeed™ is an auto-optimizing technology that enables you to easily adjust an image’s the contrast 
resolution and brightness uniformity. For using this feature, you need an additional request to your local 
agent. 

	❚ Adjusting Xpeed

To activate or deactivate Xpeed, press the [Xpeed] key on the control panel. 

Time Gain Compensation (TGC)

To compensate for weak signals or over-bright signals at various depths, you can adjust Time Gain 
Compensation (TGC) using the TGC slide controls. The 2D control adjusts the overall receiver gain and 
compensates for the brightness of the image.

	❚ Adjusting the TGC

TGC slide control selectively adjusts the sensitivity (brightness) in depth. 

	– Slide the slide control to the left to decrease the gain in the corresponding specific 2D depth. 

	– Slide the slide control to the right to increase the gain in the corresponding specific 2D depth.

	❚ TGC values

TGC compensates for attenuation in tissue by increasing the receiver gain as a function of time 
following each transmit pulse.
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Focus

Convex array, linear array, and phased array transducers support multiple transmit focus zones, which 
you can select in 2D-mode images. Focal zone markers display on the left side of the image screen.

	❚ Focus Num

Focus Num is used to control the number of focal points.

	• Adjusting Focus Num
To increase or decrease the number of focal zones, press the [Focus] key on the control panel and 
then rotate the key clockwise or counter-clockwise.

	• Focus Num values
Focal zone number may vary depending on the depth, zoom, transducer, application, and selected 
frequency setting. Focus Num values are returned to the factory or user preset value when you 
change one of the followings: Transducer, application, or new patient.

	❚ Focus Pos

Focus Pos is used to change the location of the focal point. A triangular focus marker indicates the 
depth of the focal point.

	• Adjusting the focus position
To move the focal zone to the near/far field, rotate the [Focus] key on the control panel.

	• Focus Pos values
Focal zone position may vary depending on the depth, zoom, transducer, application, and selected 
frequency setting.

	❚ Remarks

Using multiple focal zones causes a reduction in the frame rate. The amount of frame rate reduction 
depends on the depth of view and the transducer.
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Harmonic

Tissue Harmonic Imaging (THI) is a system feature that can enhance the contrast resolution with fine 
tissue differentiation, benefiting patients with poor images. THI creates images from received signals 
using the harmonics of the transmitted frequency. 

For certain applications, Filtered THI (FTHI) can be used to optimize temporal resolution. The frame rate 
of FTHI is higher than THI between similar images. To use the FTHI function, you need an additional 
request to your local agent.

	❚ Adjusting THI

To adjust THI,

1	1	 Select Harmonic on the touch screen. 2D HAR appears next to 2D image parameters.

2	2	 To change the frequency of THI, rotate the Frequency soft key clockwise or counter-clockwise.

3	3	 To exit THI, select Harmonic on the touch screen.

To adjust FTHI,

1	1	 Select Harmonic on the touch screen. 2D HAR appears next to 2D image parameters.

2	2	 If INV appears next to 2D image parameters, select Inversion on the touch screen to switch to 
FTHI (HAR).

3	3	 To change the frequency of FTHI, rotate the Frequency soft key clockwise or counter-clockwise.

4	4	 To exit FTHI, select Harmonic on the touch screen.

	❚ Harmonic values

Changing multi-frequency resets those parameters which are presettable by frequency to their preset 
values for the current harmonic frequency. Multi frequency values are returned to the factory or user 
preset value when you change one of the followings: Transducer, application.

Dual/Quad Imaging

Using Dual (or Quad) imaging, you can view two (or four) images at the same time on the display. Dual or 
quad imaging is available in all 2D live imaging modes, M mode, Color Flow mode, and TDI mode.

	❚ Adjusting Dual/Quad imaging

To activate the image layout,

1	1	 In 2D mode, Color Flow mode, or M mode imaging, press the [Dual] (or [Quad]) key on the 
control panel. The image is shown on the left of the display.

2	2	 Press the [Dual] (or [Quad]) key again to activate the second image.

3	3	 To switch between the two (or four) images, press the [Dual] (or [Quad]) key.

4	4	 Press the [2D] key to exit the dual (or quad) imaging.
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Priority 

The priority function has the following two options: Width, Tilt

	❚ Width

Control the size or angle width of the 2D image sector. A smaller angle generally produces an image 
with a higher frame rate.

You can widen or narrow the size of the sector angle to maximize the image's region of interest (ROI).

	• Adjusting the width 
To narrow or widen the ROI, press the [Priority] key on the control panel. Width is highlighted in 
the message line. Move [Trackball] left or right to decrease or increase the angle size. Then, press 
the [Priority] key to set the region of interest (ROI).

	• Width values 
Width values may vary depending on the transducer (not applicable for linear transducers) and 
application.

	❚ Tilt

After the size or angle width of the 2D image sector is set, you can steer the image sector by using the 
tilt option. Press the [Priority] key to select the tilt function. Then move [Trackball] to tilt the angle.

NOTE
The priority function may not be available with linear transducers.

Up/Down (If Preset)

Up/Down allows you to flip the image 180 degrees up/down.

	❚ Adjusting the up/down 

 To flip the image vertically, press the U/D Flip key on user-defined key.

NOTE
To assign the Up/Down function to user-defined key, press the [System Preset] key and go to User Setting 
> User Defined key > Assign User Key or Assign Numeric Key and select the U/D Flip.

	❚ Up/Down values

Up/Down values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient.
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Angle Steer

In 2D mode, you can tilt an image left or right by using a linear transducer.

	❚ Adjusting the angle steer

To adjust the angle steer, rotate the [Angle] key clockwise or counter- clockwise on the control panel. 
The each level of the angle increment/decrement is 5 degrees.

NOTE
This function may not be available when the virtual convex function is applied to the current image.

Frequency

You can adjust the operating frequency of the transducer. The selected frequency is displayed in the 
Image Parameter.

Changing the frequency value on the display is selecting different transmit patterns associated with that 
value, including transmit pulse shape, frequency and transmit sequence.

	❚ Adjusting the frequency

To adjust the frequency, rotate the Frequency soft key clockwise or counter-clockwise.

NOTE
Changing the frequency may not be available when the image is frozen. 

	❚ Frequency values

Frequency values may vary depending on the transducer and application. 
The values are returned to the factory or user preset value when you change one of the followings: 
Transducer, application, or new patient.

Dynamic Range

Dynamic range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible.

	❚ Adjusting the dynamic range

To adjust the dynamic range, rotate the DR soft key clockwise or counter-clockwise.

NOTE
When the dynamic range is set high, the image is softer and more low-level data is visible.

	❚ Dynamic Range values

Dynamic range values are 30 dB to 250 dB. Dynamic range operates in real-time, freeze, Cine, and Cine 
timeline, but is not available during the VCR playback. It also affects Gain.
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Reject

Low echo information will not be displayed on the screen below the adjusted rejection level.

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display.

	❚ Adjusting the rejection

To adjust the rejection values, rotate the Reject soft key clockwise or counter-clockwise.

NOTE
When you increase the rejection, low-level echoes are rejected and appear in the 2D image.

	❚ Rejection values

Rejection values are 0 to 10.

Live Dual

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time.

The following combination imaging modes are available:

–	 2D(BW), 2D(BW)

–	 2D(BW), Color Flow(CF)

–	 2D(BW), Power Doppler(PD)

–	 Color Flow(CF), 2D(BW)

–	 Power Doppler(PD), 2D(BW)

NOTE
You can set up the Live Dual Default Layout in Image preset menu. In Live Dual, the current imaging mode 
takes priority over the default layout values.

	❚ Adjusting the Live Dual

To activate Live Dual, select Live Dual on the touch screen. You can change the imaging mode by 
pressing the [CF] key or the [PD] key.

NOTE
Live Dual may not be available when the image is frozen or rotated 90/270 degrees.

	❚ Live Dual values

Live Dual values are On and Off.
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Virtual Convex 

On linear transducers, virtual convex provides a larger field of view in the far field.

	❚ Adjusting the virtual convex

To activate or deactivate the virtual convex, select Virtual on the touch screen.

	❚ Virtual convex values

Virtual convex values are On and Off. Virtual convex allows for a wider field of view. This is available in 
2D mode, Color Flow mode, and Doppler mode.

Sepia

Sepia function is used to activate the sepia map. 

	❚ Adjusting the sepia

To activate or deactivate the sepia map, select Sepia on the touch screen.

	❚ Sepia values

Sepia values are On and Off.

Needle Vision™ Plus

Needle Vision™ Plus is a needle enhancement feature that can enhance viewing of the needle to assist 
you in guiding the needle to the target anatomy. For using this feature, you need an additional request to 
your local agent.

NOTE
See "Needle Vision™ Plus" on page 5-17 for more information.

	❚ Adjusting Needle Vision Plus

To activate or deactivate Needle VisionTM Plus,

1	1	 Select NeedleVision on the touch screen.

2	2	 Adjust the image parameters to obtain an optimized image.

3	3	 To exit Needle Visions™ Plus, select OFF on the touch screen.

	❚ Needle Vision Plus values

Needle Vision Plus values are Shallow, Medium, and Steep.

NOTE
The Needle Vision values are On and Off. 
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Elastography

Elastography is a technique that adds value to the sonographic examination by enabling you to evaluate 
the stiffness of tissue. For using this feature, you need an additional request to your local agent.

NOTE
See "Elastography" on page 5-22 for more information.

	❚ Adjusting Elastography

To activate or deactivate Elastography,

1	1	 Select Elasto on the touch screen. The system displays two images on the screen in a live, dual 
format.

2	2	 Perform the scan. Proper manual compression/decompression is displayed by the colored strain 
map.

3	3	 Adjust the image parameters to obtain an optimized image.

4	4	 When you have finished acquiring an image, press the [Freeze] key on the control panel. 

5	5	 If necessary, press the [P1] key to save the image.

6	6	 To perform a measurement, press the [Measure] key on the control panel.

7	7	 Estimate the size and hardness of lesions.

8	8	 To exit the Elastography mode, select Exit on the touch screen.

	❚ Elastogralhy values

Elastography values are On and Off.
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Panoramic

The Panoramic feature extends your field of view by piecing together multiple 2D images into a single, 
extended 2D image. For using this feature, you need an additional request to your local agent.

CAUTION
The quality of the resulting image is user-dependent and requires some additional skill and practice to develop 
proper technique and become fully proficient. Therefore, the measurement results may be inaccurate. Before 
using the Panoramic imaging feature, be sure to read and understand the instructions. See "Panoramic 
Imaging" on page 5-13 for more information.

	❚ Adjusting the panoramic

To activate or deactivate Panoramic function,

1	1	 Select Panoramic on the touch screen. You can access the Panoramic setup mode, and the blue-
colored ROI appears.

2	2	 Press the [Set] key to start the image acquisition.

3	3	 Move the transducer linearly along the scan path.

NOTE
To acquire an optimal image, move the transducer slowly and steadily.

4	4	 When you have finished acquiring an image, press the [Freeze] key on the control panel. 

5	5	 Adjust the image parameters to optimize the image, if necessary.

6	6	 Press the [Measure] key to perform a measurement.

7	7	 Press the [P1] key to save the image.

8	8	 To exit the Panoramic imaging mode, press the [2D] key or select Exit on the touch screen.

NOTE
	• When the panoramic feature is activated, you may not use the following imaging functions: Spatial 

compound, Virtual convex, Persist.
	• For linear transducers, errors of the distance measurements may be within 5%.
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S-FOV (Selected FOV)

On convex transducers, S-FOV provides larger field of view in the far field. 

	❚ Adjusting the S-FOV

To activate or deactivate S-FOV, select  on the touch screen.

EX-FOV

On endocavity transducers, EX-FOV provides wide angle field of view.

	❚ Adjusting the EX-FOV

To activate or deactivate EX-FOV, select  on the touch screen.

Reverse

Reverse allows you to flip the image 180 degrees left/right.

	❚ Adjusting the reverse

To flip the image horizontally, select  on the touch screen or press the  key on the QWERTY 
keyboard.

Gray Map

Gray Map provides you with the system maps for 2D, M, and Doppler modes.

	❚ Adjusting the gray map

To adjust the gray map, rotate the Gray Map soft key to clockwise or counter-clockwise.

	❚ Gray Map values

Gray maps gradually change from the least contrasty or softest to the most contrasty. Gray Map values 
may vary depending on the transducer.

Colorize

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode.

	❚ Adjusting the colorize

To adjust the colorize, rotate the Colorize soft key clockwise or counter-clockwise.

	❚ Colorize values

Colorize values are 0 to 22.
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Rotation

In 2D mode, you can rotate an image clockwise by 90 degrees.

	❚ Adjusting the rotation

To adjust the rotation, select < or > of Rotation on the touch screen.

	❚ Rotation values

Rotation values are 0, 90, 180, and 270.

Persist

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. 

	❚ Adjusting the persist

To adjust the persist, rotate the Persist soft key clockwise or counter-clockwise.

	❚ Persist values

Persist values may vary depending on the transducer and application. The values are returned to the 
factory or user preset value when you change one of the followings: Transducer, application, or new 
patient.

Power

Power controls the amount of acoustic power applied in all modes.

	❚ Adjusting the power

To adjust the power, rotate the Power soft key clockwise or counter-clockwise.

	❚ Power values

Power values are 1 to 100.
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SRI

Speckle Reduction Imaging (SRI) is a smart solution that enables you to reduce unnecessary elements of 
your image such as speckles and image noises. SRI is useful when unnecessary elements interfere with 
the desired image detail. After applying SRI, you can view your image more smoothly. The SRI feature is 
available in 2D, 3D, and 4D modes.

	❚ Adjusting SRI

To activate or deactivate SRI, select SRI on the touch screen.

	❚ SRI values

SRI values are On and Off.

Edge Enhance

Edge Enhance demonstrates subtle tissue differences and boundaries by enhancing the gray scale 
differences corresponding to the edges of structures. This function allows your system to display the 
outline of tissues or an organ more clearly.

	❚ Adjusting the edge enhance

To adjust the edge enhance, rotate the Edge Enhance soft key clockwise or counter-clockwise.

NOTE
Edge Enhance may not be available in freeze mode or in Cine mode.

	❚ Edge enhance values

Edge enhance values are 0 to 10.

Full SRI™

Full SRI™ is a more powerful SRI feature that allows you to adjust the SRI level according to your image 
condition or imaging mode. The full SRI feature is available in 2D, 3D, and 4D modes. For using this 
feature, you need an additional request to your local agent. 

	❚ Adjusting the full SRI

To adjust the full SRI, select < or > of FullSRI on the touch screen.

	❚ Full SRI values

Full SRI values are 0 to 5.
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Spatial Compound

Spatial compound allows you to combine different steering frames to form a single frame at real-time 
frame rates.

	❚ Adjusting the spatial compound

To adjust the spatial compound, select < or > of Spt.Comp on the touch screen.

	❚ Spatial compound values

Spatial compound values may vary depending on the transducer and application. The values are 
returned to the factory or user preset value when you change one of the followings: Transducer, 
application, or new patient.

NOTE
The spatial compound function may not be available with phased array transducers.

Line Density

Line density optimizes 2D mode frame rate or spatial resolution for the best possible image. A lower 
line density is useful in fetal heart beat, adult cardiac applications and in clinical Radiology applications 
requiring significantly higher frame rates. A higher line density is useful in obtaining very high resolution 
(e.g. thyroid, testicles).

	❚ Adjusting the line density 

Line density changes the vector density and frame rate. To adjust the line density, rotate the 
LineDensity soft key clockwise or counter-clockwise.

	❚ Line density values

Line density values may vary depending on the transducer and application. The values are returned 
to the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. A lower line density is useful in fetal heart beat, and adult cardiac.

Frequency Compound

Frequency compound allows your system to compound images on between high and low frequencies. 
By using each imaging feature on different frequencies, you can obtain a better image of enhanced 
resolution and penetration.

	❚ Adjusting the frequency compound

To activate or deactivate the frequency compound, select Frq.Comp on the touch screen.

	❚ Frequency compound values

Frequency compound values are On and Off.
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M Mode
The M mode display is formed by using a stationary ultrasound beam, yielding distance/motion versus 
time information for reflections along a single ultrasound beam line. M mode provides a display format 
and measurement capability that represents tissue displacement (motion) occurring over time along a 
single vector.

In M mode, you can learn the movement of an area of anatomy. First, you position the M-line in the 2D 
image on the anatomy of Interest. Then you can display information about movement along that line in 
M mode trace. M mode trace can be helpful when you perform measurements, especially measuring the 
heart rate.

M mode display

Figure 4-3 M mode display

General workflow
1	1	 On the control panel, press the [M] key to activate M mode.

2	2	 Move the M-line to the anatomy of interest by using [Trackball].

3	3	 Rotate the [M] key to change the initial gain for M mode.

4	4	 To change the sweep speed, select < or > of Sweep on the touch screen.

5	5	 To review the M mode trace, press the [Freeze] key, and use [Trackball] to scroll forward or 
backward.

6	6	 To exit M mode, press the [2D] key.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-4 M mode touch screen

Gain 

With the Gain control, you can adjust the brightness of M mode image. The adjustment of the Gain 
control determines the amount of amplification applied to the received echoes. All received echoes are 
amplified with the same gain value regardless of the scan depth. The M Gain function influences the M 
trace only. 

To adjust the brightness of the entire image, rotate the [M] key on the control panel.

	• Rotate the [M] key clockwise to increase the brightness.

	• Rotate the [M] key counter-clockwise to decrease the brightness.

Frequency

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 4-9.
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TGC Slide Controls

In M mode, the TGC slide controls have the same functions in 2D mode. See "Time Gain Compensation 
(TGC)" on page 4-5 for more information.

Depth

In M mode, the depth function is the same as the one in 2D mode. See "Depth" on page 4-5 for more 
information.

Cine

In M mode, image trace information can be recalled. When freezing an image, a certain time frame 
(M information of the last examination sequence) is stored in the loop memory. The sequence can be 
reviewed second by second. 

Sweep Speed

During M mode imaging, you can adjust the sweep speed of the display.

	❚ Adjusting the sweep speed

To increase or decrease the sweep speed, select < or > of Sweep on the touch screen.

	❚ Sweep speed values

Sweep speed values are 0 to 6.

	❚ Remarks

You can speed up or slow down the timeline to see more or fewer occurrences over time.

Full Timeline

Full timeline expands the display to full timeline display.

	❚ Adjusting the full timeline

To activate or deactivate the full timeline, select Full M on the touch screen.

	❚ Full timeline values 

Full timeline values are On and Off. 
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Display Format

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. 

	❚ Adjusting the display format

To adjust the display format, select < or > of Display Format on the touch screen.

NOTE
This function can not be adjusted when Full M is activated.

	❚ Display format values 

Display format values are as follows: Vert. 1:1, Vert. 1:2, Vert. 2:1, Horiz. 1:1, Horiz. 1:2, Horiz. 2:1.

Reject

Low echo information will not be displayed on the screen below the adjusted rejection level.

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display.

For adjusting the rejection, see "Reject" on page 4-10.

Power

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 4-15.

Dynamic Range

Dynamic range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 4-9.

Gray Map

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 4-14.

Colorize

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 4-14.
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M mode zoom

When the system is in M mode, you can magnify a portion of the reference image using M mode zoom 
function.

To adjust the M mode zoom,

1	1	 In M mode or 2D mode with the M-line displayed, press the [Zoom] key on the control panel to 
activate Write zoom. To activate Read zoom, rotate the [Zoom] key.

2	2	 Use [Trackball] to position the zoom box and M line in the zoomed image, and press the [Set] key.

3	3	 Use [Trackball] to adjust the size of the zoom box, and press the [Set] key.

4	4	 To zoom out, press the [Exit] key.

Anatomical M mode

Anatomical M mode allows you to move or rotate an M line and review an image on the desired region. 
For using this feature, you need an additional request to your local agent. 

To activate Anatomical M mode,

1	1	 In M mode, select Anatomical M on the touch screen. 
The cursor line of the Anatomical M mode appears in the middle of a 2D image.

2	2	 Use [Trackball] to move the cursor line (left/right/up/down).

3	3	 Rotate the [Angle] key on the control panel to rotate the angle.

M color mode

M color mode is a combination mode of M mode and Color Flow mode which color flow information 
overlays the M mode image by using the velocity and color map. The color flow wedge is shown on 
the M-mode timeline. The color map in this mode is the same as in Color Flow mode, but the size and 
position of the color flow window depends on the 2D mode image. 

To activate M color mode,

1	1	 Press the [M] key, and then press the [CF] key.

2	2	 To switch to Color Flow mode, press the [M] key. 
To return to M color mode, press the [M] key again.
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Color Flow (CF) Mode
Color Flow mode is useful when you see the flow in a broad area. Color flow allows visualization of the 
flow in the CF ROI whereas Doppler mode provides spectral information in a smaller area.

Color Flow mode is also used as a stepping stone to Doppler mode. Use Color Flow mode to locate flow 
and vessels before activating Doppler mode.

CF mode display

Figure 4-5 CF mode display

General workflow
1	1	 Press the [CF] key on the control panel. The CF window appears over the 2D mode image. 

2	2	 Move the cursor to the CF window by using [Trackball].

3	3	 Use [Trackball] to change the position of the color ROI.

4	4	 Press the [Set] key and use [Trackball] to change the size of the color ROI.

5	5	 Press the [Set] key to move the color ROI to the left or right. 

6	6	 Press the [Freeze] key to hold the image in the memory.

7	7	 Record color flow images, if necessary.

8	8	 To exit Color Flow mode, press the [CF] or [2D] key.
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The combination imaging modes of Color Flow mode and Power 
Doppler mode 

The following combination imaging modes are available:

–	 2D mode with Color Flow or Power Doppler

–	 2D mode with color and zoom 

–	 2D/Doppler mode with Color Flow or Power Doppler

Color flow imaging parameters
Use the ultrasound system controls and soft key selections to change the settings for imaging 
parameters. The system increases the lighting intensity of the control or key associated with the active 
function.

Positioning, sizing, and steering the ROI

When you press the [CF] key in 2D mode, the color window or ROI appears on the image.

The initial location and the shape of the window depend on the active transducer and default imaging 
depth.

Changing the size and position of the color ROI

1	1	 Press the [CF] key on the control panel. The system places the ROI, outlined in solid yellow, on the 
image.

2	2	 Use [Trackball] to reposition the ROI.

3	3	 To resize the ROI, press the [Set] key and move [Trackball]. The system outlines the ROI with a 
dotted yellow line with solid corners.

4	4	 Press the [Set] key to set the size. 

5	5	 To exit Color Flow mode, press the [CF] or [2D] key.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-6 CF mode touch screen

 
Gain

Gain amplifies the overall strength of echoes processed in the Color Flow window or spectral Doppler 
timeline.

	❚ Adjusting the Gain 

	– Rotate the [CF] key clockwise to increase the gain; rotate the key counter- clockwise to decrease 
the gain.

	– Rotate the [CF] key to adjust the receive gain for color without affecting the 2D mode image gain.

	❚ Gain values

Gain values may vary by transducer, application, and multi-frequency setting. Gain value is shown as 
Gn on the display. Gain values are returned to the factory or user preset value when you change one 
of the followings: Transducer, application, or new patient.

Frequency

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 4-9.
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PRF (Pulse Repetition Frequency)

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF).

	❚ Adjusting the PRF

To raise or lower the velocity scale, rotate the PRF soft key clockwise or counter-clockwise.

	❚ PRF values

PRF values may vary depending on the transducer and application. The values are returned to the 
factory or user preset value when you change one of the followings: Transducer, application, or new 
patient. PRF is in kHz.

Ensemble

Ensemble allows you to select the density of the scan line. With increasing the number of ensemble, the 
frame rate decreases.

	❚ Adjusting the ensemble

To adjust the ensemble, rotate the Ensemble soft key clockwise or counter-clockwise.

	❚ Ensemble values

Ensemble values are 6 to 16.

Persist

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. For adjusting the persist, see "Persist" on page 4-15.

Wall Filter

Wall filter filters out clutter signals caused from vessel movement.

	❚ Adjusting the wall filter

To raise or lower the wall filter, rotate the WF soft key clockwise or counter-clockwise.

	❚ Wall filter values 

Wall filter values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change the following: Transducer, application, new patient.

Power

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 4-15.
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Smooth

Smooth allows you to make a color image smoother by enhancing connection in the axial direction.

	❚ Adjusting the smooth

To adjust the smooth, rotate the Smooth soft key to clockwise or counter-clockwise.

	❚ Smooth values

Smooth values are 0 to 10.

Color Map

Color Map allows you to change the color map used for Color Flow mode, Power Doppler mode and 
Tissue Doppler Imaging mode.

	❚ Adjusting the color map

To adjust the color map, rotate the Color Map soft key clockwise or counter-clockwise.

	❚ Color map values

Color map values are 0 to 26.

Baseline

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing.

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum.

	❚ Adjusting the baseline

To adjust the baseline, rotate the Baseline soft key.

	❚ Baseline values

Zero velocity follows the baseline. The total scale range remains the same. Values may vary by 
transducer and application. Baseline values are returned to the factory or user preset value when you 
change one of the followings: Transducer, application, or new patient.
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Threshold

Threshold assigns the grayscale level at which color information stops.

	❚ Adjusting the threshold

To increase or decrease the grayscale threshold, rotate the Threshold soft key clockwise or counter-
clockwise.

	❚ Threshold values 

Threshold values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient.

TDI

TDI switches to Tissue Doppler Imaging (TDI) mode. For more information on Tissue Doppler Imaging 
(TDI), see "Tissue Doppler Imaging (TDI) Mode" on page 4-52.

	❚ Adjusting the TDI

To switch to TDI mode, select TDI on the touch screen.

Live Dual

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time. For activating or adjusting the Live Dual, see "Live Dual" on page 4-10.

Adaptive Blend

Adaptive Blend superimposes a translucent color image over a 2D image in the color image area. You can 
adjust the transparency of the color image (easily, rapidly) to demonstrate the tissues behind the color.

	❚ Adjusting the adaptive blend

To activate or deactivate this function, select Adaptive Blend on the touch screen.

	❚ Adaptive blend values

Adaptive blend values are On and Off.

	❚ Remarks

If you activate this function, Adaptive Level soft menu is enabled on the touch screen.
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Adaptive Blend Level

Adaptive Blend Level allows you to specify the blending ratio between the 2D image and the color image.

	❚ Adjusting the adaptive blend level

To adjust this function, select < or > of Adaptive Level on the touch screen.

	❚ Adaptive blend level values

Adaptive blend level values are 1 to 25.

	❚ Remarks

A lower value gives the 2D image greater prominence.

Blend

Blend superimposes a translucent color image over a 2D image in the color image area. You can adjust 
the transparency of the color image to demonstrate the tissues behind the color. 

	❚ Adjusting the blend

To activate or deactivate this function, select Blend on the touch screen.

	❚ Blend values

Blend values are On and Off.

	❚ Remarks

If you activate this function, Blend Level soft menu is enabled on the touch screen.

Blend Level

Blend Level allows you to specify the blending ratio between the 2D image and the color image.

	❚ Adjusting the blend level

To adjust this function, select < or > of Blend Level on the touch screen.

	❚ Blend level values

Blend level values are 1 to 25.

	❚ Remarks

A lower value gives the 2D image greater prominence.
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Flow State

Flow State adjusts the PRF of the color image.

	❚ Adjusting the flow state

To adjust this function, select < or > of Flow State on the touch screen.

	❚ Flow state values

Flow state values are Low, Mid, and High. The flow state values may vary depending on the transducer 
and application.

Color Only

Color Only function hides the 2D image from the display so that you can see the color image only.

	❚ Adjusting the color only

To activate or deactivate the color only function, select ColorOnly on the touch screen.

	❚ Color only values

Color only values are On and Off.

Hide Color

Hide Color function hides the color image from the display so that you can see the 2D image only.

	❚ Adjusting the hide color

To activate or deactivate the hide color, select Hide Color on the touch screen.

	❚ Hide color values

Hide color values are On and Off.

Line Density

Line density optimizes the Color Flow mode frame rate or spatial resolution for the best possible 
color image. A lower line density is useful in fetal heart beat, adult cardiac applications and in clinical 
Radiology applications requiring significantly higher frame rates. A higher line density is useful in 
obtaining very high resolution (e.g. thyroid, testicles).

	❚ Adjusting the line density 

To adjust the line density, select < or > of LineDensity on the touch screen.

	❚ Line density values

Line density values may vary depending on the transducer and application. The values are returned 
to the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. A lower line density is useful in fetal heart beat, and adult cardiac.
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Invert (Color Invert)

Invert allows you to view blood flow from a different perspective, e.g., red away (negative velocities) and 
blue toward (positive velocities). You can invert a real-time or frozen image.

NOTE
	• Invert reverses the color map, NOT the color scale.
	• While viewing an inverse image, be careful not to confuse over scan direction or left/right image reversal.

	❚ Adjusting the invert

To reverse the color flow, select Invert on the touch screen. 
In Triplex mode, both Color Flow and Doppler mode velocity scales are inverted.

	❚ Invert values

Invert values are On and Off.

Angle Steer

You can tilt the ROI of the color flow image to the left or right by using a linear transducer.

	❚ Adjusting the angle steer

On the control panel, rotate the [Angle] key clockwise or counter-clockwise. The each level of the 
angle increment/decrement is 5 degrees.

NOTE
This function may not be available when the virtual convex function is applied to the current image.
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Power Doppler (PD) Mode
Power Doppler imaging is another way of color flow mapping technology which maps the strength of the 
Doppler signal from the blood flow. Power Doppler mode, unlike Color flow mode, displays color flow 
imaging by using the number of reflectors that are moving. Therefore, this mode has no aliasing and is 
able to measure the slow blood flow.

PD mode display

Figure 4-7 PD mode display

General workflow
1	1	 Press the [PD] key on the control panel. The Power Doppler window appears over the 2D mode 

image. 

2	2	 Use [Trackball] to change the position of the color box.

3	3	 Press the [Set] key and use [Trackball] to change the size of the color box.

4	4	 Press the [Set] key. 

5	5	 Press the [Freeze] key to hold the image in the memory.

6	6	 Record color flow images, if necessary.

7	7	 To exit Power Doppler mode, press the [PD] key or the [2D] key.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-8 PD mode touch screen

Gain

Gain amplifies the overall strength of echoes processed in the Color Flow window or spectral Doppler 
timeline.

	❚ Adjusting the Gain 

	– Rotate the [CF] key clockwise to increase the gain; rotate the key counter- clockwise to decrease 
the gain.

	– Rotate the [CF] key to adjust the receive gain for color without affecting the 2D mode image gain.

	❚ Gain values

Gain values may vary by transducer, application, and multi-frequency setting. Gain value is shown as 
Gn on the display. Gain values are returned to the factory or user preset value when you change one 
of the followings: Transducer, application, or new patient.

Frequency

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 4-9.
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PRF (Pulse Repetition Frequency)

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 4-26.

Ensemble

Ensemble allows you to select the density of the scan line. With increasing the number of ensemble, the 
frame rate decreases. For adjusting the ensemble, see "Ensemble" on page 4-26.

Persist

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. For adjusting the persist, see "Persist" on page 4-15.

Wall filter

Wall filter filters out clutter signals caused from vessel movement. For adjusting the wall filter, see "Wall 
Filter" on page 4-26.

Power

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 4-15.

Smooth

Smooth allows you to make a color image smoother by enhancing connection in the axial direction. For 
adjusting the smooth, see "Smooth" on page 4-27.

Color Map

Color Map allows you to change the color map used for Color Flow mode and Power Doppler mode. 
Color map values are 0 to 28. For adjusting the color map, see "Color Map" on page 4-27.

Baseline

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing.

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum.

For adjusting the baseline, see "Baseline" on page 4-27.
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Threshold

Threshold assigns the grayscale level at which color information stops. For adjusting the threshold, see 
"Threshold" on page 4-28.

TDI

TDI switches to Tissue Doppler Imaging (TDI) mode. For more information on Tissue Doppler Imaging 
(TDI), see "Tissue Doppler Imaging (TDI) Mode" on page 4-52.

	❚ Adjusting the TDI

To switch to TDI mode, select TDI on the touch screen.

Live Dual

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time. For activating or adjusting the Live Dual, see "Live Dual" on page 4-10.

Directional power Doppler Imaging (DPDI)

DPDI (Directional power Doppler Imaging) function shows information on the intensity and direction of 
blood flow.

	❚ Adjusting the DPDI

To activate or deactivate this function, select DPDI on the touch screen.

	❚ DPDI values

DPDI values are On and Off.

Blend

Blend superimposes a color image over a 2D image in the color image area.

	❚ Adjusting the blend

To activate or deactivate this function, select Blend on the touch screen.

	❚ Blend values

Blend values are On and Off.

	❚ Remarks

If you activate this function, Blend Level soft menu is enabled on the touch screen.
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Blend Level

Blend Level allows you to specify the blending ratio between the 2D image and the color image.

	❚ Adjusting the blend level

To adjust this function, select < or > of Blend Level on the touch screen.

	❚ Blend level values

Blend level values are 1 to 25.

	❚ Remarks

A lower value gives the 2D image greater prominence.

Flow State

Flow State adjusts the PRF of the color image.

	❚ Adjusting the flow state

To adjust this function, select < or > of Flow State on the touch screen.

	❚ Flow state values

Flow state values are Low, Mid, and High. The flow state values may vary depending on the transducer 
and application.

Color Only

	❚ Adjusting the color only

To activate or deactivate the color only function, select ColorOnly on the touch screen.

	❚ Color only values

Color only values are On and Off.

Hide Color

Hide Color hides the color bar and the ROI box from the screen. 

	❚ Adjusting the hide color

To activate or deactivate the hide color, select Hide Color on the touch screen.

	❚ Hide color values

Hide color values are On and Off.
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Line Density

Line density optimizes the Color Flow mode frame rate or spatial resolution for the best possible 
color image. A lower line density is useful in fetal heart beat, adult cardiac applications and in clinical 
Radiology applications requiring significantly higher frame rates. A higher line density is useful in 
obtaining very high resolution (e.g. thyroid, testicles). For adjusting the line density, see "Line Density" on 
page 4-30.

Invert (Color Invert)

Invert allows you to view blood flow from a different perspective, e.g., red away (negative velocities) and 
blue toward (positive velocities). You can invert a real-time or frozen image. For activating or deactivating 
the invert, see "Invert (Color Invert)" on page 4-31.

Angle steer

In Power Doppler mode, you can tilt an image left or right by using a linear transducer.

	❚ Adjusting the angle steer

To adjust the angle steer, rotate the [Angle] key clockwise or counter-clockwise. The each level of the 
angle increment/decrement is 3 or 5 degrees depending on the linear transducer type.

NOTE
This function may not be available when the virtual convex function is applied to the current image.
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Pulsed Wave Doppler (PWD) Mode
Pulsed Wave Doppler (PWD) is a Doppler mode that measures velocity in a PW sample volume and 
displays that information in a spectral trace with an audio output. 

Doppler is intended to provide measurement data concerning the velocity of moving tissues and fluids. 
PW Doppler lets you examine the blood flow data selectively from a small region called the sample 
volume.

Doppler equipment is commonly used for detecting and evaluating the blood flow in arteries and 
veins. The Doppler effect is used in medical ultrasound to detect moving reflectors and to measure and 
characterize the blood flow.

PWD mode display

Figure 4-9 PWD mode display

General workflow
1	1	 In 2D mode, press the [PW] key on the control panel.

2	2	 Adjust the position and the size of the sample volume.

3	3	 To change the sample volume size, select SV on the touch screen.

4	4	 To adjust the angle-to-flow correction, rotate the [Angle] key on the control panel.

5	5	 To change the sweep speed, select Sweep on the touch screen.

6	6	 To exit PW Doppler mode, press the [PW] or [2D] key.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-10 PWD mode touch screen

PW Doppler angle

Angle between the direction of reflector motion and the direction of propagation of the ultrasound 
beam.

PW Doppler effect

Phenomenon whereby there is a change in the perceived frequency of a sound source relative to the 
transmitted frequency when there is a relative motion between a sound source and the listener.
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Angle Correct

Estimate the flow velocity in a direction at an angle to the Doppler vector by computing the angle 
between the Doppler vector and the flow to be measured.

NOTE
When the Doppler mode cursor and angle correct indicator are aligned (the angle is 0), you cannot see the 
angle correct indicator.

	❚ Adjusting the angle correct

Flow toward the transducer is mapped above the baseline and vice versa.

To adjust the angle relative to the transducer face, rotate the [Angle] key on the control panel. The 
velocity scale changes when you adjust angle correct.

	❚ Angle correct values

Angle correct values are -89 to 89.

Frequency

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 4-9.

PRF (Pulse Repetition Frequency)

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 4-26.

HPRF (High Pulse Repetition Frequency)

High Pulse Repetition Frequency (HPRF) is a special operating mode of PW Doppler. HPRF function is 
used when detected velocities exceed the processing capabilities of the currently selected PW Doppler 
scale, or when the selected anatomical site is too deep for the selected PW Doppler scale.

	❚ Activating HPRF (High PRF)

The system automatically switches to HPRF mode when the velocity scale factor or sample volume 
gate depth exceeds certain limits. When HPRF function is activate, multiple sample volume gates 
appear on the Doppler mode cursor.

NOTE
To set the system automatically switch to HPRF mode, press the [Image Preset] key and select the HPRF 
Enable check box. 

	❚ Remarks

Make sure that more than two sample volume gates are not located in a blood vessel. If the sample 
volume gates are placed together in the same area, all Doppler signals appear in the spectrum, 
causing noise.
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Doppler sample volume length

Size the sample volume gate.

	❚ Adjusting the sample volume length

To increase or decrease the gate size, rotate the SV soft key clockwise or counter-clockwise. You can 
adjust the sample volume gate length whenever the sample volume gate appears on the display.

NOTE
Adjustments to the sample volume gate size are made from the center point of the sample volume 
position.

	❚ Sample volume length values

Sample volume length values may vary depending on the transducer and application. Sample 
volume gate size values are returned to the factory or user preset value when you change one of the 
followings: Transducer, application, or new patient.

Baseline

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing.

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum.

For adjusting the baseline, see "Baseline" on page 4-27.

Reject

Low echo information will not be displayed on the screen below the adjusted rejection level.

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display.

For adjusting the rejection, see "Reject" on page 4-10.

Power

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 4-15.

Dynamic Range

Dynamic range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 4-9.

Gray Map

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 4-14.
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Colorize

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 4-14.

Sound

Sound adjusts the Doppler sound volume.

CAUTION
Doppler audio sounds may change abruptly. Adjust the volume of sound in smaller increments to avoid 
startling the patient.

	❚ Adjusting the sound

To adjust the sound, rotate the Sound soft key clockwise or counter-clockwise.

	❚ Sound values

Sound values are 0 to 100.

	❚ Remarks

Audio sounds of the blood flow in a vessel can be used to check the proper position of the transducer.

Update (D pause)

In simultaneous mode of 2D and Doppler modes, you can pause a Doppler image and move the image to 
the 2D live screen by adjusting the Doppler gate.

	❚ Adjusting the update

1	1	 In 2D mode, press the [PW] key on the control panel.

2	2	 Press the [Update] key to freeze the Doppler image (2D mode remains live).

3	3	 Use [Trackball] to adjust the Doppler gate.

4	4	 Press the [Update] key. The Doppler image is moved to the 2D mode screen.

Angle Steer

Angle steer tilts the sample volume for the Doppler spectrum. This function is only for linear transducers.

	❚ Adjusting the angle steer

To adjust the angle steer, select < or > of Angle Steer on the touch screen. The each level of the angle 
increment/decrement is 5 degrees.

NOTE
This function may not be available when the virtual convex function is applied to the current image.

	❚ Angle steer values

Angle steer values are -20, -15, -10, 0, 10, 15, and 20.
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Auto Angle

Auto angle allows you to adjust the angle by 60 degrees.

	❚ Adjusting the auto angle

To adjust the PW Doppler angle, select Auto Angle on the touch screen.

NOTE
This function may not be available when the virtual convex function is applied to the current image.

	❚ Auto angle values

Auto angle values are -60, 0, and 60.

AutoCalc

Activate the calculation automatically when the AutoCalc is in Frozen or Live.

	❚ Adjusting the AutoCalc

To adjust the AutoCalc, select < or > of AutoCalc on the touch screen. 

	❚ AutoCalc values 

AutoCalc values are OFF, Frozen, and Live.

AutoCalc Cycle

AutoCalc Cycle is used to adjust the number of cycles.

	❚ Adjusting the AutoCalc Cycle

To adjust the AutoCalc Cycle, select < or > of AutoCalc Cycle on the touch screen. 

NOTE
This function can be adjusted when AutoCalc is activated.

	❚ AutoCalc Cycle values 

AutoCalc Cycle values are 1 to 5.
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Direction

Direction is used to specify the part of the spectrum to calculate when using AutoCalc.

	❚ Adjusting the direction

To adjust the direction, select < or > of Direction on the touch screen. 

NOTE
This function can be adjusted when AutoCalc is activated.

	❚ Direction values 

Direction values are Both, Below, and Above.

Invert

Invert vertically inverts the spectral trace without affecting the baseline position.

	❚ Adjusting the invert

To invert the spectral trace, select Invert on the touch screen. The plus (+) and minus (-) signs on 
the velocity scale are reversed when the spectrum is inverted. Positive velocities display below the 
baseline.

	❚ Invert values

Invert values are On and Off. 

Sweep Speed

Sweep speed allows you to adjust the sweep speed of the Doppler spectrum.

	❚ Adjusting the sweep speed

To increase or decrease the sweep speed, select < or > of Sweep on the touch screen.

	❚ Sweep speed values

Sweep speed values are 0 to 6.

	❚ Remarks

You can speed up or slow down the timeline to see more or fewer occurrences over time.
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Display Format

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. 

	❚ Adjusting the display format

To adjust the display format, select < or > of Display Format on the touch screen.

NOTE
This function can not be adjusted when Full D is activated.

	❚ Display format values 

Display format values are as follows: Vert. 1:1, Vert. 1:2, Vert. 2:1, Horiz. 1:1, Horiz. 1:2, Horiz. 2:1.

Full timeline

Full timeline allows you to expand the display in full timeline.

	❚ Adjusting the full timeline

To expand the display in full timeline, select Full D on the touch screen.

	❚ Full timeline values 

Full timeline values are On and Off.

Method

Method is used to trace the average mean and peak velocities in realtime or frozen images.

	❚ Adjusting the method

To adjust the method, select < or > of Method on the touch screen. 

NOTE
This function can be adjusted when AutoCalc is activated.

	❚ Method values 

Method values are Max, Mean, and Both.
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Sensitivity

Sensitivity is used to adjust the trace to follow the waveform for signal strength.

	❚ Adjusting the sensitivity

To adjust the sensitivity, select < or > of Sensitivity on the touch screen. 

NOTE
This function can be adjusted when AutoCalc is activated.

	❚ Sensitivity values 

Sensitivity values are -10 to 10.

TimeForRes

TimeForRes allows you to adjust the balance between the time resolution and spatial resolution.

	❚ Adjusting the TimeForRes

To adjust this function, select < or > of TimeForRes on the touch screen.

	❚ TimeForRes values 

TimeForRes values are 1 to 7.

Wall filter

Wall filter filters out clutter signals caused from vessel movement.

	❚ Adjusting the wall filter

To raise or lower the wall filter, select < or > of WF on the touch screen.

	❚ Wall filter values 

Wall filter values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change the following: Transducer, application, new patient.
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Continuous Wave Doppler (CWD) Mode
Continuous Wave Doppler (CWD) mode allows you to view the velocity and direction of a blood flow at 
a certain position. As you move the Doppler cursor, images on the Doppler line appear by time order. 
For using this feature, you need an additional request to your local agent. It also requires CWD mode-
supported transducers such as a phased array transducer or Doppler pencil transducer.

CWD mode display

Figure 4-11 CWD mode display

General workflow
To activate CWD mode,

1	1	 Make sure that the dedicated transducer is connected to your system.

2	2	 In 2D mode, press the [CW] key on the control panel. 
When a CWD transducer is connected to your system, CWD mode is automatically activated.

3	3	 To adjust the angle-to-flow correction, rotate the [Angle] key on the control panel.

4	4	 To change the sweep speed, select Sweep on the touch screen.

5	5	 To exit CWD mode, press the [CW] or [2D] key.
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-12 CWD mode touch screen

Update (D pause)

In simultaneous mode of 2D and Doppler modes, you can pause a Doppler image and move the image to 
the 2D live screen by adjusting the Doppler gate.

	❚ Adjusting the update

1	1	 In 2D mode, press the [CW] key on the control panel.

2	2	 Press the [Update] key to freeze the Doppler image (2D mode remains live).

3	3	 Use [Trackball] to adjust the Doppler gate.

4	4	 Press the [Update] key. The Doppler image is moved to the 2D mode screen.
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Frequency

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 4-9.

PRF (Pulse Repetition Frequency)

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 4-26.

Baseline

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing.

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum.

For adjusting the baseline, see "Baseline" on page 4-27.

Reject

Low echo information will not be displayed on the screen below the adjusted rejection level.

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display.

For adjusting the rejection, see "Reject" on page 4-10.

Power

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 4-15.

Dynamic Range

Dynamic range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 4-9.

Gray Map

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 4-14.
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Colorize

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 4-14.

Sound

Sound adjusts the Doppler sound volume. For adjusting the sound, see "Sound" on page 4-42.

Angle correct

Estimate the flow velocity in a direction at an angle to the Doppler vector by computing the angle 
between the Doppler vector and the flow to be measured.

NOTE
When the Doppler mode cursor and angle correct indicator are aligned (the angle is 0), you cannot see the 
angle correct indicator.

	❚ Adjusting the angle correct

Flow toward the transducer is mapped above the baseline and vice versa. To adjust the angle relative 
to the transducer face, rotate the [Angle] key on the control panel. The velocity scale changes when 
you adjust angle correct.

	❚ Angle correct values

Angle correct values are -89 to 89.

Auto Angle

Auto angle allows you to adjust the angle by 60 degrees. For activating or deactivating the auto angle, 
see "Auto Angle" on page 4-43.

AutoCalc

Activate the calculation automatically when the AutoCalc is in Frozen or Live. For adjusting the AutoCalc, 
see "AutoCalc" on page 4-43.

AutoCalc Cycle

AutoCalc Cycle is used to adjust the number of cycles. For adjusting the AutoCalc Cycle, see "AutoCalc 
Cycle" on page 4-43. 
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Direction

Direction is used to specify the part of the spectrum to calculate when using AutoCalc. For adjusting the 
direction, see "Direction" on page 4-44. 

Invert

Invert vertically inverts the spectral trace without affecting the baseline position. For activating or 
deactivating the invert, see "Invert" on page 4-44.

Sweep Speed

Sweep speed allows you to adjust the sweep speed of the Doppler spectrum. For adjusting the sweep 
speed, see "Sweep Speed" on page 4-44. 

Display Format

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. For adjusting the display 
format, see "Display Format" on page 4-45. 

Full timeline

Full timeline allows you to expand the display in full timeline.

	❚ Adjusting the full timeline

To expand the display in full timeline, select Full CW on the touch screen.

	❚ Full timeline values 

Full timeline values are On and Off.

TimeForRes

TimeForRes allows you to adjust the balance between the time resolution and spatial resolution.

	❚ Adjusting the TimeForRes

To adjust this function, select < or > of TimeForRes on the touch screen.

	❚ TimeForRes values 

TimeForRes values are 1 to 7.

Wall filter

Wall filter filters out clutter signals caused from vessel movement. For adjusting the wall filter, see "Wall 
filter" on page 4-46. 
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Tissue Doppler Imaging (TDI) Mode
Tissue Doppler Imaging (TDI) mode allows you to view the status of the myocardium by measuring the 
velocity of the tissue movement on the Doppler image. This mode only is available for adult cardiac 
application.

The combination imaging modes of TDI mode
The following combination imaging modes are available:

	• PW tissue Doppler

	• Color 2D tissue Doppler

TDI mode display

Figure 4-13 TDI mode display
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Image optimization controls
Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions.

Figure 4-14 TDI mode touch screen

General workflow
1	1	 In 2D mode, press the [CF] Key on the control panel. CF mode is activated.

2	2	 Select TDI on the touch screen. 
Color 2D tissue Doppler mode is activated.

3	3	 To activate PW tissue Doppler mode, press the [PW] key.

4	4	 To exit TDI mode, select TDI on the touch screen.
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3D and 4D Modes
3D mode and 4D mode are optional modes that you need to request additionally. If this mode is not 
available, the 3D and 4D options on the touch screen are deactivated. In 3D/4D setup mode, the region 
of interest (ROI) graphic appears on the image. The 3D ROI defines the area that will be processed during 
3D review and live 3D acquisition.

The following table describes functions in 3D and 4D modes. 

Table 4-1 3D/4D mode

Mode Descriptions

3D/4D setup mode Configure the settings for 3D and 4D modes. 

3D mode Reconstruct 3D image with obtained one volume image.

4D mode Obtain the 3D volume data on real time and rendering this. 

3D/4D mode display

Figure 4-15 4D mode display
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Available features in 3D and 4D modes
The following features are available in 3D and 4D modes:

	• Most of 2D controls

	• Text and Arrow

	• Measurement

	• Zoom

	• Cine (Only for 4D mode)

	• Sectional Planes: Multi Plane, AnySlice, Cubic View

	• Multi Slice: MSV, Free Angle MSV

	• Volume Analysis

NOTE
Multi Plane, AnySlice, Free Angle MSV, and Volume Analysis are optional features. For using these feature, 
you need an additional request to your local agent.



4-56 Imaging Mode

Operation controls for 3D and 4D modes
The following table describes the key functions in 3D and 4D modes. 

Table 4-2 3D/4D controls

Key Description

Freeze
In 3D/4D setup mode, press to obtain a 3D or 4D image.
In 3D mode, press to switch to 3D/4D setup mode.
In 4D mode, press to switch to 3D mode. Press again to return to 4D mode.

M In 3D or 4D mode, rotate the X axis; up and down rotation.

PW In 3D or 4D mode, rotate the Y axis; left and right rotation.

CF In 3D or 4D mode, rotate the Z axis; clockwise and counter-clockwise rotation.

Select/Depth

In 3D or 4D mode, move parallel.
	• PlaneA: Left/Right
	• PlaneB: Up/Down
	• PlaneC or 3D: Forward/Backward

Single Show a 3D image.

Dual Show one reference image and one 3D image.

Quad Show three reference images and one 3D image.

Priority

While or after acquiring the volume data, press to change the function. The activated 
function is shown on the bottom right of the display:

	• Priority: Cine, Cine Calc., Move, ROI, Curved ROI, Line1,2,3, Light Direction
	• Set: �Run and Stop (Cine or Cine Calc.), Image and Axis (Move), Pos and Size (ROI), 

Pos and Rot (Line1,2,3)
	• Cursor: Cursor (Display remains blank.)

Trackball

Adjust the position, light direction, and the size of the ROI box. 
When the [Priority] key is pressed, use to perform the activated function:

	• Cine or Cine Calc.: Use to move the cine frame.
	• Move: Use to move the image.
	• ROI: Use to adjust the clipping box size of ROI.
	• Curved ROI: Use to change the contour of the clipping line.
	• Cursor: Use to move the cursor to a desired location.
	• Light Direction: Use to change Light Direction in LiveHQ.
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3D/4D setup mode

Setting up for volume acquisition 

You can optimize the image and select settings for the volume acquisition by using the following imaging 
options.

Figure 4-16 Imaging options for volume acquisition (3D/4D)
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Table 4-3 Imaging options

Imaging option Description

View Types MPR, Sectional Planes, Multi Slice

Display Format

Change the display layout.
	• 1: One rendered volume image
	• 2: One rendered volume image and one slice image
	• 4: One rendered volume image and three slice images

User Preset Show the user preset values such as surface and spine.

Render Direction Adjust the direction of the image view.

Quality

Change the line density to adjust image quality and acquisition time.
	• Low: Low quality and fast acquisition time
	• Mid: Better quality but slower acquisition time than the low quality
	• H1: Better quality but slower acquisition time than the medium quality
	• H2: Best quality and the slowest acquisition time

Volume Angle
Set the range of the volume sweep:

	• Volume Convex: 15, 30, 45, 60, 75
	• Volume Endocavity: 10, 30, 45, 60, 75, 90, 105, 120

NOTE
The imaging options are returned to their factory values when you change the transducer.
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Volume acquisition mode

Adjusting the region of interest (ROI)

You can adjust the ROI using [Trackball]. The 3D ROI allies to both single sweep 3D and 4D acquisition.

Figure 4-17 Region of Interest (ROI)

To adjust the 3D ROI of the display,

1	1	 On the touch screen, select 3D or 4D. 

2	2	 Use [Trackball] to move the 3D ROI.

3	3	 Press the [Set] key to change the size of the ROI box.

4	4	 Use [Trackball] to adjust the size of the 3D ROI box.

5	5	 Press the [Priority] key to change the line of the Curved ROI.

6	6	 Use [Trackball] to adjust the line of the Curved ROI.
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Performing 4D image scanning	

In 4D mode, you can acquire real-time 4D images through an acquisition interface.

1	1	 Obtain a 2D image and optimize the image for the best quality.

2	2	 On the control panel, press the [3D/4D] key. If you are in 3D mode, select 4D on the touch screen. 
The yellow-colored ROI and soft menus for 4D mode appear.

3	3	 Rotate the Volume Angle soft key.

4	4	 Select the desired display format on the touch screen to change the display layout.

5	5	 Rotate the Quality soft key to adjust the image quality.

6	6	 To change the direction of the image view, rotate the Render Direction soft key. 

7	7	 When you have finished, press the [Freeze] key on the control panel to acquire the image data.

Performing 3D image scanning	

In 3D mode, you can acquire 3D images through an acquisition interface.

1	1	 Obtain a 2D image and optimize the image for the best quality.

2	2	 On the control panel, press the [3D/4D] key. If you are in 4D mode, select 3D on the touch screen. 
The yellow-colored ROI and soft menus for 3D mode appear.

3	3	 Rotate the Volume Angle soft key. 

4	4	 Select the desired display format on the touch screen to change the display layout.

5	5	 Rotate the Quality soft key to adjust the image quality.

6	6	 To change the direction of the image view, rotate the Render Direction soft key.

7	7	 When you have finished, press the [Freeze] key on the control panel to acquire the image data.
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Volume visualization mode

Viewing volume data

The following view types are available: MPR, Sectional Planes, Multi Slice and Volume Analysis. You can 
change the view type after acquiring volume data by selecting a view type menu.

To change view type,

–	 Select a view type (MPR, Sectional Planes, Multi Slice or Volume Analysis) on the touch screen.

NOTE
Volume Analysis is only available in 3D mode.

MPR (Multi-Planar Reformatting)
MPR (Multi-Planar Reformatting) shows a single volume data. The system automatically displays the 
volume and MPRs during the 4D imaging volume acquisition, after the 3D volume acquisition, or during 
the review of retrieved volumes.

Figure 4-18 MPR view

To acquire the volume data,

1	1	 Press the [Freeze] key to acquire the volume data. 

2	2	 After you acquire the volume data, the 4D mode screen appears. 

3	3	 To magnify the volume, rotate the [Zoom] key on the control panel.

NOTE
If the image stops while scanning an image, try acquiring the 3D volume of interest again.
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Defining volume of interest (VOI) and viewing planes

You can define a data to be displayed in the volume quadrant by enabling the VOI (volume of interest) 
and then resizing and repositioning the VOI in relation to the acquired volume data. The system displays 
the VOI in the volume and the related view plane in each orthogonal MPR. 

The view plane is the side of the VOI represented by a solid or dotted line.

A :  
Sagittal Plane

B :  
Transverse Plane

C :  
Coronal Plane

3D :  
Volume Image

Changing the view line (Clipping box line) of the VOI 

To adjust the VOI size,

1	1	 Select Ref. Plane on the touch screen.  
The selected plane appears on the display.

2	2	 Select the ROI item by pressing the [Priority] key.

3	3	 Select the Pos item by pressing the [Set] key.

4	4	 Control the view line by using [Trackball]. 
The size of the volume image changes according to the view line.

Changing the volume of a plane

You can change the volume of a plane by curving the VOI. 

1	1	 Select the curved ROI item by pressing the [Priority] key.

2	2	 Control the curved line by using [Trackball]. 
The volume image changes according to the curved line.
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Customizing the render settings

After acquiring the volume data, imaging options appear on the touch screen. Imaging options allow you 
to optimize the volume tissue components.

The following table describes the rendering imaging options that you can use in 4D mode.

Table 4-5 Rendering imaging options

Option Description

Edit ROI Select to adjust the size of the Region of Interest (ROI).

Vol.Sync 
	• On: Rotate the MPR image and the volume image simultaneously.
	• Off: Rotate the MPR image and the volume image separately.

Cine Manual selection of single volume frames.

Cine Calc. Displays the Cine Calculations menu.

Easy Cut Displays the Easy Cut menu.

Brightness Adjust the overall brightness of volume.

Contrast Adjust the contrast.

Threshold Adjust the threshold to define structures of interest.

Quality 
(Only for 4D mode)

Change the line density to adjust image quality and acquisition time.

Volume Angle 
(Only for 4D mode)

Adjust the range of the volume sweep.

Opacity Adjust the opacity to eliminate darker gray shades, background noise.

Smooth Adjust the smooth to apply a low-pass filter.

SRI Activate or deactivate SRI on the MPR view.

DR Adjust the dynamic range.

Gray Map Select the desired gray map.

2D Colorize Colorize the 2D image.

Initial Reset the current 3D or 4D settings. 

Preset Reloads the presets for the selected application.

ColorMap Select the desired color map.

Ref. Plane

The reference plane contains the focus for control panel keys, allowing you to 
manipulate or optimize that plane.
The reference plane selection appears differently according to the display format of 
rendering setting.

	• Single display format: The reference plane does not appear. 
	• Dual or Quad display format: The selections for the reference plane are A, B, C.

3D Orientation Adjust the orientation to rotate the fetus position.
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Option Description

Live HQ

This function enables you to represent a realistic live image. To use this function, 
adjust the Brightness and HQ Scatter options. Move [Trackball] to adjust the 
direction of the light.

	• On: Apply the Live HQ preset.
	• Off: Apply the previous preset.

Live HQ_Render Setup
	• Front Scale: Adjust the front depth scale of the Live HQ function.
	• Back Scale: Adjust the back depth scale of the Live HQ function.
	• HQ Scatter: Adjust scattering for the Live HQ function.

Light Direction Adjust the direction of the light for the Live HQ function.

Live HQ Color Map Select the desired color map.

Render Setup

For better image, be familiar with the following render settings: 
	• Surface: It is possible to combine the gradient and texture shading. This is done 

by calculating each weighted sum of the colors derived for gradient and texture 
shading.

	• Max IP: Maximum intensity projection. Represent a 3D image in maximum 
intensity. This option can be useful for observation of bone structure.

	• Min IP: Minimum intensity projection. Represents a 3D image in minimum 
intensity. This option can be useful for observation of vessels or cavities in the 
human body.

	• Light: Represent the highlight and shadow on the surface of the image. An image 
area close to viewer is shown bright; an image area distant from the viewer is 
shown shaded.

	• XRay: Represent a 3D image in average intensity. An image is shown like an X-ray 
image.

Render Direction Adjust the direction of the image view.

3D Color Map Select the desired color map.

Creating presets

Presets contain a selection of predefined rendering parameters. Thus desired combination of filter can 
be set at once. All of rendering settings support changing the preset.

On the touch screen, select Define Preset. When the User Preset Setting dialog box appears, the 
following options are available: 

	• Default All: Recover all user preset to default factory setting.

	• Reset: Recover the user preset to default setting.

	• Overwrite: Overwrite an existing preset with a new preset.

	• Rename: Change the name of an existing preset.

	• Save: Save the current preset.

	• Cancel: Cancel saving the user preset.

NOTE
You can apply the preset after acquiring volume data or scanning a live image.
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Cine

Cine allows you to save and review the acquired volume data as animated images. When you press the 
[Freeze] key, Cine options appear on the touch screen. Cine gauge bar is located on the bottom right 
corner. The selected volume cine number is shown with the color bar.

NOTE
Cine may not be available in 3D mode. 

Table 4-6 Cine options

Option Description

Full Start or stop the playback of the full Cine clip.

Clip Start or stop the playback of the selected Cine clip defined by start and end volume.

Loop Mode Play 3D Cine images in one direction and then play them in reverse direction or 
continue to play 3D Cine images in one direction repeatedly. 

Vol.byVol. Select Cine volumes.

Start Select the starting Cine number.

End Select the ending Cine number.

Speed Change the playback speed.

Cine Calc.

Cine Calc. allows the volume image to be rotated automatically according to specific orientation and 
customized angle. When volume acquisition is paused, you can review the volume data in Cine mode.

Table 4-7 Cine Calc. options

Option Description

Rotate Axis Rotate according to the selected axis centrally.

Rotate Angle Rotate image according to standards of volume data. 

Step Angle Rotate image according to the selected step angle within the Rotate Angle range.

Speed Change the playback speed.

Calculate Cine Seq. Control the Loop Mode and Play/Stop.

Play/Stop Start or stop playback.

Loop Mode Play 3D Cine images in one direction and then play them in reverse direction or 
continue to play 3D Cine images in one direction repeatedly. 

Save Ani. Save as animated images.
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Easy Cut

Easy Cut allows you to electronically edit images by cutting away unwanted structures on the ROI.

Figure 4-19 Easy Cut

1	1	 Select MPR on the touch screen.

2	2	 Select Easy Cut on the touch screen.

3	3	 Select desired options in the Easy Cut menu and press the [Set] key.

4	4	 Edit the image by using [Trackball].

5	5	 When you have finished, press the [Set] key.

The following Easy Cut options are available:

Table 4-8 Easy Cut options

Option Description

Trace Inside Structures within the contour will be discarded. 

Trace Outside Structures outside the contour will be discarded. 

Box in All information inside the box will be cut. 

Box out All information outside the box will be cut.

Eraser Small All information inside the small circle will be cut.

Eraser Medium All information inside the medium circle will be cut.

Eraser Large All information inside the large circle will be cut.

Undo/Redo Select to undo or redo.

Remove All Select to remove all.
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Sectional Planes
Sectional Planes supports following view types: Multi Plane, AnySlice, and Cubic View. An image can be 
viewed in multiple slices.

Multi Plane

Multi Plane supports the Cine Calc. to review the sliced images.

NOTE
The volume data is not displayed in Multi Plane mode.

Figure 4-20 Multi Plane

1	1	 Select Sectional Planes on the touch screen.

2	2	 Select Multi Plane on the touch screen.

3	3	 Rotate the Thickness soft key to adjust the slice thickness.

4	4	 Select a plane type of Ref. Plane to select a reference image.

5	5	 Select Cine Calc. to activate the Cine calculation. 
The slice playback menu appears on the touch screen.

6	6	 Rotate the Start soft key to take the first slice.

7	7	 Rotate the End soft key to take the last slice.

8	8	 Rotate the Speed soft key to set the playback speed for Cine images.

9	9	 Select Full to start the playback of the full Cine clip. 
Or select Clip to start the playback of the selected Cine clip.

10	10	 Select Full again to stop the playback of the full Cine clip. 
Or select Clip again to stop the playback of the selected Cine clip.
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AnySlice

AnySlice allows you to observe the sectional images after drawing a curved line on the selected image in 
MPR mode.

Figure 4-21 AnySlice

1	1	 Select Sectional Planes on the touch screen.

2	2	 Select AnySlice on the touch screen. The “ ” mark appears.

3	3	 Select Ref. Line on the touch screen, or press the [Priority] key on the control panel.

4	4	 Draw a curved line on a reference image by using the [Trackball] and press the [Set] key.

5	5	 If you have finished drawing a line, press the [Cursor] key.

6	6	 Optimize the image for observation by using options on the touch screen.
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Cubic View

In Cubic View, the display shows Sagittal, Transverse, and Coronal plane images in volume data. 

Figure 4-22 Cubic View

1	1	 Select Sectional Planes on the touch screen.

2	2	 Select Cubic View on the touch screen.

3	3	 Adjust the cube size by using the following methods:

a.	 	Using Trackball,

(1)	Select Ref. Plane on the touch screen.

(2)	Select the Move item by pressing the [Priority] key on the control panel.

(3)	Select the Axis item by pressing the [Set] key on the control panel.

(4)	Adjust the volume size using [Trackball] key.

b.	 	Using the soft key,

–	 Rotate the SlicePlaneA, SlicePlaneB, or SlicePlaneC soft key.

NOTE
	• In Cubic View, the dual image layout may not be available.
	• You can rotate X, Y, and Z axes with the corresponding keys on the control panel.
	• The volume review function is the same as the function in MPR.
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Multi Slice
Multi Slice shows parallel cut planes which are aligned along the X, Y, or Z axis of volume’s bounding box. 
The each texture is shown as an individual view. The reference image is distinguished with a dotted axis 
line.

1	1	 Select Multi Slice on the touch screen.

2	2	 Adjust the multi-sliced images by using the following imaging options.

Figure 4-23 Multi Slice

NOTE
	• The image layout keys (Single, Dual, and Quad) may not work for this view type.
	• Multi Slice can be used when the display format is 3 x 3 or 4 x 4.

The following table describes the Multi Slice options.

Table 4-9 Multi Slice options

Option Description

Display Format Select a number of the multi-slice to be shown as determining the layout. 

Ref. Plane Select a plane type to view multi-slice images.

Render Direction Adjust the direction of the image view.

Colorize Color of Multi Slice including gray. (Displays the tint map selections on the screen.)

ActiveView Slice through the Multi-Slice display.

Guide View Set the orientation plane of the Multi-Slice display.

Thickness Select the slice thickness.

SRI Activate or deactivate SRI on the Multi Slice view.

Pitch Change a step (pitch size) of multi-slice image.
Set the distance of multi slice.
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Option Description

Prev./Next
Move to the next or previous multi-slice image.
–	 Rotate the Prev./Next soft key clockwise for next images.
–	 Rotate the Prev./Next soft key counter-clockwise for previous images.

Vol.byVol. Select Cine volumes.

2D Colorize Colorize the 2D image.

Free Angle MSV (Free Angle Multi Slice View) 

Free Angle MSV mode shows several MPR views with parallel orientation.

Figure 4-24 Free Angle MSV

1	1	 Select Multi Slice on the touch screen.

2	2	 Select Free Angle on the touch screen. The marker appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key.

5	5	 The dotted lines appear on the reference image.
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Volume Analysis
Volume Analysis allows you to review parallel cut planes in specific portions of the anatomy. And you can 
calculate the volume of an object by cutting it into multiple slices.

NOTE
In Multi Slice, Volume analysis is not displayed.

Figure 4-25 Volume Analysis

1	1	 Select Volume Analysis on the touch screen. The marker appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.

3	3	 Use [Trackball] to move the marker to the end point, and press the [Set] key.

4	4	 The solid lines appear on the reference images, and the total length (Total Length) and the volume 
(Volume) are shown on the display.

The following table describes the Volume Analysis options.

Table 4-10 Volume Analysis options

Option Description

Display Format Select a number of the multi-slice to be shown as determining the layout. 

Ref. Plane Select a plane type to view multi-slice images.

Current Plane Disc The selected disc is displayed and a spline can be drawn. Or an existing spline can 
be deleted.

Disc Thickness Set the thickness of a disc plane.

Disc Transparency Set the transparency value for the disc rendering.

Delete All Select to delete all discs.
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Option Description

Delete Select to delete the spline in the selected disc.

Propagate Disc The disc of the current slice is propagated to the next slice.

Volume Display Select to show or hide the volume rendering in the result view.

Saving a 3D/4D image
You can save 3D or 4D volume data in the system memory.

To save an image or volume data,

1	1	 Acquire a 3D or 4D volume image.

2	2	 Press the [P1] key on the control panel to save the still image.  
Press the [P2] key on the control panel to save the volume data.

NOTE
	• You can assign a different function to the [P2] key in System Preset.
	• Saving a real-time image may not be available in 4D mode.

To review an image or volume data,

–	 On the touch screen, select Review, and then select an image. You can also click a saved thumbnail 
image on the right side in 2D mode.

NOTE
	• After saving a video or volume data, you can configure the render settings.
	• To assign the print keys for saving an image or volume data, press the [System Preset] key and go to User 

Setting > Print/Foot Switch.
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Freezing Images
Condition in which 2D, M, Doppler, and Color flow image data are retained in a scan converter’s memory 
for examination and/or photograph as well as for video recording.

Freezing an image
1	1	 While scanning an image, press the [Freeze] key on the control panel to freeze the image. 

You can also freeze an image with the right pedal of the footswitch, if supported.

2	2	 To reactivate the image, press the [Freeze] again. 
To enter Cine mode, use [Trackball].

NOTE
	• Deactivating the [Freeze] key allows you to erase all measurements including calculations from the 

screen (Not from the worksheet).
	• Selecting a new transducer unfreezes the image.
	• To configure the each pedal of the footswitch, press the [System Preset] key and go to User Setting > 

Print/Foot Switch.
	• To configure the [Freeze] key function after freezing an image, press the [System Preset] key and go 

to System > Control Panel > Key > Active Function on Freeze.

Processing an image 
In freeze mode, you can process 2D, Color Flow (CF) or Doppler mode image. The following controls are 
available:

2D mode CF mode PD mode PWD mode

Zoom Threshold Threshold Baseline

Reverse Baseline Color map Sweep speed

Gain Invert DPDI Invert

Dynamic range Color map Gain Color map

Up/Down Gain Blend Level Gray map

Colorize Blend Level Adaptive Level Auto Angle

Gray map Adaptive Level Angle Correction

Full SRI Reject

Edge Enhance Dynamic Range 

Reject
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Zooming Images
You can magnify a region of interest (ROI) in a live image or in Cine mode. The zoom option magnifies the 
ROI on the display. There are two zoom functions that you can use: Read zoom and Write zoom

Read zoom
Read zoom allows you to manipulate the negative picture and enlarge it. You can use Read zoom after 
using Write zoom.

To activate Read zoom, rotate the [Zoom] key on the control panel.

Write zoom
Writing zoom allows you to use the telephoto lens to bring the image closer before acquiring an image. 
You can use Write zoom after using Read zoom.

To activate Write zoom, press the [Zoom] key on the control panel while scanning a live image.
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Full Screen
Full Screen allows you to view magnified images in full screen.

Full Screen display

Figure 5-1 Full Screen display

To activate the Full Screen mode, 

1	1	 On the touch screen, select Full Screen from the 2D tab.  
The magnified image is displayed in full screen.

2	2	 To exit the Full Screen mode, select Full Screen again.
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Screen Split
Screen Split allows you to view active images as the dual display view.

1	1	 Press the [Dual] key on the control panel.

2	2	 To display other active images, press the [Dual] key again.
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CINE Images
The Cine function is available in all imaging modes. During the real-time imaging, the system places the 
most recently acquired images as well as the image currently on the screen into a Cine memory buffer.

Cine image review functions as a storage and enables you to review the sequence of images in the 
system memory. Cine review is available by pressing the [Freeze] key. Moving [Trackball] to the left or 
right scrolls through the Cine sequence.

Images from a Cine sequences can be measured and annotated. You can play back Cine images to 
simulate a real-time motion, or review an image at one time.

NOTE
Cine is useful for focusing on images during a specific part of the heart cycle or to view short segments of a 
scan session.

General workflow
To activate Cine mode,

1	1	 Press the [Freeze] key on the control panel.

2	2	 Use [Trackball] to scroll through the Cine sequences. 
To move the Cine sequence by frame, rotate the Frame by Frame soft key.

3	3	 On the touch screen, select Move First Frame to take the first frame.

4	4	 Select Move Last Frame to take the last frame.

5	5	 To exit Cine mode, press the [Freeze] or [2D] key on the control panel.
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Annotating Images
The annotation feature provides the capability to type the comments of free text or insert the pre-
defined comments from the comment library. It also provides the user with arrow marks to point to parts 
of the image.

You can place text labels and arrow marks on an image to identify anatomical structures and positions 
and also annotate an image with a body marker image that indicates the part of the anatomy that you 
are scanning.

NOTE
The annotation feature is available in live-acquisition mode and in freeze mode.

Annotation display

Figure 5-2 Annotation display
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Annotation options

Figure 5-3 Annotation touch screen

General workflow
1	1	 Press the [TEXT] key on the control panel to activate Annotation mode.

2	2	 To configure the default position of the comment cursor, use [Trackball] to place the comment 
cursor to the desired location of the image screen and select Set Home on the touch screen.

3	3	 The system automatically searches for the word you want in the text bar.

4	4	 After activating the text mode, a vertical bar type cursor appears on the screen. Use [Trackball] to 
move the cursor.

NOTE
The default text color is yellow. The color selection can be changed to any of the colors available on the 
system.

5	5	 When a specific comment or comment group is selected, the color turns to green. Once the 
comment is set or fixed, the color returns to yellow or to the user-selected color.

6	6	 Delete characters or all comments, if necessary.

	– To delete comments by character, select Back Space on the touch screen.

	– To delete comments by word, rotate and press the Grab/Delete soft key.

	– To delete the comments only, press the [Clear] key right after pressing the [Text] key.

	– To delete the arrow marks only, press the [Clear] key right after pressing the [Arrow] key.

	– To delete all comments as well as arrow marks, press the [Clear] key after entering the scan 
mode.

7	7	 Rotate the Grab/Delete soft key to move a group of words on the screen.

8	8	 To deactivate Annotation mode, press the [TEXT] key. 
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Inserting annotations

Inserting directional arrow pointers

1	1	 Press the [Arrow] key on the QWERTY keyboard, or select Arrow on the touch screen. 
An arrow pointer appears on the image screen.  
The green-colored pointer indicates that it is active and movable.

2	2	 Use [Trackball] to move the pointer to the desired position of the screen. The pointer head 
direction can be controlled as you move [Trackball].

3	3	 Adjust the length, thickness, or the angle of the pointer, if necessary.

	– To select the type of the pointer you want, rotate the Arrow Type soft key.

	– To change the size of the pointer you want, rotate the Arrow Size soft key.

	– To adjust the direction of the pointer head, rotate the Arrow Angle soft key.

4	4	 Press the [Set] key to fix the placement of the pointer and the direction of the pointer head.  
The GREEN color turns to YELLOW (or the default color if changed).

5	5	 To delete all fixed pointers, press the [Clear] or [Clear All] key.

Annotating images using the library

To reduce the amount of time spent annotating an image, store frequently-used comments in the 
comment library.

1	1	 Press the [TEXT] key. 

2	2	 Rotate the Application soft key to select the desired application.

3	3	 Rotate the Library soft key to select the desired comment library.

4	4	 Select the desired comment on the touch screen.

5	5	 Use [Trackball] to move the selected comment to the desired position of the screen.

6	6	 When you have finished, press the [Set] key.
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Annotating images with typed words

1	1	 Press the [TEXT] key. 

2	2	 Type the desired comment using the QWERTY keyboard. 
Press the [Enter] key to change or add line.

NOTE
To complete a comment automatically, rotate the Auto-Complete (on) soft key.

3	3	 To change the font size of comments, rotate the Font Size soft key.

4	4	 Use [Trackball] to move the comment to the desired position of the screen.

5	5	 When you have finished, press the [Set] key.

Editing annotations

Moving text

You can move the entered text to the desired place.

1	1	 To select the desired comment or comment group, rotate the Grab/Delete soft key. 
The selected comment color turns to green.

2	2	 Use [Trackball] to move the selected comment to the desired position of the screen.

3	3	 When you have finished, press the [Set] key to fix the position.

Replacing text

1	1	 To select the desired comment, rotate the Grab/Delete soft key. 
The selected comment color turns to green.

2	2	 Type a new comment to replace the selected comment. Or select the desired comment on the 
touch screen.

3	3	 When you have finished, press the [Set] key.

Adding text

1	1	 Place the comment cursor onto the desired text position to correct the comment and press [Set] 
key.

2	2	 Select Back Space on the touch screen to delete comment by character, if necessary.

3	3	 Type a new text to add to previous comments.

4	4	 When you have finished, press the [Set] key.
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Deleting annotations
To delete all fixed text and pointers, 

–	 Press the [Clear] key or press the [Clear All] key on the QWERTY keyboard.

Body Pattern
Body Pattern is an additional way to annotate the image. Body patterns are small graphic images 
represent the anatomy being examined. Using body patterns and transducer marker, you can indicate the 
scan position and the position of the transducer during the examination.

Figure 5-4 Body pattern display

Figure 5-5 Body pattern touch screen
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Inserting a body pattern

1	1	 To activate Body Pattern, press the [Body Pattern] key on the control panel. 
A list of body patterns appears on the touch screen.  
A default body pattern is displayed automatically when Body Pattern is activated.

NOTE
To configure the body pattern list, press the [System Preset] key and go to Annotation > BodyPattern.

2	2	 Rotate the Library soft key to select the desired application.

NOTE
The body pattern list that appears on the touch screen will vary depending on the selected application.

3	3	 Select the desired body pattern on the touch screen. 
The body pattern with a transducer marker is shown on the screen.

4	4	 To reposition the body pattern, press the Move Pattern soft key.

5	5	 Use [Trackball] to adjust the position of the body pattern and press the [Set] key.

6	6	 Rotate the Probe Size soft key to select the desired size of transducer marker. 
The selected transducer marker appears on the screen.

7	7	 Rotate the Probe Angle soft key to adjust the angle of the transducer marker.

8	8	 Use [Trackball] to adjust the position of the transducer marker and press the [Set] key.

Deleting a body pattern

To delete a body pattern,

–	 Press the [Clear] key or press the [Clear All] key on the QWERTY keyboard.
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Panoramic Imaging
The Panoramic imaging feature extends your field of view by piecing together multiple 2D images into a 
single, extended 2D image. For using this feature, you need an additional request to your local agent.

After you acquire the extended image, you can rotate it, move it linearly, magnify it, add comments or 
body patterns, or perform measurements on the extended image.

You can perform the Panoramic imaging feature on 2D images with linear and convex transducers.

CAUTION
The panoramic imaging constructs an extended image from individual image frames. The quality of the 
resulting image is user-dependent and requires some additional skill and practice to develop proper 
technique and become fully proficient. To avoid technique-related artifacts and measurement inaccuracies, 
read this entire chapter before using the Panoramic imaging feature.

Panoramic imaging display

Figure 5-6 Panoramic setup mode
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Figure 5-7 Panoramic image acquisition

Panoramic imaging options

Figure 5-8 Panoramic imaging touch screen
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General workflow
1	1	 Apply the enough ultrasound gel along the entire area to be scanned.

2	2	 Place the transducer on the desired scan area.

3	3	 Select Panoramic on the touch screen to activate the Panoramic function. 
You can access the Panoramic setup mode, and the blue-colored ROI appears.

4	4	 Press the [Set] key to start the image acquisition.

5	5	 Move the transducer linearly along the scan path.

NOTE
To acquire an optimal image, move the transducer slowly and steadily.

6	6	 If  you restart the image acquisition, press the [Set] key again. 
You can access the Panoramic setup mode, and the blue-colored ROI appears.

7	7	 When you have finished acquiring an image, press the [Freeze] key on the control panel.

8	8	 To exit the Panoramic imaging mode, press the [2D] key or select Exit on the touch screen.

TIPS
For even movement,

	• Make sure there is enough ultrasound gel along the scan path.
	• Always move the transducer slowly and steadily. 
	• Do not lift the transducer from the skin surface during the scan.
	• Always keep the transducer perpendicular to the skin surface. Do not rotate or tilt the transducer during 

the scan.
	• Keep the motion within the same scan plane, if possible. Do not slide the transducer laterally.
	• Deeper scans generally require reduced speed.
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Viewing the panoramic image
To optimize the image, use the following options.

Table 5-1 Panoramic imaging options

Option Description

Gray Map Change the gray map.
Rotate the Gray Map soft key to change the gray map of the 2D image.

Colorize Colorize the 2D image.
Rotate the Colorize soft key to change the color of the 2D image.

To zoom in the image, 

–	 Rotate the [Zoom] key clockwise. And use [Trackball] to change the position of the magnified image.

To rotate the image,

–	 Select < or > of Rotation on the touch screen.

Performing a measurement
To perform a measurement, 

–	 Press the [Measure] key on the control panel.

NOTE
2D measurement package is available.

Annotating the panoramic image
1	1	 Press the [TEXT] key on the control panel to annotate an image. 

The comment library appears on the touch screen.

2	2	 Select the desired comment on the touch screen, or type the desired comment using the QWERTY 
keyboard.

3	3	 To activate Body Pattern, press the [Body Pattern] key on the control panel. 
A list of body patterns appears on the touch screen.

4	4	 Select the desired body pattern on the touch screen. 
The body pattern with a transducer marker is shown on the screen.

Saving the panoramic image
When you have finished, press the [P1] key to save the image.
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Needle Vision™ Plus
Needle Vision™ Plus uses integrated Beam Steering technology for increased needle visualization with 
maintaining excellent image quality and enhancing the needle brightness. With the needle enhancement 
feature, you can see the needle more easily during clinical procedure. 

NOTE
Needle Vision™ Plus is an optional feature. For using this feature, you need an additional request to your local 
agent.

Needle Vision™ Plus display

Figure 5-9 Needle Vision™ Plus screen
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Needle Vision™ Plus options

Figure 5-10 Needle Vision™ Plus touch screen

General workflow
To activate Needle Vision™ Plus, 

1	1	 Select NeedleVision on the touch screen.

NOTE
You can use user-defined key to activate Needle Vision™ Plus. To assign the Needle Vision™ Plus 
function to user-defined key, press the [System Preset] key and go to User Setting > User Defined key > 
Assign User Key or Assign Numeric Key and select the Needle Vision™.

2	2	 Adjust the image parameters to obtain an optimized image.

3	3	 To exit the Needle Visions™ Plus, select OFF on the touch screen.

Needle Vision™ Plus Options
The following table describes the Needle Vision™ Plus options.

Table 5-2 Needle Vision™ Plus options

Option Description

L/R Flip

Flip the direction of beam steering horizontally. 
Select the left or right flip icon on the touch screen to flip the direction of beam 
steering.
Value: Left, Right

Angle
Change the beem angle.
Select the angle icon on the touch screen to change the angles.
Value: Shallow, Medium, Steep
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Contrast Enhanced Imaging
The contrast enhanced ultrasound imaging is used in conjunction with ultrasound contrast agents to 
enhance the imaging of blood flow and microcirculation. Blood containing the contrast agent stands out 
brightly against a dark background of normal tissue.

With the contrast enhanced ultrasound imaging, you can see the micro-circulation in tissue easily during 
clinical procedure. For using this feature, you need an additional request to your local agent.

WARNING
Only physicians or echo technicians who have received appropriate training should perform Contrast Imaging.

CAUTION
	• Cavitation may occur due to interactions between the ultrasonic waves and the contrast medium. Always 

perform examination using the ALARA (As Low As Reasonably Achievable) principle.
	• Stop the examination and perform appropriate treatment, if there is any abnormality with the patient 

during use of the contrast medium.

NOTE
	• Handle the contrast medium as described in the operation manual supplied with the contrast medium. 
	• Check the side effects of the contrast medium used with the manufacturer of the contrast medium.
	• ALPINION MEDICAL SYSTEMS is not liable for any damage or injury resulting from improper use of contrast 

media.

Abdominal contrast imaging

1 2

5

3

4

Figure 5-11 Abdominal contrast acquisition display

1 2D imaging 4 Timer

2 Contrast imaging 5 2D image info / Contrast image info

3 MI and TI information
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Abdominal contrast options

Figure 5-12 Abdominal contrast touch screen

The touch screen displays various image controls which help you to optimize the Contrast mode image. 
The following table describes available controls on the touch screen.

Option Descriptions

Side Control Select the desired view on the dual images (contrast image and the reference 
image).

Flash
Activate to expose the higher acoustic power for a specified time duration by 
pressing a control once.
Flash is available in live imaging only.

Timer
Activate to start a clock which is used to record the time of microbubble contrast 
delivery. You can use it at the time of injection.
Timer is available in live imaging only.

Output Power Set the output power of the system for Contrast Imaging.

Flash Frame Adjust the length of the Flash specified in number of frames.

NOTE
Some image optimizing controls are shared between Contrast and 2D mode.
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General workflow

NOTE
The contrast enhanced ultrasound imaging works with the SC1-4H and SC1-4HS transducer.

To perform the contrast imaging,

1	1	 On the touch screen, select Contrast from the 2D tab. 
The contrast image and 2D image are displayed side-by-side.

2	2	 Adjust the acoustic power experientially to obtain a good image.

3	3	 Observe the tissue image to find the target view.

4	4	 Inject the contrast agent, and set Timer to ON to start the timing. When the timer begins to work, 
the time will be displayed on the screen.

5	5	 Observe the image.

6	6	 To save the images, press the [Print] key on the control panel.

NOTE
To assign the print keys for saving an image or volume data, press the [System Preset] key and go to 
User Setting > Print/Foot Switch.

7	7	 Perform several live captures if there are more than one sections of interest.

8	8	 At the end of the contrast imaging, press the [2D] key to exit the contrast imaging.

9	9	 Perform step 2–8 if necessary.

TIPS
	• Optimize the 2D mode image as usual. Then select Contrast on the touch screen.
	• Administer an amount of contrast agent advised by the contrast agent manufacturer for the targeted 

application.
	• Use a low Output Power to minimize microbubble destruction.
	• Remember to start the Timer when injecting contrast agent.



5-22 Imaging Functions

Elastography
Elastography is a non-invasive method in which images demonstrating elasticity characteristics of tissue 
are used to help detect or classify tumors. It shows the spatial distribution of tissue elasticity properties 
in a region of interest by estimating the strain before and after tissue distortion caused by external or 
internal forces.

Elastography is an optional feature. For using this feature, you need an additional request to your local 
agent.

Transducers and intended applications
The transducers and applications that support Elastography are as follows:

Transducer type Transducer Application

Linear

L3-12H Thyroid, MSK, Breast

L8-17H Thyroid, MSK, Breast

L3-12HWD Thyroid, MSK, Breast

IO8-17T Thyroid, MSK

Endocavity

EV3-10T GYN, Urology

EC3-10T GYN, Urology

VE3-10H GYN, Urology

NOTE
Certain applications may not be available in some countries.
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Elastography display

1 2

3

4

5

Figure 5-13 Elastography display

1 2D imaging 4 Quality bar

2 Elastography imaging 5 2D image info

3 Color bar

Elastography options

Figure 5-14 Elastography touch screen
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General workflow

CAUTION
The results achieved in Elastography mode always depend on the accuracy of the procedure performed. Any 
clinically relevant decisions need to be verified with some other state of the art methods.

To activate Elastography, 

1	1	 Select Elasto on the touch screen. 
The system displays two images on the screen in a live, dual format. The left image is a 2D mode 
image with a region of interest (ROI). The right image is a 2D image with a corresponding ROI 
showing the elastogram.

NOTE
You can use user-defined key to activate Elastography. To assign the Elastography function to user-
defined key, press the [System Preset] key and go to User Setting > User Defined key > Assign User Key 
or Assign Numeric Key and select the Elasto.

2	2	 Perform the scan. Proper manual compression/decompression is displayed by the colored strain 
map.

3	3	 Adjust the image parameters to obtain an optimized image.

4	4	 When you have finished acquiring an image, press the [Freeze] key on the control panel. 

5	5	 Save the image if necessary.

6	6	 To exit the Elastography mode, select Exit on the touch screen.

Optimizing the Elastography image
To optimize the image, use the following options.

Table 5-3 Elastography options

Option Description

Invert Invert the color bar.
Select Invert on the touch screen to activate or deactivate the invert. 

E Persist Change the temporal averaging rate. (Value: 0 to 4)
Rotate the E Persist soft key to adjust the persist function.

Blend/Blend Level

Blend 2D and E images to overlap with each other. (Value: 0 to 100)
Select Blend on the touch screen to activate or deactivate the blend function, and 
then select < or > of Blend Level on the touch screen to adjust the intensity of 
blending.

Color Map Change the type of color map. (Value: 0 to 12) 
Rotate the Color Map soft key to change the type of color map.
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Color bar

The color bar indicates the stiffness of the tissue. The bottom of the color bar indicates that the target 
area is stiffer than the surrounding tissues, and the top of the color bar indicates that the target area is 
less stiff than the surrounding tissues.

Soft Tissue

Hard Tissue

Averaging Tissue

Hard Tissue

Soft Tissue

Figure 5-15 Color bar

Quality bar

The quality bar indicates the compression quality. The low section of the bar indicates inappropriate 
tissue deformation for a quality elastogram and the upper selection indicates appropriate tissue 
deformation for a quality elastogram.

TIPS
Elastography requires virtually no external compression for reproducible strain imaging results, but, 
exceptionally manual compression is needed to acquire Elasto images, if you exam a denser nodule.

Stable state for measurement

Unstable state for measurement

Figure 5-16 Compression quality bar
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Elastography display layout
To change the Elasto display layout, 

–	 Select Live Dual on the touch screen. The values are On and Off.

	❚ Elasto dual layout

The Elastogram and the 2D image are displayed side-by-side on the screen. The 2D image is shown on 
the left and an Elasto image is shown on the right.

	❚ Elasto single layout

The Elasto image is displayed alone on the screen.



Elastography 5-27

Performing a measurement

Elasto Size Compare

Elasto Size Compare applies the measured data in 2D mode to Elastography mode. Size of lesion in 2D 
mode and Elastography mode can be compared to have more accurate diagnose result.

NOTE
Elasto Size Compare is only available to use on freezing in Elastography mode.

Figure 5-17 Elasto Size Compare display

1	1	 Press the [Measure] key on the control panel.

2	2	 Select Elasto Size Compare on the touch screen.

3	3	 Use [Trackball] to move the marker to the start point on the 2D image, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key.

5	5	 The copied caliper appears on the Elastography image area.

6	6	 Use [Trackball] to move the marker of the copied start point to the desired position on the 
Elastography image, and press the [Set] key. 
The copied start point is fixed, and the copied end point appears.

7	7	 Use [Trackball] to move the marker of the copied end point to the desired position on the 
Elastography image, and press the [Set] key. 

8	8	 The measured value is fixed. The two values and one ratio are shown on the Result window.

NOTE
Elasto Size Compare is not available through the factory default. To configure the Elasto Size Compare, press 
the [System Preset] key and go to Measurement > Basic MEAS. > Elasto Size Compare.
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Elasto Strain Ratio

Elasto Strain Ratio provides quantitative information. It is calculated by comparing the strain of a lesion 
to the surrounding normal tissue. Soft tissue will have higher strain values than stiff tissue. It is displayed 
as a real-time color map of the relative elasticity.

NOTE
Elasto Strain Ratio is only available to use on freezing in Elastography mode.

Figure 5-18 Elasto Strain Ratio display

1	1	 Press the [Measure] key on the control panel.

2	2	 Select Elasto Strain Ratio on the touch screen.

3	3	 Use [Trackball] to move the marker to the start point on the Elastography image, and press the 
[Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key. 
The target strain is shown on the Result window.

5	5	 The copied caliper appears on the Elastography image area.

6	6	 Use [Trackball] to move the marker of the copied caliper to the reference strain point on the 
Elastography image, and press the [Set] key. 
The reference strain is shown on the Result window.

7	7	 The measured value is fixed. The strain ratio is shown on the Result window.

NOTE
Elasto Strain Ratio is not available through the factory default. To configure the Elasto Strain Ratio, press the 
[System Preset] key and go to Measurement > Basic MEAS. > Elasto Strain Ratio.
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Strain bar graph

The target and reference bars in graph are used to represent the levels of strain values. It is easy to 
compare the strain values of target and reference with the strain bar graph.

Figure 5-19 Elastography strain bar graph
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Stress Echo
WARNING
Stress Echo data are provided for reference only, not for confirming diagnoses.

Stress Echo is an optional cardiac application for Stress Echocardiogram which is combined treadmill 
test/  pharmacologic agent with an echocardiogram.

The stress package provides protocol templates for exercise, as well as pharmacological stress 
examinations.

Stress Echo data consists of Stress Echo loops, wall motion scores, and all other information pertaining to 
the Stress Echo portion of a patient examination.

To perform this function, you need to proceed the following procedure in serial order: Preacquisition, 
Acquisition, Selection, and Review modes. The following table describes how each mode takes a role:

Procedure Description

Preacquisition Select a protocol to use and ROI to define the image acquisition.

Acquisition Acquire a stress image from the selected protocol.

Selection Select images to be used for reviewing.

Review/Scoring Review the selected images for comparison with the Wall Motion Scoring.
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Protocol Editor
Protocol Editor allows you to create, edit, and delete stress echo protocols. When you create or edit a 
protocol, you can set the number of stage, the number of loops acquired for each view in the stage, and 
the standard views to include. You can define the stage type (continuous or non-continuous) and names 
for protocol/stage/view.

To access Protocol Editor,

–	 Click Protocol Editor on the Protocol Selection window.

–	 Press the [System Preset] key and go to Advanced Cardiac > Protocol Editor.

1 2

3

Figure 5-20 Protocol Editor

1 Protocols category 3 Views category (max. 7 views)

2 Stages category (max. 8 stages)

Editing an existing protocol

1	1	 Double-click a stage to edit from the stage list.

2	2	 Change the stage settings and click OK.

3	3	 To change the stage or view order, click Up or Down from the Stages or Views category.

4	4	 To copy the protocol or stage, click Copy from the Protocols or Stages category.

5	5	 To delete the protocol, stage, or view, click Delete from the corresponding category.

6	6	 To save the changes, click Save.

7	7	 When you have finished, click Save & Exit to exit from the Protocol Editor screen.
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Creating a new protocol

1	1	 On the Protocols category, click Add to create a new protocol and click OK. 
If necessary, change the default protocol name.

2	2	 From the Stages category, click Add to create a new stage and click OK.  
If necessary, edit or select a name for the new stage (Baseline, Pre exercise, Low dose, Peak dose, 
Peak exercise, Post exercise, Recovery).

3	3	 Set the following stage options:

	• Capture mode: Define the type of Capture mode.

	– Continuous: Acquisition runs for a defined time period. During this time, all views in a stage 
are acquired.

	– Prospective: After starting the acquisition, the next loop is acquired for one view in a stage.

	– Retrospective: After starting the acquisition, the last loop is stored for one view in a stage.

	• Clips per view: Define the clip number per each view (1–4 clips).

	• Preview: Configure to preview the Cine loop before storing (After View, After Stage, None).

	• Kind of Capture length: Define the unit of the capture length (Cycles or Time). If you change 
the unit of the capture length to Time, you can operate the Stress Echo function with ECG 
deactivated.

	• Capture length: Define the capture length (up to 3 cycles and 3000 ms).

	• Capture Delay(ms): Define the capture delay time.

	• Timer Type: Define the timer type (On Entry, On Acquisition, None).

4	4	 From the Views category, click Add to create a new view and click OK. (A2C, A3C, A4C, PLAX, PSAX, 
SAX-APEX, SAX-BASE)

5	5	 To save the settings, click Save.

6	6	 When you have finished, click Save & Exit to exit from the Protocol Editor screen.



Stress Echo 5-33

Preacquisition
1	1	 Activate the ECG function to acquire Stress Echo image clips.

2	2	 On the touch screen, select E-Tool and then select Stress Echo.  
The Protocol Selection window appears.

NOTE
You can use user-defined key to activate Stress Echo. To assign the Stress Echo function to user-defined 
key, press the [System Preset] key and go to User Setting > User Defined key > Assign User Key or 
Assign Numeric Key and select the StressEcho.

3	3	 Select the desired protocol by choosing the protocol name and click OK. 
The system displays the real-time imaging screen.
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Image acquisition

Figure 5-21 Stress Echo acquisition display

Figure 5-22 Stress Echo acquisition touch screen

The following table describes available acquisition menus on the touch screen.

Option Description

StartAcquisition Start image acquisition.

SkipView Select the next view in the current stage. You can cancel the view.

SkipStage Select the next stage. You can cancel the stage.

ROIPosition Adjust the ROI position during acquisition.

Clock Display the elapsed time from the start of the stress exam.



Stress Echo 5-35

1	1	 If necessary, optimize the image by use the following options:

	• Frequency: Adjust the operating frequency of the transducer.

	• DR (Dynamic Range): Adjust the dynamic range.

	• Line Density: Optimizes 2D-mode frame rate or spatial resolution for the best possible image.

	• Reject: Reduce noise in the image.

	• Power: Control the amount of acoustic power.

	• Gray Map: Adjust the gray map.

2	2	 Select Acquisition on the touch screen. The Acquisition screen appears.

3	3	 To start image acquisition, press the [Freeze] key on the control panel or select StartAcquisition on 
the touch screen. 
The system displays the Protocol window(status bar) on the left of the screen, listing the phases 
for the selected protocol along with the first phase views. The system selects the first view for 
acquisition by default, indicating the selected view by placing an arrow mark ( ) to the left of the 
view name.

4	4	 Proceed through each view in each stage according to the following instructions:

a.	 To start image acquisition, press the [Freeze] key on the control panel or select StartAcquisition 
on the touch screen. Saved views are marked with a green check mark ( ).

	– If you select After View on the Stage category of the Protocol Editor to configure to preview the 
Cine loop before storing, you can confirm image acquisition by selecting Accept on the touch 
screen before go to the next view.

NOTE
For more information about touch screen in Selection mode, see "Figure 5-24 Stress Echo selection 
touch screen" on page 5-39.

	– If you select After Stage on the Stage category of the Protocol Editor, the system goes to the 
next view for acquisition by default.

b.	 Repeat previous step until all required views are completed.

c.	 When image acquisition is completed for all views, the system switches to Selection mode.
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5	5	 If the protocol contains continuous stages, then proceed through each continuous stage according 
to the following instructions:

a.	 To start image acquisition, press the [Freeze] key on the control panel or select StartAcquisition 
on the touch screen. Continuous is shown in the status bar and the progress bar appears.

b.	 To stop capture, press the [Freeze] key or select StopAcquisition on the touch screen.

c.	 When image acquisition is completed for all views and continuous stages, the system 
automatically stops capturing and switches to Continuous Capture Selection mode.
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Image selection
The selected clips are used for analysis in the review mode and wall motion scoring mode. Selection 
mode is used to select the best loops of the examination.

When the acquisition is ended, Selection mode is enabled automatically, and you can select the 
preferred loop for each view.

NOTE
If you want to set clips per view, press the [System Preset] key and go to Advanced Cardiac > Protocol Editor 
> select Protocol > double click Stage > change the Clips per view (1–4).

1

2

3

4
5

Figure 5-23 Stress Echo selection display

1 Protocol / Protocol Editor 4 Review

2 Selected Stage/View 5 Image Selection Controls (Icons)

3 Selected image(loop)
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On the Selection screen, the following icons are available:

Icon Name Description

Enter Acquisition Go to the Acquisition screen.

Selection Layout
Select the image layout. 
(1X1, 2X1,2X2, 3X3, 4X3…)

Auto layout Provide the automatically optimized 
layout for your selected images.

Show/Hide Overlays Show or hide the overlaid window 
indicating the relevant stages or views.

Dog-ear Dog-ear the current image to scroll 
through other images.

Sync Mode Selection Free, Start, Align

Playback Mode Selection Loop, Once, Sweep

Full R-R

Set the playback interval in a heart rate 
cycle.Systole Only Playback

Diastole Only Playback

Speed Change the playback speed.

First 
Previous 
Play/Pause 
Next 
Last

Move to the first loop. 
Move to the previous loop. 
Start or pause playback. 
Move to the next loop. 
Move to the last loop.
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Figure 5-24 Stress Echo selection touch screen

The following table describes available selection menus on the touch screen.

Field Description

Acquisition Go to the Acquisition screen. You can acquire image views until one stage is
completed.

Accept Accept the current view. The selected view is marked as a green-colored check
icon.

Reject Reject the current view. The selected view is marked as a red-colored arrow icon.

To select the preferred loops to assign to the stress protocol views,

1	1	 On the Selection screen, use [Trackball] to select the desired view name.

2	2	 Press the [Set] key. The selected view name is highlighted.

3	3	 Use [Trackball] to select the desired loop to assign it to a particular view of the stress template.

4	4	 Press [Set] key. The frame of the selected image is highlighted. 

5	5	 Repeat steps 1–4 to assign loops to the other views.

6	6	 When image selection is completed, select Review on the left bottom of the screen to enter the 
Review mode.
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Review and scoring (Wall Motion Scoring)
Review/WMS mode is used to evaluate clips for cardiac wall motion abnormalities. Different views from 
different stages are selected for comparison across a wide variety of combinations.

Figure 5-25 Stress Echo review display

On the Review screen, the following icons are available:

Icon Name Description

Score point Indicate the each segment’s wall-
motion score by color

All Visible Loops Normal Assign a normal wall motion score to all 
currently displayed loops.

Selected Loop Normal Scoring wall motions for the currently 
selected loops.

Reset All Visible Loops 
Normal

Restore a normal wall motion score to 
all currently displayed loops.

Reset Selected Loop 
Normal

Restore a normal wall motion score to 
the currently selected loops.

Reset All View Restore wall motion score to all views.

Bull’s eye View the LV motion scoring diagram.
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With scoring the wall motions, you can review and compare images between stages and views.

1	1	 Select Review on the left bottom of the screen. The Review screen appears.

2	2	 In Review mode, use the following options:

	• Sort by Stage: Sort images by stage. Select the gray check box next to each required stage.

	• Sort by View: Sort images by each image view. Select the gray check box next to each required 
view.

	• Compare: Compare between the images. Select the gray check box next to each required stage 
or view.

NOTE
Shuffle mode is available. The system displays all loops that represent the selected stage or view.

3	3	 Perform review and scoring the wall motion. 

4	4	 When you have finished, select End Protocol on the touch screen. 
The Save window appears.

5	5	 To save the result, select Yes. The selected loops and their wall-motion scores are saved.

6	6	 To delete the result, select Cancel. All of the current results are deleted.

Scoring a LV wall motion

Left Ventricle Wall motion scoring (WMS) represents the score results as the Left Ventricle images. 
Abnormal motions are scored by colorizing the segments in the symbol.

1	1	 Select a score point.

Score Degree of abnormality of wall motion Color

-1 Hyperkinesis Gray

0 Not evaluated Colorless

1 Normal Green

1.5 Mild Hypokinesis Blue-green

2 Moderate Hypokinesis Yellow

2.5 Severe Hypokinesis Lemon

3 Akinesis Blue

3s Akinesis with Scar Purple

4 Dyskinesis Red

4s Dyskinesis with Scar Scarlet

5 Aneurysm Pink

2	2	 Move [Trackball] to a segment in the scoring diagram and press the [Set] key.

3	3	 The scored motion is colored and displayed in the relevant segment area in the diagram.

4	4	 To score the relevant segments, repeat steps 1–3.
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WMS report

In addition to the standard information included in the WMS report, you can include or exclude data to a 
specific stage. The WMS graphics of the each view on the report indicate the each segment’s wall-motion 
score by color or degree of shading.

Figure 5-26 WMS report

To activate the WMS report,

1	1	 Select End Protocol to exit Stress Echo and save the current results.

2	2	 Press the [Report] key on the control panel. The Report screen appears.

3	3	 Select WMS Report on the context menu.

To enter comments on the WMS report,

1	1	 Select Comment on the touch screen. The Comment screen appears.

2	2	 Enter comments in the Comments field.

3	3	 When you have finished entering comments, select Preview on the context menu to preview 
comments. You can see comments in the Comments field.

To preview and print the WMS report,

1	1	 From the Report screen, select Preview on the context menu.

2	2	 Preview the report for the currently selected mode.

3	3	 To print the report, select Print on the touch screen.
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Reviewing a stored Stress Echo

Figure 5-27 Reviewing Stress Echo via E-view

To review a stored Stress Echo,

1	1	 Press the [E-view] on the control panel.

2	2	 To review the Stress Echo, select the image. 
The selected image is highlighted.

NOTE
The Stress Echo exam displays as a single image with a stress echo icon placed on the image.

3	3	 Select Review on the touch screen.

Image Compression
The Stress-Echo supports a four-level image compression. (High, Medium, Low, Uncompressed).

Figure 5-28 Image Compression
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Cube Strain™
Cube Strain™ is an optional cardiac application that provides advanced motion and velocity information 
of the myocardial tissue. On a basis of 2D speckle tracking technology, the angle independent analysis of 
this function allows you to assess accurate strain and calculate strain rate of the myocardium, especially 
for fetal heart. With the enhanced graphic display, you can easily and quickly identify wall motion 
change.

Cube Strain display
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2 3
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8

Figure 5-29 Cube Strain analysis display

1 Selected image(loop) 5 Volume gragh

2 3D contour 6 Bull’s eye diagram

3 EF & Strain resulting gragh 7 Tool selection (Icons)

4 Longitudinal strain values 8 Image clipboard
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The following table describes the optional icons that you can use for the Cube strain™ function.

Icon Name Description

Sequence/M mode 
selection Open the Sequence/M mode selection screen. 

Start Analysis Start the velocity strain analysis. 

New Trace Start a new contour tracing. 

Correct ES Border Edit trace for the end systole.

Correct ED Border Edit trace for the end diastole.

Go To End Systole Move the frame to "End Systole" on the 2D mode display.

Go To End Diastole Move the frame to "End Diastole" on the 2D mode display.

Toggle contour/vector/ 
orbit line/2D mode Select the icon until the display shows the desired function. 

Segmental Analysis Go to Segmental Analysis page.

Zoom in/Out Zoom in or out the 2D mode display. 

Pictures Mirroring Mirroring the 2D mode display.

Image Select View Return to Image Select View.

Delete Selected Contour Delete the selected contour.
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Acquiring images and activating Cube Strain
1	1	 Connect the ECG device and make sure to obtain a stable ECG trace.

2	2	 Acquire 2D mode Cine loops of cardiac view.

3	3	 If necessary, optimize the image by using imaging optimization controls.

4	4	 Adjust the width and depth to increase the frame rate.  
The frame rate should be more than 60 frames per second. A higher frame rate is recommended for 
high heart rate.

5	5	 To activate Cube Strain, select E-Tool and then select Cube Strain on the touch screen.
The View selection window appears.

NOTE
You can use user-defined key to activate Cube Strain. To assign the Cube Strain function to user-defined 
key, press the [System Preset] key and go to User Setting > User Defined key > Assign User Key or 
Assign Numeric Key and select the Cube Strain™.
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Selecting an image

1

2 3

4

Figure 5-30 View selection window

1 Clipboard (Thumbnails) 3 View selection menu

2 Preview 4 Next icon

1	1	 Select the desired Cine image from the clipboard.  
The selected Cine images is displayed in the Preview field.

2	2	 Select the corresponding view on the view selection menu to assign to the selected Cine image. 
You can choose one to three clips simultaneously according to your analysis group.

3	3	 Click the Next icon ( ). The Sequence/M mode selection window appears.

4	4	 Define the position of the R wave.  
If the study has ECG data, the system automatically detects cardiac cycle, heart rate, and R wave 
position.

5	5	 Click the Next icon ( ). The Contour window appears.
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Contouring and starting analysis

Figure 5-31 Contouring at ES frame

1	1	 Place landmarks at the endocardium in the end-systolic(ES) frame by using [Trackball], and press 
the [Set/Cur] key.

	– Anterior annulus: Press the right [Set/Cur] key.

	– Posterior annulus: Press the right [Set/Cur] key.

	– Apex: Press the left [Set/Cur] key.

2	2	 Click the Start Analysis icon ( ) to start the analysis. The end-diastolic(ED) frame appears.

3	3	 If necessary. adjust the contour select.

	– To edit the trace for the end systole, click the Correct ES Border icon ( ). The new tracking 
will be initiated.

	– To edit the trace for the end diastole, click the Correct ED Border icon ( ). The contour of end 
systolic(ES) remains untouched.

4	4	 If necessary, editing the contour by drag and drop the red points.

5	5	 When tracing and editing contour are completed, click the Next icon ( ) to start calculation 
processes.

6	6	 The Anaysis window appears. A comprehensive array of data is displayed on the screen.
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Exporting the result
You can save the data to an external file.

To export the result,

1	1	 Insert your removable media to the media tray properly.

2	2	 Select Data Storage on the touch screen. The dialog box appears.

3	3	 Select the desired media from the Device drop-down list.

4	4	 If you select CD/DVD from the Device drop-down list, you can use the following options:

	• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or 
DVD.

	• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing.

5	5	 Select the data format.

	• Text data file: Eexport to a text file.

	• Secondary capture file: Creates a screen capture of the entire screen.

	• Avi file: Save the Cine loop in AVI format

6	6	 When you have finished, click Save.

Ending an exam
1	1	 When you have finished, press the [Exit] key on the control panel.  

The Save window appears.

2	2	 To save the results, click Yes.  
The scan screen appears and you can see thumbnail images on the clipboard.

Reviwing an exam
To review a stored Cube Strain image,

1	1	 Press the [E-view] on the control panel.

2	2	 Select the desired image. 
The selected image is highlighted.

3	3	 Select Review on the touch screen.
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This chapter describes how to capture images.

Managing Patient 
Information and Image
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Clipboard
The clipboard shows captured ultrasound images for a quick review. Pressing the [P1] key captures an 
active image and displays a preview image on the clipboard. When reloading the previous study, the 
images belong to that study are shown on the clipboard.

Capturing onto the clipboard
Press the [P1] key to capture images onto the clipboard. You can see thumbnail images on the clipboard.

NOTE
The print key is programmable. You can assign the P1, P2, and P3 key functions in User Setting > Print/Foot 
Switch.

Thumbnail Preview
1	1	 To activate Thumbnail Preview, click the Thumbnail Preview icon ( ) on the bottom right.

2	2	 Move the cursor over the thumbnail images on the clipboard. The magnified thumbnail image is 
displayed in the screen.

3	3	 To deactivate Thumbnail Preview, click the Thumbnail Preview icon ( ) again.

Reloading images from the clipboard
1	1	 Press the [Cursor] key to obtain the cursor.

2	2	 Move the cursor over the image you want to reload by using [Trackball] and press the [Set] key.

3	3	 Press the [Set] key to reload the selected image on the full screen image. 
You can also double-click a thumbnail image to reload an image. To scroll the page, click the arrow 
mark of the scroll bar to move up and down.

Deleting images from the clipboard
1	1	 Press the [Cursor] key to obtain the cursor.

2	2	 Move the cursor over the image you want to delete by using [Trackball] and press the [Set] key.

3	3	 Click the trash can icon ( ) on the bottom right.

4	4	 When the confirmation dialog box appears, click Yes to delete the image.
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Saving images permanently
1	1	 Press the [E-view] key on the control panel. The images on the clipboard appear expanded.

2	2	 Use [Trackball] to select an image or multiple images and press the [Set] key. 
To select all images, select Select All. To select inverse images, select Select Inverse.

3	3	 Select Archive on the touch screen to save the image(s).

Indices
	• The number on the top left corner denotes the consecutive order for saving.

	• Film symbol on the bottom right side denotes the Cine loop that is possible to post processing.

	• On the top of the clipboard, the clipboard indicators show the total capacity and number of images.

	• To delete the selected thumbnail image, click the trash can icon ( ) on the bottom right.

	• To change the clipboard window layout, click the single layout icon ( ) or dual layout icon ( ) 
on the bottom right.
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Touch Clip
Touch Clip allows you to compare the images from a patient’s previous exam(s) to the patient’s current 
exam.

Figure 6-1 Touch Clip display

To activate the Touch Clip function,

1	1	 Select the desired image(s) on the clipboard.

NOTE
You can add the images on E-view. See "Image View" on page 6-13 for more information.

2	2	 Click the Touch Clip icon ( ) on the bottom right of the display. Or select the Touch Clip icon ( ) 
on the touch screen.

3	3	 Select the desired image on the touch screen.

4	4	 Compare the image with live image.

To delete the image(s) on the touch screen,

1	1	 Select the desired image(s) on the touch screen.

2	2	 Select Delete on the touch screen. The Message dialog box appears.

3	3	 Click OK.

To delete the exam on the touch screen,

1	1	 Select Delete Exam on the touch screen. The Message dialog box appears.

2	2	 Click OK.

To exit the Comparison mode,

–	 Select the exit icon ( ) on the upper right of the touch screen.
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E-view
The system provides the E-view feature that allows fast and easy image management. The E-view feature 
allows you to view the whole patient from local database or removable media, export/import, save as 
with PC friendly format and send DICOM images to remote server over the network. And it allows you to 
open an already existing patient exam. 

CAUTION
You may lose patient information files such as patient’s basic information and scanned images because of 
physical shocks to the product or internal errors. Therefore, you should back up patient’s basic information 
and scanned images on a regular basis. See "Backup / Restore" on page 9-43 for more information. ALPINION 
MEDICAL SYSTEMS does not have the responsibility for data loss caused by the user’s carelessness.

To activate the E-view feature, 

–	 Press the [E-view] key on the control panel.

1 4

3

2

5
6

Figure 6-2 E-view display

1 Menu selection 4 Patient list/Study list

2 Function selection 5 Image area

3 Source information 6 Exit
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List View
List View allows you to search and quick view for patients and studies from the local hard disk drive 
(HDD) or a removable media.

Figure 6-3 List View display

Figure 6-4 List View touch screen

To activate List View,

1	1	 Select a source from the Source drop-down list. 

2	2	 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area.

3	3	 Select the desired patient from the patient list.



E-view 6-7

4	4	 Use the following options:

	• Backup: Export the patient information.

	• Send To: Send the saved images through the network.

	• Report: Access Worksheet page.

	• Reopen Exam: Reopen an already existing exam.

Backup

To move patient(s) between compatible systems or to back up and retrieve, use Backup menu. You can 
use the following types of media for performing data backup: CD, DVD, USB HDD, USB flash drive.

NOTE
Make sure that your media is appropriate for exporting or importing images. If any problem occurs, eject the 
media and retry the task.

To export from the local HDD to a removable media,

1	1	 Insert your removable media to the media tray properly.

2	2	 Select Local HDD from the Source drop-down list.

3	3	 Select the patient(s) from the patient list.

4	4	 Select Backup on the touch screen, or select Backup on the function selection. 
The dialog box appears.

5	5	 Select a media from the Device drop-down list.

6	6	 If you select USB or USB HDD from the Device drop-down list, you can enter the description such as 
information or comment.

7	7	 If you select CD/DVD from the Device drop-down list, you can use the following options:

	• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing.

	• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or 
DVD.

8	8	 Click Yes. The status information is displayed in the Backup Spooler during exporting files.
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	❚ Backup Spooler

Backup spooler displays all backups which have been sent or which have been failed.

To enter the Backup spooler, press the [DICOM Spool] key on the QWERTY keyboard, and then select 
Backup on the touch screen. You can control or monitor backup jobs. From the Back spooler, you can 
retry, delete, or redirect job.

Figure 6-5 Backup spooler

To restore from a removable media to the local HDD,

1	1	 Insert a media that contains patient data.

2	2	 Select a removable media from the Source drop-down list.

3	3	 Select the patient(s) from the patient list.

4	4	 Click Restore. The progress bar appears while importing files.

5	5	 To eject the removable media (for CD or DVD), press the [Eject] key on the QWERTY keyboard.
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Send To

Send To allows you to save images or studies from your PC to a storage media such as CD, DVD, USB flash 
drive, USB hard disk, and network storage. Before saving, make sure that the removable media is placed 
in the right position.

	❚ CD/DVD, USB/USB HDD, Network

1	1	 Select Local HDD from the Source drop-down list.

2	2	 Select the patient(s) from the patient list.

3	3	 Insert your removable media to the media tray properly.

NOTE
To configure the network storage, press the [System Preset] key and go to Connectivity > General > 
Network Storage. 

4	4	 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears.

5	5	 Select a storage media type on the left of the dialog box.

6	6	 Select a media from the Device drop-down list.

NOTE
If you select USB, USB HDD, or Network Drive from the Device drop-down list, you can add or 
delete folders by using the add folder icon ( ) or delete folder icon ( ).

7	7	 If you select CD/DVD, USB/USB HDD or Network, you can use the following options:

	• Generate DICOMDIR file: Save the patient data as DICOMDIR file.

	• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing.

	• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD 
or DVD.

8	8	 The system automatically creates a file name.  
To change the file name, select the Edit File Name check box and enter a file name in the File 
Name field.
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9	9	 Select an image format in the Type field. 
To save Cine images as a video file, skip to step 12.

Table 6-1 Image format

Format Function

DCM Save a still image as standard DICOM format.
It is possible to specify compression type and quality.

BMP Save a still image as BMP format.

JPEG Save a still image as JPEG format.
It is possible to specify compression type and quality.

NOTE
To view a DICOM format image on your PC, you need a dedicated DICOM viewer.

10	10	 If you selected DCM in step 9, select a compression type in the Compression field.

11	11	 If you selected JPEG in step 9, select an image quality in the Quality field. 

12	12	 Select a video file format.

	• 2D Cine: Save 2D Cine Images as WMV or AVI format.

	• 4D Volume Cine(*AVI): Save 4D volume Cine images as AVI format.

13	13	 When you have finished, click Save.

	❚ PACS

PACS allows you to transfer patient(s) data to the DICOM device such as DICOM storage or DICOM 
Print.

To send from the local HDD to a DICOM device,

1	1	 Select Local HDD from the Source drop-down list.

2	2	 Select the patient(s) from the patient list.

3	3	 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears.
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4	4	 Select PACS on the left of the dialog box.

5	5	 Select a destination device from the DICOM Server drop-down list.

NOTE
You can configure the destination device. To configure, press the [System Preset] key and go to 
Connectivity > Storage.

6	6	 Click Send. The progress bar appears during transferring files.

	❚ Printer

1	1	 Select Local HDD from the Source drop-down list.

2	2	 Select the patient(s) from the patient list.

3	3	 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears.

4	4	 Select Printer on the left of the dialog box.

5	5	 Select a standard (default) printer and set up the printing options.

NOTE
To configure the standard printer, press the [System Preset] key and go to System > Peripheral > 
Standard Printer.

6	6	 When you have finished, click Print. 
The selected printer prints out the selected image(s).

NOTE
To invert color between images and background, select the Invert Image check box.



6-12 Managing Patient Information and Image

Report

Report allows you to access Worksheet page. Press the [Report] key on the control panel.

Reopen Exam

Reopen Exam allows you to open an already existing exam. The reopened exam is now the current exam 
and can be closed by pressing the [End Exam].

NOTE
You cannot reopen exams, which are older than 24 hours.

To open the selected exam, 

1	1	 Select a desired patient from the patient list.

2	2	 Select Reopen Exam on the touch screen, or select Reopen Exam on the function selection. 
The scan screen appears.

3	3	 Edit an image and save it.

4	4	 To end the current exam, press the [End Exam].
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Image View
Image View allows you to view the selected images from list view. You can change the display layout.

2
1

3 4

5
6

Figure 6-6 Image View display

1 Layout selection 4 Delete

2 Page selection 5 Add Touch Clip

3 Select All/Select Inverse 6 Exit

Figure 6-7 Image View touch screen
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To activate Image View,

1	1	 Select a source from the Source drop-down list. 

2	2	 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area.

3	3	 Select the desired patient from the patient list.

4	4	 Select ImageView on the touch screen, or select ImageView on the menu selection.

5	5	 Use the following options:

	• Backup: Export the patient information.

	• Send To: Send the saved images through the network.

	• Report: Access Worksheet page.

	• Reopen Exam: Reopen an already existing exam.

To review an image,

1	1	 Select the desired image.

2	2	 Select Review on the touch screen. The image is shown on the scan screen.

To add images to Touch Clip,

1	1	 Select the desired image(s).

2	2	 Select Add Touch Clip. The image is shown on the touch screen.
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CubeNote

CubeNote allows you to send saved images to remote server and review the images through CubeNote 
app in your mobile device.

NOTE
For using this feature, you need an additional request to your local agent.

To send saved images to CubeNote Control Server,

1	1	 Select the image(s).

2	2	 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears.

3	3	 Select CubeNote on the left of the dialog box.

4	4	 Enter an e-mail address.

5	5	 You can use the following options:

	• Hide Patient Information: The patient information is removed from the images.

	• Only sent as attachments when sending mail: The selected images can be sent only by e-mail 
attachment.

6	6	 Click Send. The status information is displayed in the Spooler during transferring files.
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Image History
Image History allows you to review all previous studies for the selected patient. When you access Image 
History, the study information with the study date and location appears in a table.

Figure 6-8 Image History display

Figure 6-9 Image History touch screen
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To activate Image History,

1	1	 Insert a media that contains patient data, if necessary.

2	2	 Select a source from the Source drop-down list. 

3	3	 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area.

4	4	 Select a desired patient from the patient list.

5	5	 Select Image History on the touch screen, or select Image History on the menu selection. 
All of the studies for the selected patient are listed by chronological order.

6	6	 Select an image in the desired study by using [Trackball]. The blue-colored frame appears on the 
selected image. 
To review multiple images between different studies, select desired images of the studies you want. 
You can select up to four images at one time.

NOTE
You can compare images by changing the image layout to dual imaging or quad imaging. Press the 
[Dual] key or [Quad] key on the control panel.

7	7	 Select Review on the touch screen to review the image.

8	8	 To delete the image, select Delete on the touch screen.

9	9	 When you have finished, press the [2D] key to return to the scan mode.

Ending a study

To end a study immediately, 

–	 Press the [End Exam] key on the control panel.
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DICOM Spooler
DICOM spooler displays all DICOM transfers which have been sent or which have been failed.

On the QWERTY keyboard, press the [DICOM Spool] key to enter the DICOM spooler. You can control or 
monitor DICOM jobs. From the DICOM spooler, you can retry, delete, or redirect job.

Figure 6-10 DICOM spooler

Table 6-2 DICOM job status

Job status Description

Hold Job process is on hold.

Pending Job is currently sending and the system is waiting for the server’s response.

Active Job is in progress. 

Failed Job is failed to send.

Done Job is sent successfully.

NOTE
When your system is connected to an MPPS* service, the following job status is available: In progress, 
Completed.
*Modality Performed Procedure Step (MPPS) is a DICOM service that enables you to notify the status 
information of a study to PACS.
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Spooler options
On the DICOM spooler, you can use the following options:

Option Description

Select All Select all jobs in the DICOM spooler.

Retry Retry sending the selected job.

Delete Quit the selected job.

Suspend Suspend the selected job.

Refresh Refresh the spooler. The completed jobs are deleted from the spooler.

Cancel Exit the DICOM spooler.
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Printer

Connecting to a printer via USB connection
1	1	 When the system power is off, connect a USB cable of the printer to the USB port at the rear of the 

system.

2	2	 Press the [Power On/Off] key on the control panel. 

NOTE
Do not disconnect the USB cable when the system power is on.

3	3	 If necessary, install the printer driver.

NOTE
Only recommended printer drivers are installed as default. Refer to your printer manual for installation. 

4	4	 Set the print as default printer via E-Tool > SystemPreset > System > Peripheral.

5	5	 To assign one of the print keys to printer via E-Tool > SystemPreset > User Setting > Print/Foot 
Switch.

6	6	 From the printer list under Standard Printer, select a print to be assigned on the print key and click 
>> to add the printer device.

CAUTION
	• Before powering on the system, connect the printer via the USB cable and turn the printer power on. 
	• When you select “Cleanup Spooler jobs during boot up,” all jobs in queue will be deleted whenever 

system reboots.

Printing a report
1	1	 On the touch screen, select E-Tool and go to SystemPreset > System > Peripheral > Default Printer.

2	2	 Select a printer from the printer list.

3	3	 When you have finished, click Save & Exit to save the changes.

4	4	 Press the [P1] key on the control panel.
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DVR

Selecting a DVR
To select the DVR,

1	1	 Make sure that a DVR is connected to the system when the system power is off.

2	2	 On the touch screen, select E-Tool and go to SystemPreset > System > Peripheral > VCR.

3	3	 Select a DVR recorder from the list.

4	4	 When you have finished, click Save & Exit to save the changes.

Using the DVR
Press the [DVR] key on the QWERTY keyboard. The soft menus for the DVR controls appear.

NOTE
Before recording, make sure that the DVR power is on and the media is played in the tray.

To record an image, 

1	1	 Insert a media into the recorder.

2	2	 On the touch screen, select Record to start recording.

3	3	 To pause recording, select Pause.

4	4	 To resume recording, select Record again.

5	5	 When you have finished, select Stop and then Finalize.

NOTE
You can also record an image by using the footswitch or the [P1] key on the control panel. To configure, press 
the [System Preset] key and go to User Setting > Print/Foot Switch.
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Basics

Basic measurement operations
To begin the measurement, 

1	1	 On the control panel, press the [Measure] key.

2	2	 Use [Trackball] to move the point.

3	3	 Press the [Set] key to fix the point.

To modify a measurement,

1	1	 Click the result value you want to change from the Result window. The caliper is activated.

2	2	 Use [Trackball] to change the measurement value and press the [Set] key.

	– To switch the caliper mark of the current value, press the [Measure] key when the caliper is 
active.

	– To activate the caliper of another value, press the [Priority] key repeatedly until the desired 
value is highlighted.

To delete a measurement, 

1	1	 Click the result value you want to delete from the Result window. The caliper is activated.

2	2	 Press the [Clear] key on the control panel.

To change a measurement preset, click the measurement preset you want to change.

To exit, press the [Exit] or [2D] key on the control panel.
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Measurement menu display

Figure 7-1 Measurement menu display

	• Measure reference window: The Caliper Easy Guide feature magnifies around the caliper on 
the display. When the caliper is positioned over the image, the zoomed image is displayed in the 
reference window.

	• Basic measurement: The basic measurement menus appear on the touch menu. Displaying the list of 
basic measurement depends on an active preset and imaging mode.

NOTE
To configure the basic measurements, press the [System Preset] key and go to Measurement > Basic 
MEAS..

	• Labeled measurement: The labeled measurement menus appear on the context menu. Displaying 
the list of labeled measurement depends on an active preset and imaging mode.

①

②

③

1  Performed measurement

2  Pre-selected measurement

3  Package measurement



7-4 Measurements and Reports

NOTE
	• The result for measurement is shown on the Result window, Mini Report page, and Report page.
	• After performing basic measurement, you can assign the measurement data to the labeled 

measurement menu.
	• To configure the labeled measurements, press the [System Preset] key and go to Measurement > 

Labeled MEAS.. 

Direct key

With the Direct key feature, you can quickly access measurement menus by simply pressing 
alphanumeric keys on the QWERTY keyboard. There are total of 16 available keys: A, S, D, F, G, H, J, K, L, 
Z, Y, C, V, B, N, M

1	1	 Press the [Measure] key on the control panel.

2	2	 From the labeled measurement menu, press an alphanumeric key to access the menu you want. 
You can see the corresponding direct key on the right side of the menu.

3	3	 Repeat step 2 until the desired menu appears.
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Measurement result window

The Result window displays the measurement result. You can change the window status by selecting one 
of the following icons:

Table 7-1 Measurement result window

Icon Description

Change the background type (e.g. transparent or opaque) of the Result window.

Change the position of the Result window.

View the mini report.

	❚ Changing the Frame

Selecting Cine on the touch screen allows you to stop the measurement or change the frame without 
resetting the Result window.

1	1	 Select Cine on the touch screen.

2	2	 Move to the desired frame using [Trackball].

3	3	 Press the [Measure] key to perform the desired measurement.
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Basic measurement unit

Table 7-2 Basic measurement unit

Mode Measurement Unit Abbreviation

2D mode

Distance
Area
Circumference
Angle
%Stenosis
Volume
Disk Volume
Volume Flow Area

centimeters
centimeters2

centimeters
degree
percent
milliliter
milliliter
centimeters2

cm 
cm2

cm
deg
%
ml
ml
cm2

M mode

Distance
Time
Slope
%Stenosis
HR

centimeters 
milliseconds
centimeters per second
percent
beats per minute

cm 
ms
cm/s
%
bpm

D mode

Velocity
PG
Time
VTI
Acceleration
HR
Volume Flow

centimeters per second 
millimeters mercury
millisecond
centimeters
centimeters per second2 
beats per minute
Volume milliliter per minute

cm/s 
mmHg
ms
cm
cm/s2 

bpm
ml/min
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Measurement formula

Table 7-3 Measurement formula

Mode Measurement Method Formula

2D

Circumference Ellipse

Area Ellipse A= π(D1)(D2)/4

%Stenosis 2 Diameter
2 Area

%Steno=
(1- min(D1, D2)/max(D1, D2))X100
%Steno= 
(1- min(A1, A2)/max(A1, A2)X100

Volume

1 Distance
2 Distance
3 Distance
Ellipse
Distance + Ellipse

V= πD13/6
V= D1X D2Xmin(D1, D2)Xπ/6
V= πD1XD2XD3/6
V= D1XD2Xmin(D1, D2)Xπ/6
V= πD1XD2XD3/6

Disk Volume

Volume Flow Area A=π/4XD2

M
Slope S= (D1-D2)/∆T

HR HR= Cycle number/∆T*60

D

Acceleration Accel= (V1-V2)/∆T

PI PI= (PS-ED)/Vmean

RI RI= (PS-ED)/PS

HR HR= Cycle number/∆T*60

Volume Flow Distance Vol. Flow=AXTAmax (or TAmean)X60/ 1000 
(A=π/4XD2)
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Basic measurements
The basic measurements are available in the following imaging modes:

	• 2D mode

	• M mode

	• Doppler mode

2D mode measurements

The basic 2D mode measurements include the following measurement parameters:

	• Tissue depth

	• Distance

	• Circumference and Area

	• Angle

	• Volume 

	• Stenosis 

	• A/B Ratio

	• Disk Volume

	• Histogram

	• Elasto Size Compare

	• Elasto Strain Ratio

	• Volume Flow Area

	❚ Tissue depth

Selecting this option in the system preset enables depth to be automatically measured when the first 
measurement marker appears on the image. 

The Result window shows the distance from a point on the transducer-skin interface to the marker 
until the first marker is anchored.

NOTE
To configure the tissue depth, press the [System Preset] key and go to Measurement > General > Tissue 
Depth display(2D,M).



Basics 7-9

	❚ Distance

	• 1 Distance 

	• 3 Lengths

	• Trace

NOTE
Measurement error is within 5% of the distance you measured for all transducers.

1 Distance

1	1	 Select Distance on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 Press the [Set] key to fix the point. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

5	5	 The measured value is fixed, and the distance (D) is shown on the Result window.

3 Lengths

1	1	 Select Distance on the touch screen. The start point appears.

2	2	 Draw three straight lines using [Trackball], and press the [Set] key. 

3	3	 Move the fourth point, and then press the [Set] key.

4	4	 The measured value is fixed, and three distances (D1, D2, D3) are shown on the Result window.

Trace

1	1	 Select Distance on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The end point appears.

3	3	 Move the end point gradually along the circumference of the target object using [Trackball].

4	4	 When the start point and the end point are connected with a line, press the [Set] key to 
complete the measurement.

5	5	 The measured value is fixed, and the distance (D) is shown on the Result window.

NOTE
To configure the distance, press the [System Preset] key and go to Measurement > Basic MEAS. > 
Distance > Default method.
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	❚ Circumference and Area

	• Ellipse

	• Trace

	• Spline

Ellipse

1	1	 Select Ellipse on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point, and press the [Set] key. The ellipse 
appears.

4	4	 Use [Trackball] to adjust the height of the ellipse, and press the [Set] key again.

	– To increase the height, move [Trackball] up and right.

	– To decrease the height, move [Trackball] down and left.

5	5	 The measured value is fixed. The two diameters (D1, D2), the circumference (C), and the area 
(A) are shown on the Result window.

Trace

1	1	 Select Trace on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to move the end point gradually along the circumference of the target object.

4	4	 When the start point and the end point are connected with a line, press the [Set] key to 
complete the measurement.

5	5	 The measured value is fixed. The circumference (C) and the area (A) are shown on the Result 
window.

Spline

1	1	 Select Spline on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The second point appears.

3	3	 Set the third and subsequent points in the same way.

4	4	 Press the [Set] key twice at the same point to fix the end point.

5	5	 The measured value is fixed. The circumference (C) and area (A) are shown on the Result 
window.
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	❚ Angle

	• 3 Points

	• 2 Lines

	• 2 Lines (Axis)

	• 3 Lines(BA)

	• 3 Lines(AB)

Angle 3 Points

1	1	 Select Angle on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point.

4	4	 Press the [Set] key. The third point appears.

5	5	 Use [Trackball] to move the third point to the end point of the angle measurement.

6	6	 Press the [Set] key. The angle between the two lines appears. 

7	7	 The angle (Angle) is shown on the Result window.

Angle 3 Lines

1	1	 Select Angle on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
TThe first point is fixed, and the second arrow-shaped point appears.

3	3	 Use [Trackball] to move the marker to the second point. 

4	4	 Draw the baseline, and press the [Set] key to fix the baseline. 
The third point appears.

5	5	 Draw the remaining two straight lines to cross the baseline as the same way. The α angle and β 
angle appear.

6	6	 Press the [Set] key at the end point of the third straight line to fix the measured value.  
The two angles (Alpha, Beta) are shown on the Result window.

NOTE
To configure the angle, press the [System Preset] key and go to Measurement > Basic MEAS. > Angle > 
Default method.
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	❚ %Stenosis

	• 2 Distances

	• 2 Ellipses

	• 2 Traces

	• Trace+Ellipse

	• Ellipse+Trace

Two diameters percent stenosis calculation

1	1	 Select %Stenosis on the touch screen. The start point appears.

2	2	 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key.

3	3	 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key.

4	4	 The two diameters (D1, D2) and the diameter percent stenosis (%Steno(Diam)) are shown on 
the Result window.

Two ellipses percent stenosis calculation

1	1	 Select %Stenosis on the touch screen. The start point appears.

2	2	 Measure the outer area (A1) of the stenosis using [Trackball], and press the [Set] key.

3	3	 Measure the inner area (A2) of the stenosis using [Trackball], and press the [Set] key.

4	4	 The two ellipses (A1, A2) and the diameter percent stenosis (%Steno(Area)) are shown on the 
Result window.

NOTE
To configure the %Stenosis, press the [System Preset] key and go to Measurement > Basic MEAS. > 
%Stenosis > Default method.
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	❚ Volume

	• 1 Distance

	• 2 Distances

	• 3 Distances

	• Ellipse

	• Distance+Ellipse 

3 Distance volume

1	1	 Select Volume on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

4	4	 Measure the second and third distances in the same manner. 
When the three distances are measured, the volume is calculated.

5	5	 The measured value is fixed. The three distances (D1, D2, D3) and the volume (Vol) are shown 
on the Result window.

NOTE
When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances (D1, 
D2) and press the [Clear] key.

Ellipse

1	1	 Select Volume on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point and press the [Set] key. The ellipse 
appears.

4	4	 Use [Trackball] to adjust the height of the ellipse, and press the [Set] key again.

	– To increase the height, move [Trackball] up and right.

	– To decrease the height, move [Trackball] down and left.

5	5	 The measured value is fixed. The two distances (D1, D2) and the volume (Vol) are shown on the 
Result window.

NOTE
To configure the volume, press the [System Preset] key and go to Measurement > Basic MEAS. > Volume 
> Default method.
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	❚ Disk Volume

	• Trace

	• Spline

Trace

1	1	 Select DiskVolume on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to create a trace of the structure with the second point.

4	4	 Press the [Set] key to complete the trace.  
The start and end points of the trace are connected, and a line representing the long axis 
appears.

5	5	 Press the [Set] key again. The volume is calculated.

6	6	 The area (A), the circumference (C), the diameter (D), and the volume (V) are shown on the 
Result window.

Spline

1	1	 Select DiskVolume on the touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key. The second point 
appears.

3	3	 Set the third and subsequent points in the same manner.

4	4	 Press the [Set] key twice to complete the trace. 
The start and end points of the trace are connected, and a line representing the long axis 
appears.

5	5	 Press the [Set] key again. The volume is calculated.

6	6	 The area (A), the circumference (C), the diameter (D), and the volume (V) are shown on the 
Result window.

NOTE
To configure the disk volume, press the [System Preset] key and go to Measurement > Basic MEAS. > Disk 
Volume > Default method.
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	❚ A/B Ratio

	• 2 Distances

	• 2 Ellipses

	• 2 Traces

	• Ellipse+Trace

	• Trace+Ellipse

Two diameters ratio

1	1	 Select A/B Ratio on the touch screen. The start point appears.

2	2	 Measure the first diameter (D1) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second diameter (D2) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two distances (D1, D2) and A/B ratio (A/B Ratio) are shown on the 
Result window.

Two ellipses ratio

1	1	 Select A/B Ratio on the touch screen. The start point appears.

2	2	 Measure the first area (A1) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second area (A2) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two ellipses (A1, A2) and A/B ratio (A/B Ratio) are shown on the 
Result window.

NOTE
To configure the A/B ratio, press the [System Preset] key and go to Measurement > Basic MEAS. > A/B 
Ratio > Default method.



7-16 Measurements and Reports

	❚ Histogram

HIistogram is a function that the gray scale distribution within a marked Region of Interest (ROI) will 
be graphically displayed on the screen.

1	1	 Select Histogram on the touch screen. 

2	2	 Use [Trackball] to move the caliper to the corner of the area where you want to measure the 
histogram.

3	3	 Press the [Set] key. 

4	4	 Use [Trackball] to move the caliper diagonally to the opposite side of the area.

5	5	 Press the [Set] key. The measured value is shown on the Histogram window. 
To view the histogram, go to the Histogram window.

NOTE
To configure the histogram, press the [System Preset] key and go to Measurement > Basic MEAS. > 
Histogram.

CAUTION
Do not change the gain control of the 2D image after performing the histogram measurement. Your 
change may not be applied on the histogram.

	❚ Elasto Size Compare

Elasto Size Compare applies the measured data in 2D mode to Elastography mode. Size of lesion in 2D 
mode and Elastography mode can be compared to have more accurate diagnose result.

NOTE
For details, see "Elasto Size Compare" on page 5-27.

	❚ Elasto Strain Ratio

Elasto Strain Ratio provides quantitative information. It is calculated by comparing the strain of a 
lesion to the surrounding normal tissue. Soft tissue will have higher strain values than stiff tissue. It is 
displayed as a real-time color map of the relative elasticity.

NOTE
For details, see "Elasto Strain Ratio" on page 5-28.
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	❚ Volume Flow Area

	• Distance

1	1	 Select Volume Flow Area on the touch screen.

2	2	 Use [Trackball] to move the marker to the start point.

3	3	 Press the [Set] key to fix the point. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key.

5	5	 The measured value is fixed, and the volume flow area is shown on the Result window.

NOTE
	• To calculate the volume flow, you make Auto Trace or Semi Auto Trace measurement in Doppler mode.
	• To configure the volume flow method, press the [System Preset] key and go to Measurement > 

Advanced MEAS. > Vol.flow Method and Modify Calcs.
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M mode measurements

The basic M mode measurements include the following measurement parameters:

	• Distance

	• Time

	• Slope

	• %Stenosis

	• Heart rate (HR)

	• A/B Ratio

	❚ Distance

	• Distance

	• 3 Lengths

1 Distance

1	1	 Select Distance on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The measured value is fixed, and the distance (D) is shown on the Result window.

3 Lengths

1	1	 Select Distance and then select 3 Lengths on the touch screen.  
The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.

3	3	 Draw the first straight line using [Trackball], and press the [Set] key.

4	4	 Draw the second straight line using [Trackball], and press the [Set] key.

5	5	 Draw the third straight line using [Trackball], and press the [Set] key to complete the 
measurement.

6	6	 The measured value is fixed, and three distances (D1, D2, D3) are shown on the Result window.

NOTE
To configure the distance, press the [System Preset] key and go to Measurement > Basic MEAS. > 
Distance > Default method.
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	❚ Time

1	1	 Select Time on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The time (T) is shown on the Result window.

	❚ Slope

1	1	 Select Slope on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window.

	❚ %Stenosis

Two diameters percent stenosis calculation

1	1	 Select %Stenosis on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the larger vertical diameter (D1) of the stenosis using [Trackball], and press the [Set] 
key.

3	3	 Measure the smaller vertical diameter (D2) of the stenosis using [Trackball], and press the [Set] 
key.

4	4	 The diameters (D1, D2) and the diameter percent stenosis (%Steno(Diam)) are shown on the 
Result window.

NOTE
For diameter calculation, do not take a distance measurement from a longitudinal view. This may lead to 
an inaccurate assessment of %stenosis.
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	❚ A/B Ratio

	• Distance

	• Time

Distance ratio

1	1	 Select A/B Ratio and then select Distance on the touch screen. The start point appears. 

2	2	 The vertical line and the horizontal line are perpendicular to each other.

3	3	 Measure the first vertical diameter (D1) of the ratio using [Trackball], and press the [Set] key.

4	4	 Measure the second vertical diameter (D2) of the ratio using [Trackball], and press the [Set] key.

5	5	 The ratio is calculated. The two distances (D1, D2) and A/B ratio (Distance Ratio) are shown on 
the Result window.

Time ratio

1	1	 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Time on the touch 
screen. The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first horizontal diameter (T1) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second horizontal diameter (T2) of the ratio using [Trackball], and press the [Set] 
key.

4	4	 The ratio is calculated. The two distances (T1, T2) and A/B ratio (Time Ratio) are shown on the 
Result window.

NOTE
To configure the A/B ratio, press the [System Preset] key and go to Measurement > Basic MEAS. > A/B 
Ratio > Default method.

	❚ Heart Rate (HR)

1	1	 Select HR on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the HR cycle, press the [System Preset] key and go to Measurement > Advanced MEAS. > HR 
cycle.
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D mode measurements

The basic D mode measurements include the following measurement parameters:

	• Velocity

	• Time

	• Acceleration

	• Resistivity Index (RI)

	• Pulsatility Index (PI)

	• VTI

	• Heart Rate (HR)

	• A/B Ratio

	• S/D Ratio

	• AC/DC

	• PHT

	• Auto Calc

	• Auto Trace/Semi Auto Trace/Trace

	❚ Velocity

1	1	 Select Velocity on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed. The velocity (Vel) and pressure gradient (PG) are shown on the 
Result window.

	❚ Time

1	1	 Select Time on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The velocity (Vel) and time (T) are shown on 
the Result window.



7-22 Measurements and Reports

	❚ Acceleration

1	1	 Select Acceleration on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed, and the acceleration is calculated. The acceleration (Accel), the 
acceleration time (AT), and maximum velocity (Vmax) are shown on the Result window.

	❚ Resistivity Index (RI)

1	1	 Select RI on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point and press the [Set] key again.

4	4	 The end point is fixed, and the resistive index is calculated. The peak systolic velocity (PS), end 
diastolic velocity (ED), and resistivity index (RI) are shown on the Result window.

	❚ Pulsatility Index (PI)

1	1	 Select PI on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Move the marker to the start point of the waveform using [Trackball], and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform, and press the [Set] key.

4	4	 The pulsatility index is calculated.

5	5	 The peak systolic velocity (PS), end diastolic velocity (ED), minimum diastolic velocity (MD), the 
maximum time-average velocity (TAmax), the resistivity index (RI), the pulsatility index (PI), and 
systole/diastole ratio (S/D) are shown on the Result window.
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	❚ Velocity-Time Integral (VTI)

1	1	 Select VTI on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Move the marker to the start point of the waveform using [Trackball], and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key.

4	4	 The velocity-time integral is calculated. The minimum, maximum, mean velocities (Vmin, Vmax, 
Vmean) and maximum and mean pressure gradients (PGmax, PGmean) are shown on the 
Result window.

	❚ A/B Ratio

	• Velocity

	• Time

Velocity ratio

1	1	 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Velocity on the 
touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (V1) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (V2) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (V1, V2) and A/B ratio (Velocity Ratio) are shown on 
the Result window.

Time ratio

1	1	 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Time on the touch 
screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first time interval (T1) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second time interval (T2) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two time values (T1, T2) and A/B ratio (Time Ratio) are shown on the 
Result window.

NOTE
To configure the A/B ratio, press the [System Preset] key and go to Measurement > Basic MEAS. > A/B 
Ratio > Default method.
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	❚ AC/DC

1	1	 Select AC/DC on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first oblique line (Accel) of the slope using [Trackball], and press the [Set] key.

3	3	 Measure the second oblique line (Decel.) of the slope using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The acceleration index (Accel), the acceleration time (AT), the 
deceleration index (Decel.), and deceleration time (DT) are shown on the Result window.

	❚ Heart Rate (HR)

1	1	 Select HR on the touch screen.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.

	❚ Auto Calc 

1	1	 In PW mode, select Auto Calc on the touch screen.

2	2	 Select Frozen or Live.

3	3	 If you select Live, the caliper and waveform trace automatically appear. 

4	4	 If you select Frozen, press the [Freeze] key on the control panel to freeze the image. 
The caliper and waveform trace automatically appear. 

5	5	 The calculated value is shown on the Result window.
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Auto Calc options

	• Method: Select a trace method for Doppler spectrum.

	• Direction: Select a trace direction for Doppler spectrum.

NOTE
	• To configure the auto trace options, press the [Image Preset] key and go to General.
	• To measure the maximum velocity, select Below or Above for the trace direction.
	• To edit the trace, use [Trackball].

Figure 7-2 Doppler

	❚ Auto Trace

1	1	 In PW mode, select the desired measurement item and then select Auto Trace on the touch 
screen. 
The Doppler spectrum is traced automatically and the results are displayed.

2	2	 If necessary, adjust the calculation cycle using [Trackball] and the [Measure] key on the control 
panel.

a.	 A green line appears at the right of the spectrum.

b.	 Using [Trackball], move the line and readjust the end cycle.

c.	 Press the [Measure] key on the control panel. 
The line changes to gray.

d.	 A green line appears at the left of the spectrum.

e.	 Using [Trackball], move the line and readjust the start cycle.

f.	 Press the [Set] key on the control panel. The line changes to gray.

3	3	 The calculated value is shown on the Result window.

NOTE
To configure the auto trace options, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > Modify Calcs > Auto Trace(Calc).
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	❚ Semi Auto Trace

1	1	 In PW mode, select the desired measurement item and then select Semi Auto Trace on the 
touch screen. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point of the waveform and press the [Set] key. 
The end point appears.

3	3	 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key.

4	4	 The calculated value is shown on the Result window.

NOTE
To configure the semi auto trace, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > Modify Calc > Semi Auto Trace.

	❚ Manual Trace 

1	1	 In PW mode, select the desired measurement item and then select Trace on the touch screen. 
The start point appears.

2	2	 Use [Trackball] to move the marker to the start point of the waveform and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key.

4	4	 The calculated value is shown on the Result window.

NOTE
To configure the manual trace, press the [System Preset] key and go to Measurement > Advanced MEAS. 
> Modify Calc > Manual Trace.
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Report
The reports summarize the data obtained during the examination.

Saved reports are read-only. Therefore it is recommended that the data is carefully reviewed before the 
report is saved. Use the worksheet to facilitate the review and adjustment of data before generating a 
report. The completed report can be printed on a standard printer.

Report display

Figure 7-3 Report display
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Report options

Figure 7-4 Report touch screen

Table 7-4 Report controls

Controls Description

Report Access Worksheet page.

Basic MEAS. View a report of basic measurement.

Preview Preview the report in print format.

Graph Access OB Graph page (applies only to OB).

Anatomical Survey Access Anatomical Survey page (applies only to OB).

Fetus Compare Compare between fetuses by viewing measurement and calculation values.

2D/M/Doppler View a report in a particular mode (2D, M, or Doppler).

All View a report for more than one mode.

Comment View or edit comments.

Delete Value Delete measurement results.

Exclude Value Exclude or include measurement results

Print Prints out the report to the default printer.

Exit Exit Report page.
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Report operations

	❚ Viewing a report

1	1	 Press the [Report] key on the control panel. You can also select Report on the context menu.  
You can view a report of labeled measurement.

2	2	 To view a report of basic measurement, select Basic MEAS. on the touch screen.

3	3	 To view a report by application or measurement mode, select an application or a mode from the 
corresponding list or field on the top left of the display.

NOTE
To view a report in a particular mode, select a mode (2D, M, or Doppler) on the touch screen. To 
view a report for more than one mode, select All on the touch screen.

4	4	 When a report appears on the display, view the report information.

5	5	 To view the next page of the report, rotate the Select Page soft key.

6	6	 To exit the report, press the [Exit] key on the control panel. You can also select Exit on the touch 
screen.

	❚ Editing a report

To change the report data,

1	1	 Move the cursor to the field that you want to change.

2	2	 Press the [Set] key. The field is highlighted.

3	3	 Enter a new data. You can enter data in the blank field. 
The entered data is changed to green and changed data is shown with an asterisk mark.

To erase measurement results,

1	1	 Move the cursor to the field that you want to erase. The field is highlighted.

2	2	 Select Delete Value to delete the data.

3	3	 Press the Delete All soft key to delete all report values of the activated worksheet.

4	4	 Press the [Clear] key to delete all report values of the reloaded study.

To exclude or include measurement results,

1	1	 Move the cursor to the field that you want to exclude. The field is highlighted.

2	2	 Select Exclude Value to exclude the data. The excluded data is displayed in white.

3	3	 Select Exclude Value again to include the data that you previously excluded.
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To change the value type,

1	1	 Move the cursor to the Method column.

2	2	 Press the [Set] key. 

3	3	 Select a value type of the measurement from the drop-down list (Last, Average, Maximum, and 
Minimum).

	❚ Adding a comment

1	1	 Select Comment on the touch screen. 
You can view comments in the Exam Comments screen and Comments screen.

2	2	 On the Comments screen, enter text by using the QWERTY keyboard.

3	3	 To exit the comment, click OK or select Comment on the touch screen.

NOTE
On the Patient Registration screen, you can edit text in the Exam Comments field.

	❚ Previewing a report

To preview the report, 

	– Select Preview on the touch screen, or select Preview on the context menu.  
You can preview a report to be printed. 

To add an image to the report,

1	1	 Move the cursor to the desired image on the clipboard and press the [Set] key.

2	2	 Move the cursor where the selected image is to be inserted and press the [Set] key.

To remove an image from the report,

	– Move the cursor to the desired image on the report and select Delete Image on the touch screen.

To add image pages to the report, 

	– Select Add Image Page on the touch screen.

To delete image pages from the report, 

	– Select Delete Image Page on the touch screen.

NOTE
You cannot add more than 10 image pages to a report.



Basics 7-31

To export the report in PDF, 

1	1	 Select PDF Export on the touch screen. The dialog box appears.

2	2	 Select a media from the Device field.

3	3	 Enter a file name in the File Name field.

4	4	 Click Save. The progress bar appears during exporting files.

	❚ Printing a report

To print a report via a standard printer, 

	– Select Print on the touch screen.

To capture the report screen, 

	– Press the [P1], [P2], or [P3] key on the control panel.

NOTE
	• To configure a default standard printer, press the [System Preset] key and go to System > Peripheral > 

Standard Printer. 
	• The supported paper size for report is A4, Letter only.

	❚ Transferring a measured data

You can transfer a measured data via the RS232C port. This function is only available for OB and GYN 
reports, and anatomical survey.

1	1	 Press the [System Preset] key and go to System > Peripheral > RS232C > COM > Transfer 
Measurement.

2	2	 From the Report screen, select Transfer on the context menu. 
When the data is being transferred, the progress bar indicating the transfer appears on the 
display.
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Measurement accuracy
The measurement values should always be accurate according to measuring caliper and point.

Despite the high technical accuracy of the scan geometry and the measuring system of the E-CUBE 
8 expert equipment, one must, however, be aware of inaccuracies caused by the ultrasound beam 
properties and the physiological properties of the scanned structures, tissues and fluids. 

For the reason of improved lateral resolution you should choose the proper scan head for the depth 
range of the structure to be measured.

Table 7-5 Measurement accuracy

Mode Measurement Accuracy 

2D

Depth ±5 % or 1 mm

Distance
	 Axial
	 Lateral (Linear)
	 Lateral (Convex)
	 Lateral (Sector)

±5 % or 1 mm
±5 % or 2 mm
±5 % or 4 mm
±5 % or 4 mm

Circumference
	 Ellipse
	 Trace

±5 % or 1 mm
±10 % or 1 mm

Area
	 2 Distance
	 Ellipse
	 Trace

±5 % or 1 mm2

±5 % or 1 mm2

±5 % or 1 mm2

M
Time ±5 % or 10 ms

Slope ±5 % or 1 mm/s

D

Velocity ±15 %

Time ±5 % or 10 ms 

Doppler SV Position ±2 mm

CF Velocity ±15 %
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Calculation accuracy

Estimate the overall inaccuracy of a combined measurement and calculation by including the stated 
inaccuracy from the basic measurement accuracy statements.

Calculation formulas and databases are provided as a tool to assist the user, but should not be 
considered an undisputed database, in making a clinical diagnosis. The user is encouraged to research 
the literature and judge the equipment capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.
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Abdomen

Abdomen measurements and calculations

2D mode measurements

2D mode measurements display in the context menu and the abdomen report with measured result, 
when assigned.

Table 7-6 2D mode measurement (Abdomen)

Measurement Description

Aorta Aorta Diameter

Renal L Renal Length

Renal Renal Volume

	 Renal L Renal Length

	 Renal H Renal Height

	 Renal W Renal Width

Renal Vol Renal Volume

Aorta Aorta

Renal A Renal Artery

Hepatic A Hepatic Artery

Portal V Portal Vein

Splenic A Splenic Artery

SMA Superior Mesenteric Artery

IMA Inferior Mesenteric Artery

Iliac A Iliac Artery

Vessel Vessel

	� Volume Flow Area Volume Flow Area

%Stenosis Stenosis

Volume Volume

A/B Ratio A/B Ratio

NOTE
To configure the 2D mode measurement, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > Abdomen > 2D > Default Measurement.
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	❚ Aorta Diameter

1	1	 Select Aorta on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the aorta diameter (Aorta) is shown on the Result window.

	❚ Renal Length

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Renal L. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the renal length (Rt or Lt Renal) is shown on the Result 
window.
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	❚ Renal Volume (1)

You can measure the length, width, and height for the left and right renal. Each measurement is a 
typical distance measurement made in appropriate scan plane.

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurement is completed, the renal volume is calculated.

5	5	 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.

	❚ Renal Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Renal Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

5	5	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

6	6	 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key.

	• To configure the renal volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Abdomen > Renal Vol > Edit.
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M mode measurements

M mode measurements display in the context menu and the abdomen report with measured result, 
when assigned.

Table 7-7 M mode measurement (Abdomen)

Measurement Description 

HR Heart Rate 

NOTE
To configure the M mode measurement, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > Abdomen > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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D mode measurements

D mode measurements are shown in the context menu and in the abdomen report with measured 
result, when assigned.

Table 7-8 D mode measurement (Abdomen)

Measurement Description

Aorta Aorta

Renal A Renal Artery

Hepatic A Hepatic Artery

IVC Inferior Vena Cava

Hepatic V Hepatic Vein

Mid HV Middle Hepatic Vein

MPV Main Portal Vein

Portal V Portal Vein

Splenic A Splenic Artery

Splenic V Splenic Vein

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

IMA Inferior Mesenteric Artery

Iliac A Iliac Artery

Iliac V Iliac Vein

Vessel Vessel

Renal V Renal Vein

HR Heart Rate

NOTE
To configure the Doppler mode measurement, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Abdomen > Doppler > Default Measurement.

To select a package measurement, 

1	1	 Select a package measurement folder.

2	2	 Select the desired measurement from the measurement list.
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In each package measurement for Doppler mode, you can use the following measurements.

	• Auto Trace

	• Semi Auto Trace

	• Manual Trace

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD)

	• S/D or D/S Ratio (S/D or D/S)

	• Pulsatility Index (PI)

	• Resistive Index (RI)

	• Maximum Time-Average Velocity (TAmax)

	• Acceleration (Accel)

	• Acceleration Time (AT)

NOTE
To configure the package measurements for D mode, press the [System Preset] key and go to Measurement 
> Labeled MEAS. > Abdomen > Doppler > Package measurement (double-click) > a default measurement.

	❚ Peak Systole, End Diastole, or Minimum Diastole (PS, ED, or MD)

1	1	 Select PS, ED, or MD on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window.

	❚ PS/ED or ED/PS Ratio

1	1	 Select S/D or D/S on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window.
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	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform, and press the [Set] key.

4	4	 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The end point is fixed, and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window.

	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the maximum values of the desired portion for the spectrum.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window.
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	❚ Acceleration (Accel)

1	1	 Select Accel on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window.

	❚ Acceleration Time (AT)

1	1	 Select AT on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points is displayed. The acceleration time (AT) is shown on 
the Result window.
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Abdomen report
The Abdomen report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27. 

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the measurement value type, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > Edit > Method.
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Obstetrics

Obstetric measurements and calculations 

2D mode measurements (OB1, OB2/3)

2D mode measurements are shown in the context menu and in the OB report with measured result, 
when assigned.

Table 7-9 2D mode measurement (OB)

Measurement Description

Fetal Biometry Fetal Biometry (Package)

	 BPD Biparietal Diameter

	 HC Head Circumference

	 AC Abdominal Circumference

	 FL Femur Length

	 Humerus Humerus Length

	 AD Abdominal Diameter

	 OFD Occipito-frontal Diameter

	 APAD Anteroposterior Abdominal Diameter

	 TAD Transverse Abdominal Diameter

	 MAD Middle Abdomen Diameter

	 FTA Fetal Trunk Cross-Sectional Area

	 APTD Antero-Posterior Trunk Diameter

	 TTD Transverse Trunk Diameter

	 ThC Thoracic Circumference

Early Gestation Early Gestation (Package)

	 CRL Crown-Rump Length

	 GS Gestation Sac Length

	 YS Yolk Sac Length

	 BPD Biparietal Diameter

	 AC Abdominal Circumference

	 FL Femur Length

	 Auto NT Nuchal Translucency Length

	 NB Nasal Bone Length

	 IT Intracranial Translucency
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Measurement Description

Fetal Long Bones Fetal Long Bones (Package)

	 Humerus Humerus Length

	 Radius Radius Length

	 Ulna Ulna Length

	 Tibia Tibia Length

	 Fibula Fibula Length

	 FL Femur Length

	 CLAV Clavicle Length

	 SL Spinal Length

Fetal Cranium Fetal Cranium (Pacakge)

	 CM Cisterna Magna

	 BOD Binocular Distance

	 Auto NT Nuchal Translucency Length

	 NB Nasal Bone Length

	 CEREB Transverse Cerebellar Diameter

	 IOD Inner Orbital Diameter

	 Va Anterior Horn Lateral Ventricular Width

	 Vp Posterior Horn Lateral Ventricular Width

	 HEM Hemisphere Width

	 CSP Cavum Septum Pellucidum

	 NF Nuchal Fold 

	 IT Intracranial Translucency

	 Lat Vent Lateral Ventricle

	 FMF angle Frontomaxillary Facial Angle

Fetal Others Fetal Others (Package)

	 Foot Foot Length

	 Ear Ear

	 Umbilical V Umbilical Vein

	 MP Middle Phalanx

	 Renal L Renal Length

	 Renal AP Renal Anterior-Posterior Diameter

	 Pelvis Pelvis
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Measurement Description

	 Cardiac Axis Cardiac Axis

	 Placenta Thick. Placenta Thickness

AFI Amniotic Fluid Index

	 Q1 Quadrant 1

	 Q2 Quadrant 2

	 Q3 Quadrant 3

	 Q4 Quadrant 4

	 MVP Maximal Vertical Pocket 

CTAR Cardio-Thoracic Area Ratio (Package)

	 ThD ap Anterior-Posterior Thoracic Diameter 

	 ThD trans Transverse Thoracic Diameter

	 HrtD ap Anterior-Posterior Heart Diameter

	 HrtD trans Transverse Heart Diameter 

	 Thorax area Thoracic Area

	 Heart area Heart Area

Maternal Others Maternal Others (Package)

	 Uterus Uterus Volume

	 Ovary Ovary Volume

	 Cervix L Cervix Length

	 Placenta Thick. Placenta Thickness

	 Fibroid Fibroid

	 Cyst Cyst

MSD Mean Gestational Sac Diameter

LL Liver Length

RL Rib Length

Scapular Scapular Length

SC Splenic Circumference

FB Fetal Bowel Diameter

OOD Outer Orbital Diameter

HA Head Area

AA Abdominal Area

Umb. A Diam. Umbilical Artery Diameter
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Measurement Description

APTD-TTD Anteroposterior Trunk Diameter & Transverse

AxT Anteroposterior Trunk Diameter multiplied Diameter

CTAR Cardiothoracic Area Ratio

Ovary Ovary Volume

	 Ovary L Ovary Length

	 Ovary H Ovary Height

	 Ovary W Ovary Width

	 Ovary Vol Ovary Volume

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > OB > 2D > Default Measurement.
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2D mode measurements (Fetal Echo)

2D mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned.

Table 7-10 2D mode measurement (Fetal echo)

Measurement Description

4 Chamber view 4 chamber view (Package)

	 Ventr. L Ventricle Length

	 Ventr. W Ventricle Width

	 Atrial L Atrial Length

	 Atrial W Atrial Width

	 Ventr. inl. Ventricle Inlet Diameter

	 Ventr. Area Ventricle Area

	 Wall Thick. Wall thickness

	 Septum Septum

	 TV orifice Tricuspid Valve Orifice

	 MV orifice Mitral Valve Orifice

Aortic Arch Aortic Arch (Package)

	 Anulus Anulus

	 Asc. aorta Diam. Ascending Aorta Diameter

	 Desc. aorta Diam. Descending Aorta Diameter

LVOT Left Ventricular Outflow Tract (Package)

	 LVOT Diam. Left Ventricular Outflow Tract Diameter

Outflow track Outflow Track (Package)

	 PA Pulmonary Artery

	 PV width Pulmonary Valve width

	 Main PA Main Pulmonary Artery

	 AV width Aortic Valve width

	 Ao. root Diam. Aortic Root Diameter

	 Ao. trunk Dim. Aortic Trunk Diameter

	 Art. duct Diam. Arterial Duct Diameter

RVOT Right Ventricular Outflow Tract (Package)

	 RVOT Diam. Right Ventricular Outflow Tract Diameter

Thorax Thorax (Package)
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Measurement Description

	 Heart diagonally Heart diagonally

	 Thorax diagonally Thorax diagonally

	 Cardiac Circum. Cardiac Circumference

	 Thoracic Circum. Thorax Circumference

	 Heart Area Heart area

	 Thorax Area Thorax area

	 Cardiac Axis Cardiac axis

Venous Venous (Package)

	 SVC Superior Vena Cava Diameter

	 IVC Inferior Vena Cava Diameter

Heart Heart (Package)

	 LA Diam. Left Atrium Diameter

	 LA L Left Atrium Length

	 LVLd-A4C Left Ventricle - Diastolic major axis Dimension - Apical four chamber

	 LVLs-A4C Left Ventricle - Systolic major axis Dimension - Apical four chamber

	 LVLd-A2C Left Ventricle - Diastolic major axis Dimension - Apical two chamber

	 LVLs-A2C Left Ventricle - Systolic major axis Dimension - Apical two chamber

	 LVOT Diam. Left Ventricle Outflow Track - Cardiovascular Orifice Diameter

	 RA Diam. Right Atrium Diameter

	 RA L Right Atrium Length

	 RVAWd Right Ventricle - Anterior Wall Diastolic Thickness

	 RV L Right Ventricle Length

	 RVDd Right Ventricle Diameter - End Diastole

	 RVDs Right Ventricle Diameter - End Systole

	 RVOT Diam. Right Ventricle Outflow Track - Cardiovascular Orifice Diameter

Teichholz Left Ventricular Dimensions by Teichholz method (Package)

	 IVSd Interventricular Septum - End Diastole

	 LVIDd Left Ventricle Internal Dimension - End Diastole

	 LVPWd Left Ventricle - Posterior Wall - End Diastole

	 IVSs Interventricular Septum - End Systole

	 LVIDs Left Ventricle Internal Dimension - End Systole

	 LVPWs Left Ventricle Posterior Wall - End Systole
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Measurement Description

CT Cardiothoracic Area Ratio (Package)

	 Cardiac Area Cardiac Area

	 Thoracic Area Thoracic Area

Arteries Arteries Package

	 Ao. arch Diam. Aortic Arch Diameter

	 Aorta Diam. Aorta Diameter

	 Asc. aorta Diam. Ascending Aorta Diameter

	 Thor. aorta Diam. Thoracic Aorta Diameter

	 Trans. ao. arch Diam. Transverse Aortic Arch Diameter

	 Duct. arch Diam. Ductal Arch Diameter

	 DA Diam. Ductus Arteriosus Diameter

	 Isthmus Isthmus

	 PA Diam. Pulmonary Artery Diameter

	 Lt. PA Diam. Pulmonary Artery Diameter - Systole - Left

	 Rt. PA Diam. Pulmonary Artery Diameter - Systole - Right

	 Umb. A Diam. Umbilical Artery Diameter

Veins Veins Package

	 SVC Diam. Superior Vena Cava Diameter

	 IVC Diam. Inferior Vena Cava Diameter

	 Lt. PV Diam. Pulmonary Vein Diameter - left

	 Rt. PV Diam. Pulmonary Vein Diameter - right

	 Umb. V Diam. Umbilical Vein Diameter

	❚ Gestational Sac (GS)

1	1	 Select GS on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point.

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the gestational sac length is shown on the Result window.
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	❚ Abdominal Circumference (AC)

1	1	 Select AC on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Move the marker to the second point using [Trackball]. The ellipse appears. 

4	4	 Press the [Set] key. The end point appears.

5	5	 Move the marker to the second point using [Trackball], and press the [Set] key again.

6	6	 The measured value is fixed, and the abdominal circumference is shown on the Result window.

NOTE
You can measure the abdominal circumference by using the trace. To change the measurement method, 
press the [System Preset] key and go to Measurement > Labeled MEAS. > OB > 2D > AC > Edit > Caliper 
Type.

	❚ Biparietal Diameter (BPD)

1	1	 Select BPD on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the biparietal diameter is shown on the Result window.

	❚ Head Circumference (HC), Occipito-frontal Diameter (OFD)

1	1	 Select HC on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point. The ellipse appears. 

4	4	 Press the [Set] key. The end point appears.

5	5	 Use [Trackball] to move the marker to the second point, and press the [Set] key again.

6	6	 The measured value is fixed. The head circumference and the occipito-frontal diameter are 
shown on the Result window.

NOTE
	• To show or hide the OFD measurement, press the [System Preset] key and go to Measurement 

> Labeled MEAS. > OB > 2D > HC > Edit. This setting is available only when you perform a HC 
measurement by using the ellipse.

	• You can measure the head circumference by using the trace. To change the measurement method, 
press the [System Preset] key and go to Measurement > Labeled MEAS. > OB > 2D > HC > Edit > 
Caliper Type.
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	❚ Amniotic Fluid Index (AFI)

To calculate the amniotic fluid index, measure the four quadrants of the uterine cavity.

1	1	 Select the AFI folder on the context menu.

2	2	 Select AFI-Q1. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key. The first quadrant is completed.

3	3	 Perform 1 distance measurement.  
The AFI sum for AFI-Q1 is automatically shown on the Result window.

4	4	 Repeat step 3 to measure the second, third, and fourth quadrant (AFI-Q2, AFI-Q3, AFI-Q4).

5	5	 The total sum of your AFI measurements is shown on the Result window.

	❚ Antero-Postero Trunk Diameter by Transverse Trunk Diameter (AxT)

1	1	 Select AxT on the context menu. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key. The antero-postero trunk diameter 
(APTD) measurement is completed.

2	2	 Perform the measurement of the transverse trunk diameter (TTD) measurement in the same 
manner (a-d).

3	3	 When two distance measurements are completed, the measured value is fixed, and the 
measured value is shown on the Result window.
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	❚ CTAR

1	1	 Select CTAR on the context menu. The start point appears.

a.	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

b.	 Use [Trackball] to move the marker to the second point. The ellipse appears. 

c.	 Press the [Set] key. The end point appears.

d.	 Use [Trackball] to move the marker to the second point and press the [Set] key again. The 
heart area (Heart Area) measurement is completed.

2	2	 Perform the thoracic area (Thorax Area) measurement in the same manner (a-d).

3	3	 When two ellipse measurements are completed, the measured value is fixed, and the measured 
value is shown on the Result window.

NOTE
The cardiothoracic area ratio measurement is available for the OB1 preset and OB2/3 presets (CTAR), and 
Fetal Echo preset (CT).

	❚ Femur Length (FL)

1	1	 Select FL on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the femur length is shown on the Result window.

	❚ Spinal Length (SL)

1	1	 Select SL on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the length of vertebrae is shown on the Result window.
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	❚ Automatic Nuchal Translucency Diameter (Auto NT)

Auto NT allows you to automatically measure the nuchal translucency thickness.

Figure 7-5 Auto NT display

To perform an Auto NT measurement,

NOTE
Automatic Nuchal Translucency is not available through the factory default. To configure the Auto NT, 
press the [System Preset] key and go to Measurement > Labeled MEAS. > OB1 or OB2/3 > 2D > select 
Auto NT and click Add.

1	1	 When examining the Nuchal Translucency Diameter, press the [Freeze] key on the control panel.

2	2	 Press the [Measure] key on the control panel.

3	3	 Select Auto NT on the context menu. The start point appears.

4	4	 Use [Trackball] to move the marker to the start point.

5	5	 To fix the point, press the [Set] key. 

6	6	 Use [Trackball] to move the marker to the end point, and press the [Set] key. 
The Nuchal Translucency Diameter is shown on the Result window.

7	7	 To complete the measurement, press the [Set] key. 
The measured value is fixed.

NOTE
	• To switch the caliper options between Auto NT and Manual, rotate the Caliper soft key.
	• To adjust the NT position, rotate the NT position soft key.
	• To adjust the method, rotate the Method soft key.
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	❚ Left Ventricle – Teichholz Method

The followings are Teichholz measurements:

	• Teichholz – IVSd, LVIDd, LVPWd, IVSs, LVIDs, LVPWs

1	1	 Select the Teichholz folder on the context menu.

2	2	 Select a Teichholz measurement on the context menu. The start point appears.

a.	 Use [Trackball] to move the start point to the interventricular septum. 

b.	 To fix the point, press the [Set] key. 

c.	 As you move [Trackball], the second point and a straight line appear on the display. 

d.	 Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed.

3	3	 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d).

4	4	 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window.

NOTE
When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement.



Obstetrics 7-55

2D mode calculations (OB1, OB2/3)

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-11 2D mode calculations (OB)

Calculation label Description Required measurements 

EFW Estimated Fetal Weight The required measurements vary depending 
on the selected authors.

EFW GP Estimated Fetal Weight - Growth Percentile The values vary depending on the selected 
authors.

GA Gestational ages by last menstrual period Calculation from the LMP data

EDD Estimated date of delivery by last menstrual 
period Determined by LMP data

U/S GA Gestational ages by ultrasound Determined from all Fetal Age 
measurements and calculations

U/S EDD Estimated date of delivery by ultrasound Determined from all ultrasound 
measurements and calculations

CI Cephalic Index BPD
OFD

HC/AC Ratio of Head Circumference to Abdominal 
Circumference

HC
AC

FL/BPD Ratio of Femur Length to Biparietal 
Diameter

FL
BPD

FL/AC Ratio of Femur Length to Abdominal 
Circumference

FL
AC

FL/HC Ratio of Femur Length to Head 
Circumference

FL
HC
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2D mode calculations (Fetal Echo)

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-12 2D mode calculations (Fetal echo) 

Calculation Label Description Required

Teichholz

	 EDV End Diastolic Volume LVIDd

	 ESV End Systolic Volume LVIDs

	 SV Stroke Volume EDV, ESV

	 EF Ejection Fraction EDV, ESV

	 LV FS Fractional Shortening LVIDd, LVIDs

	 CT Cardiothoracic Area Ratio Cardiac Area, Thoracic Area

Thorax Thorax

	 CTR Cardio-Thoracic Ratio Heart diagonally, Thorax diagonally

	 CTCR Cardio-Thoracic Circumference Ratio Cardiac Circum., Thoracic Circum.

	 CTAR Cardio-Thoracic Area Ratio Heart area, Thorax Area

Define as:

	• Teichholz Method

EDV= 7x(LVIDd³) / (2.4 + LVIDd)

ESV= 7x(LVIDs³) / (2.4 + LVIDs)

SV= EDV – ESV

EF= (EDV - ESV) / EDV

FS= (LVIDd - LVIDs) / LVIDd

	• EFW Authors 

Campbell	 (AC)

Hadlock	 (AC, BPD)

Hadlock 1	 (AC, FL)

Hadlock 2	 (BPD, AC, FL)

Hadlock 3	 (HC, AC, FL)

Hadlock 4	 (BPD, HC, AC, FL)

Hansmann	 (BPD, TTD)

Merz	 (AC, BPD)



Obstetrics 7-57

Osaka	 (BPD, FTA, FL)

Persson	 (BPD, MAD, FL)

Schild 	 (HC, AC, FL)

Shepard	 (AC, BPD)

Shinozuka 1	 (BPD, APTD, TTD, FL)

Shinozuka 2	 (BPD, FL, AC)

Shinozuka 3	 (BPD, APTD, TTD, SL)

Tokyo	 (BPD, APTD, TTD, FL)

NOTE
	• To change the default EFW author, press the [System Preset] key and go to Measurement > OB MEAS. 

> EFW Formula. 
	• If a measurement of EFW formula is not shown on the context menu, the EFW formula setting may not 

be affected. This setting is only available when you set the measurement for EFW formula as default.
	• To add a measurement in the EFW formula as default, press the [System Preset] key and go to 

Measurement > Labeled MEAS. > OB > Add measurement (Insert).

	❚ Estimated Fetal Weight (EFW)

1	1	 To measure estimated fetal weight, perform several OB measurements first.

2	2	 EFW based on the measured values is calculated and the result is shown.

NOTE
The EFW calculation method (author) is selected from the EFW formula.

3	3	 Perform the measurements required for EFW.  
When the measurements are completed, the EFW is automatically calculated. 

4	4	 The each measurement and the estimated fetal weight are shown on the Result window.

NOTE
EFW is not calculated and shown if the selected measurement is not performed.

	❚ Composite Gestational ages (GA) and estimated date of delivery (EDD) by ultrasound

When you perform the OB measurement, GA and EDD are calculated based on the measured values.

NOTE
To show or hide GA and EDD, press the [System Preset] key and go to Measurement > Labeled MEAS. > 
OB > 2D > Edit.
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M mode measurements (OB1, OB2/3)

M mode measurements are shown in the context menu and in the OB report with measured result, 
when assigned.

Table 7-13 M mode measurement (OB)

Measurement Description

Generic Generic (Package)

	 Dist Distance

	 Slope Slope

	 Time Time

	 HR Heart Rate

	 %Steno(Dist) Two Distances Percent Stenosis

FHR Fetal Heart Rate (Package)

	 FHR Fetal Heart Rate

	 Atrial FHR Atrial Fetal Heart Rate

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > OB > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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M mode measurements (Fetal Echo)

M mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned.

Table 7-14 M mode measurement (Fetal echo)

Measurement Description

4 Chamber view 4-Chamber-view (Package)

	 Ventr. Dim. Ventricle Dimension

	 Ventr. wall Ventricle Wall

	 Atr. Dim. Atrium Dimension

	 Septum Septum Dimension

	 Biventric. inner Biventricle inner Dimension

	 Biventric. outer Biventricle outer Dimension

	 MV open exc. Mitral Valve Open

	 TV open exc. Tricuspid Value Open

Outflow track Outflow Track (Package)

	 AV Diam. Aortic Valve Diameter

	 PV Diam. Pulmonary Valve Diameter

FHR Fetal Heart Rate (Package)

	 FHR Fetal Heart Rate

	 Atrial FHR Atrial Fetal Heart Rate

Heart Left Heart Package (Package)

	 LA Diam. Left Atrium Diameter

	 AO Diam. Aorta Diameter - Systole

	 LVET Left Ventricle Ejection Time

	 DE Amp Slope D-E wave Amplitude and Slope

	 EF Slope E-F wave Slope

	 RADs Right Atrium Diameter - Systole

	 RADd Right Atrium Diameter - Diastole

	 RVAWd Right Ventricle Anterior Wall Diameter - Diastole

	 RVAWs Right Ventricle Anterior Wall Diameter - Systole

	 RV Diam. Right Ventricle Diameter

	 PA Diam. Pulmonary Artery Diameter

	 RVET Right Ventricle Ejection Time
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Measurement Description

Teichholz Left Ventricular Dimensions by Teichholz method (Package)

	 IVSd Interventricular Septum - End Diastole

	 LVIDd Left Ventricle Internal Dimension - End Diastole

	 LVPWd Left Ventricle - Posterior Wall - End Diastole

	 IVSs Interventricular Septum - End Systole

	 LVIDs Left Ventricle Internal Dimension - End Systole

	 LVPWs Left Ventricle Posterior Wall - End Systole

	❚ Diameter

The followings are distance measurements:

	• Heart – LA Diam., AO Diam., RADs, RADd, RVAWd, RVAWs, RV Diam., PA Diam.

1	1	 Select the Heart folder on the context menu.

2	2	 Select a distance measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 The measured value is fixed, and the distance measurement is shown on the Result window.

	❚ Time

The followings are time measurements:

	• Heart – LVET, RVET

1	1	 Select the Heart folder on the context menu.

2	2	 Select a time measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 The time interval between the two points appears. The time measurement is shown on the 
Result window.
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	❚ Slope

The followings are distance measurements:

	• Heart – DE Amp Slope, EF Slope

1	1	 Select the Heart folder on the context menu.

2	2	 Select DE Amp Slope or EF Slope. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 When the oblique line appears, the slope is calculated, and the slope measurement is shown on 
the Result window.

	❚ Fetal Heart Rate 

1	1	 Select the FHR folder on the context menu.

2	2	 Select FHR. The start point appears.  
The vertical line and the horizontal line are perpendicular to each other.

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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	❚ Left Ventricle – Teichholz Method

The followings are Teichholz measurements:

	• Teichholz – IVSd, LVIDd, LVPWd, IVSs, LVIDs, LVPWs

1	1	 Select the Teichholz folder on the context menu.

2	2	 Select a Teichholz measurement on the context menu. The start point appears.

a.	 Move the start point to the interventricular septum by using the [Trackball]. 

b.	 To fix the point, press the [Set] key. 

c.	 As you move [Trackball], the second point and straight line appear on the display.

d.	 Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed.

3	3	 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d).

4	4	 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window.

NOTE
When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement.
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M mode calculations

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-15 M mode calculations (Fetal echo)

Calculation Label Description Required

Teichholz

	 EDV End Diastolic Volume LVIDd

	 ESV End Systolic Volume LVIDs

	 SV Stroke Volume EDV, ESV

	 EF Ejection Fraction EDV, ESV

	 FS Fractional Shortening LVIDd, LVIDs

Define as:

	• Teichholz Method

EDV= 7x(LVIDd³) / (2.4 + LVIDd)

ESV= 7x(LVIDs³) / (2.4 + LVIDs)

SV= EDV – ESV

EF= (EDV - ESV) / EDV

FS= (LVIDd - LVIDs) / LVIDd
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D mode measurements (OB1, OB2/3)

D mode measurements are shown in the context menu and in the OB report with measured result, when 
assigned.

Table 7-16 D mode measurement (OB) 

Measurement Description

Aorta Aorta

Carotid Carotid Artery

MCA Middle Cerebral Artery

Umbilical A Umbilical Artery

Uterine A Uterine Artery

SMA Superior Mesenteric Artery

Celiac A Celiac Artery

	 Auto Trace Auto Trace

	 Manual Trace Manual Trace

	 PS Peak Systole (PS) Velocity

	 ED End Diastole (ED) Velocity

	 S/D S/D Ratio

	 RI Resistive Index (RI)

	 PI Pulsatility Index (PI)

	 HR Heart Rate

Ductus Ven Ductus Venosus

IVC Inferior Vena Cava 

	 Manual Trace Manual Trace

	 S Ventricular Systole

	 D Early Ventricular Diastole

	 a Atrial Contraction

	 S.a.PLI Preload Index

	 PI Pulsatility Index

	 PVIV Peak Velocity Index for Veins

	 HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > OB > Doppler > Default Measurement.
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To select a package measurement, 

1	1	 Select a package measurement folder. 

2	2	 Select a desired measurement from the measurement list.

In each Doppler package measurement, you can make the following measurements:

	• Auto Trace

	• Semi Auto Trace

	• Manual Trace

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD) 

	• S/D or D/S Ratio (S/D or D/S)

	• Pulsatility Index (PI) 

	• Resistive Index (RI) 

	• Maximum Time-Average Velocity (TAmax)

	• Acceleration (Accel)

	• Acceleration Time (AT)

NOTE
To configure the default measurement for each package measurement, press the [System Preset] key and 
go to Measurement > Labeled MEAS. > OB >Doppler > a package measurement (double-click) > a default 
measurement.

	❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD)

1	1	 Select PS, ED, or MD on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window.

	❚ PS/ED or ED/PS Ratio

1	1	 Select S/D or D/S on the context menu. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the start point (S or D) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D or S) of the ratio using [Trackball], and cpress the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S)  are shown on 
the Result window.
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	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The pulsatility index is calculated and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 When the end point is fixed, the resistive index is calculated and the resistivity index (RI) is 
shown on the Result window.

	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the maximum value of the desired portion for the spectrum.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated, and the maximum time-average (TAmax) is shown on 
the Result window.

	❚ Acceleration (Accel)

1	1	 Select Accel on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and then press the [Set] key again.

4	4	 When the oblique line appears, the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window.
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	❚ Acceleration Time (AT)

1	1	 Select AT on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window.

D mode measurements (Fetal Echo)

D mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned.

Table 7-17 D mode measurement (Fetal echo)

Measurement Description

Tricuspid Valve Tricuspid Valve

	 E-Wave E-Wave ( Early Filling ) Velocity

	 A-Wave A-Wave ( Atrial Contraction ) Velocity

	 Vmax regurg. Maximum Velocity of Regurgitant Flow

Mitral Valve Mitral Valve

	 E-Wave E-Wave ( Early Filling ) Velocity

	 A-Wave A-Wave ( Atrial Contraction ) Velocity

	 Vmax regurg. Maximum Velocity of Regurgitant Flow

	 IVRT Isovolumic Relaxation Time

Main Pulmonary A Main Pulmonary Artery

	 Manual Trace Manual Trace

	 Vmax Maximum Velocity

	 TPV Time to Peak Velocity

Aorta Aorta

	 Manual Trace Manual Trace 

	 Manual Trace Aol Aortic Isthmus(Aol) Manual Trace 

	 Vmax Maximum Velocity

	 TPV Time to Peak Velocity

	 Vmax AoI Aortic Isthmus(Aol) Maximal Velocity 

Ductus Art. Ductus Arteriosus

	 Auto Trace Auto Trace
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Measurement Description

	 Manual Trace Manual Trace

	 PS Peak Systole (PS)

	 RI Resistive Index (RI)

	 PS,ED RI,SD PS,ED RI,SD

	 ED End Diastole (ED)

	 PI Pulsatility Index (PI)

	 TPV Time to Peak Velocity

	 HR Heart Rate

Umbilical V Umbilical Vein

	 TAmax Maximum Time-Average Velocity

Ductus Ven. Ductus Venosus

	 Manual Trace Manual Trace 

	 S Ventricular Systole Velocity

	 D Early Ventricular Diastole Velocity

	 a Atrial Contraction Velocity

	 S.a.PLI Preload Index

	 PI Pulsatility Index

	 PVIV Peak Velocity Index for Veins

	 HR Heart Rate

Pulmonary Valve Pulmonary Valve

	 Manual Trace Manual Trace 

	 Vmax Maximum Velocity

	 TPV Time to Peak Velocity

	 Acc. Time Acceleration Time

	 Eject. Time Ejection Time

Aortic Valve Aortic Valve

	 Manual Trace Manual Trace 

	 Vmax Maximum Velocity

	 TPV Time to Peak Velocity

	 Acc. Time Acceleration Time

	 PR interval P-R interval Time

	 Eject. Time Ejection Time



Obstetrics 7-69

Measurement Description

FHR Fetal Heart Rate

	 FHR Fetal Heart Rate

LVOT Left Ventricular Outflow Tract

	 Manual Trace Manual Trace 

	 Vmax Maximum Velocity

	 PR interval P-R interval Time

	 ICT  Isovolumic Contraction Time

	 Eject. Time Ejection Time

	 IRT Isovolumic Relaxation Time

RVOT Right Ventricular Outflow Tract 

	 Manual Trace Manual Trace 

	 Vmax Maximum Velocity

	 ICT Isovolumic Contraction Time

	 Eject. Time Ejection Time

	 IRT Isovolumic Relaxation Time

Pulmonary Vein Pulmonary Vein

	 Vd Diastolic Velocity

	 Vs Systolic Velocity

	 A Rev.V Atrial Reversal flow velocity

	 A Rev.Dur Duration of Atrial Reversal flow velocity

Valves Valves Package

	 MV E pt Mitral Valve E point Velocity

	 MV A pt Mitral Valve A point Velocity

	 AV Vmax Aortic Valve Peak Velocity

	 PV Vmax Pulmonary Valve Peak Velocity

	 FO Foramen Ovale Velocity

Ventricles Ventricles

	 IVCT Isovolumetric Contraction Time

	 LVET Left Ventricle Ejection Time

	 IVRT Isovolumetric Relaxation Time

	 RVET Right Ventricle Ejection Time

Arteries Arteries Package
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Measurement Description

	 Asc. aorta Vmax Ascending Aorta Velocity

	 Thor. aorta Vmax Thoracic Aorta Velocity

	 Trans. ao. arch Vmax Transversal Aortic Arch Velocity

	 DA Vmax Ductus Arteriosus Velocity

	 PA Vmax Pulmonary Artery Velocity

	 Umb. A Vmax Umbilical Artery Velocity

Veins Veins Package

	 SVC Vmax Superior Vena Cava Velocity

	 IVC Vmax Inferior Vena Cava Velocity

	 Lt. PV Vmax Pulmonary Vein left Velocity

	 Rt. PV Vmax Pulmonary Vein right Velocity

	 Umb. V Vmax Umbilical Vein Velocity

	❚ Velocity

The followings are velocity measurements:

	• Valves – MV E pt, MV A pt, AV Vmax, PV Vmax, FO

	• Arteries – Asc. aorta Vmax, Thor. aorta Vmax, Trans. ao. arch Vmax, DA Vmax, PA Vmax, Umb. A 
Vmax

	• Veins – SVC Vmax, IVC Vmax, Lt. PV Vmax, Rt. PV Vmax, Umb. V Vmax

1	1	 Select a velocity measurement on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The measured value is fixed, and the velocity is shown on the Result window.

	❚ Time

The followings are time measurements:

	• Ventricles – IVCT, LVET, IVRT, RVET

1	1	 Select a time measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears and the time measurement is shown on the 
Result window.
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D mode calculations

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-18 D mode calculations 

Calculation label Description Required measurements 

E/A Mitral Valve E point /A point Ratio MV E pt
MV A pt

TEI-I TEI Index
(Index of Myocardial Performance 
of Left Ventricle)

IVCT
IVRT
LVET

Define as:

TEI-I = (IVCT+IVRT)/LVET
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OB report
To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

Report functions

–	 See "Report" on page 7-27 for more information. 

–	 To select CUA or AUA for gestational age, rotate the Select AUA/CUA soft key.

NOTE
To configure the default ultrasound age type, press the [System Preset] key and go to Measurement > OB 
MEAS. > Default US Age Type(Hadlock) > AUA or CUA.

–	 To select the fetus A, B, C, or D, rotate the Fetus A soft key. This function is for a multi-gestational 
patient. 

The OB report has three sections of information:

	• Patient information

	• Measurement information

	• Calculation information

Patient information

	• ID

	• Name

	• Age

	• Exam date 

	• Referring MD

	• LMP or IVF

	• GA(LMP) or GA(IVF), EDD(LMP) or EDD(IVF)

	• Determined from LMP or IVF data

	• GA(AUA) or GA(CUA), EDD(AUA) or EDD(CUA): If this field is checked, the system uses the 
measurement to calculate the ultrasound age. 

–	 AUA: Average Ultrasound age, regression calculation

–	 CUA: Composite Ultrasound age, an arithmetric average

	• Fetus: For a multi-gestational patient, select a fetus (A, B, C, D) in this field.

NOTE
To edit the patient information, go to Patient Registration. 
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Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–3rd: The three measurement values for each item are available. If you make more than three 
measurements, the report uses the last three.

	• GA: GA is calculated based on the measured values for the fetus. “##” appears when any of the 
values is out of range.

	• GP: The growth percentile of each measurement. The GP value is calculated by selecting LMP and 
AUA. 

	• Range: The typical range of fetal age for this measurement.

NOTE
The GA range may not be shown when the range of OB reference (author) is set to none (unavailable).

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method. 

Calculation information

	• EFW: Show the parameters used to calculate EFW. This is followed by the calculation result.

	• EFW GP: Show the source used to calculate EFW GP. This is followed by the growth percentile. When 
you enter LMP, you can check the EFW GP value and reference (Hadlock, Brenner, Williams, Pittaluga).

	• Ratio: The remaining calculation information shows ratios for several measurements.

	• CI (Cephalic index): The value calculated by measuring BPD and OFD is displayed.

–	 AC/HC 

–	 FL/BPD

–	 FL/HC

–	 FL/AC

	• EFW Range: The GP value is calculated by selecting LMP and AUA.
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Fetal heart report
To view a report, 

1	1	 Select a package measurement folder.

2	2	 Select a desired package measurement.

NOTE

If any measurement is performed, it is shown as a check mark ( ) next to the package measurement.

3	3	 When the labeled measurements appear, you can create, edit, or delete values in a cell. You can 
also change the method item.

The fetal heart report has two sections of information:

	• Patient information

	• Measurement information

Patient information

The patient information about the fetal heart report is the same as the OB report. See "Patient 
information" on page 7-72.

Patient information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To set the selected method as default, press the Save As Default soft key. To set a method to be used for all 
measurements in the current measurement preset, press the Factory Default soft key.
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OB graph
The OB graph shows curve graphs and bar graphs that indicate predicate fetal growth patterns according 
to the selected reference (author) for a measurement or calculation.

OB graph allows you to access the fetal growth curve compared to a normal growth curve. When a 
patient has completed data from the previous studies, you can use the graph to look at fetal trending.

For multi-gestational patients, you can compare the growth on the graphs.

Fetal growth – references

Table 7-19 Fetal growth (reference)

Display item name Description Reference (Author) name

EFW Estimated Fetal Weight

Brenner, Doubilet, Hadlock, Hansmann, 
Hansmann 86, Hobbins/Persutte, 
JSUM2001, Osaka, Persson
Tokyo/Shinozuka, Tokyo, Williams, Yarkoni, 
Kiserud, EIK-NE2007, Marsal, Pittaluga

AC Abdominal Circumference

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, JSUM, Kurmanavicius, Lessoway, 
Merz, Nicolaides, Shinozuka, Tokyo, 
Kiserud, Verburg

AFI Amniotic Fluid Index Moore

APAD Anteroposterior Abdominal Diameter Merz

APTD Anteroposterior Trunk Diameter Hansmann

AxT Anteroposterior Trunk Diameter multiplied by 
Transverse Trunk Diameter Shinozuka, Tokyo

BOD Binocular Distance Jeanty

BPD Biparietal Diameter

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, JSUM, Kurmanavicius, Lessoway, 
Marsal, Merz, Nicolaides, Osaka, 
Sabbagha, Shinozuka, Tokyo, EIK-NES 
2007, Kiserud, Verburg

CLAV Clavicle Length Yarkoni

CM Cisterna Magna Nicolaides

CRL Crown-Rump Length ASUM, Hadlock, Hansmann, JSUM, Marsal, 
Osaka, Robinson, Shinozuka, Tokyo

FL Femur Length

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, JSUM, Kurmanavicius, Lessoway, 
Marsal, Merz, Nicolaides, O’Brien, Osaka, 
Shinozuka, Tokyo, Warda, EIK-NES 2007, 
Kiserud, Verburg

FTA Fetal Trunk Cross-Sectional Area Osaka

Fibula Fibula Length Jeanty
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Display item name Description Reference (Author) name

GS Gestation Sac Length Hellman, Rempen

HC Head Circumference
ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, Kurmanavicius, Lessoway, Merz, 
Nicolaides, Kiserud, Verburg

Humerus Humerus Length ASUM, Jeanty, Merz, Osaka

SL Spinal Length Tokyo

MCA PI Middle Cerebral Artery Pulsatility Index Bahlman, JSUM, Schaffer

MCA PS Middle Cerebral Artery Peak Systole Velocity Mari

MCA RI Middle Cerebral Artery Resistive Index Bahlman, JSUM, Schaffer

MAD Middle Abdomen Diameter EIK-NES, Kurmanavicius, EIK-NES 2007, 
Kiserud

MSD Mean Gestational Sac Diameter Hellman, Rempen

OFD Occipito-frontal Diameter ASUM, Hansmann, Jeanty, Kurmanavicius, 
Merz, Nicolaides

Radius Radius Length Jeanty, Merz

TAD Transverse Abdominal Diameter CFEF, Merz

CEREB Transverse Cerebellar Diameter GoldStein, Hill, Nicolaides, Verburg

Tibia Tibia Length Jeanty, Merz

TTD Transverse Trunk Diameter Hansmann

Ulna Ulna Length Jeanty, Merz

UmbArt PI Umbilical Artery Pulsatility Index JSUM, Merz, Schaffer

UmbArt RI Umbilical Artery Resistive Index JSUM, Kurmanavicius, Merz, Schaffer

AO PI Aorta Pulsatility Index Schaffer

AO RI Aorta Resistive Index Schaffer

Uterine A PI Uterine Artery Pulsatility Index Schaffer

Uterine A RI Uterine Arte Resistive Index Schaffer

CI Cephalic Index Hadlock

HC/AC HC and AC ratio Ratio of Head Circumference 
to Abdominal Circumference Campbell

FL/BPD Ratio of Femur Length to Biparietal Diameter Hohler, Kiserud

FL/AC Ratio of Femur Length to Abdominal 
Circumference Hadlock

FL/HC Ratio of Femur Length to Head Circumference Hadlock
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Fetal growth curve graphs

To start a curve graph,

–	 Select Graph on the context menu.

–	 While viewing the OB report, select Graph on the context menu.

To view a curve graph,

Figure 7-6 Curve graph

	• The horizontal axis shows the fetal age in weeks. This age is determined by the entry data on the 
Patient Registration. The vertical axis shows one of the followings:

–	 For measurements: mm or cm

–	 For ratios: percent

–	 For fetal weight: gram

	• The fetal growth graph shows the following information for the selected measurement:

–	 The normal fetal growth curve

–	 The standard deviations or relevant percentiles

–	 The gestational age of the fetus, using patient data and ultrasound age (vertical dotted line)

–	 The current ultrasound measurement data, where the fetus is on the growth curve (symbol)

	• On the left of the fetal growth graph, the following additional information appears:

–	 GA(AUA) or GA(CUA): The system allows you to use the composite ultrasound age (CUA) or 
average ultrasound age (AUA). Rotate the Select AUA/CUA soft key to select a gestational age.

–	 GA(LMP) or GA(IVF): This data is determined by the LMP (or IVF) data on the Patient Registration.

–	 GA: This data is calculated based on the measured values for the fetus.
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To select a measurement,

1	1	 The system shows a list of fetal growth measurements.

2	2	 The graph list is shown by the order of measurements you performed recently. The check mark ( ) 
is shown next to the measurement that has measured values.

3	3	 To select a specific measurement, use [Trackball] to move to the measurement field and press the 
[Set] key.

4	4	 To scroll through all fetal growth curve graphs, rotate the Select Graph soft key.

To change the reference author, 

1	1	 Use [Trackball] to move the cursor to the reference, and press the [Set] key. 

2	2	 Select a reference from the drop-down list, and press the [Set] key again.

To view fetus trending on graphs, 

	• The system automatically finds the data based on the previous studies.

	• When you select the History check box, the previous and current data are shown on the graph. The 
previous data is shown as the same symbol with the current data. You can check the fetal trend on 
the graph.

To view multiple fetuses data on graphs,

	• You can view multiple gestational data on fetal growth curve graphs.

	• When you select the Compare check box, the multiple gestational data is shown on the current 
graph.

	• You can specify the maximum of four fetuses (A, B, C, or D). The specified fetuses are shown as 
different symbols and colors.

NOTE
To configure the fetus number, go to Patient Registration > OB exam information > Fetus #. 

To view a quad graph,

You can view four graphs at the same page. Press the Quad soft key. The measured values and references 
are shown at the left of the graph.

To change each graph in the quad view, 

1	1	 Use [Trackball] to move the cursor to the change graph icon ( ), and press the [Set] key. 

2	2	 Select a measurement from the measurement list, and press the [Set] key. The graph is changed.
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Fetal growth bar graphs

To start a bar graph,

–	 While viewing the OB graph, press the Bar soft key.

To view a curve graph,

–	 The horizontal axis shows the gestational weeks.

–	 The blue vertical line shows the gestational age (GA) by the LMP data.

–	 The blue dotted vertical line shows the CUA (or AUA) by the current measured values. 

–	 To select a gestational age, rotate the Select AUA/CUA soft key.

–	 The yellow symbol mark (+) shows the ultrasound GA for each measurement.

–	 The blue rectangle shows the normal age range for the measurement.

NOTE
You cannot view the fetal trending or multiple fetus data on the bar graph.
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Anatomical survey
To start the anatomical survey,

–	 While viewing the OB report, select Anatomical Survey on the touch screen.

NOTE
The patient specific contents input on the Anatomical Survey page are returned to the factory default 
settings after starting a new patient.

Anatomical survey lists

Table 7-20 Anatomical survey lists

List Descriptive data Options

Head
Lateral Ventricle, Cerebellum
Cist. magma, Orbits, Face, Nose / Lips, 
Palate, NT

(Blank), Normal

Heart
4-Chamber, LVOT, RVOT, 3-Vessel, 
Aortic Arch, Cardiac Axis, Cardiac 
Rhythm 

(Blank), Normal

Spine C-Spine, T-Spine, L-Spine, Sacrum (Blank), Normal

Chest Diaphragm, Lungs (Blank), Normal

Abdomen Abdominal Wall, Stomach, Kidneys, 
Bladder, Cord Insertion, Genitalia (Blank), Normal

Limbs Arms, Legs, Hands, Feet (Blank), Normal

Description

Fetal Position Vertex, Breech, Transverse

Placenta Location Anterior, Posterior, Fundal, Lateral, Previa

Placenta Grade 0, 1, 2, 3

Umbilical Cord Normal, 2-vessel, Nuchal Cord

Amniotic Fluid Normal, Oligohydramnios, Polyhydramnios

Biophysical profile

Fetal Movements 0, 1, 2

Fetal Breathing 0, 1, 2

Fetal Tone 0, 1, 2

Reactive NST (Reactive non-stress test) 0, 1, 2

Amniotic Fluid 0, 1, 2

Score The system totals five data to calculate a 
score for the biophysical profile.

Diagnosis Free Text (Blank)
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	• To set all values in the list as default, select Default.

	• To clear all values in the list, select Clear.

	• To edit the lists in anatomical survey, use [Trackball] to move the cursor to the descriptive data field 
and press the [Set] key. The data field is highlighted, and you can enter the anatomy name.

	• To save the data as default, press the Save As Default soft key.

	• To set the anatomical survey list as default, press the Factory Default soft key.

	• To clear all input data in the option fields, press the Clear All soft key.

Fetus compare

You can compare between fetuses by viewing measurement and calculation values. While viewing the 
OB report, select Fetus Compare on the touch screen. The measurement and calculation values for each 
fetus are shown on the display.
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Gynecology

Gynecology measurements and calculations

2D mode measurements

2D mode measurements are shown in the context menu and in the GYN report with measured result, 
when assigned.

Table 7-21 2D mode measurement (GYN) 

Measurement Description

Endo Thick. Endometrium Thickness

Cervix L Cervix Length

Follicle Follicle Volume

	 Follicle # 1–30 Measurements of the left and right ovarian follicle

Uterus Uterus Volume

	 Uterus L Uterus Length

	 Uterus H Uterus Height

	 Uterus W Uterus Width

Ovary Ovary Volume

	 Ovary L Ovary Length

	 Ovary H Ovary Height

	 Ovary W Ovary Width

Bladder Bladder Volume

	 Bladder L Bladder Length

	 Bladder H Bladder Height

	 Bladder W Bladder Width

Uterus Vol Uterus Volume

Ovary Vol Ovary Volume

Bladder Vol Bladder Volume

Fibroid Follicle Volume

	 Fibroid # 1–15 Measurements of the left and right ovarian follicle

Pelvic Floor Pelvic Floor

	� Detrusor wall thick. Detrusor wall thickness

	 Urethral rotation Urethral rotation

	 Uterine desc.max Uterine descent max
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Measurement Description

	 Re.amp.desc.max Rectal ampulla descent max

	 Rectocele depth Bladder neck descent

	 Bladder neck rest Bladder neck rest

	� Bladder neck stress Bladder neck stress

	 Bladder desc.max Bladder descent max

	 Levator hiat.stress Levator hiatus stress

	 Residual urine Residual urine

Uterine A Uterine Artery

	 Uterine A Diam. Uterine Artery Diameter

	� Volume Flow Area Volume Flow Area

Ovarian A Ovarian Artery

	� Volume Flow Area Volume Flow Area

NOTE
To configure the 2D mode measurements, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > GYN > 2D > Default Measurement.

	❚ Endometrium Thickness

1	1	 Select Endo Thick. on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key.  
The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the endometrium thickness (Endo Thick.) is shown on the 
Result window.
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	❚ Follicle Volume 

You can make the ovary follicle volume from one, two, or three distance measurements.

1 Distance Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Follicle folder. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window.

2 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Follicle folder. The start point appears.

a.	 Move the marker to the start point using [Trackball].

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Move the marker to the end point using [Trackball].

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second distance in the same manner (a-d).

4	4	 When the second distances are measured, press the [Set] key.

5	5	 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window.
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3 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Follicle folder. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d). 
When three distances are measured, the volume is calculated.

4	4	 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key.

	• To configure the follicle volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Follicle > Edit.

	❚ Ovary Volume (1)

You can measure the length, width, and height for the left and right ovaries. Each measurement is a 
typical distance measurement made in appropriate scan plane.

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Ovary folder, and then select Ovary L, Ovary W, or Ovary H. The start point appears.

a.	 Use [Trackball] to move the marker to the start point.

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 After completing the length, width, and height measurement, the ovary volume is calculated.

5	5	 The measured value is fixed, and the ovary volume (Rt or Lt Ovary Vol) is shown on the Result 
window.
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	❚ Ovary Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Ovary Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 

4	4	 The first point is fixed, and the second point appears.

5	5	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

6	6	 Measure the second and third distances in the same manner.

7	7	 When three distances are measured, the volume is calculated.

8	8	 The measured value is fixed, and the ovary volume (Rt or Lt Ovary Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key.

	• To configure the ovary volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Ovary Vol > Edit.
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M mode measurements

M mode measurements display in the context menu and the GYN report with measured result, when 
assigned.

Table 7-22 M mode measurement (GYN)

Measurement Description

Ovarian Ovarian (Package)

	 Time Time

	 Vessel Diam. Vessel Diameter

	 %Steno(Dist) Two Distances Percent Stenosis

	 HR Heart Rate

Uterine Uterine (Package)

	 Time Time

	 Vessel Diam. Vessel Diameter

	 %Steno(Dist) Two Distances Percent Stenosis

	 HR Heart Rate

FHR Fetal Heart Rate (Package)

	 FHR Fetal Heart Rate

	 Atrial FHR Atrial Fetal Heart Rate

NOTE
To configure the M mode measurement, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > GYN > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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D mode measurements 

D mode measurements are shown in the context menu and in the GYN report with measured result, 
when assigned.

Table 7-23 D mode measurement (GYN) 

Measurement Description

Aorta Aorta

Umbilical A Umbilical Artery

Placenta Placenta

Des. aorta Descending Aorta

Uterine A Uterine Artery

Ovarian A Ovarian Artery

MCA Middle Cerebral Artery

Vessel Vessel

FHR Fetal Heart Rate

HR Heart Rate

NOTE
To configure the D mode measurement, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > GYN > Doppler > Default Measurement.

To select a package measurement, 

1	1	 Select a package measurement folder. 

2	2	 Select a desired measurement from the measurement list.

In each package measurement for Doppler mode, you can use the following measurements:

	• Auto Trace

	• Semi Auto Trace

	• Manual Trace

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD)

	• S/D or D/S Ratio (S/D or D/S)

	• Pulsatility Index (PI)

	• Resistive Index (RI)

	• Maximum Time-Average Velocity (TAmax)

	• Acceleration (Accel)

	• Acceleration Time (AT)
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NOTE
To configure the default package measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > GYN > Doppler > Package measurement > a default measurement. 

	❚ Peak Systole, End Diastole, or Minimum Diastole (PS, ED, or MD)

1	1	 Select PS, ED, or MD on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window.

	❚ PS/ED or ED/PS Ratio

1	1	 Select S/D or D/S on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window.

	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform, and press the [Set] key.

4	4	 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The end point is fixed and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window.
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	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the maximum values of the desired portion for the spectrum.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window.

	❚ Acceleration (Accel)

1	1	 Select Accel on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window.

	❚ Acceleration Time (AT)

1	1	 Select AT on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points is displayed. The acceleration time (AT) is shown on 
the Result window.
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GYN / Follicle report
The GYN and Follicle report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Exam date 

	• Referring MD

	• LMP

	• Day of Cycle

	• Gravida

	• Para

	• Expected Ovul

	• Ectopics

	• Aborta

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method.
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Cardiology

Cardiology measurements and calculations

2D mode measurements

2D mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned.

Table 7-24 2D mode measurement (Cardiology)

Measurement Description

Ao/LA Aortic Valve/Left Atrium Package

	 RV Dm Right Ventricle Diameter

	 Ao Dm Aortic Diameter

	 LA Dm Left Atrium Diameter

	 ACS Aortic Valve Cusp Separation

LA Vol(Diam) Left Atrium Package

	 LA Dm ant-post Left Atrium Anterior-Posterior Left Atrium Diameter

	 LA Dm sup-inf Left Atrium Superior-inferior Left Atrium Diameter

	 LA Dm med-lat Left Atrium Mid– lateral Left Atrium Diameter

Aorta Diam Aorta Package

	 Ao SV Dm Aorta - Sinus of Valsalva Diameter

	 Ao ST Dm Aorta – Sino-tubular junction Diameter

	 Ao ASC Dm Aorta – Ascending Diameter

	 Ao Arch Dm Aorta – Arch Diameter

	 Ao Desc Dm Aorta – Descending Diameter

	 Ao Ring Dm Aorta – Annulus Diameter

Pul.Diam Pulmonary Artety Package

	 MPA Main Pulmonary Artery Diameter

	 LPA Left Pulmonary Artery Diameter

	 RPA Right Pulmonary Artery Diameter

	 LUPV Left Upper Pulmonic Vein

	 LLPV Left Lower Pulmonic Vein

	 RUPV Right Upper Pulmonic Vein

	 RLPV Right Lower Pulmonic Vein

VenaCava Vena Cave Package



Cardiology 7-93

Measurement Description

	 IVC Dm Inferior Vena Cave Diameter

	 IVC Inspir. Inferior Vena Cave- Inspiration Diameter

	 IVC Expir. Inferior Vena Cave- Expiration Diameter

	 SVC Dm Superior Vena Cave Diameter

	 SVC Inspir. Superior Vena Cave- Inspiration Diameter

	 SVC Expir. Superior Vena Cave- Expiration Diameter

RV Right Ventricle Package

	 RVIDd Mid Mid- Right Ventricle Diameter - End Diastole

	 RVIDd Base Base- Right Ventricle Diameter - End Diastole

	 RVL Right Ventricle Length - End Diastole

Simpson BP Left Ventricular Volume by Simpson method (Biplane)

	 EDV4 Left Ventricle End Diastolic Volume (Apical four chamber)

	 ESV4 Left Ventricle End Systolic Volume (Apical four chamber)

	 EDV2 Left Ventricle End Diastolic Volume (Apical two chamber)

	 ESV2 Left Ventricle End Systolic Volume (Apical two chamber)

	 HR Heart Rate

Simpson SP Left Ventricular Volume by Simpson method (Single plane)

	 EDV4 Left Ventricle End Diastolic Volume (Apical four chamber)

	 ESV4 Left Ventricle End Systolic Volume (Apical four chamber)

	 EDV2 Left Ventricle End Diastolic Volume (Apical two chamber)

	 ESV2 Left Ventricle End Systolic Volume (Apical two chamber)

	 HR Heart Rate

Modified Simpson Modified Simpson method

	 LVLd Apical Left ventricular long-axis length at end diastole

	 LVAd sax MV Left ventricular short-axis area at the level of the mitral valve at end diastole

	 LVAd sax PM Left ventricular short-axis area at the level of the papillary muscle at end diastole

	 LVLs Apical Left ventricular long-axis length at end systole

	 LVAs sax MV Left ventricular short-axis area at the level of the mitral valve at end systole

	 LVAs sax PM Left ventricular short-axis area at the level of the papillary muscle at end systole

	 HR Heart Rate

Area Length Left Ventricular Volume by Area-Length method

	 LVAd 4 Left Ventricle End Diastolic Area (Apical four chamber)
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Measurement Description

	 LVAs 4 Left Ventricle End Systolic Area (Apical four chamber)

	 LVAd 2 Left Ventricle End Diastolic Area (Apical two chamber)

	 LVAs 2 Left Ventricle End Systolic Area (Apical two chamber)

	 HR Heart Rate

Teichholz Left Ventricular Dimensions by Teichholz method

	 RVAWd Right Ventricle Anterior Wall -End Diastole

	 RVDd Right Ventricle Diameter - End Diastole

	 IVSd Interventricular Septum - End Diastole

	 LVIDd Left Ventricle Internal Dimension - End Diastole

	 LVPWd Left Ventricle - Posterior Wall - End Diastole

	 IVSs Interventricular Septum - End Systole

	 LVIDs Left Ventricle Internal Dimension - End Systole

	 LVPWs Left Ventricle Posterior Wall - End Systole

	 HR Heart Rate

LV Mass T-E Left Ventricle Mass by Truncated Ellipse

	 LVA Epi Left Ventricle End Diastolic Epicardial Area at the Papillary Muscle level

	 LVA Endo Left Ventricle End Diastolic Endocardial Area at the Papillary Muscle level

	 a Left Ventricle Semi-major Axis Diastolic Dimension

	 d Left Ventricle Truncated Semi-major Axis Diastolic Dimension

LV Mass A-L Left Ventricle Mass by Area-Length method

	 LVAd Epi Left Ventricle End Diastolic Epicardial Area at the Papillary Muscle level

	 LVAd Endo Left Ventricle End Diastolic Endocardial Area at the Papillary Muscle level

	 LVLd Left Ventricle Length- End Diastole

	 LVAs Epi Left Ventricle End Systolic Epicardial Area at the Papillary Muscle level

	 LVAs Endo Left Ventricle End Systolic Endocardial Area at the Papillary Muscle level

	 LVLs Left Ventricle Length- End Systole

LA Vol(A-L) Left Atrium Volume by Area-Length method

	 LA (A4C) Left Atrium End Systolic Area-Length (Apical four chamber)

	 LA (A2C) Left Atrium End Systolic Area-Length (Apical two chamber)

LA Vol(Simp) Left Atrium Volume by Simpson method (Biplane)

	 ESV4 Left Atrium End Systolic Volume (Apical four chamber)

	 ESV2 Left Atrium End Systolic Volume (Apical two chamber)
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Measurement Description

RA Vol(A-L) Right Ventricular Volume by Area-Length method

	 RA A4C Right Ventricular End Systolic Area-Length (Apical four chamber)

RA Vol(Simp) Right Ventricular Volume by Simpson method (Single Plane)

	 RA Vol(Simp) Right Ventricular End Systolic Volume (Apical four chamber)

TV Tricuspid Valve Package

	 TR VC Dm Vena Contracta Diameter

PISA Proximal Isovelocity Surface Area

	 AR Radius Aortic Regurgitation Radius

	 AR Aliasing Vel. Aortic Regurgitation Aliasing Velocity

	 MR Radius Mitral Regurgitation Radius

	 MR Aliasing Vel. Mitral Regurgitation Aliasing Velocity

	 TR Radius Tricuspid Regurgitation Radius

	 TR Aliasing Vel. Tricuspid Regurgitation Aliasing Velocity

	 PR Radius Pulmonary Regurgitation Radius

	 PR Aliasing Vel. Pulmonary Regurgitation Aliasing Velocity

MV Mitral Valve Package

	 EPSS Point Septal Separation

	 MV Dm Mitral Valve Diameter

	 LVOT Dm Left Ventricular Outflow Track Diameter

	 MV Area Mitral Valve Area

	 MR VC Dm Vena Contracta Diameter

	 MR Jet Area Mitral Regurgitant Jet Area

AV Aortic Valve Package

 	 AV Area Aortic Valve Area

	 LVOT Dm Left Ventricular Outflow Track Diameter

	 AR VC Dm Vena Contracta Diameter

	 AR Jet Area Aortic Regurgitant Flow jet

PV Pulmonary Valve Package

	 PV Dm Pulmonary Valve Diameter

	 Subvalvaular Dm Subvalvaular Diameter

	 Supravalvular Dm Supravalvualr Diameter

	 RVOT Dm Right Ventricular Outflow Track Diameter
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Measurement Description

Qp/Qs

	 LVOT Dm Left Ventricular Outflow Track Diameter

	 RVOT Dm Right Ventricular Outflow Track Diameter

Auto EF Auto ejection fraction 

	 Auto EF (A4C) Auto ejection fraction (Apical four chamber)

	 Auto EF (A2C) Auto ejection fraction (Apical two chamber)

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Cardiology > 2D > Default Measurement.

	❚ Aortic Root Diameter

To measure the aortic root diameters, 

	• Ao ST Dm

	• Ao SV Dm

	• Ao Ring Dm

1	1	 Select the Aorta Diam folder on the context menu.

2	2	 Select Ao ST Dm, AO SV Dm, or Ao Ring Dm. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the diameter measurement is shown on the Result window.
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①	 Aortic Annulus – Ring Diameter

②	 Aortic Sinuses of Valsalva Diameter

③	 Aortic Tubular Junction Diameter

	❚ Valve Area (Trace)

To measure the valve area, 

	• MV Area

	• AV Area

1	1	 Select the MV or AV folder on the context menu.

2	2	 Select MV Area or AV Area. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point. A line shows the traced area.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the valve area measurement is shown on the Result window.
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	❚ Right Atrium – Single Plane Simpson’s Method

This method allows you to calculate the volume of the right atrium on the four chamber cross-
sectional image. RA Vol(Simp) indicates the Simpson measurement.

1	1	 During a Cardiology study, freeze a 4 chamber cross-sectional image.

2	2	 Press the [Measure] key on the control panel. 

3	3	 Select the RA Vol(Simp) folder on the context menu.

4	4	 Select RA Vol(Simp). The start point appears.

5	5	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

6	6	 Use [Trackball] to create a trace of the structure with the second point, and press the [Set] key.

7	7	 When the start and end points are connected and a line representing the long axis is shown, 
press the [Set] key again. 

8	8	 The measured value is fixed, and the measured value is shown on the Result window.

	❚ Right Ventricle Diameter

The followings are right ventricle measurements:

	• RVIDd Mid

	• RVIDd Base

	• RVL

1	1	 Select the RV folder on the context menu.

2	2	 Select RVIDd Mid, RVIDd Base, or RVL. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the Right Ventricle diameter measurement is shown on the 
Result window.
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	❚ Left Atrium – Biplane Area Length Method

This method allows you to calculate the volume of the left atrium on the two chamber and four 
chamber cross-sectional images. The followings are area length measurements:

	• LA A4C

	• LA A2C

1	1	 During a Cardiology study, freeze 4 chamber or 2 chamber cross-sectional images.

2	2	 Use [Trackball] to scroll through Cine images.

3	3	 From the frame image of the end diastole, press the [Measure] key on the control panel. 

4	4	 Select the LA Vol(A-L) folder on the context menu.

5	5	 Select LA A4C or LA A2C. The start point appears.

a.	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

b.	 Use [Trackball] to create a trace of the structure with the second point, and press the [Set] 
key.

6	6	 The measured value is fixed, and the measured value is shown on the Result window.

NOTE
When the length is measured in both the 4 chamber and 2 chamber cross-sectional views, the shortest 
value is used in the Area Length formula.
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	❚ Left Ventricle – Teichholz Method

The followings are Teichholz measurements:

	• Diastole – IVSd, LVIDd, LVPWd

	• Systole – IVSs, LVIDs, LVPWs

1	1	 Select the Teichholz folder on the context menu.

2	2	 Select Diastole or Systole. The start point appears.

a.	 Use [Trackball] to move the start point to the interventricular septum.

b.	 To fix the point, press the [Set] key.

c.	 As you move [Trackball], the second point and straight line appear on the display.

d.	 Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed.

3	3	 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d).

4	4	 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window.

NOTE
When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement. 
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	❚ Left Ventricle – Biplane Simpson’s Method 

This method allows you to calculate the volume of the left ventricle on two chamber and four 
chamber cross-sectional images. The followings are Simpson BP measurements:

	• EDV2

	• ESV2

	• EDV4

	• ESV4

1	1	 During a Cardiology study, freeze a 4 chamber or 2 chamber cross-sectional images.

2	2	 Use [Trackball] to scroll through Cine images.

3	3	 From the frame image of the end diastole, press the [Measure] key on the control panel.

4	4	 Select the Simpson BP folder on the context menu.

5	5	 Select EDV4 or EDV2. The start point appears.

a.	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

b.	 Use [Trackball] to create a trace of the structure with the second point, and press the [Set] 
key.

c.	 When the start and end points are connected and a line representing the long axis is shown, 
press the [Set] key again. The volume is calculated.

6	6	 Press the [Exit] key.

7	7	 Use [Trackball] to scroll through Cine images.

8	8	 From the End systole frame image, press the [Measure] key on the control panel. 

9	9	 Select the Simpson BP folder on the context menu.

10	10	 Select ESV4 or ESV2.

11	11	 Perform the measurement of the disk volume in the same manner (a-c).

12	12	 When the volume trace is completed, the measured value is fixed, and the measured value is 
shown on the Result window.
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	❚ Regurgitation Flow – Jet Area

1	1	 While performing a Cardiology study in Color Flow mode, press the [Freeze] key to freeze an 
image.

2	2	 Press the [Measure] key on the control panel.

3	3	 Select the AV or MV folder on the context menu.

4	4	 Select AR Jet Area or MR Jet Area. The start point appears.

5	5	 Use [Trackball] to move the marker to the start point.

6	6	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

7	7	 Use [Trackball] to move the marker to the end point. A line shows the traced regurgitant jet 
area.

8	8	 To complete the measurement, press the [Set] key.

9	9	 The measured value is fixed, and the regurgitant jet area is shown on the Result window.

	❚ Regurgitation Flow – Vena Contracta Diameter

The followings are Vena Contracta measurements:

	• AR VC Dm

	• MR VC Dm

1	1	 While performing a Cardiology study in Color Flow mode, press the [Freeze] key to freeze an 
image.

2	2	 Use [Trackball] to scroll to the largest diameter of the vena contracta.

3	3	 Press the [Measure] key on the control panel. 

4	4	 Select the AV or MV folder on the context menu.

5	5	 Select AR VC Dm or MR VC Dm. The start point appears.

6	6	 Use [Trackball] to move the marker to the start point. 

7	7	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

8	8	 Use [Trackball] to move the marker to the end point.

9	9	 To complete the measurement, press the [Set] key.

10	10	 The measured value is fixed, and the vena contracta diameter is shown on the Result window.
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2D mode calculations

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-25 2D mode calculations (Cardiology)

Calculation Label Description Required

Ao/LA Aortic Valve/Left Atrium Package

	 Ao/LA Aortic Valve / Left Ventricle Ratio Ao Dm, LA Dm

	 LA/Ao Left Artrium / Aortic Valve Ratio Ao Dm, LA Dm

LA Vol(Diam) Left Atrium Package

	 LA Vol LA Dm apt-post, LA Dm sup-inf, LA 
Dm med-lat

	 LA Vol. index LA Vol, BSA

Area Length, Area Length method,

Simpson Method Simpson’s method of Disk volume

	 EDV End Diastolic Volume LVLd, LVAd

	 ESV End Systolic Volume LVLs, LVAs

	 SV Stroke Volume EDV, ESV

	 CO Cardiac Output EDV, ESV, HR

	 EF Ejection Fraction EDV, ESV

	 SI Stroke Index EDV, ESV, BSA

	 CI Cardiac Index EDV, ESV, HR, BSA

Teichholz Teichholz method

	 EDV End Diastolic Volume LVIDd

	 ESV End Systolic Volume LVIDs

	 SV Stroke Volume EDV, ESV

	 CO Cardiac Output EDV, ESV, HR

	 EF Ejection Fraction EDV, ESV

	 FS Fractional Shortening LVIDd, LVIDs

	 SI Stroke Index EDV, ESV, BSA

	 CI Cardiac Index EDV, ESV, HR, BSA

	 LV(s) Mass Left Ventricular Mass IVS(d, s), LVID(d, s), LVPW(d, s)

	 LV(s) Mass-c Left Ventricular Mass Corrected IVS(d, s), LVID(d, s), LVPW(d, s)

	� LV(s) Mass index Left Ventricular Mass Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA
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Calculation Label Description Required

	� LV(s) Mass-c index Left Ventricular Mass Corrected Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA

LV Mass T-E Left Ventricle Mass by Truncated Ellipse

	 LV Mass(T-E) Left ventricular mass using a Truncated Ellipse LVA Epi, LVA Endo, a, d

	 LV Mass index Left Ventricular Mass Index LV Mass(T-E), BSA

LV Mass A-L Left Ventricle Mass by Area-Length method

	� LV(d,s) Mass(A-L) Left ventricular mass using a Area-Length 
method

LVA(d,s) Epi, LVA(d,s) Endo, LVL(d,s)

	� LV(d,s) Mass index Left Ventricular Mass Index LV(d,s) Mass(A-L) BSA

PISA Proximal Isovelocity Surface Area

	 Flow Rate Peak Instantaneous Flow Rate Radius, Aliasing Vel

	 ERO Effective Regurgitant Orifice Radius, Aliasing Vel, Vmax

Define as:

	• Area Length Method

EDV =(8/(3π))xLVAd² / LVLd 

ESV =(8/(3π))xLVAs² / LVLs 

	• Simpson’s Method

ai : Radius of the i-th ellipse (2CH)

bi : Radius of the i-th ellipse (4CH)
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	• Teichholz Method

EDV= 7x(LVIDd³) / (2.4 + LVIDd)

ESV= 7x(LVIDs³) / (2.4 + LVIDs)

SV= EDV – ESV

CO= SVxHR

EF= (EDV - ESV) / EDV

FS= (LVIDd - LVIDs) / LVIDd

SI= SV / BSA

CI= CO / BSA

NOTE
BSA is automatically calculated when you enter the height and weight of a patient from the Patient 
Registration screen. 

LV Mass= 1.04x{(IVSd + LVIDd + LVPWd)³ - (LVIDd)³}

LV Mass-c= 0.8xLV Mass+0.6

LV Mass Index= LV Mass / BSA

	• PISA

Flow Rate= 2πxRadius²xAliasing Vel

NOTE
When you select Aliasing Vel(edit) on the context menu, you can edit the velocity value by entering it on 
the color bar.

	❚ AO/LA Ratio

1	1	 Select the Ao/LA folder on the context menu.

2	2	 Select Ao Dm. The start point appears.

a.	 Move the marker to the start point using [Trackball]. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 The aortic valve diameter is fixed.

4	4	 Select LA Dm.

5	5	 Perform the measurement of the left atrium diameter in the same manner (a-d).

6	6	 When two diameter measurements are completed, the measured value is fixed, and the ratio is 
shown on the Report or Mini Report page.
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	❚ Left Ventricular Mass – Area Length Method

The followings are LV Mass measurements:

	• LVAd Epi, LVAs Epi

	• LVAd Endo, LVAs Endo

	• LVLd, LVLs

1	1	 Select LV Mass A-L folder on the context menu.

2	2	 Select the LVAd Epi or LVAs Epi. The start point appears.

a.	 Use [Trackball] to move the marker to the start point and press the [Set] key. The first point 
is fixed, and the second point appears.

b.	 Use [Trackball] to create a trace of the epicardial area with the second point and press the 
[Set] key. The measured value is fixed.

3	3	 Select LVAd Endo or LVAs Endo.

4	4	 Perform the measurement of the endocardial area in the same manner (a-b).

5	5	 Select LVLd or LVLs. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

6	6	 When two area measurements and one diameter are completed, the measured value is fixed, 
and the LV mass is shown on the Report or Mini Report page.
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Auto EF measurements

Auto EF (Automated Ejection Fraction) is a semi-automatic measurement tool used for measurement of 
the global EF (Ejection fraction).

Figure 7-7 Auto EF display

To perform an Auto EF measurement,

1	1	 Connect the ECG device and activate the ECG function to acquire a stable ECG trace.

2	2	 Acquire 2D Cine images of an Apical 4 chamber view and an Apical 2 chamber view by pressing the 
[Freeze] key.

3	3	 After acquiring the Cine images, press the [Measure] key and select Auto EF on the touch screen.  
The Auto EF screen appears.

4	4	 Select the name of current cadiac view (A4C, A2C) on the touch screen. 
An endocardial border will automatically be traced.

5	5	 If necessary, select the ECG cycle from the ECG Cycle drop-down list, and select Calc. to start the 
calculation. 
When the processing is completed, the Ejection fraction is automatically calculated again.

6	6	 If necessary, select Edit EDV or Edit ESV to edit the endocardial border trace.  
You may adjust the trace by moving the cursor over the endocardial border trace, select an 
anchor point and drag it to a new location. The shape of the endocardial border trace is updated 
accordingly.

7	7	 When the editing is completed, select Calc. to start the calculation.

8	8	 The resulting Ejection Fraction (EF) , the End Diastolic volume (EDV) and the End Systolic Volume 
(ESV) are displayed in a table on the right.

NOTE
The Biplane results will only appear on screen after measuring both A2C and A4C views.

9	9	 To save the result, select Save Result on the touch screen. The results are shown on the Report page.

10	10	 To exit Auto EF, select Exit on the touch screen.
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M mode measurements

M mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned.

Table 7-26 M mode measurement (Cardiology)

Measurement Description

Teichholz Left Ventricular Dimensions by Teichholz method

	 RVAWd Right Ventricle Anterior Wall -End Diastole

	 RVDd Right Ventricle Diameter - End Diastole

	 IVSd Interventricular Septum - End Diastole

	 LVIDd Left Ventricle Internal Dimension - End Diastole

	 LVPWd Left Ventricle - Posterior Wall - End Diastole

	 IVSs Interventricular Septum - End Systole

	 LVIDs Left Ventricle Internal Dimension - End Systole

	 LVPWs Left Ventricle Posterior Wall - End Systole

	 LVET Left Ventricular Ejection Time

	 HR Heart Rate

Ao/LA Aortic Valve/Left Atrium Package

	 RV Dm Right Ventricular Diameter

	 LA Dm Left Atrial Diameter

	 Ao Dm Aortic Diameter

	 ACS Aortic Cusp Separation

	 LVET Left Ventricle Ejection Time

	 LVPEP Left Ventricle Pre-Ejection Period

MV Mitral Valve Package

	 CE Exc Excursion E wave

	 CA Exc Excursion A wave

	 DE Exc/slope Excursion D wave / D-E point Slope

	 EPSS E Point Septal Separation

	 EF slope E-F point Deceleration Slope

RV Right Ventricle Package

	 RV Dm Right Ventricular Diameter – End Diastole

	 RVOT Dm Right Ventricular Outflow Track Diameter

	 RVET Right Ventricular Ejection Time
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Measurement Description

	 RVPEP Right Ventricular Pre-ejection Period

	 TAPSE Tricuspid Annular Plane Systolic Excursion

Pul.Vein Pulmonary Vein Package

	 Pul.Vein Dm Pulmonary Vein Diameter

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Cardiology > M > Default Measurement.

	❚ Diameter

The followings are distance measurements:

	• Ao/LA – RV Dm, LA Dm, Ao Dm, ACS

	• MV – CE Exc, CA Exc, EPSS

	• RV – RV Dm, RVOT Dm, TAPSE

1	1	 Select a distance measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The measured value is fixed, and the distance measurement is shown on the Result window.

	❚ Time

The followings are time measurements:

	• Ao/LA, Teichholz, RV – LVET, RVET

	• Ao/LA, RV – LVPEP, RVPEP

1	1	 Select a time measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and then press the [Set] key again.

4	4	 The time interval between the two points appears and the time measurement is shown on the 
Result window.
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	❚ Slope

The followings are distance measurements:

	• MV – DE Exc/slope, EF slope

1	1	 Select the MV folder on the context menu.

2	2	 Select DE Exc/slope or EF slope. The start point appears.  
The vertical line and the horizontal line are perpendicular to each other. 

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 The oblique line is displayed and the slope is calculated. The slope measurement is shown on 
the Result window.

	❚ Heart Rate (HR)

1	1	 Select the Teichholz folder on the context menu.

2	2	 Select HR. The start point appears.  
The vertical line and the horizontal line are perpendicular to each other.

3	3	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point, and press the [Set] key again.

5	5	 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window.
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	❚ Left Ventricle – Teichholz Method

The followings are Teichholz measurements:

	• Diastole – IVSd, LVIDd, LVPWd

	• Systole – IVSs, LVIDs, LVPWs

1	1	 Select the Teichholz folder on the context menu.

2	2	 Select Diastole or Systole. The start point appears.

a.	 Use [Trackball] to move the start point to the interventricular septum. 

b.	 To fix the point, press the [Set] key. 

c.	 As you move [Trackball], the second point and straight line appear on the display. 

d.	 Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed.

3	3	 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d).

4	4	 When three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window.

NOTE
When you select Diastole or Systole, you can perform the 3 lengths measurement with a straight line. 
When you select IVS, LVID, or LVPW, you can perform the 1 distance measurement.
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M mode calculation

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-27 M mode calculations (Cardiology)

Calculation Label Description Required

Ao/LA Aortic Valve/Left Atrium Package

	 Ao/LA Aortic Valve/ Left Ventricle Ratio Ao Dm, LA Dm

	 LA/Ao Left Ventricle/ Aortic Valve Ratio Ao Dm, LA Dm

	 LVSTI Left Ventricular Systolic Time Intervals LVPEP, LVET

MV Mitral Valve Package

	 CA/CE Amplitude A wave/ Amplitude E wave Ratio CA Exc, CE Exc

RV Right Ventricle Package

	 RVSTI Right Ventricular Systolic Time Intervals RVPEP, RVET

Teichholz Teichholz Method

	 EDV End Diastolic Volume LVIDd

	 ESV End Systolic Volume LVIDs

	 SV Stroke Volume EDV, ESV

	 CO Cardiac Output EDV, ESV, HR

	 EF Ejection Fraction EDV, ESV

	 FS Fractional Shortening LVIDd, LVIDs

	 SI Stroke Index EDV, ESV, BSA

	 CI Cardiac Index EDV, ESV, HR, BSA

	 LV(s) Mass Left Ventricular Mass IVS(d, s), LVID(d, s), LVPW(d, s)

	 LV(s) Mass-c Left Ventricular Mass Corrected IVS(d, s), LVID(d, s), LVPW(d, s)

	� LV(s) Mass index Left Ventricular Mass Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA

	� LV(s) Mass-c index Left Ventricular Mass Corrected Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA

mVcf Mean Velocity of Circumferential Fiber 
Shortening

LVIDd, LVIDs, LVET

RWT Relative Wall Thickness LVPWd, LVIDd
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Define as:

LVSTI= LVPEP/LVET

Teichholz Method

EDV= 7x(LVIDd³) / (2.4 + LVIDd)

ESV= 7x(LVIDs³) / (2.4 + LVIDs)

SV= EDV – ESV

CO= SV x HR

EF= (EDV - ESV) / EDV

FS= (LVIDd - LVIDs) / LVIDd

SI= SV / BSA

CI= CO / BSA

NOTE
BSA is automatically calculated when you enter the height and weight of a patient from the Patient 
Registration screen.

LV Mass= 1.04x{(IVSd + LVIDd + LVPWd)³ - (LVIDd)³}

LV Mass-c= 0.8xLV Mass+0.6

LV Mass index= LV Mass / BSA

mVcf= (LVIDd-LVIDs)/(LVIDdxLVET)
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D mode measurements 

D mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned.

Table 7-28 D mode measurement (Cardiology)

Measurement Description

TV Tricuspid Valve Package

	 TV VTI Tricuspid Valve Velocity Time Integral

	 TV Vmax Tricuspid Valve Peak Velocity

	 TV E Vel. Tricuspid Valve E point Velocity

	 TV A Vel. Tricuspid Valve A point Velocity

	 RVET Right Ventricular Ejection Time

	 TCO Tricuspid Valve Close-Open Duration Time

	 TV Dec. Time Tricuspid Valve Deceleration Time

	 TR dP/dt Tricuspid Regurgitation Rate of change of pressure over time

	 TR VTI Tricuspid Regurgitation Velocity Time Integral

	 TR Vmax Tricuspid Regurgitation Peak Velocity

	 RAP(edit) Right Atrium Pressure Selection (edit)

Pul.Vein Pulmonary Vein Package

	 P Vein S Pulmonary Vein Systolic Peak Velocity

	 P Vein D Pulmonary Vein Diastolic Peak Velocity

	 P Vein A Pulmonary Vein Atrial Contraction Reversal Peak Velocity

	 Pul. A Dur. Pulmonary Vein a wave Duration Time

TDI Left Ventricle Tissue Doppler Imaging

	 MV E Vel. Mitral Valve E point Velocity

	 Sep E' Septal TDI E point Velocity

	 Sep A' Septal TDI A point Velocity

	 Sep S' Septal TDI S point Velocity

	 Sep AR/DR Mitral Lateral Annulus E wave Acceleration & Deceleration Time and Slope

	 Lat E' Lateral TDI E point Velocity

	 Lat A' Lateral TDI A point Velocity

	 Lat S' Lateral TDI S point Velocity

	 Lat AR/DR Mitral Medial Annulus E wave Acceleration & Deceleration Time and Slope

	 RV E' Right Ventricle TDI E point Velocity
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Measurement Description

	 RV A' Right Ventricle TDI A point Velocity

	 RV S' Right Ventricle TDI S point Velocity

	 TV E Tricuspid Valve E point Velocity

	 TV E' Tricuspid Valve TDI E point Velocity

	 Sep E' VTI Septal TDI E point Velocity Time Integral

	 Sep A' VTI Septal TDI A point Velocity Time Integral

	 Lat E' VTI Lateral TDI E point Velocity Time Integral

	 Lat A' VTI Lateral TDI A point Velocity Time Integral

	 Sep E'(T) Septal TDI E point (Time)

	 Sep S'(T) Septal TDI S point (Time)

	 Lat E'(T) Lateral TDI E point (Time)

	 Lat S'(T) Lateral TDI S point (Time)

	 Sep IVRT Septal Isovolumetric Relaxation Time

	 Sep IVCT Septal Isovolumetric Contraction Time

	 Lat IVRT Lateral Isovolumetric Relaxation Time

	 Lat IVCT Lateral Isovolumetric Contraction Time

AV Aortic Valve Package

	 AV VTI Aortic Valve Velocity Time Integral

	 LVOT VTI Left Ventricular outflow Track Velocity Time Integral

	 AV Vmax Aortic Valve Maximum Velocity

	 LVOT Vmax Left Ventricular outflow Track Maximum Velocity

	 IVCT Isovolumetric Contraction Time

	 IVRT Isovolumetric Relaxation Time

	 LVET Left Ventricular Ejection Time

	 MCO Mitral Valve Close-Open Duration Time

	 HR Heart Rate

	 AR PHT Aortic Regurgitant Flow Pressure Half Time

	 AR VTI Aortic Regurgitant Flow Velocity Time Integral

	 AR Decel Slope Aortic Regurgitant Flow Deceleration Time and Slope

PV Pulmonary Valve Package

	 PV VTI Pulmonary Valve Track Velocity Time Integral

	 PV Vmax Pulmonary Valve Peak Velocity
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Measurement Description

	 PV Acc Time Pulmonary Valve Acceleration Time and Slope

	 RVOT VTI Right Ventricular outflow Track Velocity Time Integral

	 RVOT Vmax Right Ventricular outflow Track Maximum Velocity

	 RVET Right Ventricular Ejection Time 

	 HR Heart Rate

	 PR VTI Pulmonary Regurgitation Velocity Time Integral

	 PR Vmax Pulmonary Regurgitation Peak Velocity

	 PR EDV Pulmonary Regurgitation End Diastole Velocity

Qp/Qs Shunts

	 LVOT VTI Left Ventricular Outflow Track Velocity Time Integral

	 Systemic HR Systemic Heart Rate

	 RVOT VTI Right Ventricular Outflow Track Velocity Time Integral

	 Pulmonic HR Pulmonic Heart Rate

PISA Proximal Isovelocity Surface Area

	 AR VTI Aortic Regurgitant Flow Velocity Time Integral

	 AR Aliasing Vel. Aortic Regurgitation Aliasing Velocity

	 MR VTI Mitral Regurgitant Flow Velocity Time Integral

	 MR Aliasing Vel. Mitral Regurgitation Aliasing Velocity

	 TR VTI Tricuspid Regurgitant Flow Velocity Time Integral

	 TR Aliasing Vel. Tricuspid Regurgitation Aliasing Velocity

	 PR VTI Pulmonary Regurgitant Flow Velocity Time Integral

	 PR Aliasing Vel. Pulmonary Regurgitation Aliasing Velocity

MV Mitral Valve Package

	 E Dur Mitral Valve E wave Duration Time

	 A Dur Mitral Valve A wave Duration Time

	 MV E/A Vel. Mitral Valve E point/A point Ratio

	 MV E Vel. Mitral Valve E point Velocity

	 MV Dec Time Mitral Valve Deceleration Time

	 MV A Vel. Mitral Valve A point Velocity

	 MVA(PHT) Mitral Valve Area (Pressure Half Time)

	 MV VTI Mitral Valve Velocity Time Integral

	 LVOT VTI Left Ventricular outflow Track Velocity Time Integral
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Measurement Description

	 IVCT Isovolumetric Contraction Time

	 IVRT Isovolumetric Relaxation Time

	 LVET Left Ventricular Ejection Time

	 MCO Mitral Valve Close-Open Duration Time

	 Sep E' Septal TDI E point Velocity

	 Sep A' Septal TDI A point Velocity

	 Sep S' Septal TDI S point Velocity

	 HR Heart Rate

	 MR Vmax Mitral Regurgitation Peak Velocity

	 MR dP/dt Mitral Regurgitation Rate of change of pressure over time

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Cardiology > Doppler > Default Measurement.

	❚ Velocity

The followings are velocity measurements:

	• MV – MV E Vel., MV A Vel., Sep E', Sep A', Sep S', MR Vmax

	• AV – AV Vmax, LVOT Vmax

	• TV – TV Vmax, TV E Vel., TV A Vel., TR Vmax

	• PV – PV Vmax, RVOT Vmax, PR Vmax, PR EDV

	• Pul.Vein – P Vein S, P Vein D, P Vein A

	• TDI – MV E Vel., Sep E', Sep A', Sep S', Lat E', Lat A', Lat S', RV E', RV A', RV S', TV E, TV E'

1	1	 Select a velocity measurement on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity is shown on the Result window.
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	❚ Time

The followings are time measurements:

	• MV – E Dur, A Dur, IVCT, IVRT, LVET, MCO

	• AV – IVCT, IVRT, LVET, MCO

	• TV – RVET, TCO

	• Pul.Vein – Pul. A Dur.

	• TDI –Sep E'(T), Sep S'(T), Lat E'(T), Lat S'(T)

	• PV – RVET

1	1	 Select a time measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears, and the time measurement is shown on the 
Result window.

	❚ VTI

The followings are velocity-time integral measurements:

	• TV – TV VTI, TR VTI

	• AV – AV VTI, AR VTI

	• PV – PV VTI, RVOT VTI, PR VTI

	• PISA – AR VTI, MR VTI, TR VTI, PR VTI

	• MV – MV VTI, LVOT VTI

	• TDI – Sep E' VTI, Sep A' VTI, Lat E' VTI, Lat A' VTI

1	1	 Select a velocity-time integral measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the waveform one cycle.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The velocity-time integral is calculated, and the velocity-time integral is shown on the Result 
window.
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	❚ Heart Rate (HR)

1	1	 Select HR on the context menu. The start point appears.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again. 

4	4	 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window.

D mode calculation

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-29 D mode calculations (Cardiology)

Calculation Label Description

MV Mitral Valve

	 E/A Mitral Valve E point /A point Ratio

	 MV Vmean Mitral Valve Mean Velocity

	 MV PGmax Mitral Valve Maximum Pressure Gradient

	 MV PGmean Mitral Valve Mean Pressure Gradient

	 MVA(VTI) Mitral Valve Area-Velocity Time Integral

	 LV MPI Left Ventricle Index of Myocardial Performance

	 SV Stroke Volume

	 CO Cardiac Output

	 SI Stroke Index

	 CI Cardiac Index

	 MV E/E'(S) Mitral Valve E point/Mitral Annulus Ea point Ratio

	 MR PGmax Mitral Regurgitation Maximum Pressure Gradient

	 MR dP/dt Mitral Regurgitation dP/dt derived from velocity

AV Aortic Valve

	 AV Vmean Aortic Valve Mean Velocity

	 AV PGmax Aortic Valve Maximum Pressure Gradient

	 AV PGmean Aortic Valve Mean Pressure Gradient

	 LVOT Vmean Left Ventricular outflow Track Mean Velocity

	 LVOT PGmax Left Ventricular outflow Track Maximum Pressure Gradient
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Calculation Label Description

	 LVOT PGmean Left Ventricular outflow Track Mean Pressure Gradient

	 AVA(VTI) Aortic Valve Area-Velocity Time Integral

	 AVA(Vmax) Aortic Valve Area- Maximum Velocity

	 AVA index(VTI) Aortic Valve Area index by Velocity Time Integral

	 AVA index(Vmax) Aortic Valve Area index by Maximum Velocity

	 SV Stroke Volume

	 CO Cardiac Output

	 SI Stroke Index

	 CI Cardiac Index

	 Qp/Qs Pulmonary Valve Cardiac Output / Aortic Valve Cardiac Output Ratio

	 Qp-Qs Pulmonary Valve Cardiac Output - Aortic Valve Cardiac Output

	 LV MPI Left Ventricle Index of Myocardial Performance

TV Tricuspid Valve

	 TV Vmean Tricuspid Valve Mean Velocity

	 TV PGmax Tricuspid Valve Maximum Pressure Gradient

	 TV PGmean Tricuspid Valve Mean Pressure Gradient

	 E/A Tricuspid Valve E point /A point Ratio

	 RV MPI Tricuspid Valve-Right Ventricle Index of Myocardial Performance

	 TR Vmean Tricuspid Valve Regurgitation Flow - Mean Velocity

	 TR PGmax Tricuspid Valve Regurgitation Flow - Maximum Pressure Gradient

	 TR PGmean Tricuspid Valve Regurgitation Flow - Mean Pressure Gradient

	 RVSP Right Ventricular Systolic Pressure

PV Pulmonary Valve

	 PV Vmean Pulmonary Valve Mean Velocity

	 PV PGmax Pulmonary Valve Maximum Pressure Gradient

	 PV PGmean Pulmonary Valve Mean Pressure Gradient

	 RVOT Vmean Right Ventricular outflow Track Mean Velocity

	 RVOT PGmax Right Ventricular outflow Track Maximum Pressure Gradient

	 RVOT PGmean Right Ventricular outflow Track Mean Pressure Gradient

	 PVA(VTI) Pulmonary Valve Area-Velocity Time Integral

	 PVA(Vmax) Pulmonary Valve Area-Maximum Velocity

	 PVA index(VTI) Pulmonic Valve Area index by Velocity Time Integral
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Calculation Label Description

	 PVA index(Vmax) Pulmonic Valve Area index by Maximum Velocity

	 SV Stroke Volume

	 CO Cardiac Output

	 SI Stroke Index

	 CI Cardiac Index

	 Qp/Qs Pulmonary Valve Cardiac Output/ Aortic Valve Cardiac Output Ratio

	 Qp-Qs Pulmonary Valve Cardiac Output - Aortic Valve Cardiac Output

PISA Proximal Isovelocity Surface Area

	 RV Regurgitation Volume Flow

TDI Tissue Doppler Imaging

	 E'/A'(S) Left Ventricular Early Diastolic Velocity / Atrial Systolic Velocity Ratio

	 MV E/E'(S) Mitral Valve E point/Mitral Annulus Ea point Ratio

	 E'/A'(L) Left Ventricular Early Diastolic Velocity / Atrial Systolic Velocity Ratio

	 MV E/E'(L) Mitral Valve E point/Mitral Annulus Ea point Ratio

	 TV E/RV E' Tricuspid Valve E point / Right Ventricle TDI E point Ratio

	 TV E/E'(R) Tricuspid Valve E point / Right Ventricle TDI E point Ratio

Define as:

PGmax= 4V2

MVA(PHT)= 220/MV PHT

MVA(VTI)= πx(LVOT Dm/2/10)2xLVOT VTI / MV VTI

AVA(VTI)= πx(LVOT Dm/2/10)2xLVOT VTI / AV VTI

LVIMP= (MV C-Odur – LVET) / LVET

LV MPI= (MV C-Odur – LVET) / LVET

RV MPI= (TV C-Odur – RVET) / RVET

dP/dt=32 / dtx1000

EO Area=2 πxRadius2xAliasing Vel / Vmax (Regurgitation flow)

Flow Vol= EO AreaxVTI (Regurgitation flow)
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	• Mitral Valve

SV= πxMV Dm2 / 4xMV VTI

	• Aortic Valve

SV= πxLVOT Dm2 / 4xLVOT VTI

	• Pulmonary Valve

SV= πxPV Dm2 / 4xPV VTI

CO= SVxHR

SI= SV / BSA

CI= CO / BSA

	• Pressure Gradient – PGmax, PGmean 

The maximum pressure gradient is calculated from a maximum velocity using a velocity measurement 
method or from the tracing waveform.

The mean pressure gradient is calculated from the mean velocity using the trace measurement 
method.

	❚ Valve Area by Pressure Half Time (PHT)

	• MV – MVA(PHT)

	• AV – AR PHT

1	1	 Select the MV or AV folder on the context menu.

2	2	 Select MVA(PHT) or AR PHT. The start point appears.  
The vertical line and the horizontal line are perpendicular to each other.

3	3	 Use [Trackball] to move the point to the e-wave velocity of the mitral valve, and press the [Set] 
key. 
The start point is fixed, and the end point appears.

4	4	 Use [Trackball] to move the point to the half point of the PHT, and press the [Set] key again.

5	5	 The measured value is calculated, and the mitral valve area is shown on the Result window.
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	❚ Valve Area by the Continuity Equation (VTI) 

You can measure the mitral valve area and aortic valve area by using the velocity-time integral (VTI) of 
the Continuity Equation.

1	1	 During a Cardiology study in 2D mode, press the [Freeze] key to freeze an image.

2	2	 Use [Trackball] to scroll to the largest LVOT diameter.

3	3	 Press the [Measure] key on the control panel. 

4	4	 Select the MV, AV, or PV folder on the context menu.

5	5	 Select LVOT Dm or RVOT Dm. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key. The measured value is fixed.

6	6	 During a Cardiology study in D mode, freeze the Doppler spectrum.

7	7	 Press the [Measure] key on the control panel. 

8	8	 Select the MV, AV, or PV folder on the context menu.

9	9	 Select LVOT VTI or RVOT VTI. The start point appears.

a.	 The vertical line and the horizontal line are perpendicular to each other. 

b.	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] 
key. The end point appears.

c.	 Use [Trackball] to trace one cycle of the waveform.

d.	 To complete the measurement, press the [Set] key. The measured value is fixed.

10	10	 Perform the measurement of the second VTI (MV VTI, AV VTI, or PV VTI) in the same manner 
(a-c).

11	11	 After one diameter and two VTI are completed, the measured value is calculated and the mitral 
or aortic valve area is shown on the Result window, Report page, and Mini Report page.
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	❚ dP/dt

1	1	 Select the MV folder on the context menu.

2	2	 Select MR dP/dt. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3	3	 The horizontal line indicating regurgitation velocities of 1m/s and 3m/s.

4	4	 Move the marker to the start point using [Trackball] where the MR jet intersects the reference 
line at a velocity of 1m/s, and then press the [Set] key. 
The end point appears.

5	5	 Use [Trackball] to move the marker to the start point where the MR jet intersects the reference 
line at a velocity of 3m/s, and then press the [Set] key.

6	6	 The measured value is fixed, and the value for dP/dt is shown on the Result window, Report 
page, and Mini Report page.
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Cardiology report 
To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27. 

The cardiology report has two sections of information:

	• Patient information

	• Measurement information

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

	• BSA

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the measurement value type, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > Edit > Method.
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WMS report
To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select WMS Report on the context menu.

NOTE
You can view the WMS report after performing and saving the Stress echo function.

To view more studies, use the combo box or the Exam soft key.

To view another stage, select Next Stage.

Electrocardiograph (ECG) 
ECG is an optional function that provides physiological trace by obtaining ECG signals. While scanning a 
cardiac image in M or Doppler mode, you can view the systolic and diastolic point on the ECG line of the 
display. This helps you study an image and perform a measurement correctly.

ECG cable 

The optional ECG cable consists of two different cables: One end is for the system cable, the other end is 
for the electrode cable. The electrode cable has a three-pronged electrode connector for connecting to 
your patient’s body.

There are two types of electrode cables. Depending on your country, the colors and names defined on 
each cable connector may be different:
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	❚ Standard IEC(I) type: European standard

	– L: Yellow-colored connector, means “Left arm”

	– R: Red-colored connector, means ““Right arm”

	– F: Green-colored connector, means “Left leg”

	– N : Black-colored connector, means “Right leg”

	❚ AHA(A) type: American standard

	– RA: White-colored connector, means “Right arm”

	– LA: Black-colored connector, means “Left arm”

	– LL: Red-colored connector, means “Left leg”

	– RL : Green-colored connector, means “Right leg”

Connecting an ECG cable

1	1	 Connect the system cable into the ECG port on the lower right side of the system.

2	2	 Hook up 3 stick-on electrodes (disposable) to each connector of the electrode cable until they click 
into place.

3	3	 Attach the each connector of the electrode cable to the corresponding body parts.

Activating ECG

1	1	 To set the application(s) to show or hide the ECG on the screen, press the [System Preset] key and 
go to User Setting > Application > ECG Display.

2	2	 Select the application(s) you want.

3	3	 When you have finished, click Save & Exit to save the changes and return to the scan mode. 
The ECG trace is activated, and the ECG tab is displayed on the touch screen.

4	4	 Select the ECG tab to activate ECG mode, and adjust the parameters to obtain an optimized image.
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ECG optimization controls

In ECG mode, you can use the ECG options on the touch screen. 

Figure 7-8 ECG mode trouch screen

The following ECG options are available:

Option Descriptions

Time Trig. Set to show a frozen image each time you specified in Delay Time.
If this option is activated, ECG Trig. is automatically set to none.

ECG Trig. Select an active ECG trigger. You can activate both two triggers at the same time.

ECG Display Activate the ECG display.

ECG Invert Invert the current ECG trace.

Sweep Speed Change the speed of the ECG trace.

Delay Time Set the time delay of the ECG trigger.

Trig. Period Set the cycle number of the ECG trigger.

Heart Cycles Display the ECG trace and Heart Rate on the screen.

ECG Gain Adjust the amplitude of the ECG trace.

ECG Pos. Adjust the vertical position of the ECG trace.
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Vascular

Vascular measurements and calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned.

Table 7-30 2D mode measurement (Vascular)

Measurement Description

Carotid Carotid Artery

	 CCA Common Carotid Artery

	 ICA Internal Carotid Artery

	 ECA External Carotid Artery

	 Vert. A Vertebral Artery

	 Bulb Carotid Bulb

UEA Upper Extremities Arteries 

	 Subclav. A Subclavian A

	 Axill. A Axillary Artery

	 Basilar A Basilar Artery

	 Brach. A Brachial Artery

	 DBA Deep Brachial Artery

	 Basilic A Basilic Artery

	 Radial A Radial Artery

	 Ulnar A Ulnar Artery

	 SPA Superficial Palmar Arch

	 Innom. A Innominate Artery

UEV Upper Extremities Veins 

	 IJV Internal Jugular Vein

	 Subclav. V Subclavian Vein

	 Ceph. V Cephalic Vein

	 Axill. V Axillary Vein

	 Brach. V Brachial Vein

	 DBV Deep Brachial Vein

	 Basilic V Basilic Vein
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Measurement Description

	 Radial V Radial Vein

	 Ulnar V Ulnar Vein

	 Innom. V Innominate Vein

LEA Lower Extremities Arteries 

	 CIA Common Iliac Artery

	 EIA External Iliac Artery

	 IIA Internal Iliac Artery

	 CFA Common Femoral Artery

	 DFA Deep Femoral Artery

	 SFA Superficial Femoral Artery

	 Pop. A Popliteal Artery

	 PTA Posterior Tibial Artery

	 ATA Anterior Tibial Artery

	 Peron. A Peroneal Artery

	 DPA Dorsalis Pedis Artery

	 Prof. A Profunda Femoris Artery

LEV Lower Extremities Veins 

	 CIV Common Iliac Vein

	 EIV External Iliac Vein

	 IIV Internal iliac vein

	 CFV Common Femoral Vein

	 DFV Deep Femoral Vein

	 SFV Superficial Femoral Vein

	 GSV Great Saphenous Vein

	 LSV Lesser Saphenous Vein

	 Pop. V Popliteal Vein

	 PTV Posterior Tibial Vein

	 ATV Anterior Tibial Vein

	 Peron. V Peroneal Vein

	 Prof. V Profunda Femoris Vein

TCD Transcranial Doppler

	 MCA Middle Cerebral Artery
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Measurement Description

	 ACA Anterior Cerebral Artery

	 PCA P1 Posterior Celebral Artery P1 segment 

	 PCA P2 Posterior Celebral Artery P2 segment 

	 Vert. A Vertebral Artery

	 Basilar A Basilar Artery

	 ICA Internal Carotid Artery

	 PComA Posterior Communicating Artery 

	 AComA Anterior Communicating Artery

Renal Renal

	 Renal A Renal Artery

	 Renal V Renal Vein

	 Segm. A Segmental Artery

	 Interlob. A Interlobar Artery of Kidney

	 Arcuate A Arcuate Artery of the Kidney

Aorta Iliac Aorta Iliac

	 Renal A Renal Artery

	 CFA Common Femoral Artery

Mesenteric Mesenteric

	 Abd. Aorta Aorta

	 Celiac A Celiac Artery

	 SMA Superior Mesenteric Artery

	 IMA Inferior Mesenteric Artery

	 Hepatic A Common Hepatic Artery

	 Portal V Portal Vein

	 Splenic A Splenic Artery

Bypass Graft Bypass Graft

	 Straight Gft Straight Graft

	 Loop Gft Loop Graft

	 Cimino Gft Cimino Graft

	 Comp Gft Comp Graft
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NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Vascular > 2D > Default Measurement.

To select a package measurement, 

1	1	 Select a package measurement folder. 

2	2	 Select the desired measurement from the measurement list.

In each package measurement, you can use the following measurements:

	• Diameter (Diam)

	• Area

	• %Stenosis-Diameter (%Steno(Diam) and %Steno(Diam) dist)

	• %Stenosis-Area (%Steno(Area))

	• Pre-Stent Diameter (Pre-Stent Diam.)

	• In-Stent Diameter (In-Stent Diam.)

	• Post-Stent Diameter (Post-Stent Diam.)

	• Auto IMT

	• Volume Flow Area



Vascular 7-133

	❚ %Stenosis (Diameter)

1	1	 Select %Steno(Diam) or %Steno(Diam) dist on the context menu. The start point appears.

2	2	 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key.

3	3	 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key.

4	4	 The two diameters percent stenosis (%Steno Diam or %Steno dist) are automatically shown on 
the Result window.

ESCT method= (L-R)/Lx100 %, N/ASCET method= (D-R)/Dx100 %

	• %Steno(Diam): Stenosis Local Gradient Diameter (%), ESCT (European Carotid Surgery Trial) 
method

	• %Steno(Diam) dist: Stenosis Distal Gradient Diameter (%), NASCET (North American 
Symptomatic Carotid Surgery Trial) method

	❚ %Stenosis (Area)

1	1	 Select %Steno(Area) on the context menu. The start point appears.

2	2	 Measure the outer area (A1) of the stenosis using [Trackball], and press the [Set] key.

3	3	 Measure the inner area (A2) of the stenosis using [Trackball], and press the [Set] key.

4	4	 The two diameters percent stenosis (%Steno Area) are automatically shown on the Result 
window.
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IMT measurements

IMT allows you to automatically measure the intima-media thickness of the wall in the carotid artery. 
When you place the start and end points in a line, the system shows the mean, max, standard deviation 
and quality index.

NOTE
You can use this feature only with linear transducer.

For optimal recognition and results, it is recommended to follow the conditions below:

	• Acquire a central plane through the vessel

	• Frequency range between 7 MHz and 12 MHz

	• Imaging depth between 30 mm and 45 mm

	• Optimize the gain control 

	• Minimize artifacts in the lumen of the vessel

To perform an IMT measurement,

1	1	 While scanning a carotid artery, press the [Freeze] key on the control panel.

2	2	 Press the [Measure] key and select Auto IMT in the labeled measurement menu. The start point 
appears.

3	3	 From the point of the arterial branch about 5 mm away, draw a straight line of 10 mm by using 
[Trackball]. The end point appears.

4	4	 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

5	5	 The system calculates the measured value and shows the Mean, Max, Distance, and QI on the 
Result window.

NOTE
You can view more measurement information including standard deviation in the Report or Mini Report 
page.
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To analyze an IMT measurement,

1	1	 Click IMT Analysis on the Report page.

2	2	 Select a measurement graph from the graph list, or from the soft key menu.

3	3	 Set the measurement options by using the soft key menu (IMT Measurement, Side, Location).

M mode measurements

M mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned.

Table 7-31 M mode measurement (Vascular)

Measurement Description

HR Heart Rate

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Vascular > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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D mode measurements

D mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned.

Table 7-32 D mode measurement (Vascular)

Measurement Description

PS Peak Systole (PS) Velocity

ED End Diastole (ED) Velocity

MD Minimum Diastole (MD)

S/D S/D Ratio

PI Resistive Index (RI)

RI Pulsatility Index (PI)

TAmax Maximum Time-Average Velocity (TAmax)

VTI Velocity Time Integral (VTI)

Vmax Pre, Vmax Intra Maximum Velocity 

Vmax Pre-Stent, Vmax In-
Stent, Vmax Post-Stent Stent Maximum Velocity 

Ved Pre-Stent, Ved In-Stent, 
Ved Post-Stent Stent Minimum Velocity 

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Vascular > Doppler > Default Measurement.
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To select a package measurement, 

1	1	 Select a package measurement folder. 

2	2	 Select a desired measurement from the measurement list.

In each package measurement, you can use the following measurements:

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD)

	• S/D Ratio (S/D)

	• Pulsatility Index (PI)

	• Resistive Index (RI)

	• Maximum Time-Average Velocity (TAmax)

	• Velocity Time Integral (VTI)

	• Maximum Velocity (Vmax Pre, Vmax Intra)

	• Stent Maximum Velocity (Vmax Pre-Stent, Vmax In-Stent, Vmax Post-Stent)

	• Stent Minimum Velocity (Ved Pre-Stent, Ved In-Stent, Ved Post-Stent)

	❚ Velocity 

1	1	 Select a labeled measurement for velocity on the context menu. The vertical line and the 
horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity is shown on the Result window.

	❚ PS/ED Ratio

1	1	 Select S/D on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (S) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D ratio (S/D) are shown on the Result 
window.
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	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform, and press the [Set] key.

4	4	 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The end point is fixed, and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window.

	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the maximum values of the desired portion for the spectrum.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window.
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D mode calculations

The calculation labels may not be available shown in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report.

Table 7-33 D mode calculations (Vascular)

Calculation Description Required

PVR Peak Velocity Ratio Vmax Pre-Stent
Vmax In-Stent

%Steno PVR Stenosis using the peak velocity ratio Vmax Pre-Stent
Vmax In-Stent

SD Peak Systole Velocity/End diastole Velocity Ratio PS, ED

ICA ED/CCA ED Internal Carotid Artery– End diastole Velocity Ratio / 
Common Carotid Artery – End diastole Velocity

CCA (ED)
ICA (ED)

ICA PS/CCA PS Internal Carotid Artery – Peak Systole Velocity /  
Common Carotid Artery – Peak Systole Velocity

CCA (PS)
ICA (PS)

Bulb PS/CCA PS Bulb – Peak Systole Velocity /  
Common Carotid Artery – Peak Systole Velocity

Bulb (PS)
CCA (PS)

Bulb ED/CCA ED Bulb – End diastole Velocity Ratio /  
Common Carotid Artery – End diastole Velocity

Bulb (ED)
CCA (ED)

Volume Flow Volumetric Blood Flow TAmax (or TAmean)
Volume Flow Area

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Vascular > Doppler > Default Measurement.

Define as:

PVR = Vmax (Stenosis intra) / Vmax (Stenosis pre) 

%Steno PVR = 1-(1/PVR)
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Vascular report 
The vascular report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27. 

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration.

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.



Vascular 7-141

Vascular summary
To start a summary,

–	 Select Summary on the context menu.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration.

Measurement information

On the Summary page, the result values are shown on the each side (left, right), if the measurement 
includes the both side values.

NOTE
You cannot edit the result values on the Summary page.

Calculation information

The calculation information is shown on the bottom of the Summary page. The following information is 
available: ICA PS/CCA PS, ICA ED/CCA ED, Bulb PS/CCA PS, Bulb ED/CCA ED
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Urology

Urology measurements and calculations 

2D mode measurements

2D mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned.

Table 7-34 2D mode measurement (Urology)

Measurement Description

Renal L Renal Length

Renal Renal Volume

	 Renal L Renal Length

	 Renal H Renal Height

	 Renal W Renal Width

Bladder Bladder Volume

	 Bladder L Bladder Length

	 Bladder H Bladder Height

	 Bladder W Bladder Width

Testicle Testicle Volume

	 Testicle L Testicle Length

	 Testicle H Testicle Height

	 Testicle W Testicle Width

Prostate Prostate Volume

	 Prostate L Prostate Length

	 Prostate H Prostate Height

	 Prostate W Prostate Width

Residual Residual Volume

	 Pre L Pre Bladder Length

	 Pre H Pre Bladder Height

	 Pre W Pre Bladder Width

	 Post L Post Bladder Length

 	 Post H Post Bladder Height

	 Post W Post Bladder Width

	 Pre Vol Pre Bladder Volume
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Measurement Description

	 Post Vol Post Bladder Volume

	 Void Vol Void Volume (Difference between Pre and Post Volume)

Renal Vol Renal Volume

Bladder Vol Bladder Volume

Testicle Vol Testicle Volume

Prostate Vol Prostate Volume

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Urology > 2D > Default Measurement.

	❚ Renal Volume (1)

You can measure the length, width, and height for the left and right renal. Each measurement is a 
typical distance measurement made in the appropriate scan plane.

1	1	 Select the Rt (right) or Lt (left) on the context menu.

2	2	 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurement are completed, the renal volume is 
calculated.

5	5	 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.



7-144 Measurements and Reports

	❚ Renal Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Renal Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

5	5	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

6	6	 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key.

	• To configure the renal volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Urology > Renal Vol > Edit.

	❚ Bladder Volume (1)

You can measure the length, width, and height of the bladder. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane.

1	1	 Select the Bladder folder on the context menu.

2	2	 Select Bladder L, Bladder H, or Bladder W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point.

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the bladder volume is 
calculated.

5	5	 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window.
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	❚ Bladder Volume (2)

1	1	 Select Bladder Vol on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

4	4	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

5	5	 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the bladder volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Urology > Bladder Vol > Edit.

2D mode calculations

NOTE
The calculation labels are not shown in the measurement menu.

The system performs the calculations when the required measurements are made. The system also 
shows the calculated values in the measured results and transfers the values to the report.

Table 7-35 2D mode calculations (Urology)

Calculation label Description Required measurements 

PSAD Prostatic Specific Antigen Density PSA
Prostate Volume

PPSA(1) Predicted Prostate 
Specific Antigen

PPSA Coefficient (1)
Prostate Volume

PPSA(2) Predicted Prostate 
Specific Antigen

PPSA Coefficient (2)
Prostate Volume

Define as:

PSAD = PSA / Prostate Vol

PPSA = Prostate Vol × PPSA Coefficient 

NOTE
If you enter the value of PSA and PPSA Coefficient on the Urology Patient Registration, PSAD and PPSA are 
automatically calculated.



7-146 Measurements and Reports

	❚ Prostate Volume (1)

You can measure the length, width, and height of the prostate. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane.

1	1	 Select the Prostate folder on the context menu.

2	2	 Select Prostate L, Prostate H, or Prostate W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the prostate volume is 
calculated.

5	5	 The measured value is fixed. The prostate volume (Prostate Vol) and calculations (PSAD and 
PPSA) are shown on the Result window.

	❚ Prostate Volume (2)

1	1	 Select Prostate Vol on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.	

4	4	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

5	5	 The measured value is fixed, and the prostate volume (Prostate Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the prostate volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Urology > Prostate Vol > Edit.
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M mode measurements

M mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned.

Table 7-36 M mode measurement (Urology)

Measurement Description 

HR Heart Rate 

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Urology > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

 NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.

D mode measurements

D mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned.

Table 7-37 D mode measurement (Urology)

Measurement Description 

Vessel Vessel

HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Urology > Doppler > Default Measurement.
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Urology report
The urology report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

	• PSA 

	• PPSA Coef(1)

	• PPSA Coef(2)

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method. 
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Pediatrics

Pediatrics measurements and calculations 

2D mode measurements

2D mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned.

Table 7-38 2D mode measurement (Pediatrics)

Measurement Description

Aorta Aorta Diameter

Renal L Renal Length

Renal Renal Volume

	 Renal L Renal Length

	 Renal H Renal Height

	 Renal W Renal Width

Renal Vol Renal Volume

Hip Hip Angle

	 Hip(BA) The system calculates and shows angles β and α.

	 Hip(AB) The system calculates and shows angles α and β.

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Pediatrics > 2D > Default Measurement.
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	❚ Renal Volume (1)

You can measure the length, width, and height of the left and right renal. Each measurement is a 
typical distance measurement made in the appropriate scan plane.

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point.

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the renal volume is 
calculated.

5	5	 The measured value is fixed. The renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.

	❚ Renal Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Renal Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

5	5	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

6	6	 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the renal volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Pediatrics > Renal Vol > Edit.
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	❚ Hip Joint (BA)

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the beta angle (β). The third line establishes the alpha angle (α).

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Hip folder, and then select Hip(BA).  
The first distance measurement (baseline) is already selected.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The baseline is completed.

5	5	 Perform the measurement for the second (β) and third (α) distances.

6	6	 When all of the three lines are measured, the hip angle is calculated. 

7	7	 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window.

F
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α
β 

	• To define the baseline, point a and b. 

	• To define the α angle line, point c and d.

	• To define the β angle line, point e and f.

	❚ Hip Joint (AB)

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the alpha angle (α). The third line establishes the beta angle (β).

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Hip folder, and then select Hip(AB).  
The first distance measurement (baseline) is already selected.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The baseline is completed.

5	5	 Perform the measurement for the second (α) and third (β) distances.

6	6	 When all of the three lines are measured, the hip angle is calculated. 

7	7	 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window.
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M mode measurements

M mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned.

Table 7-39 M mode measurement (Pediatrics)

Measurement Description 

HR Heart Rate

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Pediatrics > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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D mode measurements

D mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned.

Table 7-40 D mode measurement (Pediatrics)

Measurement Description

Aorta Aorta

Renal A Renal Artery

CHA Hepatic Artery

IVC Inferior Vena Cava

Hepatic V Hepatic Vein

Mid HV Middle Hepatic Vein

MPV Main Portal Vein

Portal V Portal Vein

Splenic A Splenic Artery

Splenic V Splenic Vein

SMA Superior Mesenteric Artery

SMV Superior Mesenteric Vein

IMA Inferior Mesenteric Artery

Iliac A Iliac Artery

Iliac V Iliac Vein

Vessel Vessel

HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Pediatrics > Doppler > Default Measurement.

To select a package measurement, 

1	1	 Select a package measurement folder. 

2	2	 Select a desired measurement from the measurement list.
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In each package measurement for Doppler mode, you can use the following measurements:

	• Auto Trace

	• Semi Auto Trace

	• Manual Trace

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD) 

	• S/D or D/S Ratio (S/D or D/S)

	• Pulsatility Index (PI) 

	• Resistive Index (RI) 

	• Maximum Time-Average Velocity (TAmax)

	• Acceleration (Accel)

	• Acceleration Time (AT)

NOTE
To configure the default package measurement for Doppler mode, press the [System Preset] key and 
go to Measurement > Labeled MEAS. > Pediatrics > Doppler > Package measurement > desired default 
measurements.

	❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD)

1	1	 Select PS, ED, or MD on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window.

	❚ PS/ED or ED/PS Ratio

1	1	 Select S/D or D/S on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window.
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	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The end point is fixed and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window.

	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 To trace the maximum value of the desired portion for the spectrum, use [Trackball].

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window.
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	❚ Acceleration (Accel)

1	1	 Select Accel on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window.

	❚ Acceleration Time (AT)

1	1	 Select AT on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window.



Pediatrics 7-157

Pediatrics report
The pediatrics report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration.

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method. 
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Small Parts

Small parts measurements and calculations

2D mode measurements

2D mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned.

Table 7-41 2D mode measurement (Small parts)

Measurement Description

Thyroid Vol Thyroid Volume

Testicle Vol Testicle Volume

Thyroid Thyroid Volume

	 Thyroid L Thyroid Length

	 Thyroid H Thyroid Height

	 Thyroid W Thyroid Width

Testicle Testicle Volume

	 Testicle L Testicle Length

	 Testicle H Testicle Height

	 Testicle W Testicle Width

Isthmus Testicle Volume

	 Isthmus H Isthmus Height

Nodule Nodule Volume

	 Nodule # 1–10 Measurements of the left and right Thyroid Nodule 

Lymph Node Lymph Node Volume

	� Lymph Node # 1–10 Measurements of the Lymph Node

Parathyroid Parathyroid Volume

	� Parathyroid # 1–4 Measurements of the left and right Parathyroid

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Small Parts > 2D > Default Measurement.
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	❚ Thyroid Volume (1)

You can measure the length, width, and height for the left and right thyroid. The each measurement is 
a typical distance measurement made in the appropriate scan plane.

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Thyroid folder, and then select Thyroid L, Thyroid H, or Thyroid W. The start point 
appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the thyroid volume is 
calculated.

5	5	 The measured value is fixed, and the thyroid volume (Rt or Lt Thyroid Vol) is shown on the 
Result window.

	❚ Thyroid Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Thyroid Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

5	5	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

6	6	 The measured value is fixed, and the thyroid volume (Rt or Lt Thyroid Vol) is shown on the 
Result window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the thyroid volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Small Parts > Thyroid Vol > Edit.
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	❚ Testicle Volume (1)

You can measure the length, width, and height of the scrotum. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane.

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Testicle folder, and then select Testicle L, Testicle H, or Testicle W. The start point 
appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the testicle volume is 
calculated.

5	5	 The measured value is fixed, and the testicle volume (Rt or Lt Testicle Vol) is shown on the 
Result window.

	❚ Testicle Volume (2)

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Testicle Vol. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

5	5	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

6	6	 The measured value is fixed, and the testicle volume (Rt or Lt Testicle Vol) is shown on the 
Result window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the testicle volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Small Parts > Testicle Vol > Edit.
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M mode measurements

M mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned.

Table 7-42 M mode measurement (Small parts)

Measurement Description 

Distance Distance

Time Time

Slope Slope

HR Heart Rate 

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Small Parts > M > Default Measurement.

	❚ Distance

1	1	 Select Distance on the context menu. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The measured value is fixed, and the distance (D) is shown on the Result window.

	❚ Time

1	1	 Select Time on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The time (T) is shown on the Result window.

	❚ Slope

1	1	 Select Slope on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window.
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	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.

D mode measurements

D mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned.

Table 7-43 D mode measurement (Small parts)

Measurement Description 

Thyroid Flow Thyroid Flow

Testicle Flow Testicle Flow

HR Heart Rate 

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Small Parts > Doppler > Default Measurement.
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Small parts report
The small parts report has three sections of information:

	• Patient information

	• Measurement information

	• Thyroid analysis

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method.
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Thyroid analysis
To start the thyroid anaysis,

–	 While viewing the thyroid report, select Analysis on the context menu.

NOTE
The patient specific contents input on the Analysis page are returned to the factory default settings after 
starting a new patient.

Analysis lists

Table 7-44 Thyroid nodule analysis lists

List Descriptive data Options

Position Superior Anterior

Superior Posterior

Medium Anterior

Medium Posterior 

Inferior Anterior 

Inferior Posterior

Isthmus 

Shape Round

Wider than tall

Taller than wide

Irregular

Composition Solid 

Predominately Solid 

Predominately Cystic 

Cystic

Spongiform

Echogenecity Markedly Hypoechoic

Hypoechoic

Isoechoic

Hyperechoic

Echotexture Homogeneous

Heterogeneous
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List Descriptive data Options

Calcifications Absent

Micro Ca++

Macro Ca++

Peripheral rim Ca++

Margin Well-defined Regular, Irregular

Ill-defined Regular, Irregular

Halo sign Absent

Complete Thin, Thick

Partial Thin, Thick

Vascularity Absent

Perinodular

Peri-Intranodular

Lymph Nodes Normal

Suspect Intramammary, Axillary

Elasticity Assessment Soft 

Intermediate

Hard

Measurement Strain Ratio

Assessment
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Breast

Breast measurements and calculations

2D mode measurements

2D mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned.

Table 7-45 2D mode measurement (Breast)

Measurement Description

Mass# 1–10 Measurements of the left and right breast mass

	 Mass L Mass Length

	 Mass H Mass Height

	 Mass W Mass Width

	 Mass Nip-Mass D Mass Nipple Mass Diameter

	 Mass Skin-Mass D Mass Skin Mass Diameter

	 Mass Vol Mass Volume

Duct Dilatation Duct Dilatation

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Breast > 2D > Default Measurement.

	❚ Mass Volume

You can make the breast mass volume from one, two, or three distance measurements.

1 Distance Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Mass folder. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point.

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the mass volume (Rt or Lt Mass Vol) is shown on the Result 
window.
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2 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Mass folder. The start point appears.

a.	 Move the marker to the start point using [Trackball].

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Move the marker to the end point using [Trackball].

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second distance in the same manner (a-d).

4	4	 When the second distances are measured, press the [Set] key.

5	5	 The measured value is fixed, and the mass volume (Rt or Lt Mass Vol) is shown on the Result 
window.

3 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Mass folder. The start point appears.

a.	 Use [Trackball] to move the marker to the start point.

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d). When 
three distances are measured, the volume is calculated.

4	4	 The measured value is fixed, and the mass volume (Rt or Lt Mass Vol) is shown on the Result 
window.

NOTE
To configure the Mass volume method, press the [System Preset] key and go to Measurement > Labeled 
MEAS. > Breast > Edit.
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M mode measurements

M mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned.

Table 7-46 M mode measurement (Breast)

Measurement Description 

Distance Distance

Time Time

Slope Slope

HR Heart Rate 

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > Breast > M > Default Measurement.

	❚ Distance

1	1	 Select Distance on the context menu. 
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The measured value is fixed, and the distance (D) is shown on the Result window.

	❚ Time

1	1	 Select Time on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The time (T) is shown on the Result window.

	❚ Slope

1	1	 Select Slope on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window.
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	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.

D mode measurements

D mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned.

Table 7-47 D mode measurement (Breast)

Measurement Description 

Breast Flow Breast Flow

HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Breast > Doppler > Default Measurement.
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Breast report
The breast report has three sections of information:

	• Patient information

	• Measurement information

	• Breast analysis

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report function, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration.

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method. 
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Breast analysis
To start the breast anaysis,

–	 While viewing the breast report, select Analysis on the context menu.

NOTE
The patient specific contents input on the Analysis page are returned to the factory default settings after 
starting a new patient.

Analysis lists

Table 7-48 Breast mass analysis lists

List Descriptive data Options

Position (0–12):(00,30) o’clock

Shape Round

Oval

Irregular

Orientation Wider than tall 

Taller than wide

Margin Circumscribed

Not circumscribed Indistinct, Angular, Microlobulated, 
Spiculated

Echo Pattern Anechoic

Hyperechoic

Complex cystic and solid

Hypoechoic

Isoechoic

Heterogeneous

Posterior Features No posterior feature 

Enhancement

Shadowing

Combined pattern

 Calcifications Not Present

Macro Ca++

Micro Ca++ in a mass

Micro Ca++ outside of a mass

Intraductal Ca++
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List Descriptive data Options

Associated Features Architectural distortion (Blank)

Duct change

Skin thickening

Skin retraction

Edema

Vascularity Not present 

Vessels in rim

Internal vascularity

Lymph Nodes Normal

Suspect Intramammary, Axillary

Elasticity Assessment Soft

Intermediate

Hard

Measurement Strain Ratio

RI < 0.70, ≥ 0.70

BI-RADS Category 0, 1, 2, 3, 4, 5, 6 

Assessment
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Musculoskeletal (MSK)

MSK measurements and calculations

2D mode measurements

2D mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned.

Table 7-49 2D mode measurement (MSK)

Measurement Description 

Volume Volume

Hip(BA) The system calculates and shows angles β and α.

Hip(AB) The system calculates and shows angles α and β.

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > MSK > 2D > Default Measurement.

	❚ Volume

You can make the volume from one, two, or three distance measurements.

1 Distance Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Volume. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point.

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window.
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2 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Volume. The start point appears.

a.	 Move the marker to the start point using [Trackball].

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point appears.

c.	 Move the marker to the end point using [Trackball].

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second distance in the same manner (a-d).

4	4	 When the second distances are measured, press the [Set] key.

5	5	 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window.

3 Distances Volume

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select the Volume. The start point appears.

a.	 Use [Trackball] to move the marker to the start point.

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When three distances are measured, the volume is calculated.

5	5	 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window.

NOTE
To configure the volume method, press the [System Preset] key and go to Measurement > Labeled MEAS. 
> MSK > Edit.
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	❚ Hip(BA)

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the beta angle (β). The third line establishes the alpha angle (α).

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Hip(BA). The first distance measurement (baseline) is already selected.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. The 
baseline is completed.

5	5	 Perform the measurement for the second (β) and third (α) distances.

6	6	 When all of the three lines are measured, the hip angle is calculated.

7	7	 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window.

	❚ Hip(AB)

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the alpha angle (α). The third line establishes the beta angle (β).

1	1	 Select Rt (right) or Lt (left) on the context menu. 

2	2	 Select Hip(AB). The first distance measurement (baseline) is already selected.

3	3	 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears.

4	4	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. The 
baseline is completed.

5	5	 Perform the measurement for the second (α) and third (β) distances.

6	6	 When all of the three lines are measured, the hip angle is calculated.

7	7	 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window.
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M mode measurements

M mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned.

Table 7-50 M mode measurement (MSK)

Measurement Description 

HR Heart Rate 

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > MSK > M > Default Measurement.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.

D mode measurements

D mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned.

Table 7-51 D mode measurement (MSK)

Measurement Description 

Vessel Vessel

HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > MSK > Doppler > Default Measurement.
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MSK report
The MSK report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit the patient information, go to Patient Registration. 

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item. If you make more than five measurements, the 
report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method.
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Emergency Medicine (EM)

EM measurements and calculations

2D mode measurements 

2D mode measurements are shown in the context menu and in the EM report with measured result, 
when assigned.

Table 7-52 2D mode measurement (EM)

Measurement Description 

Aorta Aorta

Renal L Renal Length

Bladder Bladder Volume 

	 Bladder L Bladder Length 

	 Bladder H Bladder Height 

	 Bladder W Bladder Width 

Bladder Vol Bladder Volume

NOTE
To configure the default measurement for 2D mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > EM > 2D > Default Measurement.

	❚ Aorta Diameter

1	1	 Select Aorta on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point. 

3	3	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

4	4	 Use [Trackball] to move the marker to the end point.

5	5	 To complete the measurement, press the [Set] key.

6	6	 The measured value is fixed, and the aorta diameter (Aorta) is shown on the Result window.
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	❚ Renal Length

1	1	 Select Rt (right) or Lt (left) on the context menu.

2	2	 Select Renal L. The start point appears.

3	3	 Use [Trackball] to move the marker to the start point. 

4	4	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

5	5	 Use [Trackball] to move the marker to the end point.

6	6	 To complete the measurement, press the [Set] key.

7	7	 The measured value is fixed, and the renal length (Rt or Lt Renal L) is shown on the Result 
window.

	❚ Bladder Volume (1)

You can measure the length, width, and height of the bladder. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane.

1	1	 Select the Bladder folder on the context menu.

2	2	 Select Bladder L, Bladder H, or Bladder W. The start point appears.

a.	 Use [Trackball] to move the marker to the start point. 

b.	 To fix the point, press the [Set] key. The end point, overlapping the start point, appears.

c.	 Use [Trackball] to move the marker to the end point.

d.	 To complete the measurement, press the [Set] key.

3	3	 Perform the measurement of the second and third distance in the same manner (a-d).

4	4	 When the length, width, and height measurements are completed, the bladder volume is 
calculated.

5	5	 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window.
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	❚ Bladder Volume (2)

1	1	 Select Bladder Vol on the context menu. The start point appears.

2	2	 Use [Trackball] to move the marker to the start point, and press the [Set] key.  
The first point is fixed, and the second point appears.

3	3	 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured.

4	4	 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated.

5	5	 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window.

NOTE
	• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key.

	• To configure the bladder volume method, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > EM > Bladder Vol > Edit.
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M mode measurements 

M mode measurements are shown in the context menu and in the EM report with measured result, 
when assigned.

Table 7-53 M mode measurement (EM)

Measurement Description 

%Stenosis Two Diameters Percent Stenosis

A/B Ratio Two Diameters Ratio

HR Heart Rate

NOTE
To configure the default measurement for M mode, press the [System Preset] key and go to Measurement > 
Labeled MEAS. > EM > M > Default Measurement.

	❚ %Stenosis (Diameter)

1	1	 Select %Stenosis on the context menu. The start point appears.

2	2	 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key.

3	3	 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key.

4	4	 The two diameters percent stenosis (%Steno(Diam)) are shown on the Result window.

	❚ A/B Ratio (Diameter)

1	1	 Select A/B Ratio on the context menu. The start point appears.

2	2	 Measure the first diameter (A) of the ratio using [Trackball], and press the [Set] key. 

3	3	 Measure the second diameter (B) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated and two diameters ratio (A/B Ratio) are shown on the Result window.

	❚ Heart Rate (HR)

1	1	 Select HR on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window.

NOTE
To configure the heart rate cycle, press the [System Preset] key and go to Measurement > Advanced 
MEAS. > HR cycle.
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D mode measurements

D mode measurements are shown in the context menu and in the EM report with measured result, when 
assigned.

Table 7-54 D mode measurement (EM)

Measurement Description 

Aorta Aorta

Renal A Renal Artery

SMA Superior Mesenteric Artery

IMA Inferior Mesenteric Artery

IVC Inferior Vena Cava

Uterine A Uterine Artery

Ovarian A Ovarian Artery 

Vessel Vessel

HR Heart Rate

NOTE
To configure the default measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > EM > Doppler > Default Measurement.

To select a package measurement, 

1	1	 Select a package measurement folder.

2	2	 Select the desired measurement from the measurement list.

In each package measurements for Doppler mode, you can use the following measurements:

	• Auto Trace

	• Semi Auto Trace

	• Manual Trace

	• Peak Systole (PS)

	• End Diastole (ED)

	• Minimum Diastole (MD) 

	• S/D or D/S Ratio (S/D or D/S)

	• Pulsatility Index (PI) 

	• Resistive Index (RI) 

	• Maximum Time-Average Velocity (TAmax)

	• Acceleration (Accel)

	• Acceleration Time (AT)
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NOTE
To configure the default package measurement for Doppler mode, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > EM > Doppler > Package measurement > a default measurement.

	❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD)

1	1	 Select PS, ED, or MD on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key.

3	3	 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window.

	❚ PS/ED or ED/PS Ratio

1	1	 Select S/D or D/S on the context menu.  
The vertical line and the horizontal line are perpendicular to each other.

2	2	 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key.

3	3	 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key.

4	4	 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window.

	❚ Pulsatility Index (PI)

1	1	 Select PI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to manually trace the waveform.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window.

	❚ Resistive Index (RI)

1	1	 Select RI on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again. The end point is fixed.

4	4	 The resistive index is calculated, and the resistivity index (RI) is shown on the Result window.
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	❚ Maximum Time-Average Velocity (TAmax)

1	1	 Select TAmax on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key.  
The end point appears.

3	3	 Use [Trackball] to trace the maximum value of the desired portion for the spectrum.

4	4	 To complete the measurement, press the [Set] key.

5	5	 The maximum time-average is calculated, and the maximum time-average (TAmax) is shown on 
the Result window.

	❚ Acceleration (Accel)

1	1	 Select Accel on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window.

	❚ Acceleration Time (AT)

1	1	 Select AT on the context menu.  
The vertical line and the horizontal line are perpendicular to each other. 

2	2	 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears.

3	3	 Use [Trackball] to move the point, and press the [Set] key again.

4	4	 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window.
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EM report
The EM report has two sections of information:

	• Patient information

	• Measurement information

To start a report, 

–	 Press the [Report] key on the control panel.

–	 Select Report on the context menu.

For report functions, see "Report" on page 7-27.

Patient information

	• ID

	• Name

	• Age

	• Sex

	• Exam date 

	• Referring MD

NOTE
To edit tahe patient information, go to Patient Registration.

Measurement information

	• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a report" on page 7-29.

	• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five.

	• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min.

NOTE
To configure the default method for the measurement value, press the [System Preset] key and go to 
Measurement > Labeled MEAS. > Edit > Method.
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This chapter describes the transducer overview and biopsy preparations.

Transducer and Biopsy
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Transducer
The ultrasound system uses transducers to obtain graphic data of the human body and then displays it 
on the screen. Always use application-specific transducers in order to obtain the best quality images. It is 
also important to use a preset that is best suited to the particular organ being scanned.

Transducer components

6

5

4

8

1

2 3

7

Figure 8-1 Transducer components

No. Component No. Component 

1 Connector electrical contacts 5 Transducer strain relief 

2 Connector housing 6 Transducer handle 

3 Connector strain relief 7 Transducer lens

4 Transducer cable 8 Transducer neck
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Compatible Transducers
The following transducers are compatible with the E-CUBE 8 ultrasound system:

NOTE
The manual refers to transducers that can be connected to the system. It might be possible that some 
transducers or applications are not available in some countries.

Table 8-1 Compatible transducers

Transducer Type Application Biopsy Guide

L3-12H

Linear

Abdomen, Pediatric, Small 
Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)

	• L3-12 Biopsy Starter Kit
	• Multi-angle

L3-12T

Linear

Abdomen, Pediatric, Small 
Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)

	• L3-12 Biopsy Starter Kit
	• Multi-angle

L3-12HWD

Linear

Abdomen, Pediatric, Small 
Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)

L8-17H

Linear

Abdomen, Pediatric, Small 
Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)

IO3-12

Linear

Small Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)

IO8-17T

Linear

Intra-operative, Pediatric, 
Small Parts, Musculoskeletal 
(MSK), Vascular, Emergency 
Medicine (EM)
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Transducer Type Application Biopsy Guide

C1-6CT

Convex

OB, GYN, Abdomen, 
Pediatric, Musculoskeletal 
(MSK), Urology, Emergency 
Medicine (EM)

	• SC1-6 Biopsy Starter kit
	• Multi-angle

C5-8NT

Convex

OB, Pediatric, Abdomen, 
Cardiac, Emergency 
Medicine (EM)

SC1-4H

Convex

OB, Abdomen, Pediatric, 
Musculoskeletal (MSK), 
Vascular, Urology, 
Emergency Medicine (EM)

	• SC1-6 Biopsy Starter Kit
	• Multi-angle

SC1-4HS

Convex

OB, Abdomen, Pediatric, 
Musculoskeletal (MSK), 
Vascular, Urology, 
Emergency Medicine (EM)

	• SC1-4HS Biopsy Starter Kit
	• Multi-angle

SC1-6H

Convex

OB, Abdomen, Pediatric, 
Musculoskeletal (MSK), 
Vascular, Urology, 
Emergency Medicine (EM)

	• SC1-6 Biopsy Starter Kit
	• Multi-angle

P1-5CT

Sector Phased

Abdomen, Pediatric, TCD 
(Transcranial), Cardiac, 
Emergency Medicine (EM)

SP3-8T

Sector Phased

Abdomen, Pediatric, TCD 
(Transcranial), Cardiac, 
Emergency Medicine (EM)

E3-10

Endocavity

OB, GYN, Urology, 
Emergency Medicine (EM)

	• E3-10 Disposable Needle Guide
	• E3-10 Reusable Needle Guide
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Transducer Type Application Biopsy Guide

EC3-10T

Endocavity

OB, GYN, Urology, 
Emergency Medicine (EM)

	• EN3-10 Disposable Needle 
Guide

	• EN3-10 Reusable Needle Guide

EV3-10T

Endocavity

OB, GYN, Urology, 
Emergency Medicine (EM)

	• EN3-10 Disposable Needle 
Guide

	• EN3-10 Reusable Needle Guide

VC1-6T

Volume Convex

OB, GYN, Abdomen, 
Pediatric, Urology, 
Emergency Medicine (EM)

VE3-10H

Volume 
Endocavity

OB, GYN, Urology, 
Emergency Medicine (EM)

	• VE3-10H Disposable Needle 
Guide

	• VE3-10H Reusable Needle 
Guide

CW2.0

Pencil Doppler

Cardiac

CW5.0

Pencil Doppler

Cardiac
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Transducer- specific features
Table 8-2 Transducer feature

Feature

Model

Harmonics 
(THI)

Speckle 
Reduction 
Imaging 

(SRI)

Multi-
beam Biopsy 4D Easy 

3D
Virtual 
Convex

Spatial 
Compounding

C1-6CT o o o o x x x o

C5-8NT o o o x x x x o

SC1-4H o o o o x x x o

SC1-4HS o o o o x x x o

SC1-6H o o o o x x x o

CW2.0 x x x x x x x x

CW5.0 x x x x x x x x

EV3-10T o o o o x x x o

EC3-10T o o o o x x x o

E3-10 o o o o x x x o

L3-12H o o o o x x o o

L3-12T o o o o x x o o

L3-12HWD o o o x x x o o

L8-17H o o o x x x o o

IO3-12 o o o x x x o o

IO8-17T o o o x x x o o

SP3-8T o o o x x x x x

P1-5CT o o o x x x x x

VE3-10H o o o o o o x o

VC1-6T o o o x o o x o
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Biopsy
A biopsy is a medical procedure that obtains a tissue sample of a very specific area of the body for 
diagnostic testing. The transducer and the biopsy kit are used together when conducting a biopsy with 
the ultrasound system.

Using ultrasound for needle placement assures accuracy of the cell retrieval by verifying the exact site of 
biopsy and minimizes the risk to the patient.

Biopsy kit components
The biopsy kit components vary depending on the transducer type. The components are as following:

1 1

2 3 4

5

Figure 8-2 Biopsy starter kit

No. Component No. Component 

1 Needle guide bracket 4 Sheath 

2 Needle guide & Needle barrel 5 Rubber band

3 Gel

NOTE
The biopsy starter kit can be purchased from ALPINION MEDICAL SYSTEMS.
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Precautions concerning the use of biopsy procedure

WARNING 	• Do not freeze the image during a biopsy procedure. The image must be live to avoid 
a positioning error. Biopsy guidezones are intended to assist the user in determining 
optimal transducer placement and approximate the needle path. However, actual 
needle movement is likely to deviate from the guideline. Always monitor the relative 
positions of the biopsy needle and the subject mass during the procedure.

	• Biopsy procedures should not be used for In vitro fertilization (IVF), Chronic villus 
sampling (CVS), and Percutaneous umbilical blood sampling (PUBS).

CAUTION 	• The use of biopsy devices and accessories that have not been evaluated for use with 
this equipment may not be compatible and could result in injury.

	• The invasive nature of biopsy procedures requires proper preparation and technique 
to control infection and disease transmission. Equipment must be cleaned as 
appropriate for the procedure prior to use.
–	 Follow the transducer cleaning and disinfection procedures and precautions to 

properly prepare the transducer.
–	 Follow the manufacturer's instructions for the cleaning of biopsy devices and 

accessories.
–	 Use protective barriers such as gloves and transducer sheaths.
–	 After use, follow proper procedures for decontamination, cleaning, and waste 

disposal.
	• Improper cleaning methods and the use of certain cleaning and disinfecting agents 

may cause damage to the plastic components that will degrade imaging performance 
or increase the risk of electric shock. For details, see "Transducer Safety Information" 
on page 11-7.

	• A biopsy must only be performed by physicians with adequate experiences under 
all circumstances the necessary safety precautions and sterility measures have to be 
respected.
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The biopsy guidezone display

WARNING
	• Do not freeze the image during a biopsy procedure. The image must be live to avoid a positioning error.
	• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. It is 

the user's responsibility to verify correct positioning of the needle during a biopsy procedure.

The biopsy guidezone represents a path of the needle. Colored markers in each dotted guideline show 
the actual increments in the area of the anatomy.

	• Yellow marker is represented by 1 cm increment of the needle depth.

	• Blue marker is represented by 5 cm increment of the needle depth.

NOTE
When Enable 0.5cm markers in Image Preset is selected, each yellow maker represents 0.5 increment. 

The display should be carefully monitored during a biopsy for any needle deviation from the center line 
and the guidezone. The biopsy guidezone appears along with image adjustments such as image invert, 
rotation, zoom, and depth change.

Figure 8-3 Biopsy guidezone
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Preparing the biopsy guide attachment
The each transducer (convex, sector, and linear transducers) has the optional biopsy guide attachment. 
The guide consists of a non-disposable bracket to attach to the transducer, disposable needle clip to 
attach to the bracket, sheath, coupling gel, and disposable needle guide. The disposable needle guides 
are available for a variety of needle sizes.

NOTE
Please refer to the manufacturer's instructions included in the biopsy kit.

The following table shows the multi-angle biopsy guide availability for transducers.

Table 8-3 Multi-angle biopsy guide

Transducer Multi-angle  
support

Angle 1 
(Target depth)

Angle 2 
(Target depth)

Angle 3 
(Target depth)

C1-6CT O 4 cm 7cm 10 cm

L3-12H O 1.5 cm 2.3 cm 3.5 cm

L3-12T O 1.5 cm 2.3 cm 3.2 cm

SC1-4H O 4 cm 7 cm 10 cm

SC1-6H O 4 cm 7 cm 10 cm

SC1-4HS O 4 cm 7 cm 10 cm
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Assembling the multi-angle biopsy guide

WARNING
DO NOT attempt to use the biopsy bracket and needle guide until the manufacturer's instructions, provided 
with the biopsy bracket and needle guide in the kit, have been read and thoroughly understood.

NOTE
For detailed information on a biopsy guide, please contact the manufacturer(CIVCO) of the biopsy guide.

1	1	 Scan the patient and identify the target for biopsy. Move the transducer to locate the target to the 
center of the image. Enable the system biopsy guidezone and try guidezone angles 1 to 3 to decide 
the best angle setting for the needle path.

2	2	 Prepare the appropriate biopsy guide bracket by matching the transducer label on the bracket with 
the transducer to be used.

3	3	 Orient the guide bracket toward the orientation mark of the transducer, and then attach the 
bracket by sliding it over the end of the transducer until it clicks in place.

Convex transducer Linear transducer

NOTE
Depending on the transducer you are using, attaching the guide bracket may be different. Refer to the 
manufacturer’s instruction included in the biopsy kit.

4	4	 Pull up the knob to release to move the needle guide attachment. Align the knob with a desired 
angle position (angle 1, 2, or 3) and push the knob down to secure the angle position. 

CAUTION
Hold the bracket in place on the transducer when pushing the knob to secure the angle position of the 
needle guide attachment. Excessive force may cause the bracket to release from the transducer.
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5	5	 Place the ultrasound gel inside a sanitary sheath.

6	6	 Cover the transducer and biopsy bracket with the sanitary sheath. Use the rubber bands to tighten 
the sheath.

7	7	 Snap the needle guide onto the biopsy guide bracket. 

8	8	 Push the locking mechanism towards the bracket to secure the lock. Make sure that the needle 
guide is firmly attached to the bracket.
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9	9	 Select a desired size of the needle barrel from the plastic tree. Twist the needle barrel back and 
forth to remove it.

10	10	 Place the needle barrel into the needle guide until it clicks into place.

CAUTION
Before performing a biopsy, ensure that all guide parts are seated properly.
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Assembling the single-angle biopsy guide

WARNING
DO NOT attempt to use the needle guide until the manufacturer's instructions, provided with the needle 
guide in the kit, have been read and thoroughly understood.

NOTE
For detailed information on a biopsy guide, please contact the manufacturer(Protek Medical Products) of the 
biopsy guide.

Reusable biopsy guide (Metal)

1	1	 Place the ultrasound gel inside the sheath and/or on the transducer scanning surface. 
Place the transducer sheath over the transducer and secure the sheath with bands.

2	2	 Place the needle guide (styles vary) onto the transducer as shown.

3	3	 Make sure the needle guide is securely attached to the transducer.
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4	4	 Place the second sheath over the transducer and needle guide. Secure the sheath with bands.

Disposable biopsy guide (Plastic)

1	1	 Place the ultrasound gel inside the sheath and/or on the transducer scanning surface. 
Place the transducer sheath over the transducer and secure the sheath with bands.

2	2	 Place the needle guide onto the transducer and snap into position. 
Make sure the needle guide is securely attached to the transducer.

3	3	 Place the second sheath over the transducer and needle guide. Secure the sheath with bands.
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Verifying the biopsy needle path

WARNING
	• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. It is 

the user's responsibility to verify correct positioning of the needle during a biopsy procedure. 
	• The path of the needle must display within the guideline. Do not use a needle guide if the path of the 

needle is not accurately displayed by the on-screen guidelines.

Before performing any patient procedure using a biopsy guide, you must verify that the path of the 
needle is accurately displayed by the on-screen guidelines.

1	1	 Attach the biopsy guide to the transducer.

2	2	 Set the system to the depth of the intended puncture procedure.

3	3	 Immerse the head of the transducer into the water and insert the needle into the needle guide.

4	4	 Verify that the path of the needle displays according to the guidelines shown on the screen.

5	5	 If the needle image is out of the guideline, check the needle guide or the needle guide bracket.

Performing the biopsy procedure

WARNING
	• Biopsy procedure must be performed on a live image to avoid positioning error. 
	• Before starting a biopsy, make sure that all patient information is entered and the study is saved.

CAUTION
	• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. 

It is the user's responsibility to verify correct positioning of the needle during an out-of-plane biopsy 
procedure.

	• When performing an out-of-plane biopsy, i.e. without a biopsy guide, it is the user's responsibility to 
use appropriate equipment. Ensure that the needle (especially the needle tip) is always visible in the 
ultrasound image during the whole biopsy procedure.

	• Always only use basic modes when performing an out-of-plane biopsy.

When the biopsy guide assembly is completed, perform the following biopsy procedure. 

1	1	 Scan an image. When you find a target image, place the target in the middle of the guidezone.

NOTE
Enabling Color Flow mode would allow for visualization of vascular structure around the area to take a 
biopsy.

2	2	 When the target image is prepared, press the [Biopsy] key once, twice, or three times on the 
QWERTY keyboard that corresponds to the selected angle. The biopsy guidezone appears on the 
display.

	– Press the key once for angle 1.

	– Press the key twice for angle 2.

	– Press the key three times for angle 3.
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CAUTION
Ensure that the selected angle on the biopsy guide corresponds to the selected guide line of the 
guidezone.

3	3	 Place the needle in the guide line between the needle barrel and the needle guide. Direct it into 
the area of interest.

CAUTION
Always use a straight, new and sterile needle for each biopsy procedure.

NOTE
To configure the biopsy guidezone settings, press the [Image Preset] key and go to General.

Releasing the needle
After performing a biopsy, release the needle from a transducer and an assembly by following the 
procedure. 

1	1	 Push the knob portion of the sleeve in the direction of the arrow ①.  
The needle is released from the assembly.

2	2	 Push the transducer and assembly in the direction of the arrow ② to remove the needle.
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Transducer Accessories

Transducer sheath
Transducer sheaths help to prevent contamination from blood or body fluids during the examination, 
operation, or biopsy. Sheaths should be used for clinical application that may indicate the need for such 
care, and during endocavity scanning; during biopsy or puncture procedures; or when scanning patients 
with open wounds.

WARNING
	• Always keep sheaths in a sterile state.
	• Sheaths are disposable. Do not reuse them.
	• If sheaths are torn or soiled after use, clean and disinfect the transducer.
	• Some sheaths contain natural rubber latex and talc, which can cause allergic reactions in some individuals.

CAUTION
	• Make sure that you do not use an expired sheath.
	• Using pre-lubricated condoms as a sheath might damage the transducer.

Applying the sheath

WARNING
After placing the sheath over the transducer, visually inspect the sheath to ensure there are no defects.  
Do not use the sheath if it has any holes or tears.

1	1	 Remove the packaging and unfold the transducer sheath.

2	2	 Before applying any ultrasound gel to the sheath, remove any powder in the sheath by rinsing with 
water.

3	3	 Apply a water-based ultrasound gel to the inside of the sheath and onto the face of the transducer.

4	4	 Hold the transducer by the cable relief and unroll the sheath onto the transducer. 
If necessary, cover the transducer cable as well.

5	5	 Pull the transducer sheath tightly over the face of the transducer to remove wrinkles.

6	6	 Secure the sheath to the transducer housing or cable relief with the adhesive tapes or elastic bands 
provided. 
If necessary, secure the sheath to the transducer and the transducer cable.

Disposing the sheath

While wearing protective gloves, remove the transducer sheath from the transducer and dispose of it 
according to medical regulations for biohazardous waste.
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Ultrasound Gel
The ultrasound gel helps to transfer the sound waves into the body during the examination. 

Using appropriate ultrasound gels may cause damage to the transducer. To prevent transducer damage, 
only use ultrasound gels approved or recommended by ALPINION. Refer to Download Center on website 
(http://www.alpinion.com/web/support/download.asp) for the latest list of compatible ultraound gels.

WARNING
	• Do not use mineral oil, lubricant oil, oil-based lotions, or other non-approved materials, as they may cause 

damage to the transducer. Using damaged or defective transducer could cause electric shock in users or 
patients.

	• Do not use ultrasound gels that contain the following contents:
–	 Oils such as mineral oil, cooking oil, gasoline, solvents, rust inhibitors, lanolin, paraffin-based grease, 

ester and excessive silicon-based release agent
–	 Alcohols such as acetone, methanol, plasticizer (dioctylphtalate) or denatured alcohols
–	 Glacial acetic acid and iodine
–	 All types of lotions or gels that contain aromatic substances
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This chapter describes the preset features that you can configure the default settings 
of your system. 

Preset
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System Preset
In each preset menu, you can configure different default settings for its submenus.

System Preset display

Figure 9-1 System preset display
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System Preset menus
To access preset menus, select the desired menu on the touch screen.

NOTE
After changing some preset menus, you may need to reboot the system.

Figure 9-2 System preset touch screen

Table 9-1 System preset menu 

Preset menu Description 

System Customize the system configurations such as general settings, control panel, 
peripheral, patient info, and monitor calibration.

Annotation Customize the comment and body pattern settings.

Measurement Customize the labeled measurement for each study and create a new 
measurement and OB table.

Report Customize the report and report print settings.

User Setting Customize the user-defined settings.

Connectivity Customize the DICOM device and service.

Administration Create a user ID, activate the service browser, and view the option information.

Backup / Restore Back up and restore data, and perform full backup for image data. 

Advanced Cardiac Customize the settings for the Stress echo and Cube strain™ functions.
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General workflow
To enter the System Preset menu, 

1	1	 Press the [System Preset] key on the QWERTY keyboard.

2	2	 To scroll through the current page, press the Navigate soft key.

3	3	 To exit the menu, click Save & Exit or Exit. You can also press the [System Preset] or [2D] key.

To change the settings in System Preset, 

1	1	 Press the [System Preset] key on the QWERTY keyboard.

2	2	 Select a desired menu from the left side of the display.

3	3	 Use [Trackball] to select the menu tab you want.

4	4	 Change the settings for the selected menu.

5	5	 When you have finished, click Save & Exit to save the changes and return to the scan mode.

NOTE
	• To restore the settings on the current menu screen, click Reset Default.
	• To restore all settings of the system preset, click Reset Default All.
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System 
The System menu contains the following submenus: 

	• General

	• Control Panel

	• Peripheral

	• Patient Info

	• Monitor

General 

The General menu allows you to configure the general system settings such as hospital, time and date, 
and screen saver.

	❚ Organization

	• Hospital: Enter a hospital name.

	• Department: Enter a department name.

	• Logo Path: Import a hospital logo to be shown on the top of the display.

To import a hospital logo from a USB drive,

1	1	 Insert a USB driver that stores a hospital logo to the system.

2	2	 Click … to find the file path.

3	3	 When the file selection dialog box appears, select the logo file you want.

4	4	 Click OK.

NOTE
	• The supported file formats are BMP, PNG, and JPG only.
	• You may not import a hospital logo from a CD or DVD.
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	❚ Location

	• Language: Change the display language.

NOTE
After changing the language, you need to reboot the system. 

	• Unit: Select a measurement unit, Metric or US. When you select US, all units are changed from 
centimeter to inch.

	❚ Power Off

	• Power Off: Set how the system powers off when you press the [Power On/Off] key.

	– Shutdown dialog: Set to show the shutdown dialog box.

	– Immediately: Set to power off immediately.

	❚ Monitor

	• Enable screen saver: Set to activate Screen saving mode.

	• Delay: Specify the time of inactivity.

	❚ Date / Time

	• Date Format: Select a desired date format.

	• Time Format: Select a desired time format.

To change the current date and time, 

1	1	 Click Date / Time under Time Format.

2	2	 Click the Date and Time tab.

3	3	 Click Change date and time... to change the current date and time. 
Date and Time Settings screen appears.

4	4	 Change the current date and time.

5	5	 Click OK to save the changes.

Figure 9-3 Date and Time
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To change the time zone,

1	1	 Click Date / Time under Time Format.

2	2	 Click the Date and Time tab.

3	3	 Click Change time zone... to change the time zone. 
Time Zone Settings screen appears.

4	4	 Select your time zone from the drop-down list.

5	5	 To set Daylight Savings Time (DST), select the Automatically adjust clock for daylight saving 
changes check box.

6	6	 Click OK to save the changes.

Figure 9-4 Time zone

	❚ Transducer

	• Default Port: Select a default transducer port when the system powers on.

	❚ After End Exam

	• Status: Set to return to scan mode or go to Patient Registration when you press the [End Exam] 
key. 

	❚ Touch Screen Volume

	• Volume: Adjust the volume of the touch screen.
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Control Panel 

The Control Panel menu provides options for trackball and the control panel keys.

	❚ Trackball

	• Trackball Travel Speed: Change the trackball speed (Slow, Medium, Fast).

	• Trackball Cine Speed: Change the speed for scrolling through Cine sequences (Slow, Medium, 
Fast).

	❚ Key

	• Application: Select a default application that is used for the selected function on freezing. 

	• Active Function on Freeze 2D: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in 2D mode. The selected function automatically activates when 
you press the [Freeze] key. 

	• Active Function on Freeze M: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in M mode. The selected function automatically activates when 
you press the [Freeze] key. 

	• Active Function on Freeze D: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in Doppler mode. The selected function automatically activates 
when you press the [Freeze] key. 

	• Backlight Intensity: Set the brightness of the key backlight (High, Low, Off).

	• CCW Depth Control: Set to operate the [Depth] key when you rotate the key counter-clockwise.

	• Switch the Cursor and Set Keys: Switch the key function between the [Cursor] key and [Set] key. 

	• Switch Dual(Quad) and P2(P3): Switch the key function between the [Dual] key and [P2] key, or 
between the [Quad] key and [P3] key. 

	❚ Audio

	• 'Beep' sound only when the 'P1,P2,P3'key are Pressed: Set to play a beep when you press the 
[P1], [P2], and [P3] keys.
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Peripheral

The Peripheral menu provides peripheral options for VCR, standard printer, and RS232C port. 

NOTE
To configure the printer key function, go to User Setting > Print/Foot Switch.

	❚ VCR

	• Video Format: Select a video format (NTSC or PAL).

	• VCR: Select a VCR type.

	❚ Standard Printer( Report Only )

	• Default Printer: Select a default standard printer that is used for printing reports and images. 

	• Printer Paper: Select a printing paper for the default printer.

	• Refresh: Set the system to automatically refresh the printer list when you add a new printer. 
Select this option after installing a new printer is completed.

	❚ Printer Setting

	• Add Printers...: Add a new printer driver via USB serial port or Ethernet interface. Selecting this 
option activates Windows Add Printer wizard.

	• Cleanup Printer Jobs in Queue When System Bootup: Set to clear all printer jobs in queue when 
your system reboots.

	• : Click the setting icon to manage the printer list. 

	❚ RS232C 

	• COM: Select a RS232C port setting, DVR Control or Transfer Measurement.
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Patient Info

The Patient Info menu provides useful options related to patient management and E-view, and allows 
you to configure the patient banner display option.

	❚ Patient Information

	• Hide Patient Information: Select to hide patient information on patient banner.

	• Patient Banner Line1: Select the patient information to display patient banner line1 from the 
drop-down list.

	• Patient Banner Line2: Select the patient information to display patient banner line2 from the 
drop-down list.

	❚ Patient Package Option

	• Auto ID Generation: Set the system to automatically create a new patient ID when you select New 
Patient.

	• Auto Search for Patient: Set the system to automatically search for the patient data when you 
enter the first letter of a patient ID in the Patient ID field.

	• Auto Logon: Set the system to log on automatically.

	• Auto Archiving Patient Data: Set the system to save the current patient data to archive 
automatically. 

	• Use Birthdate: Set the system automatically to enter an age when you enter a patient’s birthdate.

	• Default Layout: Select a default image layout.

	• Quick Worklist: Select to activate the worklist automatically when you activate the Patient 
Registration.

	• Keep last sorting method in patient list: Select to display the last sorting method on the Patient 
Package List screen.

	• Keep the last Column width of Patient List: Select to save the last column width when you change 
the column width of the patient list.

	• Auto Query for Worklist: Select to activate queries automatically when you activate the worklist.

	❚ Archive Option

Select an archive to be used for saving data when you select End Study. You can also add and remove 
a storage media such as DICOM device, USB flash drive, USB hard disk, or Network storage.

NOTE
The default archive “Local Archive” cannot be deleted.
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Monitor

The Monitor menu allows you to adjust the display pattern using gray bars and color bars. After the 
monitor adjustment, you need to check your peripherals. To adjust the monitor, see "Adjusting the 
Monitor and Touch Screen" on page 2-8.

Figure 9-5 Gray & Color bars

NOTE
After adjusting the monitor settings, you may need to verify the peripheral functions, such as standard printer 
and DVR.
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Annotation 
The Annotation menu allows you to specify body pattern/text options and to define body pattern/text 
libraries on the context menu. The following menus are available: General, Body Pattern, and Text.

General

The General menu allows you to configure the text and body options.

	❚ Text Preset

	• Font Color: Select a font color for comment.

	• Keep arrow’s head position when trackball is moving: Set to fix the direction of the pointer head 
when you move [Trackball]. When this option is not selected, the direction of the pointer head 
changes with the movement of [Trackball].

	• Erase Text when image is unfrozen: Set to erase all comments on the display when you press the 
[Freeze] key to return to the scan mode.

	• Erase Text when entering M mode or PW mode: Set to erase all comments on the display when 
you enter M mode or PW mode.

	• Erase Text when entering Dual or Quad mode: Set to erase all comments on the screen when the 
display is changed to the dual or quad layout screen.

	• Replace the Text: Set to type over existing comments.

	❚ Body Pattern Preset

	• Erase bodypattern when image is unfrozen: Set to erase the body pattern on the display when 
you press the [Freeze] key to return to the scan mode.

	• Copy to active side in multiple image: Set to copy the body pattern on the selected image in the 
dual or quad layout screen.

	• Set as default position when Bodypattern is moved: Set to show the last position movement of 
the body pattern when you press the Move Pattern soft key.
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BodyPattern

The BodyPattern menu allows you to define and change body pattern libraries. The left side of the 
Body Pattern menu shows all available body pattern libraries, and the right side shows the specific body 
patterns for the selected library. Once you have defined body patterns for a library, they are shown on 
the touch screen display of Body Pattern.

NOTE
To specify the default library per each preset, go to User Setting > Annotation.

Figure 9-6 Body pattern libraries

To add a body pattern,

1	1	 Select the library you want to add a body pattern from the library list.

2	2	 Use [Trackball] to select a body pattern, and press the [Set] key twice or click Add.  
The body pattern is shown on the bottom of the library.

3	3	 To change the position of the body pattern, select the body pattern and click Up/Down/Left/Right.

4	4	 Click Empty to make an empty space on the touch screen.

5	5	 Click TouchView to review the applied body marker on the touch screen.

6	6	 Press the Save soft key and then click Yes to save the changes.



9-14 Preset

To delete a body pattern,

1	1	 Select the library you want to delete a body pattern from the library list.

2	2	 Use [Trackball] to select a body pattern, and press the [Set] key. 

3	3	 Click Delete to delete the body pattern.

4	4	 Press the Save soft key and then click Yes to save the changes.

To change the location of a body pattern,

1	1	 Select the library you want from the library list.

2	2	 Use [Trackball] to select a body pattern, and press the [Set] key. 

3	3	 Click Up, Down, Left, or Right to change the location of the body pattern.

4	4	 Press the �ave soft key and then click Yes to save the changes.

Text

The Text menu allows you to change and define the text libraries. The left side of the Text menu shows all 
available text libraries, and the right side shows the specific text for the selected library. For each library, 
you can define up to one column with twenty three rows. The defined text is shown on the context menu 
of the text mode. 

To add a text,

1	1	 Select the library you want from the library list. 
The system shows all texts saved in the library.

2	2	 Use [Trackball] to select a text, and press the [Set] key. 
The text is shown on the bottom of the library.

3	3	 Click Add to add the selected text.

4	4	 To change the text position, select the text and click Up or Down.

5	5	 Click Empty to make an empty space on the touch screen.

6	6	 Click TouchView to review the applied text on the touch screen.

7	7	 Press the Save soft key and then click Yes to save the changes.

To create a new text,

1	1	 On the New Text field, press the [Set] key.

2	2	 Enter a new text and click Add.  
The new text is shown on the bottom right of the library.
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To delete a text,

1	1	 Select the library you want from the library list. 

2	2	 Use [Trackball] to select a text and press the [Set] key.

3	3	 Click Delete to delete the text.

4	4	 Press the Save soft key and then click Yes to save the changes.

To change the text location,

1	1	 Select the library you want from the library list.

2	2	 Use [Trackball] to select a text and press the [Set] key.

3	3	 Click Up or Down to change the text location.

4	4	 Press the Save soft key and then click Yes to save the changes.
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Measurement
The Measurement menu allows you to specify measurement and calculation preset. 

General

The General menu allows you to define the cursor and result window settings.

	❚ General

	• Repeat Measurement: Set to repeat the measurement.

	– Repeat: The selected measurement on the context menu is repeated.

	– None: The measurement is not repeated.

	– Default Measurement: The basic measurement is repeated (e.g. Distance).

	• Tissue Depth display(2D,M): Set to show the tissue depth (depth from the transducer surface) 
when moving the measurement cursor in 2D or M mode.

	❚ Caliper

	• Caliper Type: Select a caliper type (Number or Symbol).

	• Caliper Size: Select a caliper size (Normal or Large).

	• Caliper Color: Select a color for the fixed measurement cursor.

	• Caliper Line Width: Select a line width of the caliper (Thin, Normal, or Thick).

	• Caliper Easy Guide: Select to activate Caliper Easy Guide while performing the measurement.

	• Ellipse cross line display: Set to show the cross line for ellipse.

	• Caliper line display: Set to show the caliper line when measurement is completed. 

	• D mode caliper cross line display: Set to show the cross line of the caliper in D mode.

	• M mode caliper cross line display: Set to show the cross line of the caliper in M mode.

	❚ Result Window

	• Format: Select a window format (Wide or Narrow). 

	• Direction: Select a window direction (Top down or Bottom up).

	• Font Color: Select a font color.

	• Position 2D: Select a default position of the result window in 2D mode (Left Top, Left Bottom, 
Right Top, or Right Bottom).

	• Position TimeLine: Select a default position of the result window in M and PW modes (Left Top, 
Left Bottom, Right Top, or Right Bottom).

	• Transparency: Set to show the window background transparent or opaque.
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Basic MEAS.

The Basic MEAS. menu shows all settings for the basic measurement in each application. Depending 
on the application, available settings may vary. You can define the basic measurement and default 
method for each basic measurement. You can control basic measurement by using the soft keys in each 
measurement mode.

Figure 9-7 Basic measurement display

Figure 9-8 Basic measurement touch screen

1	1	 Select a measurement application.

2	2	 Select a measurement mode (2D, M, or Doppler). The basic measurement entries of the selected 
measurement mode appear on the table.

NOTE
The order of the basic measurement is the same as on the soft key menu.
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3	3	 Specify Default Measure Key Sequence. 
For example) OB1, M mode: Select 2 Sequences (Distance, Time) or 3 Sequences (Distance, Time, 
Slope). 

4	4	 When you select Distance, Time for 2 Sequences, the distance caliper will be shown by pressing the 
[Measure] key once. The time caliper will be shown by pressing the [Measure] key twice.

Labeled MEAS.

The Labeled MEAS. menu shows all settings for the labeled measurement. You can control labeled 
measurement using the context menu in the measurement mode.

Figure 9-9 Labeled measurement display

Figure 9-10 Labeled measurement touch screen
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1	1	 Select a measurement application from the drop-down list.

2	2	 Select a measurement mode (2D, M, or Doppler).

3	3	 All of the available measurement lists appears on the left of the measurement window. The default 
measurements are shown on the context menu.

4	4	 To add a measurement to the context menu, select a measurement from the Available 
Measurement list and click Add. 

5	5	 To delete a measurement from the context menu, select a measurement from the Default 
Measurement list and click Delete.

6	6	 To change the order of a measurement from the context menu, select a measurement from the 
Default Measurement list and click Up or Down.

7	7	 To enable automatic sequence measurement, select Auto Sequence.

NOTE
You can change the author in the OB measurement.

	❚ Creating a new measurement

To create a new measurement entry, 

1	1	 Click New Measurement. 

2	2	 Specify the following measurement information.

	• Measurement Name: Enter a measurement name. Make sure that the measurement name 
is unique. 

	• Measurement Type: Select a measurement type among Distance, Area, Angle, Volume, and 
Disk volume from the drop-down list.

	• Caliper Type: Select a caliper type from the drop-down list.

	• Parameter: Set to show Parameter, Parameter Type, Unit, Precision and Method. You can 
modify Unit, Precision and Method by changing them from the drop-down list.

NOTE
Depending on the measurement mode, available measurement types and caliper types may differ.

3	3	 To save the settings, click OK and then Yes. 
You can see the new measurement in the Available Measurement list.
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	❚ Creating a new parameter

To create a new parameter on a defined measurement,

1	1	 Click New Parameter.

2	2	 Specify the following parameter information.

	• Parameter Name: Enter a parameter name.

	• Formula: Enter a calculation formula and click Check to verify that the syntax is correct.

	• Display Unit: Select a display unit from the drop-down list.

	• Display Precision: Select a display precision from the drop-down list.

NOTE
When you input parameters, suitable unit should be considered for calculation.

3	3	 To save the settings, click OK and then Yes.

	❚ Creating a new calculation

To create a new calculation, 

1	1	 Click New Calculation.

2	2	 Specify the following calculation information.

	• Calculation Name: Enter a calculation name. Make sure that the calculation name is unique. 

	• Formula: Enter a calculation formula and click Check to verify that the syntax is correct.

	• Display Unit: Select a display unit from the drop-down list.

	• Display Group: Select a display group from the drop-down list. The display group is shown 
on the Report page.

	• Display Precision: Select a display precision from the drop-down list.

	• Measurement: Select a measurement from the drop-down list.

NOTE
When you input parameters, suitable unit should be considered for calculation.

3	3	 To save the settings, click OK and then Yes.

	❚ Editing a measurement

To edit a customized measurement, 

1	1	 Select a measurement from the list and click Edit or double-click the measurement. 
The Edit Measurement window appears on the screen.

2	2	 Add or change the measurement by using New Parameter and Edit Parameter, and then change 
Unit, Precision and Method for report.

3	3	 Click OK and then Yes to save your changes.

NOTE
The default measurements cannot be edited. 
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	❚ Editing a parameter

To edit the customized parameter,

1	1	 Select a parameter from the list and click Edit Parameter. 
The Edit Parameter window appears on the screen.

2	2	 Change the formula and output format such as Method, Unit, and Precision.

3	3	 Click OK and then Yes to save your changes.

	❚ Editing a calculation

To edit a customized calculation, 

1	1	 Select a calculation from the list and click Edit or double-click the calculation. 
The Edit Calculation window appears on the screen.

2	2	 Add or change the calculation by using New Parameter and Edit Parameter, and then change 
Unit, Precision and Method.

3	3	 Click OK and then Yes to save your changes.

	❚ Deleting a measurement

To delete a measurement entry,

1	1	 Select a customized measurement from the Available Measurement list.

2	2	 Click Del.Measurement.

	❚ Deleting a parameter

To delete a customized parameter,

1	1	 Select a parameter from the list.

2	2	 Click Delete Parameter.

	❚ Deleting a calculation

To delete a customized calculation, 

1	1	 Select a customized calculation from the Available Measurement list.

2	2	 Click Del.Measurement.

NOTE
The default calculations cannot be edited or deleted. 
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	❚ Setting up the automatic sequence for EFW

The automatic sequence feature allows you to perform EFW measurements in sequence.

1	1	 Press the [System Preset] key and go to Measurement > Labeled MEAS.

2	2	 Select an OB application from the Available Measurement list.

3	3	 Select an EFW folder and click Add.

4	4	 Double-click the selected measurement.

5	5	 Select the Auto Sequence check box on the top of the Default Measurement list.

	❚ Arranging measurements on the touch screen

To reposition the default measurements on the touch screen,

1	1	 Press the [System Preset] key and go to Measurement > Labeled MEAS.

2	2	 Click Touch Order. The Touch Order dialog box appears. 
You can see all default measurements on the touch screen.

3	3	 Select a measurement you want to move on the touch screen grid.

4	4	 Select an empty space on the touch screen grid to which you want to move.

5	5	 To save the changes, click Save.

	❚ Creating new biometry measurement

To see the different authors' measurement based on same biometry,

1	1	 Press the [System Preset] key and go to Measurement > Labeled MEAS.

2	2	 Select a biometry measurement from the Available Measurement list.

3	3	 Click Copy Biometry. 
You can see the copied measurement item in the Default Measurement list.

4	4	 To save the changes, click Save.
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OB MEAS.

The OB MEAS. menu allows you to define default OB presets such as OB type and OB graph. You can also 
register a user-defined OB table.

Figure 9-11 OB measurement display

Figure 9-12 OB measurement touch screen
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	❚ General

	• OB Type: Select an OB type (USA, Europe, Tokyo, Osaka or ASUM) from the drop-down list for the 
measurement and calculation. The default measurement list may differ depending on the selected 
OB type.

	• Default US Age Type(Hadlock): Select CUA (Composite Ultrasound Age) or AUA (Average 
Ultrasound Age).

	• Table Type (Hadlock): Select Hadlock82 or Hadlock84 for OB table.

	• OB Graph Single: Select EFW or Last for displaying OB graph as default.

	• Add 1 Week to EDD: Set to add additional week to estimate the date of delivery.

	❚ Calculations

	• EFW GP: Select an author name to calculate EFW GP (Estimated Fetal Weight Growth Percentile).

	• EFW Formula: Select Hadlock, Campbell, Hansmann, Merz, Osaka, Persson, Schild, Shepard, 
Shinosuka1, Shinosuka2, Shinosuka3, or Tokyo.

	• EFW (Hadlock Method): Select (HC, AC), (AC, FL), (AC, BPD), (AC, BPD, FL), (AC, FL, HC), or (AC, 
BPD, FL, HC). 

	• EFW Unit: Change the measurement unit for EFW.

	❚ Table Registration_Creating a new OB table

To create a new OB table,

1	1	 Click New Table. 

2	2	 Enter an author name.

NOTE
Author name always should be unique. 

3	3	 Select options in the Biometry and Ref. Author fields.

4	4	 Select Fetal Age or Fetal Growth.

5	5	 When you selected Biometry and Ref. Author, the pre-defined values are shown on the table, 
and you can edit the table value. When you selected None from Ref. Author, the table will be 
reset. 

6	6	 Select SD Format for a deviation type.

7	7	 Select Input Unit for input and Output Unit for output.

8	8	 Enter Min, Max, and Interval for range. The system creates default values on the table 
automatically. For the other options, you can manually enter or edit the values.

9	9	 To enter the value, move the cursor to the desired field and press the [Tab] key. 

	– To move the row, click → or →. You can also press the [Enter] key to move to the next row.

	– To move to the column, click ↑ or ↓.
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10	10	To add additional line, click Insert.

11	11	To delete a line, click Delete.

12	12	To clear all values, click Clear All.

13	13	When you have finished, click OK and then Yes to save your changes.

NOTE
You can import an OB table template as an Excel file which is created by PC.

	❚ Table Registration_Editing an OB table

To edit an OB table,

Once you have created your own table, you can edit the table by clicking Edit Table. You can only edit 
the table values, not the table type. The editing table procedure is the same as New Table.

NOTE
The default tables and equations cannot be edited. 

	❚ Table Registration_Creating new OB equation

To create new equation,

1	1	 Click New Equation. 

2	2	 Enter an author name.

NOTE
Author name should always be unique. 

3	3	 Select an option in the Biometry field. 

4	4	 Select Fetal Age or Fetal Growth for equation type.

5	5	 To make a formula, select formula components from the Inputs and Operators fields, and enter 
a formula in the formula field. 

6	6	 Click Check to test the formula. If there are no errors, the “Syntax OK!” appears. If any error 
occurs on the formula, an error message appears in the formula field.

7	7	 Specify the input range for the Min and Max fields.

8	8	 Click OK and then Yes to save your changes.
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	❚ Table Registration_Editing OB equation

Once you have created your own equation, you can edit the equation by selecting Edit Equation. The 
editing equation procedure is the same as New Equation.

	❚ Available operators for equation 

The following table shows available operators for using equation.

Table 9-2 Equation operator

Operator Definition

+ Addition

- Subtraction

* Multiplication

/ Division

( ) Parenthesis

^ Caret

sqrt Square root

pi Pi

log Logarithm

ln Natural logarithm

exp Exponential 

abs Absolute value

	❚ OB AutoCalculation: Set to perform the automatic OB calculation. Select the OB Table check box to 
select the OB calculations (AC*, HC*, AxT*, MAD*).
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Advanced MEAS.

The Advanced MEAS. menu allows you to define application parameters, especially the Doppler 
measurement.

	❚ Measurement Application

Select an application to be defined.

	❚ Application Settings

	• HR Cycle: Select a heart rate cycle (1-10).

	• HR Method(ECG): Select HR Method (Manual or Automatic).

	• Default Location: Select a default location for the selected application (Off, Prox, Mid, or Dist).

	• Default Side: Select a default side (Left or Right).

	• Keep Result Window: Set to show the previous results of the measurements you performed on 
the Result window (Auto/On/Off). If you select Auto, the previous result for volume measurement 
is shown on the Result window. If you select On, the previous result for labelled measurement is 
shown on the Result window. 

	• PI Calc Method: Select a parameter (ED or MD) to calculate PI (Pulsatility Index).

	• RI Calc Method: Select a parameter (ED or MD) to calculate RI (Resistivity Index).

	• Default Touch Menu: Select a default touch menu (Basic Measurement or Labeled Measurement) 
to display on the touch screen.

	• Volume Flow Method: Select a parameter (TAmax or TAmean) to calculate Volume Flow.

	❚ Measurement Unit

	• Distance: Configure the unit of measurement for all distances at one time (cm, cm2, cm3 or mm, 
mm2, mm3).

	• Velocity: Configure the unit of measurement for all velocities at one time (cm/s, m/s, or mm/s).

	❚ Modify Calcs

	• Manual Trace: Select the measurements to perform the manual calculation for the selected 
application.

	• Auto Trace(Calc): Select the measurements to perform the automatic calculation for the selected 
application.

	• Semi Auto Trace: Select the measurements to perform the semiautomatic calculation for the 
selected application.

NOTE
To set up the Auto trace direction, Auto trace method, and Auto trace sensitivity, go to Image Preset > 
General. 
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Report
The Report menu allows you to specify report and report print preset.

Print

	❚ Print Logo

Change the logo image when you print the report.

	❚ Print Section

Set the print section for each application.

	❚ Print Header & Footer

Set the options for print header and footer.

	– Select the Different First Page check box to set the header and footer for the first page differently.

Patient Info

	❚ Patient Info Section

Customize the Patient Information section for each application. 

	❚ Preview Section

Preview the Patient Information section.

User Setting 
The User Setting menu allows you to configure application specific setting and to configure 
programmable keys such as P1, P2, P3, user-defined keys, and hot key.

Application

The Application menu allows you to specify the default application to be shown when the system starts 
up. You can also configure the default settings of transducer.

Annotation

The Annotation menu allows you to specify the default body pattern library to be shown in the Body 
Pattern menu. You can also specify the default text library to be shown when you use comments.

Measurement

The Measurement menu allows you to specify the default package measurement to be shown when you 
use the measurement.
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User Defined Key

The User Defined Key menu allows you to specify user-defined keys. To assign functions onto numeric 
keys (0-9), select the Enable Hot Key check box and assign a key function. The following table shows the 
functions that you can assign for available keys.

Table 9-3 User-defined key

Key
Function Key

User key (1–3) Numeric key (0–9)

Power Preset O O

Transducer Port 1 O O

Transducer Port 2 O O

Transducer Port 3 O O

Transducer Port 4 O O

DPDI O O

TDI O O

SRI O O

Spt.Comp O O

Virtual O O

L/R Flip O O

U/D Flip O O

Quick Angle O O

Auto Calc O O

Simultaneous O O

Full D O O

Full M O O

Biopsy O O

Single O O

Needle Vision™ O O

Quick ID O O

Arrow O O

Clear All O O

User(P4) O O

User(P5) O O

Initial O O

End Exam O O
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Key
Function Key

User key (1–3) Numeric key (0–9)

DVR O O

Rec/Pause O O

Cube Strain™ data Storage O O

Eject O O

Cube View™ O O

3D O O

4D O O

Elasto O O

StressEcho O O

Cube Strain™ O O

Full Screen Mode O O

NOTE
*Power Preset allows you to quickly change the transducer and its preset.
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Print/Foot Switch

The Print/Foot Switch menu allows you to define the optional footswitch and the print keys.

To assign print keys,

1	1	 Select a print key (P1, P2, P3, User(P4), or User(P5)) on the upper side of the display.

2	2	 Select the device you want to add under the device category on the left side of the page.

3	3	 Click >> on the middle of the display.

4	4	 To configure the multiple devices to the each print key, select devices as many as you want from the 
corresponding device categories.

	❚ Print key functions

You can set the print keys to perform the following functions.

1	1	 Image Type: Set the print key to save an image to the clipboard. When you press the [Print] key, 
the current image is moved to the clipboard. The image format depends on the saving option 
and current status (live or frozen).

Table 9-4 Store format option

Option Descriptions

Image Type Select a saving area (Single, Cine, Screen capture(Whole), Screen 
capture(Diagnostic)).

2	2	 Standard Printer: Set the print key to print the image via the standard printer. You can also print 
an image via other printers.

Table 9-5 Print option

Option Descriptions

Printer Direction Select a printing direction (Landscape or Portrait).

Printer Area Select a printing area (Whole Screen, Diagnostic, or Full Diagnostic).

Printer Quality Select a printing quality (Default, Low, Medium, or High).

Printer Paper Select a printer paper. 

Enable Video Invert Set to print an image or the background in black.

Hide image parameter when 
image printed

Set to print an image with the image parameter hidden.

3	3	 DICOM Server: Set the print key to send an image to a DICOM device. To configure the DICOM 
settings, go to System Preset > Connectivity > Storage or Print.

4	4	 Network Storage & Media : Set the print key to send an image to network storage, USB 
flash drive, USB hard disk. To configure the network storage setting, go to System Preset > 
Connectivity > General > Network Storage. 
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	❚ Footswitch functions

To assign functions for the each pedal of the footswitch, select a function from the corresponding list 
(Right, Center, Left). The following functions are available:

	• Freeze 	• M Mode

	• P1 	• PW Mode

	• P2 	• Update

	• P3 	• Simultaneous

	• Single 	• Measure

	• Dual 	• End Exam

	• Quad 	• Rec/Pause

	• CF Mode 	• Transducer Port 1–4

	• PD Mode
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Connectivity 
The Connectivity preset allows you to configure the network connection and DICOM protocols. DICOM 
is an abbreviation of Digital Imaging and Communications in Medicine. This is a standard protocol for 
handling, storing, printing, and transmitting information in medical imaging. Using the DICOM option, 
you can send or print images after connecting the system and PACS.

NOTE
	• DICOM is an optional service. To use this service, you need DICOM installation.
	• To enter the connectivity screen, you must log in as an administrator.

General

The General menu allows you to configure the general network connection settings such as computer 
name, AE title, and port number.

NOTE
To set up Internet Protocol, contact your hospital’s network administrator.

To configure the general network connection settings,

1	1	 Enter a computer name in the Computer Name field.

2	2	 Enter an Application Entity (AE) title in the AE Title field. 

3	3	 Enter a port number of your system in the Port No field.

	• Cleanup DICOM Spooler jobs in Queue when System Bootup: Set to delete all DICOM jobs in 
queue when system reboots.

4	4	 Press the Save soft key and then click Yes to save the changes.

5	5	 Reboot your system.
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Network

The Network menu allows you to set up Internet protocol. You need a separate IP address for your 
system.

NOTE
To set up Internet Protocol, contact your hospital’s network administrator.

	❚ Local Area

Specify the following IP address settings:

	• DHCP: Select the DHCP option for a dynamic IP address.

	• Use Following IP Address: Select this option to use a static IP address.

	– IP Address: Enter an IP address.

	– Subnet Mask: Enter the subnet mask.

	– Default Gateway: Enter the default gateway address.

	– Preferred DNS Server: Enter the preferred DNS server.

	– Alternate DNS Server: Enter the alternate DNS server.

	– Network Speed: Select the network speed.

	❚ Wireless

To connect to the wireless network,

1	1	 Specify the IP address settings.

NOTE
The IP address settings are the same as the ones in Local Area menu.

2	2	 Select the desired SSID from the Wireless search list.

3	3	 Click Connect.

4	4	 Enter a password and click OK.

You can see the connection status of wireless network by checking the icon in the status bar.

Table 9-6 Wireless Network connection status

Icon Description

Disconnected to the USB Wireless module.

Connected to the USB Wireless module but disconnected to the wireless network.

Successfully connected to the wireless network.
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Commonly used service parameters

There are certain parameters that may need to be set up for each service. The parameters are described 
on the following service.

NOTE
	• DICOM is an optional service. To use this service, you need DICOM installation.
	• To enter the connectivity screen, you must log in as an administrator.

	• DICOM Storage

	• DICOM Storage Commitment

	• DICOM Print

	• DICOM Worklist

	• DICOM MPPS

	❚ Setting

	• Name: Enter a description for each service.

	• AE Title: Enter the Application Entity (AE) title of this service.

	• Port No: Enter a port number of the service.

	• Retry: Enter a maximum number of retry when the system fails to connect to a destination device.

	• Retry Interval(s): Set the time interval of retry.

	• Timeout(s): Set the period of timeout when the retry connection is over.

	❚ Verify

1	1	 Select a destination.

2	2	 Click Verify to start verification. When the verification is completed, the one of the following 
icons is shown.

Table 9-7 DICOM verification

Icon Description

Successfully connected 

Failed in connection

In progress

	❚ View

View allows you to view the connectivity architecture of your system such as configured DICOM 
service and network structured tree.
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Storage

The Storage menu allows you to send images with DICOM standard format to view or interpret in 
PACS. In this menu, you can add, edit, and remove a DICOM storage service and configure the service 
properties. 

To add a DICOM storage device,

1	1	 Click New.

2	2	 Enter a name of the DICOM storage device in the Destination Name field.

3	3	 Enter a device’s IP address in the IP Address field.

4	4	 Enter the Application Entity (AE) title for a device in the AE Title field.

5	5	 Enter a port number in the Port No field.

6	6	 Click Verify to confirm the connection.

7	7	 Click OK.

To remove a DICOM storage device,

1	1	 Select the destination name that you want to remove.

2	2	 Click Remove.

3	3	 Click Yes to confirm.

	❚ Properties 

	• Enable Structure Report: Set to send a report with images.

	• Enable Raw data of Compact 3D/4D (Image-Arena™): Set to send a 3D/4D image with raw data 
for Image Arena™.

	• Enable Multiframe: Set to save multi-frame Cine images in the DICOM storage.

	• Compression: Select a default compression type.

	• Quality: Select a default image quality.

	• Monochrome: Set to send images in monochrome. If you select Monochrome or Color, you will 
be asked every time to determine sending images in monochrome or color. 

	• Commitment: Set to receive notification from PACS when a study has been transferred 
successfully. When this option is enabled, you can specify the following information:

	– Properties: Select an associated storage.

	– Accepter: Specify the accepter’s settings such as AE title, port number, and timeout.
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Network Storage

The Network Storage menu allows you to customize options for sending backup data to Shared directory. 
You can add and edit a network storage device. 

To enter the Network Storage menu, 

–	 Go to General menu and click Network Storage on the bottom right of the display.

To add a network storage device, 

1	1	 Click New. 

2	2	 Enter a name of the network storage device in the Destination Name field. 

3	3	 Enter a shared directory path for the device in the Shared Dir field. 

4	4	 Enter an ID of the device in the ID field. 

5	5	 Enter a password of the device in the Password field. 

6	6	 Select a device that is connected to the intra network driver. 

7	7	 Click Verify to verify the network connection. 

To delete a network storage device,

1	1	 Select the destination name that you want to delete. 

2	2	 Click Remove. 

3	3	 Press the Save soft key.

	❚ Properties 

	• Type: Select an image format to save images to network storage (JPEG, BMP). 

	• 2D Cine: Save 2D Cine images as WMV format. 

	• 4D Volume Cine(*AVI): Save 4D volume images as AVI format.
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Cube View™

The Cube View™ menu allows you to set up the network options for accessing to the Cube View Control 
Server. You can add and edit a Cube View Control server device.

To enter the Cube View™ menu, 

–	 Go to General menu and click Cube View™ on the bottom right of the display.

To add a Control Server device,

1	1	 Click New.

2	2	 Enter a name of the Cube View Control Server device in the Destination Name field.

3	3	 Enter an IP address of the Cube View Control Server device in the IP Address field.

4	4	 Enter a Port number of the Cube View Control Server device in the Port No field.

5	5	 Enter an access ID of Cube View Client in the ID filed.

6	6	 Enter a password of Cube View Client in the Password field. 

7	7	 Click Verify to verify the Cube View Control Server connection.

To delete a Cube View Control Server device,

1	1	 Select the destination name that you want to delete.

2	2	 Click Remove.

3	3	 Press the Save soft key.

	❚ Properties

	• Compression: Select an image compression type. (Lossy, Lossless)

	• Quality: If you selected LOSSY in the Compression field, select compressibility.

	• Enable Adjust Quality: Set whether to adjust a compression format and an image quality in Client 
field.

CubeNote

The CubeNote menu allows you to set up the network options for accessing to the CubeNote Control 
Server. You can add and edit a CubeNote Control server device.

To enter the CubeNote menu, 

–	 Go to General menu and click CubeNote on the bottom right of the display.

To add a Control Server device,

1	1	 Enter a hospital code in the Hospital Code field.

2	2	 Click Verify to verify the CubeNote Control Server connection.
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Print

The Print menu provides an ability to send and receive ultrasound image data via DICOM printers. 

	❚ Properties

	• Format: Select a printing format that determines the number of images to be printed out in one 
page.

	• Priority: Select the printing job priority (HIGH, MED, or LOW).

	• Medium: Select a printing medium (CLEAR FILM, PAPER, or BLUE FILM). 

	• Copies: Select the number of copies.

	• Orientation: Select a printing direction (LANDSCAPE or PORTRAIT).

	• Film Size: Select the dimensions of the film size such as 81NX101N and 101NX121N.

	• Film Destination: Select the film destination (MAGAZINE or PROCESSOR).

	• Magnification: Select how the print magnifies the image to fit it onto the film.

	– REPLICATE: Interpolate pixels are copied of adjacent pixels.

	– BILINEAR: Interpolate pixels are created by bilinear interpolations between the adjacent 
pixels.

	– CUBIC: Interpolate pixels are created by cubic interpolations between the adjacent pixels.

	– NONE: No interpolation

	• Trim: Set to show the trim box around images on the film (YES or NO).

	• Empty Image: Set how to show empty images (BLACK or WHITE).

	• Color: Select a color type (COLOR or GRAY).

	• Min Density: Enter the minimum density level of the film.

	• Max Density: Enter the maximum density level of the film.

	• Config. information: Enter a name of the specified image quality setting.

	• Film Session Label: Enter an organization name to be shown on the film label.

	• Smoothing Type: Select the printer’s magnification interpolation for the output.

	• Border: Select a border area between the images of the film (BLACK or WHITE).
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Worklist

The Worklist menu provides a list of patients sorted by query parameters. The Search Criteria menu 
allows you to define specific search parameters for the system to use when querying the patient archive.

To add a worklist,

1	1	 Click New.

2	2	 Enter a name of the DICOM storage device in the Destination Name field.

3	3	 Enter a device’s IP address in the IP Address field.

4	4	 Enter the Application Entity (AE) title for a device in the AE Title field.

5	5	 Enter a port number in the Port No field.

6	6	 Click Verify to confirm the connection.

7	7	 Click OK.

To remove a worklist,

1	1	 Select the destination name that you want to remove.

2	2	 Click Remove.

3	3	 Click Yes to confirm.

	❚ Search Criteria 

	• DICOM Tag: Select information type that you want to define for search parameters such as 
Modality and Referring Physician’s name.

	• Value: Enter the value of the selected tag item.

	• Add to list: Add tag and value to the list of search criteria.

	• Remove: Remove tag and value to the list of search criteria.

	• Clear: Clear all tags from the list.

MPPS

The MPPS menu provides a notifying function that the procedure information of the current study is 
transferred to PACS while performing a study.
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Administration 
The Administration menu contains the following submenus:

	• Service

	• Users

	• Options

	• System Info

	• Patient Data

Service

To activate the service browser, click Service Station. The Windows login screen appears. 
For more information, see the Service Manual.

Users

The Users menu allows you to define the user settings.

To set the system to log on automatically, 

–	 Select the System Auto Login check box.

To create a user ID,

1	1	 Click New.

2	2	 Enter a user ID in the ID field. You can enter up to 16 characters.

3	3	 Enter the patient information using the alphanumeric keyboard.

4	4	 Enter a new password in the New Password field.

5	5	 Enter the new password again in the Confirm field.

6	6	 Click OK to save your settings.

NOTE
	• Use alphanumeric keys only for the user ID. Do not enter symbols such as asterisk (*), question mark (?), 

and slash (/). 
	• After saving, you can edit all information except for the user ID.

To delete a user ID,

1	1	 Select a user ID from the user list by using [Trackball].

2	2	 Click Delete.

3	3	 Click Yes to save the changes.
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To change the password,

1	1	 Select a user ID from the user list by using [Trackball].

2	2	 Click Password.

3	3	 Enter the current password in the Old Password field. 

4	4	 Enter a new password in the New Password field.

5	5	 Enter the new password again in the Confirm field.

6	6	 Click OK to save the changes.

Options

The Options menu allows you to view the status of optional functions that require license keys to be 
installed. The followings show the current status of the selected function.

	• Demo.: The option is activated for a certain period that the manufacturer specified.

	• Activated: The option is activated for 3 months after the activation.

	• Invalid: The option is not installed.

	• Permanent: The option is installed permanently. 

To add or delete a license key, go to Service Station.

System Info

The System Info menu allows you to view the current software and hardware versions of your system.

Patient Data

The Patient Data menu allows you to delete the patient data for a specified period.

	• Delete include Patient Information: Set to delete the patient information when you delete the 
patient data for a specified period.
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Backup / Restore 
The Backup / Restore menu allows you to back up and restore the user data. You may lose user settings 
or patient information files such as patient’s basic information and scanned images because of physical 
shocks to the product or internal errors. Therefore, you should back up user settings and patient 
information data on a regular basis.

The following submenus are available:

	• User Backup

	• Image Backup

	• Full Backup

You can select a storage media (CD, DVD, USB flash drive, USB hard disk, and network storage) to 
perform the backup. 

NOTE
To save images permanently, avoid using the local hard disk. Regularly back up the image archive to a storage 
media.

CAUTION
Follow the suggested backup procedure in the manual. ALPINION MEDICAL SYSTEMS does not have the 
responsibility for data loss caused by the user’s carelessness.

User Backup

You can use a CD, DVD, and USB flash drive for user preset backup.

The User Backup menu allows you to back up the each preset data. To select all user-defined presets, 
select the User Defined Configuration check box.

	• Image Preset: Set to back up or restore the Image preset only.

	• Service: Set to back up or restore the Service preset only.

	• Measurement: Set to back up or restore the Measurement preset only.

	• Annotation: Set to back up or restore the Text and Body Pattern preset only.

	• Connectivity: Set to back up or restore the Connectivity preset only.

	• Report: Set to back up or restore the Report only.

	• Others: Set to back up or restore other presets such as System and User settings.

To back up the user preset data,

1	1	 Insert a blank media properly on your system.

2	2	 Select a media from the Media drop-down list.

3	3	 If you select USB from the Media drop-down list, enter the description in the Description field.

4	4	 Select the user preset you want to back up.

5	5	 Click Backup to start backup. The backup procedure begins.

6	6	 After the backup is completed, the last backup time and date appear next to the preset category. 
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To restore the user preset data,

NOTE
Make sure that the software version of the data is the same as the system’s software version. If NOT, you may 
not perform the restoration.

1	1	 Insert a media on your system.

2	2	 Select the user preset(s) you want to restore. 
If your media is USB flash drive, select the user preset(s) you want to restore from the backup list.

3	3	 Click Restore to start restoring. The restore procedure begins. 

Image Backup

The Image Backup menu allows you to perform image backup using a storage media. Select your 
memory storage such as CD, DVD, USB flash drive, USB hard disk, and network storage. 

CAUTION
	• While restoring Image Archive data, some existing database may be overwritten on the local hard disk and 

you may not be able to restore the old data. Make sure that you use the appropriate media before the 
restoration proceeds.

	• Before restoring Image Archive, make sure that the software version is the same or compatible with the 
current system. The system may not proceed restoring if the version is different.

	• Do NOT turn the system off while backup is in progress. You may lose your image data.

NOTE
Use Restore on E-view to restore image data.

	❚ Media

	• Media: Select your default storage media. Available media are CD, DVD, USB flash drive, USB hard 
disk, and network storage. 

	• Media Capacity: Select the media capacity. The system calculates the number of backup CDs that 
you need before performing the backup and informs you. 

	❚ Image Archive Option

	• Backup period: Specify the starting and ending date to back up patient data for a certain period.

	• Image Move after Backup: Set to remove the backup image file after backup is completed.

	• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or DVD.

	• Finalization of CD/DVD: Set to finalize a CD or DVD after backup is completed.

	• Skip the data that has already backed up: Set to skip the data backup if the data has already been 
backed up. 

NOTE
DICOMDIR is a DICOM file format which provides index and summary information for all the DICOM files on 
media. If you want to save studies to CD or DVD and view them on the PACS system, you should select this 
option.
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To back up Image Archive,

1	1	 Configure Media.

2	2	 Configure Image Archive Option.

3	3	 Prepare unformatted CD(s).

4	4	 Click Backup to start backup Image archive. 
The media formatting starts and the instructional message appears.

You can view and import backup media via E-View menu.

To view the backup images,

1	1	 Insert your media.

2	2	 Go to E-View.

3	3	 Change the source to your media from the local hard disk. 

4	4	 View the backup images of the study you want.

Full Backup

NOTE
The USB hard disk drive is only available for the full preset backup. 

This full preset backup is for service purpose only. You can back up the system data such as user preset, 
image archive, and service configuration.
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Advanced Cardiac

Protocol Editor

The Protocol Editor menu allows you to manage protocols to be used for Stress Echo. You can add, copy, 
and delete protocols, stages, and views.

	❚ Adding a new protocol

1	1	 From the Protocols category, click Add. 

2	2	 Enter a new protocol name and select OK.

3	3	 Select Add to add a new stage on the Stages category.

4	4	 Enter a stage name and specify the stage options (Capture mode, Clips per view, Preview, 
Capture length, Capture Delay(ms), Timer Type).

5	5	 Select OK.

6	6	 Select Add to add a new view on the Views category.

7	7	 Select a view name from the drop-down list and select OK.

	❚ Managing a protocol, stage, and view

To change the order of the stages or views,

	– Select Up or Down to move a desired stage or view from the corresponding category.

To copy a protocol, stage, or view,

1	1	 Select Copy to copy a desired protocol, stage, or view.

2	2	 Enter a name for the selection and select OK.

To delete a protocol, stage, or view,

1	1	 Select Delete to delete a desired protocol, stage, or view. 

2	2	 Select Yes to confirm the deletion.

Image Compress

The Image Compress menu allows you to set the compression strength of the stress echo images. 
Available options are High (30 %), Medium (50 %), Low (70 %), and Uncompress (100 %).

Cube Strain™

The Cube Strain™ menu allows you to set the image capture time for the Cube strain™ function.
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Image Preset
To enter the Image Preset menu, press the [Image Preset] key on the control panel. 

To exit from the Image Preset menu, click Save & Exit or Exit. You can also press the [Image Preset], 
[Exit], or [2D] key on the control panel.

General workflow
To use Image preset function,

1	1	 Press the [Image Preset] key on the control panel. The General menu appears.

2	2	 Select the desired transducer from the transducer list.

3	3	 Select the desired application from the application list.

4	4	 To change a parameter, do one of the following:

–	 Select the value from a list.

–	 Select or clear a check box.

5	5	 Click Save & Exit to save the changes and return to the scan mode.

New preset
You can create a new preset by pressing the [F7] key on the QWERTY keyboard. Once you have added a 
new preset, it appears in the application list of the transducer selection page, the Patient Registration 
screen, and the Image Preset screen. This function is useful when you want to use user-defined presets 
easily.

To create a new preset,

1	1	 Adjust the image parameter settings as you want, and then press the [F7] key on the QWERTY 
keyboard.

2	2	 Select the application that you want to add from the Application list.

3	3	 Enter a preset name in the Preset Name field.

4	4	 To show the automatic preset selection when you change the transducer, select the Automatic 
Preset selection when changes the transducer check box.

5	5	 When you have finished, click OK.
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To overwrite an existing preset,

1	1	 Adjust the image parameter settings as you want, and then press the [F7] key on the QWERTY 
keyboard.

2	2	 Select the application that you want from the Application list.

3	3	 Select the preset that you want to overwrite from the Preset Name list.

4	4	 To show the automatic preset selection when you change the transducer, select the Automatic 
Preset selection when changes the transducer check box.

5	5	 When you have finished, click OK.

6	6	 Click Yes to confirm.

To delete a preset,

1	1	 Press the [Image Preset] key on the QWERTY keyboard.

2	2	 Select the preset that you want to delete from the Preset Name list, and then press the Delete 
Preset soft key.

3	3	 When the Delete dialog box appears, click Yes to confirm.

NOTE
The default presets cannot be deleted. 
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System Care and Maintenance
It is the responsibility of the user to verify that the ultrasound system is safe for diagnostic operation on 
a daily basis. Each day, prior to using the system, perform each of the steps in the daily checklist.

All exterior parts of the system, including the control panel, keyboard, and transducers, should be 
cleaned and/or disinfected as necessary or between uses. Clean each component to remove any surface 
particles. Disinfect components to kill vegetative organisms and viruses.

The air filter on the ultrasound system must be cleaned regularly to maintain proper system cooling. 
Remove and check the air filter weekly, and clean as needed.

CAUTION
	• The system does not contain any operator serviceable internal components. Ensure that unauthorized 

personnel do not tamper with the unit.
	• When defects or malfunctions occur, do not operate the system until the problems are resolved. Contact 

your local service representative.

Expected Service Life Description
The expected service life for the E-CUBE 8 system and transducers is identified in this table:

Equipment / Accessory Expected Service Life

E-CUBE 8 system The expected service life for the E-CUBE 8 system is at least seven 
(7) years from the manufacturing date under the provision of regular 
maintenance by authorized service personnel.

E-CUBE 8 transducers The expected service life for the E-CUBE 8 transducers meets or exceeds 
five (5) years from the date the transducer is placed in service, under the 
provision that the customer follows the care instructions provided on 
the E-CUBE 8 User Manual.
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Daily checklist
Perform the following each day before using the ultrasound system:

	• Visually inspect all transducers. Do not use a transducer which has a cracked, punctured, or 
discolored casing or frayed cable.

	• Visually inspect all power cords. Do not turn on the power if a cord is frayed or split, or shows signs 
of wear. If your system’s power cord is frayed or split, or shows signs of wear, contact your ALPINION 
service representative for power cord replacement.

	• Visually inspect that the trackball and other controls on the control panel to make sure that they are 
clean and free from gel or other contaminants.

	• Visually inspect the ECG connector and cables. Do not use the ECG connector and cables if they are 
damaged.

WARNING
To avoid electrical shock, you must visually inspect the transducer prior to use. Do not use the transducer that 
has a cracked, punctured, or discolored casing or a frayed cable.

Monthly checklist
To inspect the system, examine the following on a monthly basis.

	• Connectors on cables for any mechanical defects

	• Entire length of electrical and power cables for cuts or abrasions

	• Control panel and keyboard for defects

	• Casters for proper locking operation

NOTE
To maintain the safety and functionality of the ultrasound system, maintenance must be performed every 
12 months. Electrical safety tests must also be performed at regular intervals as specified by local safety 
regulations. Refer to the service manual for the electrical leakage test.

WARNING
When the LED lamp needs to be replaced, contact the ALPINION service representative.

CAUTION
To avoid electrical shock hazard, do not remove panels or covers from the console. This service must be 
performed by qualified service personnel. Failure to do so could cause a serious injury.

Weekly maintenance
The system requires weekly care and maintenance to function safely and properly. Clean the following:

	• Monitor

	• Control panel

	• Footswitch

Failure to perform required maintenance may result in unnecessary service calls.
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Cleaning the system
Prior to cleaning any part of the system:

–	 Turn off the system power. If possible, disconnect the power cord. 

Cleaning the surface of the ultrasound system

CAUTION
Do not spray any liquid directly into the unit when cleaning the system.

1	1	 Use a clean gauze pad or lint-free cloth, lightly moistened with a mild detergent, to wipe the surface 
of the ultrasound system. Take particular care to clean the areas near the trackball and the slide 
controls. Ensure these areas are free of gel and any other visible residue. 
Ensure that cleaning solution does not seep into the control panel, keyboard, or any other 
openings.

2	2	 After cleaning, use a clean, lint-free cloth to dry the surface.

3	3	 After cleaning, reconnect the power cord of the system into the power outlet.

Cleaning the liners of the transducer holders

1	1	 Use the tab to remove the liner from the transducer holder.

2	2	 Clean the liner under the running water, using a mild detergent and dry with a lint-free cloth.

3	3	 Reinsert the liner into the transducer holder.

Cleaning the trackball

CAUTION
Do not drop or place foreign objects inside the trackball assembly. This may affect the trackball’s operation 
and damage the system. Avoid other solvents that may damage the mechanical parts of the trackball 
assembly.

1	1	 Remove the front panel bezel by rotating the bezel counter-clockwise.

2	2	 Remove the trackball and the teflon ring.

3	3	 Clean the trackball and the teflon ring with tissue and isopropyl alcohol.

4	4	 Clean the inside of the trackball assembly with a cotton swab and isopropyl alcohol.

5	5	 Allow the assembly parts to completely dry before the reassembly.

6	6	 Replace the trackball and front panel bezel.
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Cleaning the monitor face

Use a soft, folded cloth and a glass cleaner solution. Apply the glass cleaner to the cloth. Gently wipe the 
monitor face.

Do NOT use a glass cleaner that has a hydrocarbon base (such as Benzene, Methyl Alcohol or Methyl 
Ethyl Ketone) on monitors with the filter (anti-glare shield). Prolonged use of such cleaners will damage 
the filter (anti-glare shield). Hard rubbing will also damage the filter.

CAUTION
When cleaning the monitor, make sure not to scratch the monitor.

Removing and cleaning the air filter

The air filter on the ultrasound system must be cleaned regularly to maintain the proper system cooling. 
Remove and check the air filter weekly, and clean as needed.

CAUTION
Do not scrub, stretch, or bend the filter, or apply heat to the filter, as doing so could damage the filter.

1	1	 Power off and unplug the power cord from the power outlet.

2	2	 Grasp the air filter and pull it out of the system.

3	3	 Rinse the air filter with running water and allow the filter to completely dry. To hasten drying, you 
may gently shake the filter, or blot the filter with a clean, lint-free cloth.

4	4	 Reinsert the filter into the ultrasound system.

5	5	 Plug the power cord into the power outlet.
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Battery Care and Maintenance
The battery is a consumable item. The battery will gradually lose its capacity for charging after repeated 
use and after time has passed. Alpinion Medical Systems recommends that you replace the battery once 
in one year or after 500 recharging cycles, whichever comes first.

NOTE
	• For the replacement or disposal of the battery, contact an authorized agent or an ALPINION MEDICAL 

service engineer.
	• The warranty period for the battery is six months.

Recharging the battery
Connecting AC power automatically begins charging the battery. To charge the battery faster, please 
power off the system.

CAUTION
Do not recharge the battery using a non-recommended method, as this may cause an explosion or a fire.

The battery that are not used for several weeks at a time should be recharged at regular intervals. 
Alpinion Medical Systems recommends that you recharge the battery every 1 or 2 months even without 
use.

The battery must be charged and discharged within the following temperature ranges:

Temperature

Charge 0–45 °C

Discharge -20–60 °C

Storing the battery
The battery must be stored within the following temperature ranges:

Temperature

Less than 1 month -20–60 °C

1 – 3 months -20–45 °C

4 – 12 months -20–20 °C
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Transducer Care and Maintenance
It is the responsibility of the user to verify that the transducer is safe for diagnostic operation. After each 
use, inspect the transducer's lens, cable, and casing. Look for any damage that would allow liquid to 
enter the transducer. If any damage is found, do not use the transducer until it has been inspected and 
repaired/replaced by ALPINION Service Representative.

WARNING 	• Always place a sterile, non-pyrogenic transducer sheath on a transducer used in 
procedures requiring sterility.

	• There have been reports of severe allergic reactions to medical devices containing 
latex (natural robber). Health care professionals are advised to identify latex-sensitive 
patients and to be prepared to treat allergic reactions promptly.

	• During neurosurgical procedures, if a transducer becomes contaminated with tissue 
or fluids of a patient known to have Creutzfeld-Jacob disease, the transducer should 
be destroyed, as it cannot be sterilized.

	• When using an endocavity transducer with a CF type applied part, the patient leakage 
currents may be additive. Prior to each use, the leakage current test must be done.

	• To avoid electrical shock and damage to the system, disconnect the transducer prior 
to cleaning or disinfecting.

	• The list of disinfectants and cleaning methods are recommended by ALPINION 
for the compatibility with product materials, not for the biological effectiveness. 
Refer to disinfectant label instructions for the guidance on disinfection efficacy and 
appropriate clinical uses.

CAUTION 	• Transducers are sensitive instruments – irreparable damage may occur if they are 
dropped, knocked against other objects, cut, or punctured. Do not attempt to repair 
to alter any part of a transducer.

	• To avoid cable damage, do not roll the system over transducer cables.
	• To avoid damage to the transducer, do not use transducer sheaths containing on 

oil-based coating or petroleum-or mineral oil-based ultrasound coupling agents. Use 
only a water-based ultrasound coupling agent.

	• DO NOT place or store the transducer in the side pocket or the storage area on the 
system to prevent damaging it from accidently falling off.

	• To avoid damage to the transducer, observe the immersion levels indicated for each 
transducer type. Do not immerse or allow the cable or connector of a transducer to 
become wet. See "Figure 10-1 Transducer immersion level" on page 10-11 for more 
detailed information.

	• The transducer have been designed and tested to be able to withstand high-level 
disinfection as recommended by the manufacturer of the disinfectant product. 
Carefully follow the disinfectant manufacturer’s instructions. Do not immerse for 
more than one hour.
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Transducer handling and infection control
This information is intended to increase user awareness of the risks of disease transmission associated 
with using this equipment and provide guidance in making decisions directly affecting the safety of the 
patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that must be coupled to the patient by direct 
physical contact. Depending on the type of examination, this contact occurs with a variety of tissues 
ranging from intact skin in a routine exam to recirculating blood in a surgical procedure. The level of risk 
of infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between patients is with single use or disposable 
devices. However, ultrasound transducers are complex and expensive devices that must be reused 
between patients. It is very important, therefore, to minimize the risk of disease transmission by using 
barriers and through proper processing between patients.

Cleaning and disinfecting transducers
All transducers must be cleaned and disinfected after each use. Cleaning is an important procedure that 
must be carried out before disinfecting the transducer. For cleaning and disinfecting the transducer, 
carefully follow the proper disinfectant and disinfectant method recommended by ALPINION MEDICAL 
SYSTEMS. Using an inappropriate cleaning or disinfecting agent may damage the transducer.

WARNING
	• To avoid electrical shock and damage to the system, disconnect the transducer before cleaning and 

disinfecting.
	• Always use protective eyewear and gloves when cleaning and disinfecting transducers.
	• Check the housing, strain relief, lens and seal for damage, and check for any functional problem after 

cleaning and disinfecting the transducer.

CAUTION
	• Do not use a surgical brush when cleaning transducers.
	• Do not use a cleaning brush when cleaning the transducer lens. Even the use of soft brushes can damage 

the transducer lens.
	• Do not use paper products or products that are abrasive when cleaning the transducer. They damage the 

lens of the transducer.
	• Be sure to use the proper concentration of enzymatic cleaner and rinse thoroughly.
	• Before storing transducers, ensure that they are thoroughly dry.
	• The use of 70% isopropyl alcohol (rubbing alcohol) and alcohol-based products on all transducers is 

restricted. On non-TEE transducers, the only parts that may be cleaned with isopropyl alcohol are the 
connector housing and the transducer housing and lens. Do not wipe any other part of a transducer with 
isopropyl alcohol (including cables or strain reliefs), as it can damage those parts of the transducer. This 
damage is not covered by the transducer warranty.
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Cleaning the transducer

Cleaning is an important procedure that is carried out before disinfecting the transducer. The transducer 
must be cleaned after each use. 

1	1	 Disconnect the transducer from the system.

2	2	 Moisten a clean gauze pad with purified water and wipe the transducer to remove any gel or 
particles remaining on the transducer. If purified water is not effective, then you can use an 
approved pre-cleaner or low-level disinfectant. Follow the solution manufacturer's instructions for 
the cleaning of transducers.

3	3	 Carefully wipe the entire transducer, including the cable and connector. 
When cleaning the connector, do not allow any type of fluid to enter through the connector strain 
relief, electrical contacts or areas surrounding the locking-lever shaft and the strain relief.

4	4	 To remove remaining particulate and cleaning residue, use cleaning wipes according to the 
manufacturers’ instructions, or rinse thoroughly with water up to the immersion point. 
Do not immerse the connector, connector strain relief, or cable that is within 5 cm of the connector 
strain relief.

NOTE
If you place the transducer into the water or cleaning solution, make sure not to immerse the 
transducer into the liquid beyond the immersion level. See "Transducer Immersion Level" on page 10-11 
for more information.

5	5	 If remaining particulate and cleaning residue have dried onto the transducer surface, scrubbing 
with a soft bristle brush may be necessary.

NOTE
Do not use a cleaning brush when cleaning the transducer lens. Even the use of soft brushes can 
damage the transducer lens.

6	6	 Dry the transducer using a sterile cloth or gauze after rinsing. Do not dry the transducer by heating 
it.

NOTE
To dry the lens, use a soft cloth and a blotting motion instead of a wiping motion.

7	7	 Examine the housing, strain relief, lens and seal for damage, and check for any functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent.
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Disinfecting the transducer

WARNING
	• If a pre-mixed solution is used, be sure to observe the solution expiration date.
	• The type of tissue it will contact during use dictates the level of disinfection required for a device. Ensure 

that the solution strength and duration of contact are appropriate for disinfection.

CAUTION
	• Only wipe the cable, strain relief and parts of the transducer. Do not wipe the connector of the transducer.
	• Do not immerse transducers in a solution for longer than one hour, unless under disinfectant 

manufacturer's instructions.
	• Using a non-recommended disinfectant or not following the recommended disinfection method can 

damage and/or discolor the transducer and will void the transducer warranty.

To low-level disinfect a transducer,

1	1	 Disconnect the transducer from the system.

2	2	 Thoroughly clean, rinse, and dry the transducer.

3	3	 After cleaning, choose a low-level disinfection solution compatible with your transducer.

4	4	 Low-level disinfect the transducer by following the disinfection method recommended by the 
disinfection solution manufacturer.

5	5	 After disinfecting, examine the housing, strain relief, lens and seal for damage, and check for any 
functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent.

To high-level disinfect a transducer,

1	1	 Disconnect the transducer from the system.

2	2	 Thoroughly clean, rinse, and dry the transducer.

3	3	 After cleaning, choose a high-level disinfection solution compatible with your transducer.  
If a pre-mixed solution is used, be sure to observe the solution expiration date.

4	4	 Disinfect or high-level disinfect the transducer by following the disinfection method recommended 
by the disinfection solution manufacturer. High-level disinfection is recommended for general 
transducers and is required for endocavity transducers.

NOTE
If you place the transducer into the water or disinfection solution, make sure not to immerse the 
transducer into the liquid beyond the immersion level. See "Transducer Immersion Level" on page 10-11 
for more information.

5	5	 Rinse the transducer with plenty of sterile water to remove all chemical residues on it. Or follow the 
rinsing method recommended by the disinfectant manufacturer to rinse the transducer.

6	6	 Wipe off the water on the transducer with sterile cloth or gauze after rinsing it. Do not dry the 
transducer by heating.

7	7	 Examine the housing, strain relief, lens and seal for damage, and check for any functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent.
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Transducer Immersion Level

CAUTION
	• Make sure not to immerse the transducer into any liquid beyond the immersion level specified for that 

transducer.
	• Do not immerse the transducer connector and cable in liquid.

P1-5CT SP3-8T VC1-6T E3-10 EC3-10T EV3-10T VE3-10H CW2.0 CW5.0

SC1-4H
SC1-4HS

C1-6CT C5-8NT SC1-6H IO3-12 IO8-17T L3-12H 
L3-12T

L3-12HWD L8-17H

Figure 10-1 Transducer immersion level
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List of Compatible Disinfectants and Cleaning Solutions

ALPINION MEDICAL SYSTEMS routinely reviews new cleaning and disinfection solutions for compatibility 
with the materials used in the transducer housing, cable and lens in order to provide users with options 
in choosing a cleaning or disinfection solution. Refer to Download Center on website (http://www.
alpinion.com/web/support/download.asp) for the latest list of compatible cleaning solutions and 
disinfectants.

	• HLD=High level disinfectant, ILD=Intermediate level disinfectant, LLD=Low level disinfectant

	• Y=Yes, N=No

	• S=Spray, W=Wipes, L=Liquid, P=Powder, G=Gel, D=Device

	• O=Approved, X=Not approved (DO NOT USE), Δ=Untested (DO NOT USE)

Table 10-1 List of Compatible Disinfectants and Cleaning Solutions
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Level HLD HLD - HLD HLD HLD HLD HLD - HLD HLD - -

FDA Approval Y Y Y Y Y Y Y Y Y N Y Y Y N

TYPE L L L L P L L L L L L L L L

C1-6CT Δ O Δ X Δ Δ O O Δ Δ Δ O Δ Δ

SC1-4HS Δ O Δ X O O O O Δ Δ Δ X Δ Δ

SC1-4H Δ O Δ X O O O O Δ Δ Δ X Δ Δ

SC1-6H Δ O Δ X O O O O Δ Δ Δ X Δ Δ

L3-12T Δ O Δ X O O O O Δ Δ Δ X Δ Δ

L3-12H Δ O Δ X O O O O Δ Δ Δ X Δ Δ

L3-12HWD Δ O Δ X O O O O Δ Δ Δ X Δ Δ

L8-17H Δ O Δ X O O O O Δ Δ Δ X Δ Δ

P1-5CT Δ O Δ X O O O O Δ Δ Δ X Δ Δ

VC1-6T Δ O Δ O O O Δ O Δ Δ Δ Δ Δ Δ

E3-10 Δ O Δ Δ O O Δ Δ Δ Δ Δ Δ Δ Δ

EV3-10T Δ O Δ X O O O O Δ Δ Δ X Δ Δ

EC3-10T Δ O Δ X O O O O Δ Δ Δ X Δ Δ

IO3-12 Δ O Δ X O O O O Δ Δ Δ X Δ Δ

CW2.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

CW5.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

VE3-10H Δ O Δ O O O Δ O Δ Δ Δ Δ Δ Δ

C5-8NT Δ O Δ X O O O O Δ Δ Δ X Δ Δ

SP3-8T Δ O Δ O O O O Δ Δ Δ Δ Δ Δ Δ

 IO8-17T Δ O Δ X O O O O Δ Δ Δ X Δ Δ

http://www.alpinion.com/web/support/download.asp
http://www.alpinion.com/web/support/download.asp
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Disinfectant (2)
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FDA Approval N N N N N N Y Y N N N N Y Y

TYPE L W L W W W S S W W S S S W

C1-6CT Δ Δ Δ Δ Δ O Δ O O O Δ Δ O O

SC1-4HS Δ Δ Δ O O O O O O X X X X O

SC1-4H Δ Δ Δ O O O O O O X X X X O

SC1-6H Δ Δ Δ O O O O O O X X X X O

L3-12T Δ Δ Δ O O O O O O X X X X O

L3-12H Δ Δ Δ O O O O O O X X X X O

L3-12HWD Δ Δ Δ O O O O O O X X X X O

L8-17H Δ Δ Δ O O O O O O X X X X O

P1-5CT Δ Δ Δ O O O O O O X X X X O

VC1-6T Δ Δ Δ O O O Δ O Δ Δ Δ Δ Δ Δ

E3-10 Δ Δ Δ O O O Δ Δ Δ Δ Δ Δ Δ Δ

EV3-10T Δ Δ Δ O O O O O O X X X X O

EC3-10T Δ Δ Δ O O O O O O X X X X O

IO3-12 Δ Δ Δ O O O O O O X X X X O

CW2.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

CW5.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

VE3-10H Δ Δ Δ O O O Δ O Δ Δ Δ Δ Δ Δ

C5-8NT Δ Δ Δ O O O O O O X X X X O

SP3-8T Δ O Δ O Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

 IO8-17T Δ Δ Δ O O O O O O X X X X O
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Disinfectant (3)
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Level HLD HLD - - HLD - HLD - L/ILD - - - - -

FDA Approval Y Y N N Y N Y Y Y N N N N N

TYPE L L W W L L L W W L L L L W

C1-6CT Δ Δ Δ Δ O O X Δ Δ Δ Δ X X O

SC1-4HS O O X O O O O O O X O X X O

SC1-4H O O X O O O O O O X O X X O

SC1-6H O O X O O O O O O X O X X O

L3-12T O O X O O O O O O X O X X O

L3-12H O O X O O O O O O X O X X O

L3-12HWD O O X O O O O O O X O X X O

L8-17H O O X O O O O O O X O X X O

P1-5CT O O X O O O O O O X O X X O

VC1-6T O Δ O O O O O O O O O O Δ O

E3-10 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

EV3-10T O O X O O O O O O X O X X O

EC3-10T O O X O O O O O O X O X X O

IO3-12 O O X O O O O O O X O X X O

CW2.0 Δ Δ Δ Δ Δ Δ Δ Δ O Δ Δ Δ Δ Δ

CW5.0 Δ Δ Δ Δ Δ Δ Δ Δ O Δ Δ Δ Δ Δ

VE3-10H O Δ O O O O O O O O O O Δ O

C5-8NT O O X O O O O O O X O X X O

SP3-8T Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

 IO8-17T O O X O O O O O O X O X X O
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Pre-Cleaner
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Level - - - - - - - - - - - -

FDA Approval Y Y Y N Y Y Y Y Y Y Y N

TYPE S S L L L L L L L L L W

C1-6CT Δ Δ Δ Δ Δ O Δ Δ Δ Δ O Δ

SC1-4HS Δ Δ O Δ Δ O Δ Δ Δ Δ O O

SC1-4H Δ Δ O Δ Δ O Δ Δ Δ Δ O O

SC1-6H Δ Δ O Δ Δ O Δ Δ Δ Δ O O

L3-12T Δ Δ O Δ Δ O Δ Δ Δ Δ O O

L3-12H Δ Δ O Δ Δ O Δ Δ Δ Δ O O

L3-12HWD Δ Δ O Δ Δ O Δ Δ Δ Δ O O

L8-17H Δ Δ O Δ Δ O Δ Δ Δ Δ O O

P1-5CT Δ Δ O Δ Δ O Δ Δ Δ Δ O O

VC1-6T Δ O O O O O Δ Δ Δ O O O

E3-10 O Δ Δ Δ O Δ Δ Δ Δ Δ Δ Δ

EV3-10T Δ Δ O Δ Δ O Δ Δ Δ Δ O O

EC3-10T Δ Δ O Δ Δ O Δ Δ Δ Δ O O

IO3-12 Δ Δ O Δ Δ O Δ Δ Δ Δ O O

CW2.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

CW5.0 Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ Δ

VE3-10H Δ O O O O O Δ Δ Δ O O O

C5-8NT Δ Δ O Δ Δ O Δ Δ Δ Δ O O

SP3-8T Δ Δ O Δ Δ O O Δ Δ Δ Δ Δ

 IO8-17T Δ Δ O Δ Δ O Δ Δ Δ Δ O O
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Solution
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Level - - -

FDA Approval - - -

TYPE D D D

C1-6CT Δ Δ O

SC1-4HS O O O

SC1-4H O O O

SC1-6H O O O

L3-12T O O O

L3-12H O O O

L3-12HWD O O O

L8-17H O O O

P1-5CT O O O

VC1-6T O X Δ

E3-10 Δ Δ Δ

EV3-10T X O O

EC3-10T O O O

IO3-12 O O O

CW2.0 Δ Δ Δ

CW5.0 Δ Δ Δ

VE3-10H O X Δ

C5-8NT O O O

SP3-8T Δ Δ Δ

 IO8-17T O O O

NOTE
Slight discoloration of parts of the transducer such as housing and cable can occur when disinfecting the 
transducer with Antigermix or V-PRO. This has no influence on the performance of the transducer. 
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Cable handling
Take the following precautions with transducer cables:

	• Keep free from wheels

	• Do not bend the cable acutely

	• Avoid crossing cables between transducers

Planned maintenance
The following maintenance schedule is suggested for the transducer to ensure the optimum operation 
and safety.

	• Daily: Inspect transducers

	• After each use: Clean transducers

	• After each use: Disinfect transducers
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This chapter describes the safety and regulatory information relevant for operating 
this ultrasound system.

Safety and Regulatory 
Information
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Safety Summary
You should make sure the following safety precautions during all phases of operation, service, and 
repair of the E-CUBE 8 ultrasound system. If you fail to comply with these safety precautions or specific 
warnings in this manual, you violate safety standards in terms of design, manufacture, and intended use 
of this system. ALPINION MEDICAL SYSTEMS Co., LTD. does not have liability for your failure to comply 
with these requirements.

Safety notice

WARNING A WARNING notice indicates a hazard. You need to observe an operating procedure, 
practice, or conducts like that. If you do not correctly perform this notice, it could result 
in personal injury or death.

CAUTION A CAUTION notice indicates a hazard. You need to observe an operating procedure, 
practice, or conducts like that. If you do not correctly perform this notice, it could result 
in damage to the system or loss of important data.

Service document
The service manual supplies block diagrams, lists of spare parts, descriptions, adjustment instructions or 
similar information to help adequately qualified technical personnel in repairing those parts defined as 
repairable by the manufacturer.
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Equipment Safety Information

WARNING 	• Installing the system yourself may cause damage to the system or electrical shock.  
To avoid damage to the system and avoid electrical shock, only qualified ALPINION 
service engineer must install the system.

	• Do not remove the covers of a system yourself to avoid damage to the system and 
unexpected electrical shock. Only qualified ALPINION service engineer must repair or 
replace components.

	• Do not modify this system such as system components, or software. When you 
modify the system, it may cause safety hazards. Only qualified ALPINION service 
engineer must modify the system.

	• When you observe that the system causes any malfunction, you must stop operating 
the system and take proper action for patients. After that, contact ALPINION service 
engineer.

	• The system voltage may cause serious injury or damage to the system.
	• You must make sure grounded integrity of the power outlet and system regularly.
	• To avoid risk of electric shock, you must connect the system to the supply mains with 

the protective earth.
	• For patient safety, you must locate the system to easily unplug the power cord from 

the power outlet when a malfunction or an error occurs.
	• Always make sure that you do not use the system in an explosive atmosphere.
	• Before cleaning up and disinfecting the system, always make sure you turn off the 

system power and unplug the power cord from the power outlet.
	• Do not allow water or liquids on or above the system. Dripping water or liquids into 

the system may cause electrical shock and damage to the system.
	• You must follow safety precautions and avoid any situation that causes injury or 

damage.
	• Always use the system properly to avoid serious injury. Before using the system, you 

must make sure the instructions and hazards involving ultrasound system. ALPINION 
provides training assistance, if needed.

	• The use of the equipment outside the described conditions or intended use, 
and disregarding safety related information is considered abnormal use. The 
manufacturer is not liable for injury or damage caused by abnormal use. Any 
abnormal use will void the warranty of the equipment.

	• Always use peripherals and accessories approved by ALPINION. You must securely 
connect peripherals and accessories to the system.

	• Always use transducers approved or recommended by ALPINION.
	• Always use approved ECG cables and recommended electrodes by ALPINION.
	• Your ultrasound system is not intended for diagnosing and monitoring ECG. Do not 

use the system for cardiac operation.
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Patient Safety Information

WARNING 	• When you enter patient data, always make sure that you enter correct identification 
with the patient data.

	• Do not use the system until you become familiar with the system operation.
	• To avoid the transducer from overheating, you must freeze the system when imaging 

is not performed.

CAUTION 	• Do not allow the system to transmit acoustic output when the transducer is not in 
use. Otherwise, it could result in overheating of the transducer.

	• When not using the system, you should freeze the image or turn off the acoustic 
output.

	• Do not use the system with defibrillator. The system does not include a defibrillation-
proof applied part for ECG.

	• Do not allow the germicide to contact your patient. Contact to the patient’s skin or 
mucous membrane may cause an inflammation.
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Anti-Virus Program
ALPINION MEDICAL SYSTEMS Co., LTD provides customers with the proactive measures to help secure 
the E-CUBE 8 ultraosund system. Below are some proactive measures that we have performed and 
implemented to help secure the product.

	• Only the communication ports that are reqired for the E-CUBE 8 ultrasound system to operate are 
enabled. All other operating system communication ports are disabled. Typically, only one port is 
used for DICOM connectivity.

	• To minimize the cause of security vulnerabilities, all operating system services that are not used by 
the system application software are disabled.

	• The "auto run" feature is disabled on the system. For example, when a DVD or USB memory stick that 
contains a program that runs automatically is connected,the system will not open or run the program.

ALPINION MEDICAL SYSTEMS Co., LTD do not use Anti-Virus software for several reasons. The main 
reasons for not doing so:

	• All virus scanners are constantly active in the background. Because of the software-intensive 
operating system of the ultrasound scanner, all computing resources are required for normal 
operation of this device. The activity of Anti-Virus software would degrade the system performance.

	• The operating software of a medical ultrasound system belongs to an FDA-cleared medical device that 
requires a specific release process. Any update of the Anti-Virus software would mean a change of 
the system software. These changes require a comprehensive release and validation process to help 
ensure that the Anti-Virus update does not affect the system software performance and reliability.

For all the users, it is strongly recommended to follow several instructions to minimize the risk of virus 
and/or malware infections.

	• Before using USB-connected devices or drives (USB HDD, USB flash drive, or Network storage), clean 
them first by executing a virus scan.

	• It is recommended to block SMB ports (139.445) at Firewall level in order to prevent WannaCry 
ransomware attacks.
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Electrical Safety Information

WARNING 	• Do not clean or disinfect a system before turning off and unplug the system from the 
power outlet. Otherwise, it could result in electrical shock and damage to the system.

	• Do not place water or liquids on the system. Dripping water or liquids into the system 
may cause electrical shock and damage to the system.

	• Do not remove the panels or covers of a system to prevent system damage and 
electrical shock.

	• Do not use extension cords, adaptors or converters, which are a three-prong to two-
prong type, to connect with a power plug.

	• The system voltage may cause serious injury or damage to the system. When you 
observe that the system causes any malfunction, you must stop operating the system 
and take proper action for patients. After that, contact ALPINION service engineer.

	• Do not modify the AC power connector plug of the system to prevent electrical shock.
	• You should use the ultrasound system after few hours when the system is in a 

humidity place.
	• Do not connect, disconnect, or replace any part of the system during the scanning of 

a patient at the same time.
	• Do not replace the fuse or power cord by yourself. An ALPINION MEDICAL service 

engineer or an authorized agent must perform the replacement. Replacing the fuse 
or power cord by yourself will avoid your warranty. 

	• Using spray cleaners on the system drips cleaning fluid into the system. It damages 
components in the system. 

	• Do not use aerosol spray cleaners on the monitor to prevent electrical shock and 
damage to the system.

	• While using the ECG function, keep ECG cables or patients away from any other 
electrical conductor to prevent electrical shock.

	• Different voltage power between your system and other devices may cause electrical 
shock. According to the IEC requirements (Refer to IEC 60601-1-1 and clause 16 
of the 3 Ed. of IEC 60601-1, respectively), you must use the equipotential cable 
(equipotential bonding) to connect additional devices to your system. Contact your 
ALPINION MEDICAL service engineer.
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Transducer Safety Information
Damaged transducers or improper use and manipulation of the transducer may result in injury or 
increase the risk of infection. 

Never use excessive force when manipulating intracavity transducers. Become familiar with all 
instructions and precautions provided with the special purpose transducers.

The use of damaged transducers can result in injury or increase the risk of infection. Inspect transducer 
often for sharp, pointed, or rough surface damage that could cause injury or tear protective barriers. 

WARNING 	• Do not use damaged or defective transducer to prevent system damage and serious 
patient injury.

	• Make sure you do not bend or pull the transducer cable to prevent the damage to the 
transducer.

	• Use only approved coupling gels. Using unapproved gels may damage the transducer 
and void the warranty.

	• To reduce the risk of leakage currents and electrosurgical interference, use only 
isolated output electrosurgical units with an endocavity transducer and disconnect 
the transducer when it is not in use.

	• When an endocavity transducer causes malfunctions, contact ALPINION Service 
Representative to prevent any safety hazard from the transducer. 

CAUTION 	• Do not drop the transducer. Always keep the transducer secure when you do not use 
it.

	• Using damaged or defective transducer causes unexpected electric shock. Make sure 
to use and take care of the transducer accordingly.

	• Do not allow the system to transmit acoustic output when the transducer is not in 
use. Otherwise, it could result in overheating of the transducer.

	• When not using the system, you should freeze the image or turn off acoustic output.
	• To avoid serious patient injury, always inspect the transducer that you use has 

sharp edges and rough surfaces. Especially for an endocavity transducer, inspect it 
exhaustively prior to each use.

	• Proper cleaning and disinfecting the transducer prevent disease transmission. You 
must follow infection control procedures.

	• Always use sterile, legally marketed transducer sheaths for endocavity exams.
	• Make sure that you do not use an expired transducer sheath.
	• Using pre-lubricated condoms as a sheath might damage the transducer.
	• Do not allow your eyes (or patient’s eyes) to contact the coupling gel. If there is gel 

contact to the eyes, flush thoroughly with clean water.
	• When the surface temperature of your endocavity transducer reaches a safe level 

41 °C, manually freeze the system and stop imaging if the system does not respond 
automatically.



11-8 Safety and Regulatory Information

IPX8 immersion levels

CAUTION
To avoid damage to the transducer, observe the immersion levels indicated for each transducer type. 

Transducers meet Ingress Protection IPX8 of EN 60529 and IEC 60529 to the depth of the immersion line 
shown in the illustration only for transducers with the “IPX8” symbol on the connector of the transducer.

NOTE
Test Standard of IPX8: 
Immersion for 90 minutes at a depth of 1 meter.

Connector

Connector strain relief

Figure 11-1 IPX8 immersion level
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Biopsy Safety Information

Precautions concerning the use of biopsy procedure

WARNING 	• Do not freeze the image during a biopsy procedure. The image must be live to avoid 
a positioning error. Biopsy guidezones are intended to assist the user in determining 
optimal transducer placement and approximate the needle path. However, actual 
needle movement is likely to deviate from the guideline. Always monitor the relative 
positions of the biopsy needle and the subject mass during the procedure.

	• Biopsy procedures should not be used for In vitro fertilization (IVF), Chronic villus 
sampling (CVS), and Percutaneous umbilical blood sampling (PUBS).

CAUTION 	• The use of biopsy devices and accessories that have not been evaluated for use with 
this equipment may not be compatible and could result in injury.

	• The invasive nature of biopsy procedures requires proper preparation and technique 
to control infection and disease transmission. Equipment must be cleaned as 
appropriate for the procedure prior to use.
–	 Follow the transducer cleaning and disinfection procedures and precautions to 

properly prepare the transducer.
–	 Follow the manufacturer's instructions for the cleaning of biopsy devices and 

accessories.
–	 Use protective barriers such as gloves and transducer sheaths.
–	 After use, follow proper procedures for decontamination, cleaning, and waste 

disposal.
	• Improper cleaning methods and the use of certain cleaning and disinfecting agents 

may cause damage to the plastic components that will degrade imaging performance 
or increase the risk of electric shock. For details, see "Transducer Safety Information" 
on page 11-7.

	• A biopsy must only be performed by physicians with adequate experiences under 
all circumstances the necessary safety precautions and sterility measures have to be 
respected.
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System Symbols and Labels
The following is a list of system symbols and labels for safety. They indicate that you must refer to the 
manual for specific information to avoid personal injury or damage to the product.

Safety symbols/ Labels Location Explanation

On the power button of the control 
panel System on/off/stand-by

On the system rating label for 
overseas, transducer label, and ECG 
port

Patient applied part meets the isolation 
requirements for type BF equipment

On the ECG port ECG triggered display

 On the transducer label

This symbol indicates that the 
transducer meets immersion 
requirements. Depending on the 
transducer model, the immersion label 
may differ.

On the multi-caution label, rating 
label for overseas, transducer label, 
and gel warmer label

This symbol indicates that when the 
end-user wishes to discard this product, 
it must be sent to separate collection 
facilities for recovery and recycling. 
By separating this product from other 
household-type waste, the volume of 
waste sent to incinerators or land-fills 
will be reduced and natural resources 
will thus be conserved. 
Please contact an authorized 
representative of the manufacturer 
for information concerning the 
decommissioning of your equipment.

On the multi-caution label, rating 
label for overseas, and system 
packing box

This system complies with regulatory 
requirements of European Directive 
93/42/EEC regarding medical device.

On the multi-caution label, gel 
warmer label, and I/O panel

Consult instructions for use (or consult 
operating instructions)

Various locations on labels

Attention (Caution) – consult 
accompanying documents if complete 
information cannot be provided on the 
label

On the rating label for overseas:  
Adjacent to the AC power and the 
AC power outlet

Alternating current in accordance with 
IEC 60878-01-14

Adjacent to the AC power outlet Push-push button
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Safety symbols/ Labels Location Explanation

Adjacent to the AC power Equipotentiality

Adjacent to the DVD-RW Universal Serial Bus 

On the system rating label for 
overseas and transducer label

Date of manufacture 
See ISO 8601 for date format

On the system rating label for 
overseas and transducer label

Symbol for manufacturer 
This symbol shall be accompanied 
by the name and the address of the 
manufacturer.

On the system rating label for 
overseas and transducer label Serial Number

On the multi-caution label
To ensure safety of user, moving and 
delivering system shall be performed by 
at least 2 persons.

On the LCD caution label and multi-
caution label

Do not forcibly push the monitor or the 
system when the casters are locked.

On the LCD caution label

Do not press or place loads on the 
monitor when folded. Otherwise, 
monitor and (or) professional arm could 
be damaged.

On the multi-caution label
Do not use mobile transmitter such 
as mobile phone, radio receiver, 
broadband power line, etc.

On the LCD caution label
Be very careful not to injure yourself or 
damage the system when rotating the 
monitor arm.

Rear of the LCD monitor Caution label

Top of the monitor arm Care against pinch shall be taken. (In 
accordance with IEC 60878)
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Safety symbols/ Labels Location Explanation

Rear of the system body Multi-caution label

Right cover of the system body No gender detection label

Top (or side panel) of the system 
body Safety working load label

Bottom of the control panel System rating label for overseas

Bottom of the control panel System rating label for domestics

On the cable port of the gel warmer Gel warmer voltage label

Rear of the gel warmer Gel warmer label 

Transducer
Name of transducer manufacturer, 
WEEE symbol, indicating separate 
collection, Certification mark
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Safety symbols/ Labels Location Explanation

Transducer Transducer name, Serial, IPX Rating, 
Caution mark

Transducer
Name of transducer manufacturer, 
WEEE symbol, indicating separate 
collection, Certification mark

Transducer Transducer name, Serial, IPX Rating, 
Caution mark
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Regulatory Information
The E-CUBE 8 ultrasound system conforms to the following classifications, in accordance with the IEC/EN 
60601-1:6.8.1:

Classifications:

	• Type of protection against electrical shock: Class I

	• Degree of protection against electrical shock (Patient connection): Type BF equipment

	• Degree of protection against harmful ingress of water: Ordinary equipment and all of applied parts 
(IPX7, IPX8) except ECG meet ingress protection level according to IEC 60529.

	• Degree of safety of application in the presence of a flammable anesthetic material with air or with 
oxygen or nitrous oxide: Equipment not suitable for use in the presence of a flammable anesthetic 
mixture with air or with oxygen or nitrous oxide.

	• Mode of operation: Continuous operation

The E-CUBE 8 ultrasound system conforms to the following standards:

	• MDD 93/42/EEC

	• EN ISO 10993-1:2009 (ISO 10993-1:2009)

	• EN ISO 10993-10:2013 (ISO 10993-10:2010)

	• EN ISO 10993-5:2009 (ISO 10993-5:2009)

	• EN ISO 13485:2016 (ISO 13485:2016)

	• EN ISO 14155:2011+AC:2011 (ISO 14155:2011)

	• EN ISO 14971:2012 (ISO 14971:2007)

	• EN ISO 15223-1:2016 (ISO 15223-1:2016)

	• EN 1041:2008+A1:2013

	• EN 55011:2016+A1:2017 (CISPR 11:2015/AMD1:2016)

	• EN 55032:2015 (CISPR 32:2015)

	• EN 60601-1:2006+A1:2013 (IEC 60601-1:2005/AMD1:2012)

	• EN 60601-1-2:2015 (IEC 60601-1-2:2014)

	• EN 60601-1-6:2010+A1:2015 (IEC 60601-1-6:2010/AMD1:2013)

	• EN 60601-2-37:2008+A11:2011+A1:2015 (IEC 60601-2-37:2007/AMD1:2015)

	• EN 61000-3-2:2014 (IEC 61000-3-2:2018)

	• EN 61000-3-3:2013 (IEC 61000-3-3:2013)

	• EN 61000-4-11:2004 (IEC 61000-4-11:2004)

	• EN 61000-4-2:2009 (IEC 61000-4-2:2008)

	• EN 61000-4-3:2006+A1:2008+A2:2010 (IEC 61000-4-3:2006/AMD2:2010 )

	• EN 61000-4-4:2012 (IEC 61000-4-4:2012)

	• EN 61000-4-5:2014 (IEC 61000-4-5:2014)

	• EN 61000-4-6:2014 (IEC 61000-4-6:2013)

	• EN 61000-4-8:2010 (IEC 61000-4-8:2009)

	• EN 62304:2006+A1:2015 (IEC 62304:2006/AMD1:2015)
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	• EN 62366-1:2015 (IEC 62366-1:2015)

	• MEDDEV 2.12/2 Rev.2

	• MEDDEV 2.7.1 Rev.4

	• NEMA UD2:2004 (R2009)

	• Medical Devices Regulations (SOR/98-282)

	• 의료기기법, 의료기기법 시행령, 의료기기법 시행규칙
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Manufacturer:

Name: Alpinion Medical Systems Co., LTD. 
Address: 5FL, I Dong, 77, Heungan-daero 81beon-gil,  
Dongan-gu, Anyang-si, Gyeonggi-do, Republic of Korea 
Phone: +82 (2) 3282 0903

Authorized EU Representative:

Name: Alpinion Medical Deutschland GmbH 
Address: Alpinion Medical Deutschland GmbH Lilienthalstrasse 17a 
85399 Hallbergmoos Germany 
Phone: +49 (0) 811 99 82 86 0 

Authorized US Representative:

Name: Alpinion USA (Kevin Chun) 
Address: 21222 30th Dr SE Ste C-122 Bothell, WA 98021, United States 
Phone: +1 425 949 1059
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Electromagnetic Compatibility (EMC)
This equipment generates, uses, and can radiate radio frequency energy. The equipment may cause radio 
frequency interference to other medical and non-medical devices and radio communications. To provide 
reasonable protection against such interference, this product complies with emissions limits for a Group 
1, Class Medical Devices Directive as stated in EN 60601-1-2.

Electrical medical equipment requires special precautions regarding EMC and must be installed and 
implemented according to the EMC information provided in the user manual.

AII types of electronic equipment may characteristically cause electromagnetic interference with other 
equipment, transmitted either through air or connecting cables. The term Electromagnetic Compatibility 
(EMC) indicates the capability of the equipment to curb electromagnetic influence from other 
equipment, while at the same time not affecting other equipment with similar electromagnetic radiation.

Radiated or conducted electromagnetic signals can cause distortion, degradation, or artifacts in the 
ultrasound image which may impair the ultrasound unit’s essential performance. 

There is no guarantee that interference will not occur in a particular installation. If this equipment is 
found to cause interference (which may be determined by turning the equipment on and off), the user 
(or qualified service personnel) should attempt to correct the problem by one or more of the following 
measure(s):

	• Reorient or relocate the affected device(s).

	• Increase the separation between the equipment and the affected device.

	• Power the equipment from a source different from that of the affected device.

	• Consult the point of purchase or service representative for further suggestions.

Use of accessories, transducers and cables other than those specified may result in increased emission or 
decreased immunity of the equipment.

The manufacturer is not responsible for any interference caused by using other than recommended 
interconnect cables or by unauthorized changes or modifications to this equipment. Unauthorized 
changes or modifications could void the users’ authority to operate the equipment.

Devices which intrinsically transmit radio waves, such as cellular phones, radio transceivers, mobile radio 
transmitters, radio-controlled toys, etc., should preferably not be operated near the equipment. Keep the 
power to these type devices turned off when near the equipment.

NOTE
Use of devices that transmit radio waves near the equipment could cause it to malfunction. See "Minimum 
distances" on page 11-21 for information about the recommended minimum separation distances between 
portable and mobile RF communications equipment and the ultrasound unit.

The system or its components should not be used adjacent to or stacked with other equipment. If 
adjacent or stacked use is necessary, the system or its components should be observed to verify normal 
operation in the configuration in which it will be used.

The medical staff in charge of this equipment is required to instruct technicians, patients, and other 
people who maybe around this equipment to fully comply with the above requirement.
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Electromagnetic emissions
This system is suitable for use in the following environment. The user must assure that it is used only in 
the electromagnetic environment as specified.

Guidance and manufacturer’s declaration–electromagnetic emissions

Emissions test Compliance Electromagnetic environment - guidance

RF emissions
CISPR 11 Group 1

The E-CUBE 8 uses RF energy only for its 
internal function. Therefore, its RF emissions 
are very low and are not likely to cause any 
interference in nearby electronic equipment.

RF emissions
CISPR 11 Class B

The E-CUBE 8 is suitable for use in all 
establishments, including domestic 
establishments and those directly connected 
to the public low-voltage power supply 
network that supplies buildings used for 
domestic purposes.
WARNING: This system is intended for use 
by healthcare professionals only. This system 
may cause radio interference or may disrupt 
the operation of nearby equipment. It may be 
necessary to take mitigation measures, such 
as re-orienting or relocating the system or 
shielding the location.

Harmonic emissions 
IEC 61000-3-2 Class A

Voltage fluctuations / flicker 
emissions
IEC 61000-3-3

Complies
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Electromagnetic immunity
This system is suitable for use in the following environment. The user must assure that the system is used 
according to the specified guidance and only in the electromagnetic environment listed.

Guidance and manufacturer’s declaration-electromagnetic immunity

Immunity test IEC 60601 Test level Compliance level Electromagnetic environment 
-guidance

Electrostatic 
discharge (ESD)

IEC 61000-4-2

±8 kV Contact

±2,4,8,15 kV air

±8 kV Contact

±2,4,8,15 kV air

Floors should be wood, concrete or 
ceramic tile. If floors are covered 
with synthetic material, the relative 
humidity should be at least 30 %. 

Electrical fast
transient/burst

IEC 61000-4-4

±2 kV for power
supply lines
±1 kV for input/output 
lines

±2 kV for power
supply lines
±1 kV for input/output 
lines 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Surge

IEC 61000-4-5

±0.5,1 kV line(s) to 
line(s)
±0.5,1,2 kV line(s) to 
earth

±0.5,1 kV line(s) to 
line(s)
±0.5,1,2 kV line(s) to 
earth

Mains power quality should be that 
of a typical commercial or hospital 
environment.

Voltage dips, short
interruptions and 
voltage variations
on power supply
input lines

IEC 61000-4-11

< 0 % Uт
(> 95 % dip in Uт) for 
0.5 cycle

0 % Uт
(60 % dip in Uт )
for 1 cycle

70 % Uт
(30 % dip in Uт)
for 25 cycle, 30 cycle

<0 % Uт
(> 95 % dip in Uт ) for 
250 cycle, 300 cycle

< 0 % Uт
(> 95 % dip in Uт) for 
0.5 cycle

0 % Uт
(60 % dip in Uт )
for 1 cycle 

70 % Uт
(30 % dip in Uт)
for 25 cycle, 30 cycle

<0 % Uт
(> 95 % dip in Uт ) for 
250 cycle, 300 cycle

Mains power quality should be 
that of a typical commercial or 
hospital environment. If the user 
of the E-CUBE 8 image intensifier 
requires continued operation during 
power mains interruptions, it is 
recommended that the E-CUBE 8 
image intensifier be powered from 
an uninterruptible power supply.

Power frequency
(50/60 Hz)
magnetic field

IEC 61000-4-8

30 A/m 30 A/m

Power frequency magnetic  fields 
should be at levels  characteristic 
of a typical  location in a typical  
commercial or hospital environment.

NOTE Uт is the a.c. mains voltage prior to application of the test level.
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Guidance and manufacturer’s declaration-electromagnetic immunity

Immunity test IEC 60601 test 
level

Compliance 
level Electromagnetic environment -guidance C

level
Electromagnetic 
environment - 
guidance

3 Vrms

3 V/m

Portable mobile RF communications equipment 
should be used no closer to any part of the E-CUBE 8, 
including cables, than the recommended separation 
distance calculated from the equation applicable to 
the frequency of the transmitter.

Recommended separation distance

800 MHz to 2.5 GHz

80 MHz to 800 MHz

where P is the maximum output power rating of the 
transmitter in watts (W) according to the transmitter 
manufacturer and d is the recommended separation 
distance in meters (m).

Field strengths from fixed RF transmitters, as deter-
mined by an electromagnetic site survey, a should 
be less than the compliance level in each frequency 
range. b

Interference may occur in the vicinity of equipment 
marked with the following symbol :

NOTE 1) At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2) �These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people.

a  �Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land 
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically 
with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site 
survey should be considered. If the measured field strength in the location in which the EUT is used exceeds 
the applicable RF compliance level above, the EUT should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the E-CUBE 
8.

b  Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
c  See examples of calculated separation distances in next table.
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Minimum distances
The E-CUBE 8 is intended for use in an electromagnetic environment in which radiated RF disturbances 
are controlled. The customer or the user of the E-CUBE 8 can help prevent electromagnetic interference 
by maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the E-CUBE 8 as recommended below, according to the maximum output power of the 
communications equipment.

CAUTION
Portable and mobile RF communications equipment (e.g. peripherals such as antenna cables and external 
antennas, two-way radio, cellular phones, wireless computer networks) should be used no closer than 30 
cm (12 inches) to any part of this system including cables provided by or designated by ALPINION MEDICAL 
SYSTEMS.

Recommended separation distances between portable and mobile RF communications equipment  
and the ultrasound unit

Rated maximum output 
power of transmitter [W]

Separation distance according to frequency of transmitter [m]

150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 2.5 GHz

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 
metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where p is the 
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.
NOTE 1) At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
NOTE 2) �These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people.

Immunity and compliance level for system

Immunity test Frequency of Interest 
[MHz] Actual Immunity Level Compliance Level

Conducted RF  
IEC 61000-4-6 0.15 MHz to 80 MHz 3 Vrms 0.3 Vrms

Radiated RF  
IEC 61000-4-3

80 MHz to 800 MHz 3 V/m 1 V/m

800 MHz to 2.5 GHz 3 V/m 3 V/m
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Diagnostic Ultrasound Indications for Use Format

E-CUBE 8 Ultrasound System
Indications for Use (Describe)

The device is intended for use by a qualified physician for the evaluation of soft tissue and blood flow in 
the clinical applications; Fetal, Abdominal (renal & GYN/pelvic), Pediatric, Small Organ (breast, testes, 
thyroid), Neonatal Cephalic, Adult Cephalic, Trans-rectal, Trans-vaginal, Musculo-skeletal (Conventional), 
Musculo-skeletal (Superficial), Cardiac (adult& pediatric), Peripheral Vascular (PV), and Urology (including 
prostate).  

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P P

Abdominal P P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P P

Small Organ 
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic P P P P P P P

Adult Cephalic P P P P P P P

Trans-rectal P P P P P P P N

Trans-vaginal P P P P P P P N

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult P P P P P P P P

Cardiac Pediatric P P P P P P P P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P P N

Urology (including prostate) P P P P P P P P

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with C1-6CT Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with C5-8NT Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic P P P P P P P

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult P P P P P P P

Cardiac Pediatric P P P P P P P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with SC1-4H Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) N N N N N N N

Musculo-skeletal (Superficial) N N N N N N N

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K161439; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with SC1-4HS Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) N N N N N N N

Musculo-skeletal (Superficial) N N N N N N N

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K161439; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with SC1-6H Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K161439; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with L3-12T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic P P P P P P P

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with L3-12H Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic P P P P P P P

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with L3-12HWD Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with L8-17H Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal N N N N N N N

Abdominal N N N N N N N

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric N N N N N N N

Small Organ
(breast, testes, thyroid) N N N N N N N

Neonatal Cephalic N N N N N N N

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) N N N N N N N

Musculo-skeletal (Superficial) N N N N N N N

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate)

N = new indication; P = previously cleared by FDA; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with IO3-12 Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal  (Conventional) N N N N N N N

Musculo-skeletal  (Superficial) N N N N N N N

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate)

N = new indication; P = previously cleared by FDA K150773; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with IO8-17T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ
(breast, testes, thyroid) P P P P P P P

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional) P P P P P P P

Musculo-skeletal (Superficial) P P P P P P P

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N

Urology (including prostate)

N = new indication; P = previously cleared by FDA K153424; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with SP3-8T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic P P P P P P P

Adult Cephalic P P P P P P P

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult P P P P P P P

Cardiac Pediatric P P P P P P P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with P1-5CT Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic P P P P P P P

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult P P P P P P P

Cardiac Pediatric P P P P P P P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with VC1-6T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P P

Abdominal P P P P P P P P

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric P P P P P P P P

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel

Urology (including prostate) P P P P P P P P

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with VE3-10H Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P P

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal P P P P P P P P

Trans-vaginal P P P P P P P P

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel N N N N N N N N

Urology (including prostate) P P P P P P P P

N = new indication; P = previously cleared by FDA K161439; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with EV3-10T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal P P P P P P P

Trans-vaginal P P P P P P P

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with EC3-10T Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal P P P P P P P

Trans-vaginal P P P P P P P

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with E3-10 Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal P P P P P P P

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ 
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal P P P P P P P

Trans-vaginal P P P P P P P

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult

Cardiac Pediatric

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P P P P P P P

Urology (including prostate) P P P P P P P

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with CW2.0 Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult P

Cardiac Pediatric P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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E-CUBE 8 with CW5.0 Transducer
Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows:

Clinical Application

Mode of Operation

B M PWD CWD Color 
Doppler

Power 
Doppler

Tissue 
Harmonic 
Imaging

Combined* 
(Specify)

Other** 
(Specify)

Ophthalmic

Fetal

Abdominal

Intra-operative (Specify)

Intra-operative (Neuro)

Laparoscopic

Pediatric

Small Organ
(breast, testes, thyroid)

Neonatal Cephalic

Adult Cephalic

Trans-rectal

Trans-vaginal

Trans-urethral

Trans-esoph. (non-Card.)

Musculo-skeletal (Conventional)

Musculo-skeletal (Superficial)

Intravascular

Cardiac Adult P

Cardiac Pediatric P

Intravascular (Cardiac)

Trans-esoph. (Cardiac)

Intra-cardiac

Peripheral vessel P

Urology (including prostate)

N = new indication; P = previously cleared by FDA K172732; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D
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Acoustic Output
The E-CUBE 8 ultrasound system shows the acoustic output display (e.g. Mechanical Index (MI), Thermal 
Index (TI)) on the upper right side of the screen. This acoustic output display allows you to monitor the 
acoustic levels generated by the system. 

Two standards for the acoustic output display are as follows:

AIUM/NEMA UD3 Standards for Real-time Display of Thermal and Mechanical Acoustic Output Indices on 
Diagnostic Ultrasound equipment.

IEC 60601-2-37, Mechanical Electrical Equipment – Part2-37: Particular Requirements for the Safety of 
Ultrasound Medical Diagnostic and Monitoring Equipment.

WARNING
You should use the E-CUBE 8 ultrasound system at the lowest mechanical/thermal index setting necessary to 
generate clinically acceptable images.
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Acoustic output display (Mechanical/Thermal indices)
The E-CUBE 8 ultrasound system displays Mechanical index (MI) and Thermal index (TI) on the upper 
right side of the screen as shown below.

The acoustic output display has three values as follows:

	• Mechanical Index (MI) 

	• Thermal Index (TI)

	• Power value

MI is used as an indicator of the mechanical bio-effect such as cavitation in the tissue. TI represents the 
ratio of total power to the power required to raise tissue by 1°C. The power value informs you of where 
the system is operating within the range of available output power.

One of the following TI values display on the screen based on the application and type of tissue.

	• Soft Tissue Thermal Index (TIS) 

	• Bone Thermal Index (TIB)

	• Cranial Bone Thermal Index (TIC)

The TI and MI are displayed all the times. The MI and TI display start at a value of 0.4 and increments in 
steps of 0.1 (values less than 0.4 are displayed as < 0.4).

WARNING
Be sure to have read and understood control explanations for each mode used before attempting to adjust 
the power control or any control that can affect Acoustic Output.

Controls affecting acoustic output
The potential for producing mechanical bioeffects (MI) or thermal bioeffects (TI) can be influenced by 
certain controls. The power control has the most significant effect on Acoustic Output. Indirect effects 
may occur when adjusting controls.

Controls that can influence MI and TI are detailed under the bioeffects portion of each control in the 
Image chapter. Always observe the acoustic output display for possible effects.

To minimize exposure time and keep ultrasound levels low, operate your system by using the ALARA (As 
Low As Reasonably Achievable) principle, increasing output only when you needed to obtain diagnostic 
image quality. It is recommended that all users receive ALARA training program. The ALARA training 
program by ALPINION application specialists provides you with basic ultrasound principles, possible 
biological effects, the derivation and meaning of the indices, ALARA principles, and examples of specific 
applications of the ALARA principle.
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Principle of ALARA
The principle of ALARA, which stands for As Low As Reasonably Achievable, is to keep the radiation 
exposure at the minimum level necessary to obtain the diagnostic information. This principle is widely 
practiced in medical x-ray protection where exposure at any level is potentially harmful. Historically, 
ALARA was initiated as a cautious approach for dealing with uncertain hazards but has since become the 
principle method for reducing the risk of injury from hazards that do not have safe minimum threshold.

While no minimum thresholds for harmful bioeffects have been established with the use of diagnostic 
ultrasound, the principle of ALARA can be readily implemented on equipment incorporating an output 
display. As the operator adjusts the equipment to optimize the image quality, the display interactively 
updates to indicate the effect on output.

Controls that have no noticeable impact on image quality should be set to minimize the output while 
controls that improve the image quality and also increase acoustic output should be set no higher than 
needed to achieve a diagnostic quality image.
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This chapter describes:

Appendix
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Appendix A. Biopsy Guide
The system supports biopsy capability for the transducers listed in the table below.

Biopsy Guide Transducer Type Dimension Manufacturer

L3-12 Biopsy L3-12T, L3-12H Multi-angle 90.5(W)×48.3(D)×22.9(H) mm CIVCO Medical 
Solutions

SC1-4HS Biopsy SC1-4HS Multi-angle 101.6(W)x56.6(D)x30.5(H) mm CIVCO Medical 
Solutions

SC1-6 Biopsy C1-6CT, SC1-4H, 
SC1-6H

Multi-angle 106.7(W)×55.8(D)×27.9(H) mm CIVCO Medical 
Solutions

E3-10 Biopsy  
(Disposable)

E3-10 Single-angle 167.6(W)x17.8(D) mm CIVCO Medical 
Solutions

E3-10 Biopsy  
(Reusable)

E3-10 Single-angle 157.8(W)x25.4(D) mm CIVCO Medical 
Solutions

EN3-10 Biopsy  
(Disposable)

EV3-10T, EC3-10T Single-angle 147.8(W)×20.7(D) mm  Protek Medical 
Products 

EN3-10 Biopsy  
(Reusable)

EV3-10T, EC3-10T Single-angle 138.8(W)×28.0(D) mm  Protek Medical 
Products 

VE3-10H Biopsy  
(Disposable)

VE3-10H Single-angle 148.3(W)x35.5(D) mm  Protek Medical 
Products 

VE3-10H Biopsy  
(Reusable)

VE3-10H Single-angle 142.4(W)x40.9(D) mm  Protek Medical 
Products 

WARNING
The biopsy option is intended for use by a duly licensed physician who has received the appropriate training 
in biopsy techniques as dictated by current relevant practices, as well as in proper operation of the ultrasound 
unit.
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Biopsy Starter Kit for Linear and Convex Transducers
Convex and Linear transducers have an optional biopsy kit specific for each transducer. The biopsy kit 
consists of:

	• A reusable non-sterile bracket

	• Disposable sterile Ultra-Pro II™ Needle guide kits (CIVCO Medical Solutions) consisting of:

–	 Sets with needle inserts covering gauge size 14 through 23 (2.1 mm to 0.6 mm)

–	 Sterile sheath

–	 Rubber bands

–	 Gel

	• Instructions

In addition sterile Ultra-Pro II™ Needle guide kits can be ordered as replacement kit.

WARNING
Read the instructions and the user’s guide for the Ultra-Pro II™ Needle guide kits before using the biopsy 
equipment.

Biopsy Starter Kit for Endocavity Transducers
The endocavity transducer has an optional specific biopsy kit. The biopsy kit consists of:

	• Disposable sterile needle guide/ Reusable  non-sterile needle guide

	• Sterile sheath

	• Rubber bands

	• Gel

	• Use Instructions for Disposable Endocavity Needle Guide/ Use Instructions for Reusable Endocavity 
Needle Guide

In addition disposable sterile endocavity needle guide can be ordered as replacement kit.

WARNING
Read the instructions for the Disposable/Reusable Endocavity Needle Guide from Protek Medical Products 
before using the biopsy equipment.
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